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အ ခြေြေံ သင်ြေန််းစာ အတွက် လ ိုအပ်ြေျက် 

ဤအ ခြေြေံ သင်ြေန််းစာ အတွက် သင်တန််းသူ/သာ်းမျာ်းက Computerက ို အသင်ေ့အတင်ေ့အဆင်ေ့မှ ကျွမ််းကျင်အဆင်ေ့ အထ  

အသိုံ်းခပြုတတ်ရန် လ ိုအပ်ပါသည်။ သ ိုို့မှသာ သင်ကကာ်းသူ အတွက် ရာ၊ သင်ယူသူအတွက်ပါ အဆင် ခပ  ြေျာ မွဲ့ပပ ်း လ ိုရာ 

ြေရ ်း ရာက်ပါမည်။ Keyboard က ို အသိုံ်းခပြုတတ်ခြေင််း။ Mouse က ို အသိုံ်းခပြုတတ်ခြေင််း၊ Software မျာ်းက ို အဖွင်ေ့ အပ တ် 

လိုပ်တတ်ခြေင််း၊ Software အသိုံ်းခပြုနည််းမျာ်းက ို သ ရှ ထာ်းရပါမည်။  

Computer အ ခြေြေံသင်တန််း (Microsoft Office Suite သ ိုို့မဟိုတ် OpenOffice Suite) က ို  ကာင််းစွာသ ရှ ရန်လ ိုအပ်ပါသည်။ 

အြေျ  ြုဲ့ နရာမျာ်းတွင် GIS  ခမပိုံမျာ်းက ို ခမန်မာဘာသာခဖင်ေ့  ရ်းဆွဲရမည် ခဖစ် သာ ကကာင်ေ့ အသိုံ်းမျာ်း သာ ခမန်မာ၃ လက်ကွက် 

ခမန်မာစာက ိုလည််း ကျွမ််းကျင်စွာ ရ ိုက်န ိုင်ရပါမည်။ 

Computer အ ခြေြေံရှ မှသာ GIS software မျာ်း၏ Tool မျာ်းက ို ဖွင်ေ့ခြေင််း၊ Tool မျာ်း၏ အလိုပ်လိုပ်ပိုံ သ ဘာတရာ်းက ို 

နာ်းလည်န ိုင်ခြေင််း၊ GIS ဖ ိုင်မျာ်းက ို ဖွင်ေ့ခြေင််း၊ အသစ်ဖန်တ ်းခြေင််း၊ GIS ထဲသ ိုို့ ဖ ိုင် input/output လိုပ်ခြေင််း၊ software နှင်ေ့ data က ို 

ကွဲခပာ်း အာင် နာ်းလည်န ိုင်ခြေင််း၊ Digitizing ခပြုလိုပ်တတ်ခြေင််း စသည်တ ိုို့က ို  ကာင််းမွန်စွာ ခပြုလိုပ်န ိုင်ပါမည်။ အြေျ  ြုဲ့ သာ 

အဆင်ေ့မျာ်းတွင် GIS လိုပ်ထိုံ်းလိုပ်နည််းမျာ်း အတ ိုင််း တင်ခပထာ်း သာ်လည််း သင်ယူသူ၏ Computer အ ခြေြေံ အာ်းနည််းြေျက် 

 ကကာင်ေ့သာ ထ ိုသင်ြေန််းစာမျာ်းက ို နာ်းလည်ရ ြေက်ြေဲ နတတ်ပပ ်း၊ GIS က ို သင်ယူရန် ြေက်ြေဲသည်ဟို ခဖစ်သွာ်းတတ်ပါသည်။ 

GIS ဆ ိုတာဘာလဲ 

A geographic information system (GIS) is a computer system designed to capture, store, manipulate, analyze, 

manage, and present all types of geographical data.  

GIS ဆ ိုတာ ပထဝ အြေျက်အလက် တွက ို  ကာက်ယူစို ဆာင််းခြေင််း၊ သ မ််းဆည််းသ ိုမှ ်းခြေင််း၊  လေ့လာဆန််းစစ်ခြေင််း၊ စ မံခြေင််း၊ 

တင်ဆက်ခပသခြေင််း စသည်တ ိုို့က ို ခပြုလိုပ်န ိုင်တဲေ့ computer စနစ်တစ်ြေိုပဲ ခဖစ်ပါတယ။် 

“A geographic information system (GIS) integrates hardware, software, and data for capturing, managing, 

analyzing, and displaying all forms of geographically referenced information. (ESRI) 

GIS allows us to view, understand, question, interpret, and visualize data in many ways that reveal relationships, 

patterns, and trends in the form of maps, globes, reports, and charts. 

GIS နဲဲ့ဘာလိုပ်န ိုင်လဲ 

GIS က ိုကမဘာရဲဲ့  နရာ ေသ တစ်ြေိုြေိုနဲဲ့ ပတ်သက် နတဲေ့ အြေျက်လက်မျ  ြု်း၊ ဆက်စပ်မှုရှ တဲေ့ မည်သည်ေ့က စစမျ  ြု်းတွင် မဆ ို 

အသိုံ်းခပြုန ိုင်ပါတယ။် GIS က ို ကဏ္ဍနယ်ပယ်  တာ် တာ်မျာ်းမျာ်းမှာ အသိုံ်းြေျ နကကပပ ်း၊ GIS ဟာ အ တာ် လ်း Popular 

ခဖစ်လာပါတယ။် မ မ တ ိုို့ရဲဲ့ လိုပ်ငန််း အမျ  ြု်းအစာ်းအလ ိုက် ပေါ် မူတည်ပပ ်း GIS နည််းပညာဟာ အသိုံ်းဝင်ပါတယ။် (ေါ ပမယ်ေ့ တစ်ြေို 

မှတ်သာ်းထာ်း ရမှာ က တာေ့ GIS ဆ ိုတာ ဘာလာလာ ကိုသ ပ်းန ိုင်တဲေ့ Panacea ဆ ိုတဲေ့မ သ ဆ်းမျ  ြု်း တာေ့ မဟိုတ်ပါဘူ်း။) GIS က ို 

အတ ိုင််းအတာ တစ်ြေိုအထ  Decision support အတွက် အ ထာက်အပံေ့ ခဖစ် စတဲေ့ Tool တစ်ြေို အ နနဲဲ့ အဓ က အသိုံ်းခပြုန ိုင်ပါသည်။ 

အြေျ  ြုဲ့လိုပ်ငန််းမျာ်းမှာ တာေ့ GIS ဟာ မရှ မခဖစ် အ ရ်းပါတဲေ့ အပ ိုင််းတစြ်ေို ခဖစ်ပပ ်း လိုပ်ငန််းရဲဲ့ ရာြေ ိုင်နှုန််း  တာ် တာ်မျာ်းမျာ်းမှာ 

အသိုံ်းခပြု နရပါတယ်။ ယ နဲ့ အလျင်အခမန် တ ို်းတက် န သာ Digital  ြေတ် ကာလတွင် GIS က ို မခဖစ်မ န 

အသိုံ်းခပြုတတ်ရပါမည်။ GIS က ကျွန်ိုပ်တ ိုို့၏ ပတ်ဝန််းကျင်ရှ  ကမဘာကက ်းက ို အသွင်သစ် အခမင်သစ်ခဖင်ေ့ ကကည်ေ့ခမင်တတ် စရန် 

စွမ််း ဆာင် ပ်းန ိုင်ပါသည်။ GIS က ို သိုံ်းပပ ်း တာေ့  

• ဘာ တွ ဘယမ်ှာရှ သလဲ - Map Where Things Are 
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• အ ရအတွက် ဘယ် လာက် ရှ သလဲ - Map Quantities 

• ဘယ် လာက် သ ပ်သည််းမှုရှ  သလ ဲ- Map Densities 

• အဲေ  နရာထဲမှာ ဘာ တွရှ ြေဲေ့လ ဲ- Find What's Inside 

• အဲေ  နရာ အန ်းအနာ်းမှာ ဘာ တွရှ  နသလဲ - Find What's Nearby 

• ဘာ တွ  ခပာင််းလဲသွာ်းသလဲ၊ ဘယ် လာက်  ခပာင််းလဲသွာ်းသလဲ - Map Change 

စသည်တ ိုို့က ို အလွယတ်ကူ သ ရှ န ိုင် စရန် စွမ််း ဆာင်  ပ်းန ိုင်ပါသည်။(ESRI) 

GIS နည််းပညာက ို မည်သည်ေ့ Enterprise အမျ  ြု်းအစာ်း Information System Framework နှင်ေ့မဆ ို ပူ်း ပါင််းပပ ်း ထည်ေ့သွင််း 

အသိုံ်းခပြုန ိုင်ပါသည်။ 

Geoinfomatics (GIS/GPS/RS တ ိုို့ဆကန်ွယ်ပို)ံ 

GIS က ိုအသိုံ်းခပြုသည်ေ့ အြေါမှာ Remote Sensing/GPS/Photogrammetry စသည်တ ိုို့နှင်ေ့ မျာ်းစွာ ဆက်စပ် နပပ ်း၊ 

၎င််းပညာရပ်မျာ်းက ိုပါ တွဲပပ ်း သိုံ်း လေ့ရှ  သာ ကကာင်ေ့ လက် တွဲ့တွင် GIS ၏ margin က ို ြေွဲခြော်းဖ ိုို့ ြေက်ြေဲပါတယ။်  နာက်ပ ိုင််းမှာ 

 လေ့လာရမည်ေ့ သင်ြေန််းစာ တွထဲမှာ  ဖာ်ခပထာ်းပါသည်။ အဲေ  တာေ့ GIS က ို လေ့လာရင် Remote Sensing ၊ GPS ၊ 

Photogrammetry စသည်ေ့ ပညာရပ်မျာ်းပါ မလွဲဧကန် ပါဝင်လာမည် ခဖစ်ပါသည်။ 

GIS ရဲဲ့အစ တ်အပ ိုင််းမျာ်း 

 

GIS ၏ အဓ က အစ တအ်ပ ိုင််းကက ်း (၆) ြေို 

GIS က ိုအသိုံ်းခပြုရန်အတွက် hardware  ြေေါ် Computer လ ိုပါတယ။် Personal computer, Laptop, 

Server, စသည်ခဖင်ေ့ မ မ အသိုံ်းခပြုလ ိုတဲေ့ အ ပေါ်မှာမူတည်ပပ ်း အမျ  ြု်းမျ  ြု်း လ ိုအပ်ပါတယ။် အြေို နာက်ပ ိုင််းမှာ 

Mobile phone  တွမှာ တာင် GIS နည််းပညာ တွပါ နပါပပ ၊ သိုံ်းစွဲ နကကပါပပ ။ အဲေ  တာေ့ Computer 

တစ်ြေို တာေ့ အနည််းဆိုံ်း လ ိုအပ်ပါတယ။် Computer မရှ ရင်  တာေ့ GIS နည််းပညာက ို 

အသိုံ်းခပြုလ ိုို့မရန ိုင်ပါဘူ်း။   
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လူတစ်ဦ်းတစ် ယာက်သာ အသိုံ်းခပြုမယ်ဆ ိုရင် တာေ့ Laptop/Desktop  လ်း တစ်လိုံ်းနဲဲ့ လိုံ လာက်တာ ပါို့။ အလိုပ်ထဲမှာ 

လူအမျာ်းနဲဲ့ သိုံ်းရင်လည််းပဲ GIS အတွက် သ ်းသန်ဲ့ တစ်လိုံ်းစ၊ နှစလ်ိုံ်းစ နဲဲ့ သိုံ်းရင်လည််း ရန ိုင်တာ ပါို့။ မျာ်းခပာ်း သာ data  တွက ို 

share လိုပ်ပပ ်း အမျာ်းက ဝ ိုင််းပပ ်းလိုပ်ရမည်ေ့ လိုပ်ငန််းမျ  ြု်းအတွက်ဆ ိုပါက Server Computer  ပေါ်မှာ 

တင်ပပ ်း တာေ့ share လိုပ်ဖ ိုို့ Server Grade computer မျ  ြု်းက ို သိုံ်းစွဲရပါမည်။ ဌာန ပါင််းစိုံက 

ဝ ိုင််းသိုံ်းြေျင်ရင် တာေ့ Enterprise Level သိုံ်းလ ိုို့ရန ိုင်တဲေ့ Server နဲဲ့ Network  တွက ို သိုံ်းဖ ိုို့ လ ိုလာမှာ ပါို့။ 

အဲ တစ်န ိုင်ငံလိုံ်း တစ်ကမဘာလိုံ်း သိုံ်း စြေျင်ရင် တာေ့ Web Server တစ်လိုံ်းနဲဲ့ Internet ြေျ  တ်ဆက်မှုပါ 

လ ိုလာမှာ ပါို့။  

 နာက်တစ်ြေိုက Software  တွ လ ိုအပ်ပါတယ်။ မ မ လိုပ် ဆာင်ရမည ေ့ အလိုပ်အမျ  ြု်းအစာ်း၊ ရည်ရွယြ်ေျက်၊ လ ိုအပ်ြေျက် 

 ပေါ်မူတည်ပပ ်း Software အမျ  ြု်းမျ  ြု်း ရှ ပါတယ်။ လ ိုအပ်ပါတယ်။ က ိုယ်လိုပ် စြေျင်တဲေ့ အလိုပ်မျ  ြု်းက ို လိုပ် ဆာင် ပ်းန ိုင်တေဲ့ feature 

 တွပါဝင်တဲေ့ software မျ  ြု်း လ ိုအပ်ပါတယ်။ ဥပမာ အမှတ ် ၂ ြေို (သ ိုို့မဟိုတ်) တည် နရာ (၂)ြေို၏ အကွာအ ဝ်းက ို 

တ ိုင််းတာြေျင်တယ်ဆ ိုရင် တ ိုင််းတာခြေင််းက ို ခပြုလိုပ်ဖ ိုို့ tool  တွ feature  တွ ပါရှ တဲေ့ GIS Software မျ  ြု်း လ ိုအပ်တာ ပါို့။ 

သိုံ်းဖက်ခမင် ခမပိုံက ို ကကည်ေ့ြေျင်တယဆ် ိုရင် 3D feature ပါတဲေ့ software မျ  ြု်းလ ိုတာ ပါို့။ Processing က ိုလိုပ်ဖ ိုို့ ဆ ိုရင် processing 

module  တွပါတဲေ့ sotware လ ိုတာ ပါို့။  data  တွ အမျာ်းကက ်း သ မ််းထာ်းရန် လ ိုအပ်ပါက database software လ ိုမှာ ပါို့။  ခမပိုံက ို 

Layout ခပင်ြေျင်တယ်ဆ ိုရင် Layout feature ပါတဲေ့ GIS software မျ  ြု်း လ ိုမှာ ပါို့။ Digitizing လိုပ်ြေျင်တယ်ဆ ိုရင် digitizing feature 

 တွပါတဲေ့ software မျ  ြု်း လ ိုမှာ ပါို့။ ယြေို စာအိုပ်ထဲမှာ တာေ့ Desktop GIS software က ိုပဲ နမူနာခပြုလိုပ်ပပ ်း  ဖာ်ခပ ထာ်းပါတယ်။ 

သ ိုို့ ပမယ်ေ့ သ ထာ်းရမှာက GIS ဆ ိုတာက Desktop application တစ်မျ  ြု်းတည််းရှ တာ မဟိုတ်ပါဘူ်း။ ေါို့ခပင ် ဘာ GIS 

အမျ  ြု်းအစာ်းမျာ်း ရှ  သ်းတာလဲ  ခပာခပပါလာ်း (Assignment)။ 

Free GIS software မ  ျားထဲမှ အခ   ျို့က   ော့ 

Free GIS software မ  ်ားထမဲွ အခ  ်ဳိ႕ကေတ ာ့  

GRASS GIS – Originally developed by the U.S. Army Corps of Engineers: a complete GIS. 
 
 
gvSIG – Written in Java. Runs on Linux, Unix, Mac OS X and Windows. 
 
 
 
ILWIS (Integrated Land and Water Information System) – Integrates image, vector and thematic 
data. 
 
 
JUMP GIS / OpenJUMP ((Open) Java Unified Mapping Platform) – The desktop GISs 
OpenJUMP, SkyJUMP, deeJUMP and Kosmo all emerged from JUMP.[3] 

 

 
MapWindow GIS – Free desktop application and programming component. 
 
 
QGIS (previously known as Quantum GIS) – Runs on Linux, Unix, Mac OS X and Windows. 
 
SAGA GIS (System for Automated Geoscientific Analysis) –- A hybrid GIS software. Has a 

unique Application Programming Interface (API) and a fast growing set of geoscientific 
methods, bundled in exchangeable Module Libraries. 
 
 

uDig – API and source code (Java) available. 
 
 

စသည်တ ိုို့ ခဖစ်ကကပါတယ်။ 

http://en.wikipedia.org/wiki/GRASS_GIS
http://en.wikipedia.org/wiki/U.S._Army_Corps_of_Engineers
http://en.wikipedia.org/wiki/GvSIG
http://en.wikipedia.org/wiki/ILWIS
http://en.wikipedia.org/wiki/JUMP_GIS
http://en.wikipedia.org/wiki/Kosmo
http://en.wikipedia.org/wiki/List_of_geographic_information_systems_software#cite_note-spatialserver.net-3
http://en.wikipedia.org/wiki/MapWindow_GIS
http://en.wikipedia.org/wiki/QGIS
http://en.wikipedia.org/wiki/SAGA_GIS
http://en.wikipedia.org/wiki/Application_Programming_Interface
http://en.wikipedia.org/wiki/UDig
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အခြော်း သာ commercial GIS software မျာ်းထဲက အြေျ  ြုဲ့က တာေ့ ESRI ArcGIS ၊ MapInfo ၊ Global Mapper ၊ eCognition ၊ 

Manifold GIS ၊ Intergraph ၊ IDRISI ၊ TNTmips စသည်တ ိုို့ ခဖစ်ကကပါတယ။် 

 နာက်တစ်ြေိုက Data လ ိုအပ်ပါတယ။် GIS မှာ အဓ ကက data  တွက ို Process လိုပ်ဖ ိုို့၊ analysis လိုပ်ဖ ိုို့ ခဖစ်ပါတယ်။ data 

အရင်ဆိုံ်း ရှ ထာ်းပါမှ GIS အလိုပ် တွက ို လိုပ်လ ိုို့ ရတာက ို်း။  ေတာဆ ိုတာ ဘာလဲ။ It is data about our real world. GIS  ေတာ 

ဆ ိုတာက ကျွန်ိုပ်တ ိုို့ ခမင် တွဲ့  နရတဲေ့ ကမဘာကက ်းရဲဲ့ သွင်ခပင် လကခဏာ physical feature ခဖစ်တဲေ့ ခမစ် ြေျာင််း၊  တာ တာင်၊ 

အ ဆာက်အဦ်း ၊ ကာ်းလမ််း စသည်တ ိုို့ နဲဲ့ အခြော်း သာ ၎င််းတ ိုို့ရဲဲ့ ဂိုဏ်ပိုေ် တွခဖစ်တဲေ့ (Attribute)  ရ၏အ ရာင် (အခပာ၊ အဝါ 

စသည်)၊ သစ်ပင်အရွယ်အစာ်း (အကက ်း၊ အ သ်း စသည်)၊ အ မ်၏အ ရာင် (အန ၊ အစ မ််း စသည်)၊ အ မ်ပ ိုင်ရှင် အမည်၊ 

ကာ်းလမ််းအမျ  ြု်းအစာ်း ( ဖာက်လိုပ် သာြေိုနှစ်၊ ခပငဆ်င် သာ ြေိုနှစ်) စသည်တ ိုို့ ခဖစ်ပါတယ။် GIS  ေတာက အဲေါ တွက ို 

က ိုယ်စာ်းခပြု ထာ်းခြေင််း ခဖစ်ပါတယ်။ 

ဥပမာ  နာက်တစ်ြေို အ နနဲဲ့ န ိုင်ငံတစ်ြေိုရဲဲ့ ခပည်နယ်တ ိုင််း၊ ပမ ြုဲ့နယ်၊ ရပ်ကွက်၊  ကျ်းရွာမျာ်းအလ ိုက် လူဦ်း ရ စာရင််း ဇယာ်း  တွဟာ 

attribute  တွခဖစ်ပါတယ်။  ေတာ တွ မရှ ြေဲေ့ရင် တာေ့ နည််းတစ်မျ  ြု်းမျ  ြု်းနဲဲ့  ေတာ တွက ို တ ိုင််းတာ ပပ ်း တာေ့ ရယူရတယ။် Create 

လိုပ် ပ်းရတယ်။ လိုပ်လ ိုို့ရတယ်။ (ေါက ို Data Acquisition Process လ ိုို့လည််း  ြေေါ်တယ။်  နာက်အြေန််း  တွမှာ အဲေ အ ကကာင််းက ို 

အပ ိုင််းတစ်ြေို အ နနဲဲ့  ဖေါ်ခပထာ်းတယ်။) ဥပမာ  နရာတစ်ြေိုရဲဲ့ အပူြေျ  န်က ို သ ြေျင်ရင်၊ သာမ ိုမ တာနဲဲ့ တ ိုင််းတာ မှတ်သာ်းပပ ်း 

ရယူန ိုင်တာမျ  ြု်း ပါို့။ တ ိုင််းတာထာ်းတဲေ့ အပူြေျ  န်ဆ ိုတဲေ့  ေတာ ရှ ထာ်းမှသာ အပူြေျ  န ် ခပာင််းလဲမှုက ို ဆန််းစစ် လေ့လာလ ိုို့ ရမှာ ပါို့။ 

လကမဘာ ပေါ်မှာ သွာ်းတ ိုင််းရင် တာေ့ လရဲဲ့ data  တွရမှာ ပါို့။  နအ ကကာင််း တ ိုင််းတာ ထာ်းရင် တာေ့  နရဲဲ့ data ခဖစ်မှာ ပါို့။ 

ကကယ်တာရာ တွရဲဲ့အ ကကာင််း တ ိုင််းတာ မှတ်သာ်းထာ်းရင် ကကယ်တာရာ တွရဲဲ့ data ခဖစ်မှာ ပါို့။  

 ေတာရပပ ်းရင်လဲ  ေတာ တွက ို စနစ်တကျ Store လိုပ်ရပါတယ။် Data က ို Manage လိုပ်ရပါတယ။် Data က ို Maintain 

လိုပ်ရပါတယ်။  ေတာ တွ အသစ်တ ို်းလာလ ိုို့ပဲ ခဖစ်ခဖစ်၊  ခပာင််းလဲသွာ်းလ ိုို့ပဲ ခဖစ်ခဖစ်  ေတာ တွက ို အပမဲ Update 

လ ိုက်လိုပ် ပ်းရပါတယ်။ ဥပမာ  နဲ့နဲဲ့ည  ခပာင််းလဲ နတဲေ့ အပူြေျ  န်မျ  ြု်း၊ ရွာသွန််း နတဲေ့ မ ို်း ရြေျ  န်မျ  ြု်း၊ တ ို်းပွာ်းလာ နတဲေ့ လူဦ်း ရလ ိုမျ  ြု်း 

တ ိုို့လ ို ပါို့။ ထ ိုကဲေ့သ ိုို့ သာ data မျ  ြု်းက ို အပမဲတမ််းလ ိုက်ပပ ်း တာေ့ တ ိုင််းထွာ တွက်ြေျက် ကာ Update လိုပ် ပ်းရပါတယ်။ 

ေ မှာ တစ်ြေိုထပ်ပပ ်း စဉ််းစာ်းဖ ိုို့လ ိုတာက  ေတာရဲဲ့သက်တမ််း ဆ ိုတာပါ။ ေ  ေတာက ို ဘယ်အြေျ  န်တိုန််းက တ ိုင််းတာြေဲေ့တာလ ဲဆ ိုတဲေ့ 

အြေျ  န်ကာလက ိုပါ မှတ်သာ်းထာ်းဖ ိုို့  ကာင််းတယ်ဗျ။ ပပ ်းြေဲေ့တဲေ့နှစ်က  ကာက်ထာ်းတဲေ့ လူဦ်း ရက ိုပဲ က ိုင်ပပ ်း ေ  နဲ့ မိုန်ဲ့ ဝြေဲေ့လ ိုို့ 

ပ ို နတဲေ့လူဦ်း ရအတွက် မိုန်ဲ့မ လာက်ရင် အြေက်အြေဲ ခဖစ်သွာ်းန ိုင်ပါတယ။် မိုန်ဲ့ရတဲေ့လထူဲမှာ က ိုယ်မပါဘဲ ခဖစ်သွာ်းမှာ ပါို့။ 

က ိုယ်သိုံ်းတဲေ့  ေတာရဲဲ့ သ ဘာသဘာဝ က ိုလည််း သ ထာ်းဖ ိုို့ လ ိုတယ်ဗျ။ တစ်ြေျ  ြုဲ့ သာ  ေတာ တွက သ ပ် အ ခပာင််းအလဲ 

မရှ တာမျ  ြု်း ရှ တယ်။ အြေျ  န်မျာ်းစွာကကာမှ  နာက်တစ်ကက မ် ထပ်မံ ကာက်ရန် လ ိုအပ် ပါတယ။် သစ်ပင် ပါက် လာတာမျ  ြု်း လ ို ပါို့။ 

အရင်နှစ်က  ေတာ တွနဲဲ့ သိုံ်းလ ိုို့ ရြေျင်ရန ိုင် သ်းတယ် (မြေိုတ်ြေဲေ့ရင် ပါို့)။ တစ်ြေျ  ြုဲ့ သာ  တွက အ ခပာင််းအလဲ သ ပ်ခမန်တတ်တယ်။ 

Dynamic ခဖစ်တယ်။ အဲေ အြေါကျရင် ြေပ်စ တ်စ တ် လ်း တ ိုင််း ပ်းရန်၊  ကာက်ယူရန် လ ိုအပ်ပါတယ။် ငှက်ဖျာ်းထတာတ ိုို့၊  သွ်းတ ို်း 

တက်တာ တ ိုို့လ ိုမျ  ြု်း တွ ပါို့။ ေါမှသာ Analysis လိုပ်တဲေ့အြေါအ သ်းစ တ် လိုပ်န ိုင်မှာ ပါို့။ က ဲ ေါ လာက်ဆ ို 

 ေတာဘာလဲသ  လာက် နပပ ။ က ိုယ်လိုပ်မဲေ့ Project အတွက် ဘယ်ဟာက  ေတာလဲ၊  ခပာခပကကည်ေ့ပါလာ်း (Assignment)။ 

 နာက်တစ်ြေိုက GIS က ို အသိုံ်းခပြုမည်ေ့လူ၊ အဖွဲဲ့အစည််း၊ အသ ိုင််းအဝ ိုင််း လ ိုအပ်ပါတယ။် သိုံ်းမယ်ေ့လူ တွက ဘယ်သူ တွလဲ။ အြေို 

စာဖတ် နကကတဲေ့ သူ တွ ပါို့။ ဘယ် နရာမှာ သိုံ်းမှာလဲ။ ဘာအတွက်နဲဲ့ သိုံ်းမှာလဲ။ သိုံ်းစွဲမယ်ေ့ လူပိုဂ္ ြုလ် သ ိုို့မဟိုတ် ဌာန၊ 

အဖွဲဲ့အစည််းနှင်ေ့သိုံ်းစွဲသည်ေ့ အ ကကာင််းအရာ ပေါ်မူတည်ပပ ်း၊ ကွာခြော်းသွာ်းမယ်။ ဥပမာ အစ ို်းရရိုံ်းက ပမ ြုဲ့ခပက ို စ မံဖ ိုို့အတွက်သိုံ်းမယ်၊ 

သဘာဝ သယံဇာတ တွက ို စ မံဖ ိုို့သိုံ်းမယ်၊ ကိုမပဏ က သူို့ ရာင််းကိုန်ပစစည််းက ို ခဖန်ဲ့ခဖ ်းဖ ိုို့ နဲဲ့  ရာင််းြေျဖ ိုို့   ်းကွက် အတွက်သိုံ်းမယ်၊ 

Taxi ကိုမပဏ က ြေရ ်းသည်က ို လ ိုရာ အ ရာက်ပ ိုို့ ဆာင်ဖ ိုို့အတွက် သိုံ်းမယ်၊ သဘာဝပတ်ဝန််းကျင်သမာ်းက ပတ်ဝန််းကျင်က ို 

 စာင်ေ့ကကပ် ကကည်ေ့ရှုရန် (Monitor) အတွက် သိုံ်းမယ်၊ သစ် တာ ခမ၊ စ ိုက်ပျ  ြု်း ခမ၊ လယ် ခမ တွက ို စ မံြေန်ဲ့ြေွဲရန် အတွက် သိုံ်းမယ်၊ 

 ရ ပ်း ဝတဲေ့လကူ  နရာအစိုံ  ရ ပ်းန ိုင်ဖ ိုို့အတွက် သိုံ်းမယ်၊ ဆည် ခမာင််းအင်ဂျင်န ယာက ဆည် ဆာက်ဖ ိုို့ ၊  ခမာင််း ဖာက်ရန် 
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အတွက် သိုံ်းမယ်၊ လမ််းအင်ဂျင်န ယာက လမ််းက ိုစနစ်တကျ စ မံဖ ိုို့အတွက် သိုံ်းမယ်၊ Survey အဖွဲဲ့ တွက Survey  ခမပိုံဆွဲဖ ိုို့ အတွက် 

သိုံ်းမယ်၊ Global Warming က ို လေ့လာ နသူမျာ်းက  ရြေဲ တာင် အရည်  ပျာ်တာ  စာင်ေ့ကကည်ေ့ဖ ိုို့အတွက် သိုံ်းမယ်၊ ကျန််းမာ ရ်း 

ဝန်ထမ််းမျာ်းက  နရာ ေသ အလ ိုက်၊ ရာသ အလ ိုက်  ရာဂါ ကူ်းစက်ပျဲံ့ပွာ်းမှု Pattern နဲဲ့ သတ  ပ်းြေျက်မျာ်း ထိုတ်ခပန်ဖ ိုို့ရန် အတွက် 

သိုံ်းမယ်၊ မ ို်း လဝသ ပညာရှင်မျာ်းက မ ို်း လဝသ အ ခြေအ နက ို  လေ့လာ မှတ်သာ်းရန်၊ ကက ြုတင်ြေန်ဲ့မှန််းြေျက်မျာ်း ထိုတ်ခပန်ရန် 

အတွက် သိုံ်းမယ်၊ သို တသန  ကျာင််းသူ၊ ကျာင််းသာ်းမျာ်းက အသစ်ရှာ ဖွဖ ိုို့ စူ်းစမ််း လေ့လာဖ ိုို့ အတွက်သိုံ်းမယ်၊ စသည်ခဖင်ေ့ 

အသိုံ်းခပြုမည်ေ့သူ မျာ်းစွာနှင်ေ့ အသိုံ်းခပြုန ိုင်သည်ေ့  နရာမျာ်းစွာ ရှ ပါမည်။ ယြေို စာဖတ်ရှု နသူလဲ ဘယမ်ှာ သိုံ်းမှာလဲ၊ ဘာလ ိုို့ 

သိုံ်းြေျင်ရတာလဲ ( ခဖကကည်ေ့ ပ်းပါ၊ Assignment)။ 

GIS ဘာသာရပ်က ို Aeronautics and Astronautics ၊ Anthropology ၊ Civil and Environmental Engineering ၊ Classics ၊ 

Electrical Engineering ၊ Geological and Environmental Sciences ၊ Geophysics ၊ History ၊ Political Science စသည်ေ့ 

ဘာသာရပ်နယ်ပယ် အသ ်းသ ်းတ ိုို့တွင် အသိုံ်းြေျရန် အတွက် သင်ကကာ်း နကကပိုံက ို Standford တကကသ ိုလ်တွင် နမူနာ အ နခဖင်ေ့ 

 လေ့လာ တွဲ့ရှ န ိုင်ပါသည်။  

(မူလရင််းခမစ်: https://lib.stanford.edu/geographic-information-systems-gis-branner-library/gis-related-classes) 

 နာက်ထပ် တစ်ြေိုက computer ရှ ပပ ၊ software လည််းထည်ေ့ထာ်းပပ ်းပပ ၊  ေတာ တစ်ြေျ  ြုဲ့လည််း ရှ ပပ ်းပပ ၊ သိုံ်းလ ဲ သိုံ်းြေျင် နပပ ၊ 

ြေက်တာက ဘယလ် ို သိုံ်းရမှန််း မသ ဘူ်း။ အဲေ  တာေ့ အသိုံ်းခပြုတဲေ့ပိုံစံနဲဲ့ အသိုံ်းခပြုတဲေ့နည််းလမ််း (method ၊ procedure) 

လည််းလ ိုအပ်ပါတယ။် Software က ို သိုံ်းတတ်သွာ်းပပ ဆ ိုရင် သိုံ်းမည်ေ့ နရာ လ ိုလာပါတယ။် အလိုပ်ထဲမှာ လက် တွဲ့ အသိုံ်းြေျတဲေ့ 

နည််းလမ််းမျ  ြု်း လ ိုလာပါတယ။် GIS Application  ြေေါ် GIS အသိုံ်းြေျနည််းဆ ိုတာ ပညာတစ်ြေိုပါပဲ။ ေ  နရာမှာ ဘာအတွက် 

အသိုံ်းြေျမှာလဲ၊ ဘယ်လ ိုပိုံစံမျ  ြု်းနဲဲ့ အသိုံ်းြေျမှာလဲ ဆ ိုတဲေ့ သိုံ်းပိုံသိုံ်းနည််း ကွာခြော်းပါတယ်။ က ိုယ်ေ့အလိုပ်နဲဲ့ သိုံ်းြေျင်တဲေ့ ရည်ရွယ်ြေျက်ဆ  

တစ်ြေါ ခပန် ရာက်သွာ်းပါတယ်။ GIS သ ဘာ တရာ်းက ို လက်မလွတ်ဘဲနဲဲ့ က ိုယ်ေ့အလိုပ်ထဲမှာ ခပန်ပပ ်း အသိုံ်းြေျကကရမှာပါ။  

မ မ မှာ computer ရှ တယ၊် software နဲဲ့ နမူနာ  ေတာ တွ  ပ်းပပ ်း၊ အသိုံ်းခပြုနည််း က ိုပါ  ဖာ်ခပ ပ်းထာ်းလ ိုို့ သ သင်ေ့သ လာက်၊ 

တတ်သင်ေ့သ လာက် တာေ့ တတ်သ သွာ်းပပ လ ိုို့ ဆ ိုန ိုင်ပါတယ်။ (စာဖတ်သူမှ စာအိုပ်ဖတ်ပပ ်း၊ က ိုယ်တ ိုင် လ ိုက်လိုပ်န ိုင် စရန် 

အတွက်ရည်ရွယ်ပပ ်း ခပင်ဆင်ထာ်းခြေင််း ခဖစ်ပါသည်။) ခပည်ေ့စိုံပပ ဟို ယူဆန ိုင်ပါပပ လာ်း၊ ဘာလ ို သ်းလဲ။ 

အာ်းစ ိုက်ထိုတဖ် ိုို့ လ ိုပါ သ်းတယ်။ အဲေ့ေါမှသာ စက်ဝ ိုင််း တစ်ပတ် လည်သွာ်းမှာ ပါို့။ လမ််းညွှန်  ပ်းမည်ေ့ စာအိုပ်က အသင်ေ့ရှ  နပပ ၊ 

လက် တွဲ့  လေ့ကျင်ေ့ြေန််း  တွလည််း ရှ  နပပ ၊  ေတာလည််း ရှ  နပပ ၊ software အသိုံ်းခပြုပိုံက ို ကျွမ််းကျင်စွာ အသိုံ်းခပြုတတ်ဖ ိုို့ 

က ိုယ်တ ိုင် အရင်ဆိုံ်း လ ိုက်လိုပ်ကကည်ေ့ဖ ိုို့ လ ိုအပ်မယ်။ လ ိုက်လိုပ်ကကည်ေ့ တာေ့ သ ပ် တာေ့ မြေက်ဘူ်းဆ ိုတာက ို  တွဲ့ရပါလ မ်ေ့မယ်။ အဲ 

 နာက်ဆိုံ်း အ ရ်းကက ်းဆိုံ်းက က ိုယ်ေ့ရဲဲ့လိုပ်ငန််းထမဲှာ ခပန်လည် အသိုံ်းြေျတတ်ဖ ိုို့ လ ိုအပ်ပါတယ။်  ခပ်းတဲေ့နည််းက ို သ ထာ်းပပ ်း 

သကာလ၊ အ ခပ်းြေျန်ပ ယံ ခဖစ် အာင် မ မ က ိုယ်တ ိုင်ပဲ ကျင်ေ့ကကံရမှာ ခဖစ်ပါတယ်။ က ိုယ်က လ ိုြေျင်စ တ ်တတ်ြေျင်စ တ် ခပင််းခပစွာ၊ 

လိုပ်ြေျင်စ တ်ကက ်းစွာနဲဲ့ ဉာဏ်သိုံ်းပပ ်း အာ်းထိုတ်ရင် ခဖစ်ရမှာ ပါို့။ (There will be your own project assignment in later part of 

the training for the application of what you've learnt.)  

Beginner  တွအတွက် GIS ရဲဲ့ Fundamental က ိုသ ထာ်းပပ ၊ Software  တွ Tool  တွက ို  ကာင််း ကာင််း သိုံ်းတတ်သွာ်းပပ  ဆ ိုရင် 

GIS အသိုံ်းြေျတဲေ့နည််းက ို သာဓက ကာင််း တွဆ က န နမူနာယူပပ ်း ဆက် လေ့လာပါ။  ဘာလိုပ်ရသလဲ ဆ ိုပပ ်း တာေ့ လ ိုက်ပပ ်း 

စူ်းစမ််းကကည်ေ့ လ ိုက်ရင် က ိုယ်လည််း လ ိုက်သိုံ်း တတ်သွာ်းမယ်။ ပပ ်းရင်  တာေ့ က ိုယ်ေ့အလိုပ်ထဲမှာ ခပန်အသိုံ်းြေျန ိုင် အာင် ကက ြု်းစာ်းပါ။ 

ေါပါပဲ။ မြေက်ပါဘူ်း။ အဲ ေ  နရာမှာ Creative Thinking ရှ ဖ ိုို့ တာေ့ လ ိုအပ်မယ်။ အဲေါမှ ထူ်းထ်ူးခြော်းခြော်း တ ထွင်ကကံဆ 

အသိုံ်းခပြုန ိုင်မယ် လ။ (အမျာ်းက  ခြေ ထာက်နဲဲ့ လမ််း လ ာက် နတာက ို က ိုယ်က လက်နဲဲ့ ဇာက်ထ ို်း လ ာက်ဖ ိုို့ ဆ ိုလ ိုတာမျ  ြု်း တာေ့ 

မဟိုတ်ဘူ်း ပါို့။) 

တစ်ြေျ  ြုဲ့ GIS က ိုအသိုံ်းြေျတဲေ့ နည််း တွကျ တာေ့ နည််းပညာ အခမင်ေ့ တွနဲဲ့ ဆ ိုင်တယ်။ ဘာခဖစ်လ ိုို့လဲဆ ို တာေ့ GIS ဆ ိုတာက Computer 

က ိုမှ ပပ ်း ခဖစ် ပေါ်တ ို်းတက်လာရတာက ို်း၊ Computer  ကာင််း ကာင််း တတ်ရင် GIS တတ်ဖ ိုို့၊ မ မ က ိုယ်တ ိုင် စ တ်ကက ြုက်ဖန်တ ်းန ိုင်ဖ ိုို့ 
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အလာ်းအလာ ပ ိုပွင်ေ့သွာ်းမယ်။ Computer က ို အ တာ်အသင်ေ့ သိုံ်းတတ ် ရင်လဲ ခဖစ်ပါတယ၊် မ မ လ ိုြေျင်တာက ို Computer 

programmer က ို  ခပာခပပပ ်း program  ရ်းြေ ိုင််းလ ိုို့ ရပါတယ။် Computer သမာ်းဟာ အရာရာတ ိုင််းက ို တတ်သ တဲေ့ ပညာရှင် 

မဟိုတ်ဘူ်း ဆ ိုတာပါ။ မ မ က ိုယ်တ ိုင် အရာရာတ ိုင််းက ို လိုပ်ြေျင်တယ်ဆ ိုရင် တာေ့ အဲေ့ေ  ထပ်ဆင်ေ့ နည််းပညာ တွက ိုပါ လ ိုက်ပပ ်း 

 လေ့လာရတယ။် သင်ေ့သင်ေ့မ တ သာ အာ်းစ ိုက်ထိုတ်မှုခပြုရင် ဘာမှ သ ပ်မြေက်ပါဘူ်း၊ Technology တစ်ြေိုဆ ိုတာ ကက ြု်းစာ်းသင်ရင် 

တတ်သွာ်းတာပါပဲ။ ြေက်ြေဲတာက ို ြေက်တဲေ့အတ ိုင််း သွာ်းသင် နရင် တာေ့ ြေက်တာ ပါို့၊ ရင် မာသွာ်းလ မ်ေ့မယ်၊ လွယ ်အာင် 

ရ ို်းရှင််း အာင် အရင်လိုပ် ပ်းလ ိုက်၊ ပပ ်းမှ သင်ယူလ ိုက်၊ ေါဆ ို လွယ်သွာ်းမယ်။ Language barrier ရှ ြေဲေ့ရင်လည််း 

ဘာသာခပန် ပ်းလ ိုက်ရင် လွယ်လွယန်ဲဲ့ နာ်းလည်သွာ်းတာ ပါို့၊ ေ လ ိုဆ ို လ ိုက်သိုံ်း တတ်ပပ  ပါို့။ အလွယ ်လ်း၊ ကက ြု်းစာ်းပပ ်း 

လ ိုက်လိုပ်ကကည်ေ့လ ိုက်။ 

တစ်ြေျ  ြုဲ့ GIS အသိုံ်းြေျနည််းကျ တာေ့ Thinking  ကာင််း ကာင််းနဲဲ့ Logic  တွက ို လှလှပပ အသိုံ်းြေျသွာ်းတာ။ GIS ရဲဲ့ 

အ ခြေြေံသ ဘာတရာ်း နှင်ေ့ လူို့ရဲဲ့ အ တွ်းအ ြေေါ် ကာင််း တ ိုို့က ို  ပါင််းစပ်ပပ ်း တာေ့ အသိုံ်းြေျလ ိုက်တာ နည််းအသစ် တွ 

 ပေါ်လာပါ လ ရာ။ Paper  တွ  ရ်း နတာ ၊ PhD  တွလိုပ် နတာဟာ အဲေ  အ တွ်း ကာင််း မျ  ြု်း တွက ို ရှာ ဖွ နကကတာ ပါို့။ 

 တွ်းတာက ို ကျင်ေ့သာ်းပါ နတဲေ့လူ တွ က တာေ့ အပမဲ အ တွ်း ကာင််း ထွက် လေ့ ရှ တယ်။ Very productive ၊ တာ်းလ ိုို့မရဘူ်း၊ 

 တွ်းရင််းနဲဲ့ပဲ လူ တာ် တွ ခဖစ်သွာ်းကကတာ။ ေ လ ို အသိုံ်းြေျနည််းကျ တာေ့ နမူနာပဲြေျခပလ ိုို့ ရန ိုင်တယ်၊ အဲသလ ိုမျ  ြု်း 

လ ိုက်လိုပ်တတ် အာင် ထွက်လာ အာင် သင် ပ်းဖ ိုို့ ြေက်ြေျင် ြေက် နတတ်တယ် (ြေက်တယ်)။ အဲသလ ို အကကံဉာဏ် ကာင််း တွ 

ထွက်လာ အာင်  ဘ်းက န အ ခြေအ န ဖန်တ ်း ပ်းပပ ်း အကကံဉာဏ် ညှစ် ပ်းလ ိုို့ပဲရတယ။် ကွင််းထဲက ို ကျာ်းတစ် ကာင် လွှတ် ပ်း 

လ ိုက်ရင်  ခပ်း ပါက်ရှာဖ ိုို့ ကကံရ တာေ့မယ်ေ့ ယိုန်က လ်းရဲဲ့ အ တွ်းမျ  ြု်း ပါို့။ အဲေ ယိုန်က လ်း ဘာ တွ်း  နမှာလဲ။ 

ကဲအကကံဉာဏ် ကာင််း တွ ထွက်လာ အာင် လ ိုက် တွ်း ကကည်ေ့လ ိုက် ပါို့ဗျာ။ GIS  ကကာင်ေ့ ရူ်းသွာ်း ရင် တာေ့ တာဝန် မယူဘူ်း နာ်။  

အထက်က  ခပာတဲေ့ GIS/RS အသိုံ်းခပြုကကပိုံမျာ်းက ို ဘယမ်ှာ သွာ်းရှာကကည်ေ့ ရမှာလဲဆ ို တာေ့ Journal  တွ၊ Research Paper  တွမှာ 

နမူနာယူပပ ်း  လေ့လာဖတ်ရှု န ိုင်ပါတယ။် အြေျ  ြုဲ့ သာ GIS နှင်ေ့သက်ဆ ိုင် သာ ဂျာနယ ်  တွက ထိုတ်ထာ်းတဲေ့ Paper မျာ်းသည် 

 ကာင််းမွန် သာ ကကာင်ေ့  နာက်လူ တွက စာတမ််းမျာ်းတွင် ၎င််းတ ိုို့က ို ရည်ညွန််းပပ ်း၊ က ိုကာ်း ရ်းသာ်း  ခပာဆ ို တတ်ကကတယ်။ 

ေ လ ိုမျ  ြု်း က ို်းကာ်းမှုမျာ်း လ ဂျာနယ်နဲဲ့ Paper ရဲဲ့ Ranking က ပ ိုခမင်ေ့ လ ခဖစ်ပါတယ။် Paper  တွရဲဲ့ ညွန််းက န််းတစ်ြေိုခဖစ်တဲေ့ Impact 

Factor  နဲဲ့ တ ိုင််းတာပပ ်း တာေ့ ပါတယ။် Paper မျာ်း က ို်းကာ်းခြေင််း ြေံရ သာ အကက မ် ရ နှင်ေ့ ဂျာနယ်မှာ ပါရှ တဲေ့ Paper  စာင် ရ တ ိုို့က ို 

အြေျ  ြု်းြေျထာ်းခြေင််း ခဖစ်ပပ ်း၊ ဂဏန််းကက ်း လ လ  ကာင််း လ လ ခဖစ်ပါတယ။် Journal တစ်ြေို၏ Impact Factor ဥပမာက ို 

http://www.mdpi.com/about/announcements/622 မှာ  တွဲ့ရှ န ိုင်ပါတယ။် Nature မဂ္ဇင််း 

(http://www.nature.com/nature/index.html) ထဲမှာ  ဆာင််းပါ်း ပါန ိုင်ရင် ပညာရှင် တွက လွတ် ပျာ ်ဆ ိုပဲ။ သူတ ိုို့ရဲဲ့  ပျာ်ရွင်မှု 

အရသာက ို မသ ြေျင်ဘူ်းလာ်း။ သူတ ိုို့ ပညာရပ်က ို အသိုံ်းြေျပိုံ၊ သူတ ိုို့ သို တသနခပြုပိုံ၊ စာတမ််း ရ်းပိုံ တွက ို အရင်ဆိုံ်း 

 လေ့လာကကည်ေ့န ိုင်ပါတယ်။  နာက်မှာ RS/GIS နယပ်ယ်နဲဲ့ သက်ဆ ိုင်တဲေ့၊ အြေမဲေ့ Paper မျာ်း ပါရှ တဲေ့၊ သ ိုို့မဟိုတ ်အြေမဲေ့ ဖတ်လ ိုို့ ရတဲေ့၊ 

Free Download Paper မျာ်း ပ်း သာ Online Journal တစ်ြေျ  ြုဲ့က ို ထပ်ဆင်ေ့  ဖေါ်ခပ ပ်းထာ်းပါတယ။် 

Free and Open Source Software (FOSS) အ ကကာင််း တ စေ့ တ စာင််း 

Free and Open Source software ဆ ိုတာမျ  ြု်းက product  ရာ source code က ိုပါ အြေမဲေ့ အသိုံ်းခပြုလ ိုို့ ရတယ်၊ ကူ်းယူလ ိုို့ရတယ်၊ 

ခပန်ခဖန်ဲ့လည််းရတယ၊် source code  တွက ို ခပငြ်ေျင်ရင်လည််းရတဲေ့ computer software အမျ  ြု်းအစာ်း ခဖစ်ပါသည်။ အလကာ်း 

သ ိုို့မဟိုတ် အလကာ်း န ်းပါ်း အသိုံ်းခပြုလ ိုို့ ရန ိုင်ပါတယ်။ Operation System မှာလည််း အြေမဲေ့ အသိုံ်းခပြုလ ိုို့ ရတဲေ့ OS software  တွ 
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ရှ ပါတယ။် ဥပမာ Linux ၊ Android လ ိုမျ  ြု်း ပါို့။ Free Application software မျ  ြု်း  တွလည််းရှ ပါတယ။် ဥပမာ VLC ၊ Open Office 

Suite ၊ Firefox စသည်ေ့ software တ ိုို့လ ိုမျ  ြု်း ခဖစ်ပါတယ။် 

FOSS  တွက ို သိုံ်းတဲေ့အြေါ အလကာ်းရတဲေ့ စာ်းစရာတစ်ြေိုနဲဲ့ ဆင်တူပါတယ။် ဥပမာ - အလကာ်းစာ်းရတဲေ့  ရြေဲမိုန်ဲ့ တစ်ြေိုလ ိုပါပဲ။ 

ဟ ိုဟာ မပါလ ိုို့ ေ ဟာ မပါလ ိုို့ ဆ ိုပပ ်း တာေ့ ဂျ  ်းမျာ်းပပ ်း ဘယ်သူို့က ိုမှ complaint သွာ်းတက်စရာ မရှ ပါဘူ်း။ အသိုံ်းခပြု နရင််း အြေက်အြေဲ 

ရှ လာတတ်ပါတယ်။ အဲသလ ို အြေက်အြေဲ  တွဲ့ြေဲေ့ရင် user  တွ အြေျင််းြေျင််း အ တွဲ့အကကြုံ တွ၊ အသ ပညာ တွ ဖလှယ်ကကတဲေ့၊ 

 ဆွ်း နွ်းကကတဲေ့  နကကတဲေ့ Forum  နရာမှာ လှမ််းပပ ်း အကူအည  တာင််း၊  မ်းခမန််းလ ိုို့လဲရပါတယ။် GIS နဲဲ့ပတ်သက်ပပ ်း တာေ့ 

 မ်းြေျင်တာ ရှ လ ိုို့ရှ ရင် http://gis.stackexchange.com/ မှာ အာ်းမနာတမ််း အလကာ်း  မ်းလ ိုို့ ရန ိုင်ပါတယ်။  မ်းြေွန််း မ မ်းြေင် 

အရင် လ ိုက်ဖတ်ကကည်ေ့ဖ ိုို့ တာေ့ လ ိုမယ်၊ တစ်ြေျ  ြုဲ့ မ်းြေွန််း တွက သူမျာ်း တွ  မ်းထာ်းပပ ်းသာ်းခဖစ်မယ်။  မ်းြေွန််း  မ်းြေဲေ့ရင်လည််း 

တ တ ကျကျနဲဲ့ ရှင််း န အာင်  မ်းတတ်ဖ ိုို့ တာေ့လ ိုမယ်။ က ိုယ်ကသ ရင်လည််း ဝင်ကူပပ ်း  ခဖ ပ်းလ ိုို့လည််း ရန ိုင်ပါတယ။် ေါဟာလည််း 

ပညာက ို နှ ်း နှာဖလှယ်ခြေင််းသာမက user မျာ်းအြေျင််းြေျင််း၏  ကာင််းမွန် သာ Team work ဥပမာ တစ်ြေိုပါပဲ။ န ိုင်ငံတကာက 

ပညာရှင်မျာ်း၏ ပူ်း ပါင််း ဆာင်ရွက် နတဲေ့ နမူနာ  ကာင််း တွပါ။ 

Free and Open Source GIS Softwares မျာ်း 

GIS အတွက် Open Source Geospatial Software  တွက ို အဓ က ဦ်း ဆာင် နတဲေ့ 

အဖွဲဲ့အစည််းက တာေ့ OSGeo http://www.osgeo.org/ ပဲခဖစ်ပါတယ။် ၎င််းတ ိုို့ 

လိုပ် ဆာင် နတဲေ့ project  တွက တာေ့ Web Mapping, Desktop Application, 

Geospatial Libraries, Metadata Catalog, Outreach Projects စသည်ေ့ 

အမျ  ြု်းအစာ်းမျာ်းအစိုံအလင် ပါရှ ကကပါတယ။်  အာက် ဖေါ်ခပပါ ပိုံသည်ကဏ္ဍ အသ ်းသ ်းတွင် အသိုံ်းခပြု နသည်ေ့ free 

and open source GIS software မျာ်း အြေျ  ြုဲ့နှင်ေ့ ၎င််းတ ိုို့ တစ်ြေိုနှင်ေ့ တစ်ြေို အြေျင််းြေျင််း ြေျ  တ်ဆက် အသိုံ်းခပြုန ိုင်ပိုံက ို 

နမူနာ အခဖစ်  ဖေါ်ခပထာ်းပါသည်။ 

ယြေို အ ခြေြေံ သင်တန််းတွင် စတင် မ တ်ဆက် ပ်းမည်ေ့ ၎င််းတ ိုို့ရဲဲ့ Desktop GIS software ထဲက တစ်ြေိုက တာေ့ QGIS လ ိုို့ 

အတ ို ြေေါ်တဲေ့Quantum GIS software ပ ဲ ခဖစ်ပါတယ်။ အခြော်း သာ software မျာ်းက ိုလည််း အြေျ  န်အြေါ က ိုက်ည လာပါက 

တင်ဆက် ပ်းသွာ်းပါမည်။ ေ  QGIS software က ို ဘာသာစကာ်းမျ  ြု်းစိုံသ ိုို့ဝ ိုင််းပပ ်း ဘာသာခပန်ကက၊ ထိုတ် ဝ ခဖန်ဲ့ခဖ ်းသိုံ်းစွဲ နကကပပ ်း၊ 

ကက ်းမာ်း သာ user group နှင်ေ့ developer group တ ိုို့ရှ ပါတယ။် အ သ်းစ တ်က ို http://qgis.org/en/site/ မှာ ဆက်လက်  လေ့လာ 

န ိုင်ပါတယ။် QGIS က ိုသိုံ်းတဲေ့ အြေျ  န်မှာ က ိုယ်သွာ်းြေျင်တဲေ့  နရာက ို တည်ေ့တည်ေ့မတ်မတ်  ရှာ ရှာရှုရှုနဲဲ့ ပ ိုို့ ပ်းြေျင်  ပ်းန ိုင်တယ်၊ 

အသင်ေ့မရှ  သ်းလ ိုို့  ကွဲ့ပတ်ပပ ်းမှ သွာ်းရတာ တွလည််း ရှ န ိုင်ပါတယ။် လ ိုရာက ို တာေ့  ရာက် အာင် သွာ်းန ိုင် ပါတယ်။ 

အသိုံ်းခပြုရင််းနဲဲ့  လေ့ကျင်ေ့ြေန််း လိုပ်ရင််းနဲဲ့ အဲေ  အရသာမျ  ြု်း တွက ို က ိုယ်တ ိုင် ကကြုံ တွဲ့ လာပါလ မ်ေ့မယ်။ က ိုယ်လ ိုြေျင်တဲေ့ feature 

 တွက ို ခပည်ေ့စိုံ အာင် ထည်ေ့သွင််း  ရ်း ပ်း စြေျင်တယ် ဆ ိုရင် တာေ့ က ိုယ်က financial support နဲဲ့လည််း developer group က ို 

အဆ ိုခပြု  တာင််းဆ ိုလ ိုို့ ရန ိုင်ပါတယ။် QGIS နဲဲ့ပတ်သက်ပပ ်း  မ်းခမန််းြေျင်ရင် http://users.qgis.org/en/site/ မှာ  မ်းလ ိုို့ရပါတယ်။ 

 နာက်တစ်ြေိုက QGIS မှာ Plugin feature ပါရှ ပါတယ်။ http://plugins.qgis.org/plugins/ မှာ Plugin မျ  ြု်းစိုံ  တွဲ့န ိုင်ပါတယ်။ ေ  

plugin  တွက QGIS software ရဲဲ့ လိုပ် ဆာင်န ိုင်စွမ််းက ို ပ ိုမ ိုတ ို်းပွာ်း စပါတယ။် က ိုယ်က ိုတ ိုင် Plugin  ရ်းပပ ်း သိုံ်းလ ိုို့လည််း 

ရန ိုင်ပါတယ်။ Plugin  တွ အသိုံ်းခပြုပိုံက ို Plugin အြေန််းမှာ ထပ်ပပ ်း မ တ်ဆက် ပ်းမယ်။ 
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GIS  ေတာအမျ  ြု်းအစာ်း 

GIS  ေတာ တွက ို File Format ပိုံစံ တစ်မျ  ြု်းမျ  ြု်းထဲမှာ  ရ်းထည်ေ့ထာ်းပပ ်း တာေ့  ေတာ အ နနဲဲ့ Computer ထဲမှာ 

သ မ််းဆည််းထာ်းခြေင််း ခဖစ်ပါတယ်။ Information ပိုံစံအ နနဲဲ့ သ မ််းဆည််းထာ်းခြေင််းသာ ခဖစ်ပါတယ။် ပပ ်း တာေ့မှ ေ  ေတာ တွက ို 

 ခမပိုံ ပေါ်မှာ သ ကေတ တွ အ နနဲဲ့ ခပန်လည်တင်ဆက်ခပသခြေင််း ခဖစ်ပါတယ။် GIS မှာက အ ခြေြေံအာ်းခဖင်ေ့  ေတာ တွက ို Vector 

file format အမျ  ြု်းအစာ်း နှငေ့် Raster file format အမျ  ြု်းအစာ်းဟို တစမ်ျ  ြု်းမဟိုတ်တစမ်ျ  ြု်းနှငေ့် သ မ််းထာ်းတတ်ပါတယ။်  

Vector Data အမျ  ြု်းအစာ်း 

GIS မှာက အ ခြေြေံအာ်းခဖင်ေ့  ေတာ တွက ို Vector file format အမျ  ြု်းအစာ်းခဖငေ့သ် မ််းထာ်းတတ်ပါတယ။် အဲေ ထဲမှာ Point, Line, 

Polygon စသည် ပိုံစံ ၃ မျ  ြု်း  ရ်းဆွဲလ ိုို့ ရပါတယ်။ ဥပမာ  

Point – အစက်အ ခပာက် ၊ အမှတ်အသာ်း 

ရွာ တည် နရာ၊  တာင်ထ ပ်၊  ရထွက်  နရာ စသည်ခဖင်ေ့ အရာဝတထြု ၊  နရာတစ်ြေိုြေိုက ို 

အစက်ငယ် လ်းနဲဲ့ က ိုယ်စာ်းခပြုပပ ်း  ရ်းဆွဲြေျင်ရင် point အမျ  ြု်းအစာ်းက ို သိုံ်းတယ။် ဥပမာ ခမန်မာ 

န ိုင်ငံတွင်ရှ  သာ ပမ ြုဲ့မျာ်း၏ တည် နရာက ို point  လ်းနဲဲ့ က ိုယ်စာ်းခပြုပပ ်း  ဖေါ်ခပထာ်းတယ။် 

တည် နရာက ို  ယဘိုယျ သ ဘာ လာက်ပဲ သိုံ်းြေျင်ရင်လည််း point က ို သိုံ်းကကတယ။် 
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Line - မျဉ််း ကကာင််း  

ခမစ်၊  ြေျာင််း၊ လူသွာ်းလမ််း၊ ကာ်းလမ််း၊ ရထာ်းလမ််း စသည်ခဖင်ေ့ ဆက်နွယ် နတဲေ့ အရာ တစ်ြေိုြေိုက ို 

မျဉ််း ကကာင််းက လ်းနဲဲ့ က ိုယ်စာ်း ခပြုပပ ်း  ရ်းဆွြဲေျင်ရင် line အမျ  ြု်းအစာ်းက ို သိုံ်းတယ။် ဥပမာ 

ခမန်မာန ိုင်ငံတွင််းရှ  ကာ်းလမ််းမျာ်းက ို line  တွနဲဲ့ က ိုယ်စာ်းခပြုပပ ်း  ဖေါ်ခပထာ်းတယ။် အရှည်လ ိုက် 

ရှ တဲေ့အရာက ို  ယဘိုယျ သ ဘာ လာက်ပဲ သိုံ်းြေျင်ရင်လည််း line က ို သိုံ်းကကတယ်။ 

Polygon - ဧရ ယာ 

 ရကန်၊ ပမ ြုဲ့ဧရ ယာ ၊ သစ် တာဧရ ယာ၊ လယ်ကွက်၊ န ိုင်ငံတစ်ြေိုရဲဲ့ အကျယ်အဝန််း စသည်ေ့ 

အကျယ်အဝန််း နဲဲ့ ပိုံပန််းသဏ္ဍာန်တ ိုို့က ို  ဖေါ်ခပြေျင်ရင် polygon အမျ  ြု်းအစာ်းနဲဲ့ က ိုယ်စာ်းခပြုပပ ်း 

 ရ်းဆွတဲယ်။ ဥပမာ ခမန်မာန ိုင်ငံ၏  ခမပိုံ၊ ခပည်နယ်နဲဲ့ တ ိုင််း တွရဲဲ့ ဧရ ယာက ို polygon  တွနဲဲ့ 

က ိုယ်စာ်းခပြုပပ ်း  ဖေါ်ခပထာ်းတယ်။ တစ်ြေျ  ြုဲ့ သာ feature  တွက ို အကျဉ််းအကျယ် အတ ိုင််းအတာ 

သ ိုို့မဟိုတ ်ပိုံပန််းသဏ္ဍာန်က ို အ သ်းစ တ်  ဖေါ်ခပြေျင်တဲေ့ အြေါမျာ်းမှာလည််း Polygon က ို သိုံ်းပါသည်။ 

ဥပမာ ကာ်းလမ််းအကျယ်၊ ခမစ် ြေျာင််းအကျယ်၊ ပမ ြုဲ့ ခမ နရာစသည်တ ိုို့က ို  ဖေါ်ခပ သာ အြေါမျ  ြု်းမှာ သိုံ်းပါတယ။် 

GIS vector ဖ ိုင် တစ်ြေိုမှာ Spatial Information က ို သ မ််းထာ်းတဲေ့ Geometry ဆ ိုတဲေ့ 

အပ ိုင််းနဲဲ့၊ Attribute က ို သ မ််းထာ်းတဲေ့ Database Table ဆ ိုတဲေ့ အပ ိုင််းတ ိုို့ ပါရှ ပါတယ်။ 

Geometry ဆ ိုတဲေ့အပ ိုင််းမှာ တာေ့ Point, Line and Polygon တ ိုို့ပါဝင်ပါတယ်။ 

Attribute အပ ိုင််းမှာ တာေ့ ယင််းနှင်ေ့ သက်ဆ ိုင် သာ အြေျက်အလက်မျာ်း ပါဝင်ပါတယ်။ 

မ မ လ ိုအပ် သာ အြေျက်အလက် အမျ  ြု်းမျ  ြု်း က ို သ မ််းဆည််းထာ်းရာ  နရာလည််း ခဖစ်ပါ 

တယ။် 

Vector feature  ည်   က်ထ ျားပ ုံ 

Two Dimension plane ထဲမှာ Point feature တစ်ြေို က ို ဆွဲရန်အတွက် အနည််းဆိုံ်း X 

Coordinate နဲဲ့ Y-Coordinate နှစ်ြေို လ ိုအပ်တယ်။ အဲေါမှ သူို့ရဲဲ့ Geometry coordinate 

တည် နရာ တန်ဖ ို်း အရ  ခမပိုံ ပေါ်မှာ ခပန်ဆွဲလ ိုို့ ရမယ်။ Geometry က ေ  feature 

ဘယ် နရာမှာ ရှ တယ ်ဆ ိုတာက ို  နရာတကျ မှတ်သာ်းထာ်း  ပ်းပါတယ။် 

 နာက်တစ်ြေိုက Attribute တန်ဖ ို်း၊ သူို့က ို ကျ တာေ့ အနည််းဆိုံ်း ID တစ်ြေိုပါရှ ရပါမယ် (ID 

က ို software က automatic create လိုပ် ပ်း လေ့ရှ ပါတယ်။ ကျန်တဲေ့ point Attribute 

properties  တွခဖစ်တဲေ့ point ရဲဲ့ အမည်နှင်ေ့ အခြော်းလ ိုအပ် သာ အြေျက်အလက်မျာ်းက ို လ ိုအပ်သ လာက် Column ြေွဲပပ ်း 

ထည်ေ့သွာ်းလ ိုို့ ရတယ။်  

ဥပမာ ပမ ြုဲ့တစ်ပမ ြုဲ့၏ တည် နရာ နှင်ေ့ ပမ ြုဲ့၏အမည်၊ ရွာတစ်ရွာ၏ တည် နရာနှင်ေ့ ရွာ၏ အမည်၊ အရွယ်အစာ်း၊ အမျ  ြု်းအစာ်း၊ 

ရွာ၏လူဦ်း ရ၊ ၎င််းတည်ရှ ရာ န ိုင်ငံ အမည်၊ ခပည်နယ်အမည်၊ ပမ ြုဲ့နယ်အမည်၊ စသည်တ ိုို့ခဖင်ေ့ စိုံလင်စွာ ထည်ေ့သွင််း ပါရှ  နခြေင််း 

ခဖစ်ပါသည်။ ေ  Attribute က ို ဘာလ ိုို့ ခပာတာလဲ ဆ ို တာေ့  အာက်ပါ လက် တွဲ့  လေ့ကျင်ေ့ြေန််း မျာ်းသည်  ခမပိုံ ပေါ်က ို 

တင်ပပ ်း နာက်၊ GIS Layer ဖ ိုင်ထဲမှာ ပါလာတဲေ့ Attribute properties (သ ိုို့မဟိုတ)် Attribute information မျာ်း ပေါ် မူတည်ပပ ်း တာေ့ 

 ခမပိုံ တွက ို အမျ  ြု်းမျ  ြု်း  ခပာင််းလဲ  ရ်းဆွဲ နရခြေင််း ခဖစ်ပါသည်။ Attribute database ထဲမှာ က ိုယ်လ ိုြေျင်တဲေ့ information 

မပါလာလ င်  ခမပိုံ ပေါ်မှာ ၎င််း၏ တည် နရာ အမှတ်အသာ်းက လ်း ခဖစ်တဲေ့ Geographic location တည် နရာက ို ခပရိုသံာ 

ခပ ပ်းန ိုင်ပပ ်း ကျန်တဲေ့ Attribute properties  တွက ို ြေွဲခြော်းပပ ်း တာေ့ ခပလ ိုို့ မရန ိုင် တာေ့ဘူ်း ပါို့။ 
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Raster Data အမ   ျားအစ ျား 

Raster file format အမျ  ြု်းအစာ်း က တာေ့  ေတာ  တွက ို ကျာ်းကွက်ပိုံ လ ိုမျ  ြု်း GRID  တွနဲဲ့ pixel 

တစ်ြေိုြေျင််းစ ထဲမှာ  ေတာ တွ ထည်ေ့သ မ််းထာ်းတာ ခဖစ်ပါတယ်။ ဥပမာ ခမန်မာန ိုင်ငံ၏  ခမခပင်အန မေ့်အခမငေ့်ပိုံက ို 

 ဖေါ်ခပထာ်းတယ်။ ေ ပိုံမှာ တာေ့ အထက်က point, line, polygon  တွနဲဲ့ မတူတဲေ့  ေတာ တွနဲဲ့ 

ဖွဲဲ့စည််းထာ်းပါတယ။်  အာက်က နမူနာပိုံကကမ််းက ို ဆက်ကကည်ေ့လ ိုက်ရင် ပ ိုရှင််းသွာ်းပါမယ်။ 

 

နာ်းလည် လွယ် အာင်  ခပာရရင် Raster မှာက Grid သ ိုို့မဟိုတ် Cell တစ်ြေိုြေျင််းစ  အတွက်  ေတာ တစ်ြေိုစ  သ မ််းထာ်းလ ိုို့ ပ ိုပပ ်း  တာေ့ 

အ သ်းစ တ် ပါတယ။် data size လည််း ပ ိုကက ်း လေ့ ရှ ပါတယ်။ ပမ ြုဲ့နယ်ဧရ ယာ တစ်ြေိုထဲမှာ ရှ သမ  စိုစို ပါင််း လူဦ်း ရက ို 

ခပထာ်းတာမျ  ြု်း မဟိုတ်ဘဲ Population Grid အ နနဲဲ့ ခဖန်ဲ့ကျက်ထာ်းတဲေ့ ပိုံလ ို ပါို့။ 

 ခမခပင် ပေါ်မှာရှ တဲေ့ 10 x 10 Kilometer အတ ိုင််းအတာ တစ်ြေိုက ို Raster ပိုံထဲမှာ Grid ကွက် တစ်ကွက် အ နနဲဲ့ က ိုယ်စာ်းခပြုမယ် 

 ရ်းဆွမဲယ်ဆ ိုရင်၊ ကာ်းလမ််း တွ ပမ ြုဲ့ငယ် တွ သစ်ပင် တွက ို  တွဲ့န ိုင်မှာ မဟိုတ် တာေ့ဘူ်း။ ေါမျ  ြု်းက တစ်ကမဘာလိုံ်းက ို ပိုံတစ်ပိုံထဲမှာ 

ခြေြုံငိုံထည်ေ့ပပ ်း Global scale နဲဲ့ ခပဖ ိုို့ပဲသိုံ်းမယ်။  ခမခပင် ပေါ်မှာရှ တဲေ့ 1 x 1 meter အတ ိုင််းအတာ တစ်ြေိုက ို Raster ပိုံထဲမှာ Grid ကွက် 

တစ်ကွက် အ နနဲဲ့ က ိုယ်စာ်းခပြုမယ်  ရ်းဆွဲမယ်ဆ ိုရင်၊ ပမ ြုဲ့က ို အ သ်းစ တ် ကကည်ေ့ခမင်န ိုင်ပပ ်း၊ အ မ် တ ွတ ိုက် တွ၊ သစ်ပင် တွက ို 

 တွဲ့ခမငန် ိုင်မှာ ခဖစ်ပါတယ။်  

လူ တွရ ိုက် နကကတဲေ့ ဓါတ်ပိုံ တွဟာ ေ လ ို Raster ဖ ိုင် 

အမျ  ြု်းအစာ်းမျ  ြု်း ခဖစ်ပါတယ။် Pixel အ ရအတွက်မျာ်း လ 

ပိုံကပ ိုအနိုစ တ် ပပ ်း ပ ိုပပ ်း အ သ်းစ တ်က ို ခမငန် ိုင် လပါပဲ။ 

ဗဟိုသိုတ အ နနဲဲ့ဆက် ခပာရရင် GDAL 

ဆ ိုတာ က တာေ့ GeoSpatial 

Information  တွပါတဲေ့ Raster File  တွက ို Process လိုပ်ဖ ိုို့နဲဲ့  ေတာ တွ သ မ််းထာ်း ပ်းဖ ိုို့ရန် အတွက် 

အသိုံ်းခပြုရတဲေ့ Free and Open Source File Format Library သ ိုို့မဟိုတ် Driver တစ်ြေို ခဖစ်ပါတယ။် GDAL 

library  တွက ို Remote Sensing သ ိုို့မဟိုတ် GIS software  ရ်းရာမှာ မရှ မခဖစ် အသိုံ်းခပြုရတဲေ့ driver တစ်ြေို 

ခဖစ်လာ ပါတယ။် GDAL ဟာ အသိုံ်းမျာ်းတဲေ့ GIS Raster ဖ ိုင် တွ  တာ် တာ်မျာ်းမျာ်းက ို  ရ်းဖတ်န ိုင်စွမ််း ရှ ပါတယ။် 

QGIS မှာ Raster ဖ ိုင် တွက ို ဖွင်ေ့ဖ ိုို့၊ process လိုပ်ဖ ိုို့အတွက် အဓ က driver အခဖစ် ထည်ေ့သိုံ်းထာ်းပါတယ။် GDAL အ ကကာင််းက ို 

အ သ်းစ တ် သ ြေျင်ရင် တာေ့  ၎င််းရဲဲ့ တရာ်းဝင် website ခဖစ်တဲေ့ http://www.gdal.org/ မှာ  လေ့လာ န ိုင်ပါတယ်။ GDAL 

Vector ႏွ ွ ာ့ Raster 
Raster အမ  ်ဳိ်ားအစ ်ားမွ  Pixel တစ ခု၏ အလ  ်ားအနံ အတ်ဳို  ်ားအတ ာသည  ၎ Image ရဲ႕ Spatial Resolution က်ဳိ ု
က်ဳိုယ စ ်ားျပ  ထ ်ားပါာသည ။ ထ်ဳိုထက ပ်ဳိုၿပ ်ား ခ ဲ႕လြန ်ားရ   ပုံကဝါ်ားာြ ်ားတယ ။ 
Vector မွ က အဲာလ်ဳိ ုမျဖစ ္ဘ်ား ႀက်ဳိ က ာေလ က  ခ ဲ႕ၾကသည ာ့လ်ဳိုု႔ ရႏွ်ဳို  တယ ။ Resolution မရွ်ဳိေတ ာ့ ဘ္်ား။ Data က်ဳို Derive 
လုပ ခဲာ့တဲာ့ Source ရဲ႕ စေက်ား ေပပမ ွပဲ မဘတသည ေတ ာ့တယ ။ 
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က ိုသိုံ်းထာ်းတဲေ့ Tool  တွက ိုလည််း  တွဲ့ရမှာ ခဖစ်ပါတယ။် ဥပမာ QGIS တွင် Raster ဖ ိုင်တစ်ြေိုက ို Projection  ခပာင််းခြေင််း၊ Polygon 

သ ိုို့ ခပာင််းခြေင််း စသည်တ ိုို့ဟာ GDAL Tool  တကွ ို အသင်ေ့ယူသိုံ်းထာ်းခြေင််း ခဖစ်ပါတယ။် GDAL က ိုသိုံ်းပပ ်း ဖွင်ေ့န ိုင်၊  ရ်းန ိုင်တဲေ့ Raster 

ဖ ိုင်အမျ  ြု်းအစာ်း  တွရဲဲ့ စာရင််းက ို တာေ့ http://www.gdal.org/formats_list.html မှာ အ သ်းစ တ်  လေ့လာ  တွဲ့ရှ န ိုင်ပါတယ်။ 

မ မ ၏ က ိုယ်ပ ိုင် software  တ ွ  ရ်းတဲေ့အြေါမှာ အသိုံ်းခပြုြေျင်ရင် တာေ့ http://ftp.remotesensing.org/gdal နှင်ေ့ 

http://download.osgeo.org/gdal/ တ ိုို့မှာ update version  တွက ို  စာင်ေ့ကကည်ေ့ ရယူန ိုင်ပါတယ်။ 

GIS ဖ ိုင် အမျ  ြု်းအစာ်း တစ်ြေို ခဖစ်တဲေ့ Vector ဖ ိုင် အမျ  ြု်းအစာ်း  တွက ို ဖွင်ေ့၊ ဖတ်၊  ရ်း န ိုင်တဲေ့ Free and Open Source library 

သ ိုို့မဟိုတ ် driver က တာေ့ GDAL နဲဲ့ အတူ OGR ဆ ိုတဲေ့ library ခဖစ်ပါတယ။် ေ  GDAL နဲဲ့ OGR က ို GIS software 

 တာ် တာ်မျာ်းမျာ်းမှာ ထည်ေ့သွင််း အသိုံ်းခပြုထာ်းကကပါတယ။် QGIS မှာလည််း GDAL နဲဲ့ OGR က ို အဓ ကထည်ေ့သိုံ်းထာ်းပါတယ။် OGR 

driver  တွနဲဲ့ vector ဖ ိုင် တွက ို  ရ်း၊ ဖတ် ကကပါတယ။် OGR က ဖွင်ေ့န ိုင်၊  ရ်းန ိုင်ခြေင််း ရှ ၊ မရှ   သာ vector file  တွရဲဲ့ စာရင််း 

အခပည်ေ့အစိုံ နှင်ေ့ အ ခြေအ နက ို http://www.gdal.org/ogr/ogr_formats.html မှာ အ သ်းစ တ်  ဖေါ်ခပထာ်းပါတယ။် OGR 

အ ကကာင််းက ို အ သ်းစ တ် သ ြေျင်ရင် တာေ့ http://www.gdal.org/ogr/ မှာ ဆက်လက်  လေ့လာန ိုင်ပါသည်။ 

GIS File Format နှင်ေ့ Data Interoperability အ ကကာင််း 

GIS က ို  လေ့လာရင် GIS  ေတာဖ ိုင်  တွရဲဲ့ ဖ ိုင်အမျ  ြု်းအစာ်းက ို သ ထာ်းဖ ိုို့ လ ိုအပ်ပါတယ။်  နာက်လာမည်ေ့  လေ့ကျင်ေ့ြေန််း 

 တွမှာလည််း ေ  ေတာ  တွက ိုပဲ ထပ်ြေါတလဲလဲ အပမဲက ိုင်တွယ်  နရတာ ခဖစ်ပါတယ။် ဘာလ ိုို့ အ ရ်းကက ်းလဆဲ ို တာေ့ သိုံ်းတေဲ့ 

software  ပေါ်မူတည်ပပ ်း  သာ်လည််း ကာင််း၊ သိုံ်းတဲေ့ အ လေ့အထ  ပေါ်မူတည်ပပ ်း သာ်လည််း ကာင််း တစ် ယာက်တစ်မျ  ြု်းစ  

အဆင်သင်ေ့သလ ို သိုံ်း နကကတဲေ့ အြေါ GIS file format  တ ွမတူတဲေ့ ခပဿနာ တွ ရှ  နလ ိုို့ပါပဲ။ တစြ်ေျ  ြုဲ့ software  တွက သူို့ format 

နဲဲ့သူပဲ အလိုပ်လိုပ်တတ်ကကတယ်။ တြေျ  ြုဲ့ software ကျ တာေ့ သူို့ file format မဟိုတ်လည််းဘဲ ဖွင်ေ့လ ိုို့ရတယ။် အ ရ်းကက ်းတာက 

က ိုယ်ကျွမ််းကျင်ရာ၊ အဆင် ခပရာ ဘာအမျ  ြု်းအစာ်းက ိုပဲသိုံ်းသိုံ်း GIS  ေတာ တွက ို အခပန်အလှန် ဖလှယ ် (exchange) လိုပ်လ ိုို့ 

ရန ိုင်ရင် ပပ ်းတာပါပဲ။ ေ လ ို အခပန်အလှန် system တစ်ြေိုက န အခြော်းတစ်ြေိုစ က ို  ေတာ Import/Export လိုပ်န ိုင်စွမ််းက ို Data 

InterOperability လ ိုို့ ြေေါ်တယ်။ လ ိုရင််းက ို ဆ ိုရရင် က ိုယ်သိုံ်းမယ်ေ့ GIS software အမျ  ြု်းအစာ်းသည် (ပ ိုက်ဆံ ပ်းရသည် ခဖစ် စ၊ 

မ ပ်းရသည် ခဖစ် စ) ပထမဦ်းစွာ Data InterOperability က ို  ထာက်ပံေ့  ပ်းန ိုင်ရန် လ ိုအပ်ပါသည်။ အဲေါမှသာ ဖ ိုင်မျ  ြု်းစိုံက ို 

အသွင််းအထိုတ် ခပြုလိုပ်လ ိုို့ရမည်၊ အခြော်း သာ system မျာ်းနှင်ေ့လည််း ြေျ  တ်ဆက်ပပ ်း အသိုံ်းခပြု၍ ရန ိုင်ပါမည်။ 

တြေျ  ြုဲ့ သာ software  တွက ဖ ိုင်အမျ  ြု်းအစာ်း တွက ို  ခပာင််းလဲပပ ်း အသွင််းအထိုတ် လိုပ် ဆာင်ရာတွင် ကန်ဲ့သတ်ထာ်းတတ် 

ကကတယ။် ေ အြေါမှာ က ိုယ်အလိုပ် လိုပ်ထာ်းတဲေ့ GIS  ေတာ  တွက ို ေ ခပငေ့ ်software  တွမှာ ခပန်လည်အသိုံ်းခပြုဖ ိုို့ အတွက် အြေက်အြေဲ 

ခဖစ် န၊ ရှ  နတတ်ပါတယ။် နည််းပညာရဲဲ့ အကန်ဲ့အသတ် ကကာင်ေ့လည််း ခဖစ်ြေျင်ခဖစ်န ိုင်တယ၊် Proprietary software 

(ပ ိုက်ဆံ ပ်းဝယ်ရတဲေ့ software)  တွရဲဲ့ ထ န််းြေျြုပ်မှု ကကာင်ေ့လည််း ခဖစ်ြေျင် ခဖစ်န ိုင်ပါတယ်။ ေ လ ို အြေျ  န်မျ  ြု်းမှာ က ိုယ်ေ့လိုပ်အာ်းက ို 

က ိုယ်ခပန်သိုံ်း၊ မရဘူ်းဆ ိုရင် က ိုယ်ေ့စရ တ်နဲဲ့က ိုယ်  ငွ ပ်းပပ ်း တာေ့ အြေျည်ြေံရတာပဲ။ အဲေ  တာေ့ကာ Extensible လိုပ်န ိုင်တဲေ့ System 

မျ  ြု်းနဲဲ့ data Interoperability က ို ထာက်ပံေ့န ိုင်တဲေ့ Application မျ  ြု်းက ို အစကတည််းက  ရွ်းြေျယ် သိုံ်းဖ ိုို့ဟာလည််းပဲ 

အ ရ်းကက ်းပါတယ။် 
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 နရာ  ေသတစ်ြေို၏ GIS database နှင်ေ့ SDI အ ကကာင််း 

 နရာ  ေသတစ်ြေို၏ GIS database နှင်ေ့ SDI အ ကကာင််း  နရာ ေသတစ်ြေို၊ န ိုင်ငံတစ်ြေို အတွက် 

မည်ကဲေ့သ ိုို့ သာ GIS  ေတာမျာ်း လ ိုအပ်သနည််း။ လိုပ်ငန််း ကဏ္ဍ အသ ်းသ ်းမှာ အသိုံ်းခပြုန ိုင်ရန် 

အတွက် Land Cover ၊ Soil type ၊ Settlements ၊ topography ၊ transportation ၊ 

infrastructure ၊ Geology ၊ စသည်တ ိုို့နှင်ေ့ thematic GIS datasets မျ  ြု်းစိုံ လ ိုအပ်ပါတယ်။ ေ  

data တွက ို ဘယ်လ ို Collect လိုပ်ရမလဲ။ ဘယန်ည််းနဲဲ့ GIS data  တွက ို ဖန်တ ်း၊ စို ဆာင််းန ိုင် 

သလဲ ဆ ိုတာက ို Data Acquisition အပ ိုင််းမှာ ထပ်မံ၍ ရှင််းခပသွာ်း ပါမည်။ 

GIS dataset မျာ်းက ို စနစ်တကျ စို ဆာင််းစ မံ က ိုင်တွယ်ဖ ိုို့ရန်အတွက် GIS Data Infrastructure 

တစ်ြေိုရှ ဖ ိုို့လည််း လ ိုအပ်လာပါတယ်။ 

SDI ဆ ိုတာက Data Infrastructure Framework တစ်ြေိုပဲ ခဖစ်ပါတယ။် SDI ရဲဲ့ အဓ က ရည်ရွယ်ြေျက်က တာေ့ spatial data က ို 

လူအမျာ်းမ ှလွယ်လင်ေ့တကူ နှင်ေ့ ထ  ရာက်စွာ အသိုံ်းခပြုန ိုင်ရန် အတွက်၊ GIS data မျာ်းက ို စံနှုန််းခဖင်ေ့ တစ် ခပ်းည  အသိုံ်းခပြုခြေင််းက ို 

အာ်း ပ်းရန် အတွက်၊ လူအမျာ်းအသိုံ်းခပြုသည်ေ့ core data မျာ်းက ို အတူတကွ ဖန်တ ်း အသိုံ်းခပြုန ိုင်ရန် အတွက်၊ GIS data မျာ်းက ို 

မှန်ကန်စွာခဖင်ေ့ ခပန်လည် ခဖန်ဲ့ခဖ ်းခြေင််း၊ ထ န််းသ မ််း ခြေင််း စသည်တ ိုို့က ို ခပြုလိုပ် ပ်းန ိုင်သည်ေ့ စနစ်တစ်ြေို တည် ဆာက်ရန် အတွက်၊ 

 တွဲ့ကကြုံရ သာ ခပဿနာ မျာ်း နှင်ေ့ ခဖစ် ပေါ်တ ို်းတက်လာ သာ နည််းပညာအသစ် မျာ်းအတွက်  ဆွ်း နွ်းဖလှယ် န ိုင် သာ နရာ 

Platform တစ်ြေို ဖန်တ ်း  ပ်းရန် အတွက် စသည်တ ိုို့ပဲ ခဖစ်ပါတယ်။  

ဥပမာအာ်းခဖင်ေ့ ပမ ြုဲ့မျာ်း၏တည် နရာ (Town location) ၊ လမ််းပန််းဆက်သွယ် ရ်း (Transportation) ၊ အိုပ်ြေျြုပ် ရ်းဇိုန် 

(Administratvie boundaries) စသည်ေ့ data မျာ်းသည် အမျာ်းနှင်ေ့ သက်ဆ ိုင် သာ core data မျာ်းဟို ယူဆပပ ်း၊ share လိုပ်ပပ ်း free 

access  ပ်းခြေင််းခဖင်ေ့ အမျာ်းမှ အသိုံ်းခပြုန ိုင်ပပ ်း၊ တစ်ဦ်းတစ် ယာက်မှ လိုပ်အာ်းစ ိုက်ကာ ထပ်မံ  ရ်းဆွဲ နရခြေင််းက ို  ရှာင်ရှာ်း 

န ိုင်ပါသည်။ 

What is a Spatial Data Infrastructure (SDI)?  
   “The SDI provides a basis for spatial data discovery, evaluation, and application for users and 
providers within all levels of government, the commercial sector, the non-profit sector, academia and by citizens in 
general.” 
    --The SDI Cookbook  http://www.gsdi.org 
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SDI တစ်ြေိုမှာ ပါဝင် နတဲေ့ အစ တ်အပ ိုင််းမျာ်း က တာေ့ Policy ၊ နည််းပညာ စနံှုန််း၊ အဖွဲဲ့အစည််း ၊ Spatial data မျာ်းက ို ရယူန ိုင်ဖ ိုို့၊ 

Process လိုပ်ဖ ိုို့၊ ခပန်လည်ခဖန်ဲ့ ဝဖ ိုို့၊ အသိုံ်းြေျဖ ိုို့၊ ထ န််းသ မ််းဖ ိုို့၊ စ မံြေန်ဲ့ြေွဲဖ ိုို့ အတွက် လ ိုအပ် သာ နည််းပညာနှင်ေ့ လူို့စွမ််းအာ်း 

အရင််းအခမစ် နှင်ေ့ မူဝါေဆ ိုင်ရာ သ ဘာတူည မှု စသည်တ ိုို့ ပါရှ ပါသည်။  

SDI တစ်ြေိုမှာ ဘယ်သူ တွ ပါရှ သလဲဆ ို  တာေ့ အစ ို်းရဌာနမျာ်း၊  အဂျင်စ မျာ်း၊ အစ ို်းရ မဟိုတ်သည်ေ့ အဖွဲဲ့အစည််းမျာ်း၊ စ ်းပွာ်း ရ်း 

အဖွဲဲ့အစည််းမျာ်း၊ ပိုဂ္လ ကအဖွဲဲ့အစည််းမျာ်း၊ ပညာရပ်ဆ ိုင်ရာ အဖွဲဲ့ အစည််းမျာ်း၊ န ိုင်ငံသာ်းမျာ်း စသည်ခဖင်ေ့ အစိုံ ပါဝင် ပါတယ။် 

ပိုံ (၁) အသိုံ်းခပြုသူက ို ဗဟ ိုခပြုသည်ေ့ SDI တြေိုတွင် ပါဝင် သာ အစ တ်အပ ိုင််းမျာ်း ပိုံ 

SDI တွင် မည်သည်ေ့ ဌာန၊ အဖွဲဲ့အစည််းတွင် မည်သည်ေ့ data 

မျာ်းရှ သည် ဟူ သာ Data Catalogue နှင်ေ့ မည်သည်ေ့နည််းခဖင်ေ့ 

ဖန်တ ်း ရ်းဆွဲထာ်းသည်၊ ဘယ်နှစ်ြေိုနှစ်က ဘယစ် က်းနဲဲ့ 

ဆွဲထာ်းသည်၊ စသည်ေ့ခဖင်ေ့ data တစ်ြေို၏ အ ကကာင််းက ို 

အ သ်းစ တ ်  ဖေါ်ခပ သာ Meta data စနစ်လည််း ပါရှ ပါသည်။ 

သ ိုို့မှသာ data က ို ရှာ ဖွရ လွယ်ကူ ပပ ်း၊  နာက်တစ် ယာက်မှ 

အသစ် ထပ်မံ ဖန်တ ်းစရာ မလ ိုဘ ဲ repeation of effort က ို 

 ရှာင်ရှာ်းန ိုင်မည် ခဖစ်ပါ သည်။  

SDI တစ်ြေိုတွင် Standardization အတွက် အမျာ်း သ ဘာတူ 

ထာ်းသည်ေ့ စံနှုန််းက ို အသိုံ်းခပြုထာ်းကကပါသည်။ သ ိုို့မှသာ System တစ်ြေိုမှ အခြော်း သာ System တစ်ြေိုသ ိုို့ လွယ်လင်ေ့တကူ လှမ််း၍ 

ြေျ  တ်ဆက် (Interoperability) အသိုံ်းခပြုန ိုင်မည် ခဖစ်ပါသည်။ 

Catalogue နှင်ေ့ data က ို publish လိုပ်န ိုင်ရန် အတွက်၊ Data က ို ထ န််းသ မ််းသ ိုမှ ်းရန်အတွက်၊ process လိုပ်ရန် အတွက်၊ Search 

 ပ်းလိုပ်န ိုင်ရန် အတွက် ၊ data က ို ကကည်ေ့ရှုန ိုင်ရန် အတွက် စသည်ေ့ functionality မျာ်းပါရှ  သာ software မျာ်း၊ database မျာ်း၊ 

server မျာ်း၊ client မျာ်း၊ Web Portal မျာ်းတ ိုို့ ပါရှ ပါသည်။ 

SDI တွင် လူအမျာ်းနှင်ေ့ သက်ဆ ိုင် သာ data မျာ်းက ို ဖန်တ ်းခြေင််း၊ စို ဆာင််းခြေင််း၊ အြေမဲေ့ Access  ပ်းခြေင််း၊ share ခပန်လိုပ် ပ်းခြေင််း၊ 

Download ရယူပပ ်း အသိုံ်းခပြုန ိုင်ခြေင််း၊ စသည်ေ့ လိုပ်ငန််းစဉ် အဆင်ေ့ဆင်ေ့တ ိုို့ ပါဝင်ပါသည်။ ထ ိုကဲေ့သ ိုို့ spatial data မျာ်းက ို ဖန်တ ်းရန် 

အတွက်၊ စို ဆာင််းရန်အတွက်၊ ခပန်လည် ခဖန်ဲ့ခဖ ်းရန် အတွက် လိုပ်န ိုင်ရန် မူဝါေမျာ်းနှင်ေ့ သ ဘာတူည ြေျက်မျာ်းက ို ြေျမှတ်ခြေင််း နှင်ေ့ 

အထက်ပါ လိုပ်ငန််းမျာ်း အတွက် အစ ို်းရဌာနမျာ်းမှ အတူတကွ ပူ်း ပါင််းပါဝင်ခြေင််း စသည်တ ိုို့ ပါဝင်ပါသည်။  

န ိုင်ငံတစ်ြေိုရဲဲ့ National SDI တစ်ြေိုက ို စို ပါင််းစွမ််းအာ်းနဲဲ့ အြေျ  န်ယူပပ ်း တခဖည််းခဖည််းခြေင််း တည် ဆာက် ရယ ူန ိုင်ပါသည်။ 

ကမဘာေ့န ိုင်ငံမျာ်း ပူ်း ပါင််း  ဆာင်ရွက်မှု တစ်ြေိုခဖစ် သာ Global SDI အ ကကာင််းက ို ၎င််း၏ တရာ်းဝင် website 

http://www.gsdi.org/ တွင် အ သ်းစ တ် ဆက်လက်ဖတ်ရှုန ိုင်ပါသည်။ 

QGIS software က ိုအသိုံ်းခပြုပပ ်း တာေ့ GIS က ို လေ့လာသွာ်းမယ်။ မ မ လိုပ် ဆာင် န သာ လိုပ်ငန််းမျာ်းအတွက် လ ိုအပ်သည်ေ့ GIS 

 ခမပိုံ တွက ို က ိုယ်တ ိုင် ခပင်ဆင်  ရ်းဆွတဲတ် စရန် ရည်ရွယပ်ါသည်။ GIS က ိုသိုံ်းမယ်ဆ ိုရင် Tool  တွက ို အရင်ဆိုံ်း ယဉ်ပါ်း အာင် 

က ိုင်တွယ်တတ်ဖ ိုို့ လ ိုအပ်ပါတယ်။ အဲေါပပ ်းမှ ဘယ်လ ိုသိုံ်းန ိုင်မလဲ ဆ ိုတဲေ့ အပ ိုင််းက ို ဆက်ကကတာ ပါို့။  

ေ  Tool  တွက ဘာလဲ ဘာ တွလဲ ၊  ဘယလ် ိုအလိုပ်လိုပ်သလဲ၊  ဘာ ကကာင်ေ့လိုပ်ရတာလဲ ၊ ဘယလ် ို လိုပ်ရမှာလဲ၊ ဘယ်အြေျ  န်မှာ 

သိုံ်းလဲ စသည်တ ိုို့က ို နမူနာမျာ်းခဖင်ေ့ လက် တွဲ့ကျကျ  လေ့ကျင်ေ့သွာ်းပါမည်။ ဤသင်တန််းစာအိုပ်တွင် လက် တွဲ့ 

 လေ့ကျင်ေ့ြေန််းမျာ်းက ို အဓ က ဦ်းစာ်း ပ်း သွာ်းပါမည်။ ေ သင်ြေန််းစာမျာ်းမှာ Theory မျာ်းက ို အကျယ်တဝင်ေ့ မ ရ်းထာ်းပါဘူ်း။ 

လ ိုအပ်သည်ေ့ အြေျက်မျာ်းသာ  ဖေါ်ခပထာ်းပါတယ်။ GIS ရဲဲ့Theory အပ ိုင််းက ို ကာလရှည် သာသင်တန််းမျာ်း သ ိုို့မဟိုတ် Reference 

စာအိုပမ်ျာ်းထဲမှ မ မ ဖာသာ အြေျ  န်မျာ်း ပ်းကာ ဆက်လက် လေ့လာ သွာ်းရပါမည်။ GIS ပညာရပ်နှင်ေ့ သက်ဆ ိုင် သာ Reference 

http://www.gsdi.org/
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စာအိုပ် အမျာ်းစိုမှာ English ဘာသာရပ်ခဖင်ေ့  ရ်းထာ်း သာ ကကာင်ေ့  ကာင််းမွန်စွာ ဖတ်ရှုနာ်းလည်န ိုင် စရန် အတွက် English 

ဘာသာရပ်က ိုပါ  လေ့လာထာ်းရန် တ ိုက်တွန််းပါသည်။ 

အ ခြေြေံမှာ တာေ့ စာဖတ်သူအတွက် လွယက်ူ စရန် လိုပ် ဆာင်ရမည်ေ့ အဆင်ေ့မျာ်းအလ ိုက် အ သ်းစ တ် လ ိုက် ရ်း ပ်းထာ်းပါသည်။ 

GIS Tool  တွက ို သိုံ်းတတ်သွာ်းပပ ဆ ိုရင်  နာက်ပ ိုင််းမှာ GIS Application က ို ဆက်သွာ်းပါမယ်။ ေ  နရာမှာ Idea  ကာင််းဖ ိုို့လ ိုတယ်။ 

အလျင််းသင်ေ့သ လာက် တာေ့ ထည်ေ့ ပ်းထာ်းတယ်။ တကယ်ေ့ ရှင််းလင််းြေျက်က Lecture က ို  ခပာ နရင််း၊ Interaction လိုပ် နရင််း၊ 

အ မ်းအ ခဖ လိုပ် နရင််း၊ Discussion လိုပ် နရင််းနဲဲ့ ထွက်လာတဲေ့ နှစ်ဦ်းနှစ်ဖက်ရဲဲ့ အ တွ်း ပေါ်မှာလည််း အမျာ်းကက ်း 

မူတည်ပါတယ။် သင်တန််းသူ/သာ်း တွရဲဲ့ စ တ်ဝင်တစာ်းနဲဲ့  မ်းတဲေ့  မ်းြေွန််း တွက အ ကကာင််းအရာက ို နာ်းလည် အာင်၊ 

ပ ိုပပ ်းရှင််းသွာ်း အာင် ခပန် ခဖဆ ိုတဲေ့  ဆွ်း နွ်းြေျက် ရှင််းလင််းြေျက် ပေါ်မှာလည််း မူတည်ပပ ်း  ခပာင််းလဲပါမည်။ တတ်ြေျင်လျင် 

စာမျာ်းမျာ်းဖတ် ပ်းပါ။ ပ ိုသ ြေျင်လျင် အဓ ပပါယ်ရှ တဲေ့  မ်းြေွန််းမျ  ြု်း မျာ်းမျာ်း မ်းကကပါ။ Good question က Good explanation ဆ က ို 

ကူပပ ်း ဆွဲ ြေေါ်သွာ်းန ိုင်ပပ ်း အကျ  ြု်းပ ိုခဖစ်ထွန််းပါတယ။်  မ်းခမန််းသူရဲဲ့ အ တွ်းနဲဲ့  မ်းြေွန််းက ို လမ််းမှန်သ ိုို့  ရာက်ရှ သွာ်း အာင် Guide 

လိုပ်ပပ ်း  ခဖဆ ိုမှု ပေါ်မှာလည််း မူတည်ပါမည်။ 

လက် တွဲ့  လေ့ကျငေ့်ြေန််းမျာ်း 

The following materials will be used for the training package. 

Softwares : 3.10.3-A Coruña ( ဖ ဖေါ်ဝါရ လ၊၂၀၂၀ မှာ ထွက်ရှ ထာ်းပါသည်။) 

Data used : Data folder of Training Exercise Package , point, line, polygon, raster 

Mainly Natural Earth World datasets, Landsat Images, MIMU Myanmar GIS datasets, 

GPS, sample GPS points in MS Excel file.  

Sr. No. File Name Description 

1 ne_10m_admin_0_countries.shp Countries of the world in 10 million scale 

2 ne_10m_populated_places.shp Cities, Town of the world in 10 million scale 

3 ne_10m_railroads.shp Railroads in 10 million scale 

4 ne_10m_roads.shp Roads in 10 million scale 

5 World Ocean Ocean Data 10 million scale 

6 mmr_polbnda_adm1_250k_mimu.shp State/Region Level in 250,000 scale 

7 mmr_polbnda_adm3_250k_mimu.shp Township Level in 250,000 scale 

8 mmr_polbndl_250k_mimu Township level in 250,000 scale 

9 mmr_pplp1_250k_mimu.shp Towns in 250,000 scale 

10 mmr_rdsl_250k_mimu.shp Roads in  250,000 scale 

11 mmr_rlwl_250k_mimu.shp Railways in  250,000 scale 

12 mmr_airports_mimu Airport in  250,000 scale 

အထက်ပါ  ပ်းထာ်း သာ GIS  ေတာမျာ်း အာ်းလိုံ်းက ို မ မ  Computer  ၏ D:\data\folder ထဲတွင် ကူ်းထည်ေ့ ထာ်းပါ။  အာက်ပါ 

 လေ့ကျင်ေ့ြေန််းမျာ်းတွင် ဤ data folder ထဲတွင်GIS ဖ ိုင်မျာ်းက ို ထာ်းရှ သည်ဟို ယူဆကာ D:\data\ ဟူ သာ လမ််း ကကာင််း 

က ိုရည်ညွှန််းပပ ်း အသိုံ်းခပြုသွာ်း ပါမည်။ ေ ထက်ပ ိုပပ ်း တာေ့ GIS data  တွက ို ထပ်မံလ ိုြေျင်ပါက 
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http://geonode.themimu.info/layers/?limit=100&offset=0 စာမျက်နှာတွင် Download ရယူန ိုင်ပါသည်။ ေ အ ခြေြေံမှာ GIS 

ဖ ိုင် တွက ို individual flat file အ နခဖင်ေ့ အမျာ်းဆိုံ်း အသိုံ်းြေျ သွာ်းပါမည်။ 

QGIS website မ ှ  ေတာမျာ်းခဖင်ေ့  လေ့ကျင်ေ့ြေျင်ပါက  အာက်ပါ  နရာမှ ရယူပပ ်း  လေ့ကျင်ေ့သွာ်း န ိုင်ပါသည်။ 

http://download.osgeo.org/qgis/data/qgis_sample_data.zip [21.MB] 

 

1. QGIS က ို မ တ်ဆက် ပ်းခြေင််း နှင်ေ့ စတင် အသိုံ်းခပြုခြေင််း 

Version 3.10.3-A Coruña released on February 2020. 

ေ အြေန််းအတွက် လိုပ် ဆာင်ြေျက်။ Software က ို စတင် မ တ်ဆက်မယ်။ Tool  တွ လ ိုက်စမ််းပပ ်း ဖွင်ေ့ပ တ်ကကည်ေ့မယ်။  ေတာ  တွက ို 

software သိုံ်းပပ ်း ဖွင်ေ့ကကည်ေ့မယ်။ QGIS က ို စတင်က ိုင်တွယ်နည််း အ ခြေြေံက ိုသ ဖ ိုို့ ခဖစ်ပါတယ်။ Quantum GIS နဲဲ့ QGIS တ ိုို့က ို 

အလွယ်တကူ ‘ကွ ဂျ  အ ိုင်အက်စ်’ လ ိုို့ပ ဲ ြေေါ်ကကပါစ ိုို့။ 

 

1.1 QGIS Download ရယူခြေင််း 

Window version QGIS က ို ၎င််း၏ တရာ်းဝင် download website ခဖစ် သာ 

https://www.qgis.org/en/site/forusers/download.html မ ှ ရယူန ိုင်ပါသည်။ အခြော်း သာ Operating System မျာ်းအတွက် 

https://qgis.org/en/site/forusers/download.html တွင် ကကည်ေ့ရှုပပ ်း ရယူထည်ေ့သွင််းန ိုင်ပါသည်။  

The Open Source Geospatial Foundation http://www.osgeo.org မှလည််း အခြော်း သာ free software မျာ်းနှင်ေ့ အတူတကွ 

ရယူန ိုင်ပါသည်။ ၎င််းတွင် Desktop software, web mapping software နှင်ေ့ လ ိုအပ် သာ Library မျာ်း အစရှ သည်ေ့ free software 

မျာ်း ပါရှ ပါသည်။ OSGeo Live မ ှ Install ခပြုလိုပ်လ င်၊ Internet connection  နှ်းပါက၊ အရင်ဆိုံ်း Computer သ ိုို့ Package က ို 

Download ခပြုလိုပ်ပပ ်း၊ Install From Computer နည််းက ို သိုံ်းပါက ပ ို၍အဆင် ခပပါမည်။ http://live.osgeo.org/en/index.html 

တွင် အြေမဲေ့ ရယူန ိုင်ပါသည်။ 

 

1.2 QGIS Software Installation ခပြုလိုပ်ခြေင််း 

32 bit Window Computer မျာ်းအတွက် QGIS-OSGeo4W-3.10.3-3-Setup-x86 က ို Install လိုပ်လ ိုက်ပါ။ 

64 bit Window OS Computer မျာ်းအတွက် QGIS-OSGeo4W-3.10.3-3-Setup-x86_64 ခဖင်ေ့ Install လိုပ်လ ိုက်ပါ။ 

အခြော်း သာ Free and Open source software မျာ်းနှင်ေ့အတူ အတွဲလ ိုက် စိုံလင်စွာ တစ်ြေါတည််း install ခပြုလိုပ်ြေျင်ပါက Package 

အလ ိုက် ထည်ေ့ ပ်းန ိုင်သည်ေ့ installer ဖ ိုင် Osgeo4w-setup-x86.exe က ိုလည််း အသိုံ်းခပြုန ိုင်ပါသည်။ 

Install လိုပ်ပပ ်းပပ ဆ ိုရင် စသိုံ်းလ ိုို့ရပါပပ ။ 

 

1.3 QGIS က ို အဖငွေ့အ်ပ တ် ခပြုလိုပ်ခြေင််း 

Window > All programs > QGIS 3.10 က ိုသွာ်းပပ ်း QGIS Desktop 3.10.3 က ို Double-click ခဖင်ေ့ ဖွင်ေ့လ ိုက်ပါ။ 

QGIS က ို မ မ  Install ခပြုလိုပ်စဉ်က  ရွ်းြေျယ်တာ်း သာ အခြော်း optional software မျာ်းနှင်ေ့ အတူ  တွဲ့ရပါမည်။  

Shortcut တွင် အပမဲတမ််း ပါရှ  နမှာ က တာေ့ QGIS Desktop version နဲဲ့ QGIS Browser version တ ိုို့ခဖစ်ပါသည်။ ကွာခြော်းြေျက်က  

http://geonode.themimu.info/layers/?limit=100&offset=0
https://qgis.org/en/site/forusers/download.html
http://live.osgeo.org/en/index.html
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QGIS Browser version က GIS ဖ ိုင် အမျ  ြု်းမျ  ြု်းရဲဲ့ metadata, Attribute နဲဲ့ Preview ဖွင်ေ့ကကည်ေ့ရိုံသာ ရန ိုင်ပပ ်း QGIS Desktop 

version က ဖန်တ ်း Create, edit, visualize, analyze and publish geospatial information စတဲေ့ GIS အလိုပ်မျာ်းက ို 

ခပြုလိုပ်ဖ ိုို့ခဖစ်ပါတယ။် 

 

1.4 QGISDesktop ၏ GUI Interface နှင်ေ့စတင် မ တ်ဆက်ခြေင််း 

 
 

QGIS GUI တွင် အပ ိုင််း ၅ပ ိုင််းပါရှ သည်။ 

1 - Menu Bar 

2 - Tool Bar  

3 - Map Legend က Layer အတွက် 

4 - Map View က  ခမပိုံက ို လာခပမည်ေ့  နရာ 

5 - Status bar က တည် နရာ နှင်ေ့ စ က်း စသည်ေ့ အပ ိုင််းတ ိုို့ ပါဝင်ပါမည်။   

 

ေ အပ ိုင််းက ို ရှင််းခပဖ ိုို့ရန် အတွက်  ခမပိုံတစ်ြေိုနဲဲ့ ရှင််းခပရင် ပ ိုပပ ်း တာေ့ ရှင််းရှင််းလင််းလင််းနဲဲ့ နာ်းလည်လွယ်မယ်။ ကမဘာေ့န ိုင်ငံမျာ်းပိုံက ို 

အရင်ဆိုံ်း ဖွင်ေ့ထာ်း  ပ်းကကည်ေ့လ ိုက်ပါ။ ပပ ်းရင် ေ အပ ိုင််းက ို ခပန်လာြေဲေ့ပါ။ 

Menu bar မှာ QGIS software ရဲဲ့ အဓ က feature  တွနဲဲ့ Project နှင်ေ့သက်ဆ ိုင် သာ အရာမျာ်း၊ Layer 

နှင်ေ့ပတ်သက် သာ အရာမျာ်းက ိုလ ိုအပ်သလ ို Manage ခပြုလိုပ်န ိုင်ရန်၊ ဖ ိုင် အသွင််း၊ အထိုတ်၊ ခပင်ဆင် တည််းခဖတ်ခြေင််း၊ (input ၊ 

output ၊ editing) ၊ Settings၊ Plugins မျာ်း စသည်တ ိုို့ ပါရှ ပါတယ်။ 

Toolbar သည် Menu bar ဆင်တူပပ ်း၊ အဓ ကက တာေ့Tool  တ ွ နဲဲ့ ၎င််းရဲဲ့ လိုပ် ဆာင်ြေျက်တ ိုို့ပါရှ ပါတယ်။ 

 ေတာမျာ်းက ို Analyze လိုပ်ဖ ိုို့ ၊ Process လိုပ်ဖ ိုို့ ၊  ခမပိုံနှင်ေ့ အခပန်အလှန် ဆက်သွယဖ် ိုို့ အတွက်လည််း ပါရှ ပါသည်။ Toolbar နဲဲ့ 

Menu bar မှာပါရှ  သာ အစ တ်အပ ိုင််း တစ်ြေိုခြေင််း၏ အ သ်းစ တ်က ို QGIS Maunal တွင် အကျယ်တဝင်ေ့ ဆက်လက် ကကည်ေ့ရှုပါရန်။ 

Status bar က  ခမပိုံရဲဲ့ စ က်း၊ projection system ၊  ခမပိုံ ပေါ်မှာ တင်ထာ်းတေဲ့ Mouse Pointer ရဲဲ့ Coordinate 

တည် နရာ စသည်တ ိုို့က ို  ဖေါ်ခပပါသည်။ 
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Layer တစ်ြေို လာက် ထည်ေ့ပပ ်းတဲေ့အြေါမှာ နမူနာ သိုံ်းခပပါမယ်။ လ ိုြေျင်တဲေ့ Button  ပေါ်မှာ Mouse က ိုတင်ပပ ်း တာေ့ click 

လိုပ်လ ိုက်ရင် Tool က ို  ရွ်းပပ ်းသာ်း ခဖစ် နမယ်။ လွယ်ကူစွာ  လေ့လာအသိုံ်းခပြုန ိုင်ပါတယ်။ 

 
အသိုံ်းခပြုရန် လ ိုအပ်တဲေ့ Toolbar  တွက ို အနည််းငယ် မ တ်ဆက် ပ်းပါမယ်။ 

Toolbar တစ်ြေိုက ို Turn On/Off ခပြုလိုပ်ြေျင်ပါက Menu bar > View menu > Toolbars က ိုသွာ်းပပ ်း Tick ခဖင်ေ့ ဖွင်ေ့ခြေင််း/ပ တ်ခြေင််း 

ခပြုလိုပ်န ိုင်ပါသည်။ Tick လိုပ်တယ်ဆ ိုတာက အမှန်ခြေစ် လ်း  ပေါ် အာင် check လိုပ်တာက ို ဆ ိုလ ိုတာပါ။ 

 

 
 

 နာက်တစ်နည််းက တာေ့ Toolbar  တွက ို QGIS ရဲဲ့ Menu bar  ပေါ်မှာ Right-click တင်ပပ ်း တာေ့လည််း  ြေေါ်န ိုင်ပါတယ။် က ိုယ်တ ိုင် 

လ ိုက်စမ််းကကည်ေ့လ ိုက်ပါ။ 

 
 

Toolbar  တွက ို Drag ဆွဲပပ ်း  ရ ဲ့လ ိုို့ရတယ်။ အခပင်က ို ဆွဲထိုတ်ပပ ်း float လိုပ်ြေ ိုင််းထာ်း လ ိုို့ရတယ်။ စမ််းကကည်ေ့န ိုင်ပါတယ။် 

အ ခြေြေံ  လေ့ကျင်ေ့ြေန််း တွ အတွက် မရှ မခဖစ် အသိုံ်းခပြုရန် ဖွင်ေ့ထာ်းရမယ်ေ့ Toolbar  တွက တာေ့ File, Manage Layers, 

Layers, Browser, Map Navigation, Attribute စသည်တ ိုို့ ခဖစ်ပါတယ။် မပွင်ေ့ သ်းရင်  သြေျာ အာင် ဖွင်ေ့ထာ်း ပ်းလ ိုက်ပါ။ 

၎င််းတ ိုို့ရဲဲ့ အလိုပ်လိုပ်ပိုံက ို နမူနာအာ်းခဖင်ေ့  အာက်မှာ  ဖေါ်ခပထာ်းပါတယ်။ လက် တွဲ့ တကယ်သိုံ်းလ ိုက်တဲေ့ အြေါကျရင် 

လွယလ်ွယ် လ်းနဲဲ့ ပ ိုသ ဘာ ပါက်ပါမယ်။ 

File toolbar က QGIS project  တွက ို ဖွင်ေ့ဖ ိုို့ ပ တ်ဖ ိုို့၊ သ မ််းဖ ိုို့ သိုံ်းတယ။် Menu bar ရဲဲ့ Project 

menu  အာက်က Tool  တွနဲဲ့ တူတပူါပဲ။  
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Manage Layers toolbar က ို layer အမျ  ြု်းအစာ်း 

အမျ  ြု်းမျ  ြု်းက ို ဖွင်ေ့ဖ ိုို့ အတွက်သိုံ်းတယ။် 

 Browser toolbar က GIS 

ဖ ိုင် တွက ို browse လိုပ်ကကည်ေ့ရန် အတွက် သိုံ်းတယ။် Browser က နတဆင်ေ့ layer ရဲဲ့ Property က ို 

ကကည်ေ့လ ိုို့ရတယ။် layer  တွက ို import/add လိုပ်လ ိုို့ ရတယ်။ 

Layers toolbar က import လိုပ်ထာ်းတဲေ့ ဖ ိုင်မျာ်းနှင်ေ့ ၎င််းတ ိုို့၏ Map Legend  တွ အတွက် သိုံ်းပါတယ်။ 

လက် တွဲ့လိုပ်ခပတဲေ့အြေါကျရင် လွယလ်ွယ်နဲဲ့ သ ဘာ ပါက်လာပါလ မ်ေ့မယ်။ 

Map Navigation toolbar က တာေ့ 

 ခမပိုံက ို ြေျဲဲ့ပပ ်း ကကည်ေ့ဖ ိုို့၊ ြေျြုံဲ့ပပ ်း ကကည်ေ့ဖ ိုို့၊ 

ခမငက်ွင််းက ို အထက် အာက် ဘယ်ညာ 

တွန််း  ရ ဲ့ကကည်ေ့ဖ ိုို့ အတွက် သိုံ်းပါတယ။်  

Attribute toolbar က တာေ့ layer  တွရဲဲ့ 

feature က ို identify လိုပ်ဖ ိုို့၊ layer ရဲဲ့ Attribute 

table  တွက ို ကကည်ေ့ဖ ိုို့၊ feature က ို select 

လိုပ်ဖ ိုို့အတွက် သိုံ်းပါတယ်။ 

ကျန်တဲေ့ Tool  တွက ို အလျင််းသင်ေ့သလ ို  နာက်မှ ထပ်ပပ ်း မ တ်ဆက် ပ်းပါမယ်။ 

1.5 QGIS Setting and Configuration မျာ်းက ို ခပင်ဆင်ခြေင််း 

ေ အြေန််းအတွက် လိုပ် ဆာင်ြေျက်။ Software က ို မ မ ခပ စြေျင်တဲေ့ အတ ိုင််း Setting  တွက ို ခပင်ထာ်းရပါမယ်။ 

ထ ိုသ ိုို့ခပင်ဆင်ရန် Menu bar > Settings > Options > က ိုဖွင်ေ့ပပ ်း CRS tab က ို click လိုပ်ပါ အဲေ မှာ“CRS ဆ ိုတာ Coordinate 

Reference System” က ို  ခပာတာပါ။ 

 
CRS for Project တွင် Use CRS from first layer added နှငေ့် Use a default CRS Project ဟိုနှစ်မျ  ြု်းရှ ပါသည်။ Project 

အသစ်ဖန်တ ်း သာအြေါတွင် Use CRS from first layer added နှငေ့် Use a default CRS က ိုတစြ်ေို  ရွ်း ပ်းရပါမည်။ Use CRS from 

first layer added က ို ရွ်းလ င် ပထမထည်ေ့လ ိုက် သာ layer ၏ CRS က ိုအသိုံ်းခပြုမည်ခဖစ်သည်။  Use a default CRS က ို select 

လိုပ်ထာ်းပါက မ မ   ပေါ် စလ ို သာ CRS က ို CRS box တွင်  ရွ်း ပ်းရပါမည်။ ယြေို project တွင် Use CRS from first layer added 

က ို ရွ်းထာ်းပါ။ 

CRS for layers သည် လိုပ် ဆာင်မှုအသစ်က ိုဖန်တ ်းရန် သ ိုို့မဟိုတ ်CRS မပါဘဲ layer တစြ်ေိုဖွငေ့် သာအြေါ လိုပ် ဆာင်ရန် 

သတ်မှတ်န ိုင်သည်။ ယြေို project တွင် Prompt for CRS က ို ရွ်းထာ်းပါ။ ပပ ်းလ င် OK က ို click လိုပ်ပါ။ 



Basic GIS Training - Using QGIS 

 Copyright © MIMU 2020 19 

 နာက်တစ်ဆငေ့် Menu bar > Project Properties က ိုဖွင်ေ့ပပ ်း  ပေါ်လာ သာ Property Window တွင် CRS tab က ို click 

လိုပ်ပါ။ Predefined Coordinate Reference System တွင် မ မ  Display view တွင် ခပလ ို သာ CRS က ို ရွ်း န ိုင်သည်။ ယြေို Project 

တွင် EPSG:4326 က ို ရွ်းပါ။ Display view တွင် latitude/ Longitude ခဖငေ့ ်ခပရန်အတွက ်ခဖစ်သည်။ 

EPSG ဆ ိုတာ projection system က ို ဖေါ်ခပတဲေ့ စနစ်တစ်ြေိုခဖစ်ပပ ်း European Petroleum Survey Group က စတင် 

သတ်မှတ်အသိုံ်းခပြုထာ်းတဲေ့စနစ်က ို  ြေေါ် ဝေါ်ထာ်းတာပါ။ 
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2. QGIS တွင် GIS Layer မျာ်းခဖငေ့်စတင် လေ့လာခြေင််း 

ယြေို လေ့ကျငေ့်ြေန််းတွင် အသိုံ်းခပြုဖ ိုို့ရန်အတွက် လူသိုံ်းမျာ်းတဲေ့ ESRI Shapefile အမျ  ြု်းအစာ်း ခဖစ်တဲေ့ GIS ဖ ိုင်မျာ်းက ို အဓ က 

အသိုံ်းခပြုသွာ်းပါမည်။ ေ  shapefile အမျ  ြု်းအစာ်းမှာ GIS  ေတာ တစ်ြေိုက ို အနည််းဆိုံ်း ဖ ိုင်သိုံ်းြေိုနဲဲ့ ဖွဲဲ့စည််းထာ်း ပါတယ်။ 

ဖ ိုင်နာမည် တွရဲဲ့  နာက်မှာ extension ၃ မျ  ြု်းနဲဲ့ ြေွဲခြော်းပပ ်း သ ်းခြော်းစ  သ မ််းထာ်းတယ်။  

1. .shp  ဖ ိုင်ထဲမှာ Geometry  တွပါဝင်တယ။်  

2. .dbf  ဖ ိုင်ထဲမှာ Attribute  တွပါဝင်တဲေ့ database ဖ ိုင်ခဖစ်တယ်။ 

3. .shx  ဖ ိုင်ထဲမှာ index  တ ွပါရှ တယ်။ 

အြေျ  ြုဲ့မှာ Projection က ို  ဖေါ်ခပတဲေ့ .prj ဖ ိုင် တစ်ြေို ထပ်ပပ ်း ပါဝင် နပါလ မ်ေ့မည်။ ထ ိုို့ ကကာင်ေ့ shapefile မျာ်းက ို ကူ်းယူခြေင််း 

ခပြုလိုပ်ြေျင်ပါက ထ ိုဖ ိုင်မျာ်း အာ်းလို်ံးက ို အစိုံလ ိုက် ကူ်းယူပါမှ ခပည်ေ့စိုံ သာ GIS shapefile ဖ ိုင် တစ်ြေို ခဖစ်ပါမည်။ Shapefile 

အ ကကာင််း အ သ်းစ တ် ထပ်သ ြေျင်ရင် ESRI ကထိုတ်တဲေ့ shapefile.pdf စာတမ််းမှာ ဆက်ပပ ်း  လေ့လာန ိုင်ပါတယ်။  

http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf 

 

2.1 GIS data layer မျာ်းက ို QGIS Project ထဲသ ိုို့ စတင် Import ခပြုလိုပ်ခြေင််း 

QGIS Project Window ထဲသ ိုို့ Data မျာ်းထညေ့်သွင််းရန် နည််းလမ််းမျာ်းမှာ menu bar တွင်ရှ  သာ Layer > Add Layer, Manage 

layer Toolbar မ ှAdd layer, Browser panel မ ှမ မ ထညေ့်သွင််းလ ို သာ layer က ို drag လိုပ်ပပ ်း layer window ထဲတွင် drop 

ခပြုလိုပ်၍လည််းထညေ့်န ိုင်သည်။ File explorer မှလည််း မ မ ထညေ့်သွင််းလ ို သာ layer က ို drag လိုပ်ပပ ်း layer window ထဲတွင် drop 

ခပြုလိုပ်၍လည််းထညေ့်န ိုင်သည်။ 

ယြေို လေ့ကျငေ့်ြေန််းတွင် menu bar မ ှadd vector က ိုသိုံ်းပပ ်း စတင် လေ့လာကကညေ့်ပါမည်။ 

Menu bar က န Layer > Add Vector Layers က ိုနှ ပ်ပါ။ Source type အတွက် File က ို  ရွ်းထာ်းပပ ်း Browse က ို နှ ပ်လ ိုက်ပါ။ 

 
 

D:\MIMU_TrainingData\Vector Data\World Data ထဲက ကမဘာေ့န ိုင်ငံမျာ်းဖ ိုင် ခဖစ်သည်ေ့ ne_10m_admin_0_countries.shp က ို 

 ရွ်း ပ်းပပ ်း Open က ို နှ ပ်လ ိုက်ပါ။ (မ မ ၏ computer ထဲက shapefile မျာ်း သ မ််းထာ်း သာ  နရာက ို ညွှန်ခပ ပ်းရပါမည်။) 

http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf
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Add vector layer ဆ ခပန် ရာက်လာပပ ်း Source dataset မှာ က ိုယ် ရွ်း ပ်းထာ်းတဲေ့ ဖ ိုင်နာမည်  ပေါ် နမည်။  အာက်နာ်းမှာ ရှ တဲေ့ 

add button က ို ဆက်နှ ပ်လ ိုက်ပါက အဲေ  ဖ ိုင်က ို map view ထဲသ ိုို့ import လိုပ်ပပ ်းသာ်း ခဖစ်မည်။

 

2.2 QGIS ထဲမှာ ဖွင်ေ့ဖတ်န ိုင်တဲေ့ ဖ ိုင်အမျ  ြု်းအစာ်းမျာ်း 

QGIS software က န ဖွင်ေ့န ိုင်တဲေ့ ဖ ိုင်အမျ  ြု်းအစာ်း  တွက တာေ့ GDAL/OGR driver  တွက support လိုပ်တဲေ့ Raster နှင်ေ့ Vector 

ဖ ိုင် အမျ  ြု်းအစာ်းမျာ်း၊ Spatial database မျာ်းမှ  ေတာမျာ်း၊ OGCWeb Service မျာ်းမှ  ေတာမျာ်း၊ non-spatial tabular data မျာ်း 

စသည်တ ိုို့ခဖင်ေ့ အစိုံအလင် ပါဝင်ပါသည်။ 
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QGIS supports Dataset 

• Raster datasets – using GDAL Library (>100 raster formats) 

E.g. Arc/Info Binary Grid, Arc/Info ASCII Grid,GeoTIFF, Erdas Imagine 

• Vector datasets – using OGRLibrary (>60 vector formats) 

E.g. ESRI shape files, MapInfo MIF (interchange format), MapInfo TAB (native format) စသည်ေ့ အမျ  ြု်းအစာ်းတ ိုို့က ို 

ဖွင်ေ့၍လည််း process လိုပ်န ိုင်ပါတယ။်  

ေါဟာ QGIS ထဲက ို File Import လိုပ်န ိုင်တဲေ့ အမျ  ြု်းအစာ်းထဲက တစြ်ေျ  ြုဲ့ ပါို့။ ေ ခပငေ့ ်ဘာ တွ ဖွင်ေ့ကကည်ေ့လ ိုို့ ရ သ်းသလဲ။ Database 

file, Web Map Service, Flat file စသည်တ ိုို့က ိုလည််း ဖွင်ေ့လ ိုို့ ရန ိုင်ပါတယ။် 

 

2.3 Map Navigation tool bar က ိုအသိုံ်းခပြုခြေင််း 

Map Navigation tool bar က ိုသိုံ်းပပ ်း  ခမပိုံက ို ြေျြုံဲ့၊ ြေျဲဲ့၊  ရ ဲ့ (Pan, Zoom) လိုပ်ကစာ်းကကည်ေ့လ ိုက်ပါ။  ခမပိုံ ပေါ် mouse 

တင်ပပ ်း mouse ရဲဲ့ အလယ်ဘ ်းက ို  ရှဲ့သ ိုို့  နာက်သ ိုို့ တွန််းလ မ်ေ့ကကည်ေ့လ ိုက်ပါ။ Pan map tool နဲဲ့ ရ ဲ့ပပ ်း ခမန်မာန ိုင်ငံက ို ရှာကကည်ေ့ပါ၊ 

Zoom က ိုသိုံ်းပပ ်း map view မှာ  ခမပိုံက ိုအခပည်ေ့  ပေါ် န အာင် ြေျ  န်ညှ ကာ ဆွဲြေျဲဲ့ကကည်ေ့လ ိုက်ပါ။ 

Browser Toolbar က ို ဖွင်ေ့ထာ်း ပ်းပါ။ ဘယ်ဘက် side bar မှာ  ပေါ်လာပါလ မ်ေ့မယ်။ Browser tab က န GIS 

ဖ ိုင် တွထည်ေ့ထာ်းတဲေ့ D:\MIMU_TrainingData\Vector Data\World Data က ိုသွာ်းပါ။ ပပ ်း နာက် ne_10m_roads.shp ဆ ိုတေဲ့ 

ဖ ိုင် ပေါ်က ို Right-click တင်ပပ ်း၊ Add Layer က ိုနှ ပ် ပ်းလ ိုက်ခြေင််းအာ်းခဖင်ေ့ QGIS map project ထဲသ ိုို့  နာက်ထပ် layer တစ်ြေို 

ထပ်ထည်ေ့ ပ်းလ ိုက်ပါ။ 

World Cities ဖ ိုင်ခဖစ်သည်ေ့ ne_10m_populated_places.shp က ို map view ထဲသ ိုို့ Window ရဲဲ့ file explorer မ ှFolder 

view/file view မ ှfile က ို Drag ဆွဲပပ ်း ထည်ေ့ ပ်းလ ိုက်ပါ။ 

 

2.4 QGIS project ထဲက Layer တစ်ြေိုက ို အဖငွ်ေ့၊ အပ တ် ခပြုလိုပ်ခြေင််း 

Layer pane ထဲက Layer တစ်ြေိုက ို အဖွင်ေ့၊ အပ တ် ခပြုလိုပ်ြေျင်ပါက 

ဖွင်ေ့ပ တ်လိုပ်ြေျင်တဲေ့ Layer အမည်ရဲဲ့ ဘယဘ်က် အစနာ်းက အမှန်ခြေစ်က ို တစ်ြေျက်စ  

နှ ပ် ပ်းပါက အဲေ  Layer က ို Turn On/Off ဖွင်ေ့ခြေင််း၊ ပ တ်ခြေင််း ခပြုလိုပ်န ိုင်သည်။ 

 

2.5 Layer မျာ်းက ို အထက် အာက် အစ အစဉ ် ခပာင််းခြေင််း 

Layer အမည်ရဲဲ့ အ ပေါ်က ိုmouse နဲဲ့ Drag ဆွဲပပ ်း အထက် 

 အာက်  ရ ဲ့ပပ ်း စ  ပ်းလ ိုို့ ရတယ်။ Layer pane ထဲတွင်ရှ သည်ေ့ Layer 

တစ်ြေို၏ အမည် ပေါ်တွင် select လိုပ်ထာ်းပပ ်း အထက်၊  အာက်သ ိုို့ Drag 

လိုပ်ကာ ဆွ ဲ ခြေင််းအာ်းခဖင်ေ့ layer မျာ်းက ို မ မ တ ိုို့ လ ိုအပ် သာ 

အစ အစဉ်အတ ိုင််း  ခပာင််းလဲန ိုင်ပါသည်။ 
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ဤသ ိုို့  ရ ဲ့ ပ်းခြေင််းအာ်းခဖင်ေ့  ခမပိုံ ပေါ် မှာလည််း layer မျာ်း အထက် အာက် လ ိုက်ပပ ်း  ခပာင််းသွာ်းပါလ မ်ေ့မယ်။ 

အမျာ်းအာ်းခဖင်ေ့ Point, Line တ ိုို့က ို Polygon ရဲဲ့အ ပေါ်မှာ Overlay တင်ထာ်းပပ ်း သိုံ်း လေ့ရှ တယ။် အဲေါမှ အပ တ် ခဖစ် နတဲေ့ Polygon 

က ကျန်တဲေ့ Point ၊ Line  တွက ို မဖိုံ်း တာေ့ဘူ်း ပါို့။ 

န ိုင်ငံ အ ပေါ်မှာ ကာ်းလမ််း၊ ကာ်းလမ််း အ ပေါ်မှာ ပမ ြုဲ့ စသည်ေ့ အစ အစဉ် အတ ိုင််း ထာ်းပပ ်း စ  ပ်းလ ိုက်ပါ။ 

 အာက်ကအလွှာ တွက ို ခမငြ်ေျင်ရင် တာေ့ Layer Transparency နဲဲ့  ဖာက်ပပ ်း ခပလ ိုို့ရန ိုင်တယ။် 

 

2.6 Attribute tool က ိုအသို်ံးခပြုခြေင််း 

 

Attribute tool က ို ဖွင်ေ့ထာ်းပပ ်း၊ Identify က ိုသိုံ်း၍  ခမပိုံ၏ တစ် နရာ ပေါ် တွင် Click လိုပ်ကကည်ေ့လ ိုက်ပါ။ ထ ို feature နှင်ေ့ 

သက်ဆ ိုင် သာ Attribute အြေျက်အလက်မျာ်းက ို  တွဲ့ရပါမည်။ တစ်ြေိုပပ ်း တစ်ြေို  ခပာင််း၍ စမ််းကကည်ေ့လ ိုက်ပါ။ 

Feature selection tool က ိုအသိုံ်းခပြု၍ feature မျာ်းက ို select လိုပ်န ိုင်သည်။ feature မျာ်းက ို  ရွ်းရန် 

မ မ အသိုံ်းခပြုလ ို သာ tool က ို  ရွ်းြေျယ်ရန် လ ိုအပ်သည်။ feature selection tools 

မျာ်းက ို  လေ့လာကကညေ့်ပါ။  

Select features by area or single click က ို ရွ်းပပ ်း feature  ပေါ်တွင် click 

လိုပ်ကကညေ့်ပါ။ click လိုပ်လ ိုက် သာ feature သည် 

အဝါ ရာင်  ရွ်းြေျယ်သွာ်းသည် က ို တွဲ့န ိုင်သည်။ 

Select feature tool သည် Mouse ခဖငေ့ ် feature 

တစြ်ေို သ ိုို့မဟိုတ ်တစြ်ေိုထက်ပ ို သာ feature မျာ်းက ို ရွ်းရန် 

အသိုံ်းခပြုသည်။ 

 

Select feature using expression tool က  အသ ုံျားပပ ပပ ျား 

attribute table က   select လ ပ်ပခင်ျား  

Select feature using expression tool သည် attribute table က ိုအ ခြေြေံပပ ်း  ရွ်းြေျယ်ခြေင််းခဖစ်သည်။ သတ ခပြုရန်မှာ 

attributr table နှငေ့် map canvas တွင်ရှ  သာ feature သည် အြေျက်အလက်တစြ်ေိုတည််းခဖစ်သည်။ သင် attribute table မှ 

feature တစြ်ေိုက ို select လိုပ်လ င် map canvas တွင်လည််း select ခဖစ် နပါမည်။ 

Attribute table က ိုအ ခြေြေံပပ ်း select လိုပ်ရန် layer panel တွင်ရှ  သာ ne_10m_admin_0_countries layer က ို select 

လိုပ်ထာ်းပါ။ select feature using an expression button က ို click လိုပ်ပါ။ 

 

ယြေို လေ့ကျငေ့်ြေန််းတွင် လူဦ်း ရ သန််းတစ်ရာနှငေ့်အထက်ရှ  သာ န ိုင်ငံမျာ်းက ို  ရွ်းြေျယ်ရန်ခဖစ်သည်။ ထ ိုသ ိုို့ ရွ်းြေျယ်ရန်။ 

Select by Expression window မ ှfield and value က ို 

ခဖနဲ့်ထိုတ်လ ိုက်ပါ။ ထ ိုမှတစ်ဆငေ့် pop_est က ို double 

click လိုပ်လ ိုက် သာအြေါ expression section 

၏ အာက်တွင် pop_est  ပေါ်လာသည်က ို တွဲ့ရမည်။ 

field value မျာ်းမ သြေျာလ င် dataset အတွင််းမှ 

unique value မျာ်းက ို တွဲ့န ိုင်ရန် all unique button 

က ိုနှ ပ်ပါ။  အာက်တွင် unique value မျာ်းက ို တွဲ့ရမည်။ 

ထ ိုအထဲမှ မ မ လ ို သာ data က ို double click 

လိုပ်၍ထညေ့်န ိုင်သလ ို  “ > 1000000 “  ရ ိုက်ထညေ့်ပါ။ 

expression section တွင်  
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 "pop_est" >100000000 ခပထာ်းသညေ့်အတ ိုင််း  တွဲ့ရမည်။ ပပ ်းလ င် select feature က ို click လိုပ်လ ိုက်ပါ။ လူဦ်း ရ 

သန််းတစ်ရာနှငေ့်အထက်ရှ  သာန ိုင်ငံမျာ်း   ရွထာ်းသည်က ို  တွဲ့ရမည်။ 

 

Exercise: ne_10m_populated_places layer မ ှန ိုင်ငံပမ ြုဲ့ တာ်မျာ်းနှငေ့် လူဦ်း ရ ၁၀သန််းအထက်ရှ  သာ ပမ ြုဲ့မျာ်းက ို  ရွ်းပါ။ 

Attribute tool က  အသ ုံျားပပ ပခင်ျား 

Layers tab ထဲရှ  Layer အမည်တစ်ြေိုြေို  ပေါ်က ို click နှ ပ်ကာ select လိုပ် ပ်းထာ်းပပ ်း Attribute tool ထဲက Open 

Attribute Table က ို click တစ်ြေျက် နှ ပ်လ ိုက်ပါ။ ထ ို layer အတွက် Attribute table  ပေါ်လာပါလ မ်ေ့မည်။ ထ ိုဇယာ်းက ို 

စူ်းစမ််း လေ့လာ ကကည်ေ့ပါ။ 

အခြော်း သာ layer အတွက် Attribute မျာ်းက ို အထက်ပါနည််းတူ Attribute ဇယာ်းမျာ်းက ို စူ်းစမ််း  လေ့လာကကည်ေ့လ ိုက်ပါ။ 

Attribute table ပွငေ့်လာ သာအြေါတွင်လည််း attribute table နှငေ့်သက်ဆ ိုင် သာ tools မျာ်းက ိုလည််း 

 တွဲ့ရမည်ခဖစ်သည်။  

 

2.7 Layer မျာ်း အတွက ်Label ထ ို်းခပခြေင််း 

Feature နှငေ့်ပတ်သက်သညေ့်မည်သညေ့်အြေျက်အလက်က ိုမဆ ို  ခမပိုံ ပေါ်တွင်ထည်ေ့သွင််းန ိုင်သည်။ မည်သညေ့် vector layer 

မဆ ို ၎င််းနှငေ့်ဆက်စပ် သာအမည်မျာ်း ရှ န ိုင်သည်။ ထ ိုအမည်မျာ်းသည် ၎င််းတ ိုို့ပါဝင်မှုအတွက် layer တြေို၏ attribute 

တွင်ထညေ့်သွင််းထာ်း သာအြေျက်အလက်မျာ်း ပေါ်တွင်မူတည်ပါသည်။ 

န ိုင်ငံမျာ်းက ို ခပ သာ layer အမည် ပေါ်တွင် Right-click > Properties က ိုနှ ပ်လ ိုက်ပါ။ Layer Properties window တစ်ြေို 

 ပေါ်လာပါမည်။ 

 ပေါ်လာ သာ Layer Properties window ၏ Labels tab က ို နှ ပ်လ ိုက်ပါ။ ထ ို tab အတွင််း No Label 

 ပေါ် န သာ နရာတွင် drop box မ ှsingle labels က ို  ရွ်း ပ်းပါ။ value  နရာတွင် Name က ို ရွ်း ပ်းပါ။ ပပ ်းလ င် apply က ို click 
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နှ ပ် ပ်းပပ ်း OK လိုပ် ပ်းလ ိုက်ပါ။ ထ ိုအြေါ layer  ပေါ်၌ န ိုင်ငံအမည်မျာ်း  ပေါ်လာ နပါလ မ်ေ့။ တခြော်း သာ label option မျာ်းက ို 

 လေ့လာကကညေ့်ပါ။ 

 

    
 

Label နှငေ့်သက်ဆ ိုင် သာ အ ခြေြေံအသိုံ်းခပြု သာ tools မျာ်းက ို ပ ိုမ ိုသ ရှ  စရန် ပမ ြုဲ့မျာ်းက ိုခပ သာ Layer က ို label 

မျာ်း ရ်းပပ ်း label နှငေ့်သက်ဆ ိုင် သာ အြေျက်မျာ်းက ို  လေ့လာကကညေ့်ပါ။ 

 

 

Field  စ်ခ ထက်ပ   သ  Label မ  ျား   ်ပပပခင်ျား 

Field တစ်ြေိုထက်ပ ိုပပ ်း Label ထ ို်းြေျင်ပါက Label Expression မ ှ အာက်ပါ နည််းအတ ိုင််း ခပြုလိုပ်န ိုင်ပါသည်။ No Label 

box တွင် single label က ို ရွ်းပါ။ value box တွင် မ မ  label ခပလ ို သာ name field က ို ရွ်းပါ။ ပပ ်းလ င် name field 

 ဘ်းနာ်းတွင်ရှ  သာ expression symbol က ို click လိုပ်ပါ။  

 ပေါ်လာ သာ Label Expression ထဲတွင် Label ထ ို်းြေျင် သာ  ကာ်လံက ို Fields and Values ထမဲ ှDouble-click နှ ပ်ပပ ်း 

ထည်ေ့ပါ။ Expression ထဲတွင်  ပေါ်လာပါမည်။ Expression ထဲတွင် field တစ်ြေိုနှင်ေ့ တစ်ြေိုကကာ်းထဲ၌ String Concatenation ၏ 

သ ကေတ ခဖစ် သာ “ | | ”  က ိုသိုံ်းပပ ်း ထ ို်းသွာ်းန ိုင်ပါသည်။  
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Expression dialog box တွင် OK လိုပ်လ ိုက် သာအြေါ value field တွင်  အာက်ပါအတ ိုင််း တွဲ့ရမည်။ 

 
 

ယြေို တွဲ့ရ သာ expression သည် ပထမ field တွင်ရှ  သာ label နှငေ့် ေိုတ ယ field တွင်ရှ  သာ label 

သည်တဆက်တည််းခဖစ် နလ မေ့်မည်။ ထ ိုစာသာ်းနှစ်ြေိုကကာ်း space ခြော်းရန်လ ိုအပ်ပါက Field ကကာ်းတွင် space က ို 

က ိုယ်စာ်းခပြု သာ “ ‘  ’ ” က ို ြေံပပ ်း ထ ို်း ပ်းန ိုင်ပါသည်။ ပပ ်းလ င် OK က ို နှ ပ်လ ိုက်ပါ။ ဤ Label Expression ထဲတွင် Double quote 

ခဖစ် သာ “ ” သည် field တန်ဖ ို်းက ို ထညေ့်ဖ ိုို့ရန် အတွက်သိုံ်းပပ ်း single quote ‘ ’ သည် Text စာသာ်း ထညေ့်ဖ ိုို့ရန် အတွက် သိုံ်းပါသည်။ 

expression က ို အာက်ပါအတ ိုင််းခပင် ပ်းရန်လ ိုပါသည်။ 

 
 

Label က ို နှစ် ကကာင််း ခဖစ် အာင် ထ ို်းြေျင်ပါက စာ ကကာင််း တစ် ကကာင််းနှင်ေ့ တစ် ကကာင််း အကကာ်းတင်ွ new line ၏ 

သ ကေတ ခဖစ် သာ  “ ‘\n’  ” ခဖင်ေ့ ြေံပပ ်း ထ ို်း ပ်းန ိုင်ပါသည်။ 
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ပပ ်းလ င် apply, OK လိုပ်လ ိုက်ပါ။ text property တွင် စာသာ်းပိုံစံ မျာ်းမ မ နှစ်သက်သလ ိုခပငန် ိုင်ပါတယ်။ 

2.8 QGIS-3.0 နှင်အထက် တငွ် GIS dataset က ိုခမန်မာစာစနစခ်ဖင်ေ့ အသိုံ်းခပြုခြေင််း 

GIS database တွင် Unicode စနစ ် အသိုံ်းခပြုန ိုင်ဖ ိုို့သည် အခြော်း သာ Tabular စာရင််းဇယာ်းသတင််း 

အြေျက်အလက်မျာ်းမျာ်းနှင်ေ့ ြေျ  တ်ဆက်အသိုံ်းခပြုရန်အတွက် အ ရ်းကက ်းပါသည်။ 

QGIS version 3.10 မှစတင်ပပ ်း Unicode အသိုံ်းခပြုထာ်းသည်ေ့ ခမန်မာစာအာ်း စတင်အသိုံ်းခပြုန ိုင်ပါသည်။ Unicode 

စနစ်သိုံ်းခမန်မာစာအာ်း ဖတ်ရှုန ိုင် စရန် မ မ  Computer ထဲတွင် မှန်ကန်စွာ ဖေါ်ခပန ိုင်ရန် Unicode fonts မျာ်းက ို အရင်ဆိုံ်း 

ထည်ေ့သွင််းထာ်းဖ ိုို့လ ိုအပ်ပါသည်။ အသိုံ်းခပြုန ိုင် သာ Unicode Fonts မျာ်းမှာ Myanmar3, Pyidaungsu, Myanmar_Census, 

Microsoft Myanmar Text မျာ်းစသည်ေ့ 

Unicode စနစ်သိုံ်း ခမန်မာစာအာ်း ခပြုခပင်ခြေင််း ခဖည်ေ့စွက်ခြေင််းမျာ်းခပြုလိုပ်န ိုင်ရန် Computer ထဲတွင် Unicode Keyboard 

ရှ ရန်လ ိုအပ်ပါသည်။ Unicode Keyboard မရှ ပါက Font Convertor က ိုအသိုံ်းခပြုန ိုင်ပါသည်။ 

http://burglish.my-mm.org/latest/trunk/web/fontconv.htm  

 

 

GIS dataset ထဲတွင် Unicode အသိုံ်းခပ န ိုင်ရန် နည််းလမ််းနှစ်ြေိုရှ ပါသည်။ 

GIS dataset ထဲတွင် Unicode font ခဖင်ေ့အသိုံ်းခပထာ်း သာ ခမန်မာစာက ို တစြ်ေါတည််းထည်ေ့သွင််းထာ်းခြေင််း။ 

 နာက်တစန်ည််းမှာ GIS datasets မဟိုတ် သာ သ ်းခြော်း Data base မျာ်းတွင် သ မ််းထာ်း သာ Excel, CSV, စသည်ေ့ 

မျာ်းခဖင်ေ့လည််း ြေျ  တ်ဆက်အသိုံ်းခပြုန ိုင်ပါသည်။ 

လက် တွဲ့ လေ့လာန ိုင်ရန်အတွက်  ပ်းထာ်း သာ GIS file ထဲမှ mmr_polbnda_adm1_250k_mimu.shp က ို ဖွင်ေ့လ ိုက်ပါ။ ထ ို 

Layer ၏property က ိုဖွင်ေ့ကကည်ေ့ပါ။ File information တွင် Encoding သည် UTF-8 ခဖစ် နပါသည်။ 

 

http://burglish.my-mm.org/latest/trunk/web/fontconv.htm
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အကယ်၍ Encoding သည် UTF-8 ခဖစ်မ နပါက UTF-8 က ို ခပာင််း ပ်းရန်လ ိုအပ်ပါသည်။ UTF-8 သ ိုို့ ခပာင််းရန် layer 

properties မ ှSource tab က ို  ရွ်းပါ။ Data source encoding တွင် UTF-8 သ ိုို့ ခပာင််းပါ။ ပပ ်းလ င် OK လိုပ်ပါ။ 

 
mmr_polbnda_adm1_250k_mimu.shp file ၏ AttributeTable က ို ဖွင်ေ့ကကည်ေ့ပါ။ Unicode font အာ်း 

 အာက်ပါအတ ိုင််း  ကာင််းစွာဖတ်ရှုန ိုင်သည်။ 
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Note: QGIs 2.xxx version မျာ်းတွင် ခမန်မာစာစနစ် ကာင််းစွာမ ပေါ် ပ။ 

ထ ိုကဲေ့သ ိုို့ ခမန်မာစာ စာလိုံ်းမျာ်း ကာင််းစွာ ပေါ် စရန်အတွက် Attribute Table ထဲတွင် Unicode Font ခဖင်ေ့ 

ရ ိုက်ထည်ေ့ထာ်းခြေင််းခဖစ်သည်။ 

Attribute Table က ို Edit ခပြုလိုပ်ပပ ်း Field အသစ်ဖန်တ ်းကာ Unicode စနစ်ခဖင်ေ့ ရ ိုက်ထည်ေ့ပပ ်း save လိုပ်ကကည်ေ့ပါ။ 

 နာက်ထပ် mmr_polbnda_adm2_250k_mimu.shp နှင်ေ့ mmr_polbnda_adm3_250k_mimu.shp file မျာ်းက ို 

ဆက်လက် လေ့လာကကည်ေ့ပါ။ 

 

2.9 Layer မျာ်းက ို Show/Hide ခပြုလိုပ်နည််း 

Layer မျာ်းအာ်းလိုံ်းက ို အလိုပ်လိုပ် န သာ QGIS project ထဲမှာ အကိုန်လိုံ်း တစ်ပပ ြုင်နက်တည််း Show/Hide 

ခပြုလိုပ်ြေျင်ပါက Menu bar > Layer > Show All Layers သ ိုို့မဟိုတ် Menu bar > Layer > Hide All Layers ခဖင်ေ့ ခပြုလိုပ်န ိုင်ပါသည်။ 

 

2.10 Layer မျာ်းက ို QGIS project ထဲမှ ဖယ်ရှာ်းနည််း 

Layer တစ်ြေိုက ို အလိုပ်လိုပ် န သာ QGIS project ထဲမှ ဖယ်ထိုတ်ြေျင်ပါက layer ဖ ိုင်နာမည် ပေါ် Right-click > Remove 

ခဖင်ေ့ ဖယ်ရှာ်း န ိုင်ပါသည်။ 

  

2.11 QGIS Project တစ်ြေိုက ို ဖွင်ေ့၊ ပ တ်၊ သ မ််းခြေင််း 

Menu bar > Project > Save က ို နှ ပ်လ ိုက်ပါ။ D:\MIMU_GISS_Training > Exercise>ထဲတွင် Exe-01 ဟို အမည် ပ်းပပ ်း 

map project က ို Save လိုပ်လ ိုက်ပါ။ 

Menu bar > Project > Close GIS က ို နှ ပ်လ ိုက်ပါ။ 
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ပထမ Session ေ မှာတင်ပဲ ပပ ်းဆို်ံးပါပပ ။ က ဲ အသင် QGIS က ို ဖွင်ေ့ပ တ ် တတ်ပပ ။ GIS ဖ ိုင် တွက ို QGIS ထဲမှာ 

ဖွင်ေ့ကကည်ေ့တတ်သွာ်းပပ ။ layer  တကွ ို overlay လိုပ်တတ်သွာ်းပပ ။ Label စာတမ််းထ ို်းတတ်သွာ်းပပ ။ feature  တွက ို 

စူ်းစမ််းတတ်သွာ်းပပ ။ Layer  တွရဲဲ့ Attribute က ို ဖွင်ေ့ကကည်ေ့တတ်သွာ်းပပ ။ Project တစ်ြေိုက ို သ မ််းထာ်းတတ်ပပ ။ 

 နာက်အြေန််းမှာ  ခမပိုံ တွက ို ကကည်ေ့ ကာင််းသွာ်း အာင် ခပင်ဆင်တင်ဆက်တဲေ့နည််းက ို ဆက် လေ့လာ ကကရ အာင်။ 

 

2.12  လေ့ကျငေ့်ရန ်

QGIS project တွင် layer မျာ်းက ို ထညေ့်ခြေင််း၊ ထိုတ်ခြေင််း၊ Attributr tools bar က ို အသိုံ်းခပြုခြေင််း၊ Label Tool 

မျာ်းက ိုအသိုံ်းခပြုကကညေ့်ခြေင််း၊ Layer မျာ်းက ို Show/Hide ခပြုလိုပ်ခြေင််း။ 
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3. QGIS တွင် Layer မျာ်း ခဖင်ေ့ အ ရာင်နှငေ့်စတ ိုင် အမျ  ြု်းမျ  ြု်း ခပြုလိုပ် ကကည်ေ့ခြေင််း 

ေ အြေန််း တွမှာ မ မ တ ိုို့  ဖေါ်ခပလ ို သာ  ခမပိုံ အြေျက်အလက်မျာ်းက ို အ ရာင်အ သွ်း အရွယ်အစာ်း အမျ  ြု်းအစာ်း 

စသည်တ ိုို့ခဖင်ေ့ လ ိုရာ ရာက် အာင် ခပင်ဆင်  ခပြုလိုပ်ခြေင််းတ ိုို့က ို  လေ့လာသွာ်းပါမည်။ Map preparation ၊ Data presentation ၊ 

Graphical representation ၊ Information visualization ၊ Information visualization in the form of map စသည်ခဖင်ေ့ အမျ  ြု်းမျ  ြု်း 

 ခပာဆ ို သိုံ်းနှုန််းလ ိုို့ရမယ်။ အ ရ်းကက ်းတာက  ခမပိုံ ပေါ်မှာ ခပြေျင်တဲေ့ အ ကကာင််းအရာက ို  ခမပိုံဖတ်သူမျာ်း နာ်းလည် သ ဘာ ပါက် 

လွယက် ူအာင် ထ ထ မ မ  ရှင််းရှင််းလင််းလင််းနဲဲ့ ခပတတ်ဖ ိုို့ ခဖစ်ပါတယ။် 

 

3.1 Style Manager က ိုအသိုံ်းခပြုခြေင််း 

 Style manager က တာေ့  ယဘူယျအာ်းခဖငေ့် 

Style  တွက ို သင်က ိုယ်တ ိုင် ခပြုခပင်ဖန်တ ်းန ိုင် သာ 

 နရာပါ။ Symbol, Color ramp, text formats or 

label setting မျာ်းက ို မ မ လ ိုသလ ို ပိုံစံအမျ  ြု်းမျ  ြု်း 

 ခပာင််းလဲအသိုံ်းခပြု န ိုင်ပါတယ်။  

 

 

 

 

 

အသငေ့်ရှ  သာ Symbol and color sets မျာ်း 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ပထမဆိုံ်း အဝါ ရာင်စက်ဝ ိုင််းအတွင််း အန  ရာင်ကကယ်ပါ သာ symbol တစြ်ေိုဖန်တ ်းကကညေ့်ကကစ ိုို့။ 
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Marker symbol တစြ်ေို လာက်ဖန်တ ်းရန် style manager မ ှMarker tab က ို click လိုပ်ပါ။ ပပ ်းလ င် အာက်တွင်ရှ  သာ add item 

(Plug Sign) က ို click လိုပ်လ ိုက်လ င် symbol selector 

 ပေါ်လာပါမည်။ 

 

Symbol selector သည် symbol အသစ်တစြ်ေိုဖန်တ ်းရန် အဓ က 

ခဖစ်ပါသည်။ Marker symbol, Line symbol သ ိုို့မဟိုတ ်Fill symbol 

မျာ်းက ို ခပြုခပင်ဖန်တ ်းန ိုင်သည်။  

မ မ ခပြုလိုပ်လ ို သာ symbol style ရလ င် OK က ို click လိုပ်ပါ။ Save 

New Symbol window အသစ် ပေါ်လာမည်။ ထ ို window တွင် 

Name  နရာတွင် Capital City ဟို ရ်းထညေ့်ပါ။ မ မ ထညေ့်လ ို သာ 

အမည်က ို  ရ်းထညေ့်န ိုင်သည်။ 

 

Tag(s)  နရာတွင် Colorful က ို ရွ်းပါ။ Add 

to favorites က ို check လိုပ်ပါ။ ပပ ်းလ င် 

Save လိုပ်ပါ။ သင်၏ marker symbol list 

ထဲတွင် marker အသစ်တစ်ြေို တ ို်းလာ 

သည်က ို  တွဲ့ရမည်။ 

 

 
ထ ိုို့အတူ line symbol, Fill symbol, color ramp စသညေ့် မျာ်းက ိုလည််း ခပြုခပင်ဖန်တ ်းန ိုင်ပါသည်။ က ိုယ်တ ိုင်  လေ့လာကကညေ့်ပါ။ 

 

3.2 Layer မျာ်းက ို Symbology အမျ  ြု်းမျ  ြု်း  ခပာင််းကကည်ေ့ခြေင််း 

Vector Symbology က    လော့လ ကကည်ော့ပခင်ျား 

Symbology က ို အမျ  ြု်းမျ  ြု်း  ခပာင််းကကည်ေ့န ိုင်ဖ ိုို့ အတွက် Vector ဖ ိုင် အမျ  ြု်းအစာ်းက ို သိုံ်းပပ ်း နမူနာ ခပထာ်းတယ်။ 

 ခမပိုံ ပေါ်မှာ က ိုယ်ခပ စြေျင်တာက ို ပိုံအမျ  ြု်းမျ  ြု်းနဲဲ့ ၊ ပိုံစံအမျ  ြု်းမျ  ြု်းနဲဲ့  ဖေါ်ခပဖ ိုို့ အတွက် သိုံ်းတယ်။ Symbology ဟာ  ခမပိုံတစ်ြေိုရဲဲ့ 
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ေ ဇ ိုင််းက ိုမျာ်းစွာ အကျ  ြု်းသက် ရာက်ပါတယ။် က ိုယ် ဖေါ်ခပြေျင်တဲေ့ information က ို ပေါ်လွင် ထင်ရှာ်း န အာင် ခပတတ်ဖ ိုို့ 

အ ရ်းကက ်းတယ်။  ဖာ်ခပမည်ေ့ပိုံစံ၊ အ ရာင်အဆင််း၊ အရွယ်အစာ်း စသည်တ ိုို့ခဖင်ေ့ လ ိုက်ဖက် အာင် နှင်ေ့ ခပသလ ို သာ ရည်ရွယ်ြေျက်က ို 

ထ  ရာက် အာင်  ရွ်းြေျယ်တတ်ဖ ိုို့ လ ိုမယ်။ အြေျ  ြုဲ့ သာ  ခမပိုံမျာ်းမှာ သတ်မှတ်ထာ်း သာ  ခမပို ံ သ ကေတမျာ်းက ိုသာ 

အသိုံ်းခပြုကကပါသည်။ ခဖစ်န ိုင်သမ  သတ်မှတ်ထာ်း သာ သ ကေတ မျာ်းက ို အသိုံ်းခပြုလ င် ကကည်ေ့ရှုသူ အတွက် ရာ  ခမပိုံခပင်ဆင်သူပါ 

ပ ိုမ ို၍ အဆင် ခပ လွယ်ကူပါမည်။  

GIS Layer တစ်ြေိုအတွက် ၎င််း ခမပိုံရဲဲ့ Theme ဟာ အပမဲတမ််း ပိုံ သ တစ်ြေိုတည််း ရှ  နတာ မဟိုတ်ပါဘူ်း။ အဲေ  layer ရဲဲ့ 

Attribute ထဲမှာပါတဲေ့ data အမျ  ြု်းအစာ်းမျာ်း  ပေါ်မူတည်ပပ ်းပိုံက ို အမျ  ြု်းမျ  ြု်း  ခပာင််းလ ိုို့ ရန ိုင်ပါတယ်။ အဲေ  တာေ့ အရင်ဆိုံ်း က ိုယ်ေ့ရဲဲ့ 

GIS data ထဲမှာ ဘာ data  တွ ပါရှ သလဲ ဆ ိုတာ သ ရှ ထာ်းဖ ိုို့ လ ိုအပ်ပါတယ။် Layer တစ်ြေိုရဲဲ့ Attribute table က ို ကကည်ေ့ဖ ိုို့ရန် 

အတွက် Layer နာမည် ပေါ်တင်ပပ ်း Right-click > Open Attribute Table ခဖင်ေ့ ကကည်ေ့န ိုင်ပါတယ။် 

Layer  တွက ို ပိုံအမျ  ြု်းမျ  ြု်း  ခပာင််းဖ ိုို့ရန် အတွက် ၎င််း layer တစ်ြေိုြေျင််းစ ၏ Properties ထ ဲStyle  အာက်ထဲမှာ Single 

symbol, Categorized, Graduated, Rule base and point displacement စသည်တ ိုို့အထဲမှ တစ်ြေိုြေိုက ို  ရွ်းြေျယ်ပပ ်း 

 ခပာင််းလဲ ပ်း န ိုင်ပါသည်။ ရှ ပါတယ။် QGIS version 2.4 မှာ Inverted polygons ဆ ိုပပ ်း တာ အသစ်တစ်ြေို ထပ်ပါလာပါတယ်။ 

 အာက်တွင် ခပြုလိုပ်ပိုံ အဆင်ေ့ဆင်ေ့က ို  ဖေါ်ခပသွာ်းပါမည်။ 

3.3 Single Symbol 

Default အာ်းခဖင်ေ့ point, line, polygon မျာ်းက ို Simple marker ခဖင်ေ့  ခမပိုံတွင်  ပေါ် နလ မ်ေ့မည်။  

အခြော်း သာ ပ ိုသင်ေ့ လျာ်မည်ေ့ သ ကေတ တစ်ြေိုက ို စမ််းပပ ်း  ခပာင််းကကည်ေ့ရ အာင်။  ပ်းထာ်း သာ GIS data မျာ်းထဲမှ 

ne_10m_airports.shp သည်  လဆ ပ်၏ တည် နရာက ိုခပ သာ GIS ဖ ိုင်ခဖစ်သည်။ ၎င််းက ို Single Symbol ခဖင်ေ့ airport သ ကေတ 

က ို ရွ်းပပ ်း ခပကကည်ေ့လ ိုက်ပါ။ ခပြုလိုပ်နည််း အဆင်ေ့ဆင်ေ့မှာ 

Layers pane ထဲက ဖ ိုင်နာမည် (ne_10m_airports)  ပေါ်မှာ Right-click > Properties က ို နှ ပ်လ ိုက်ပါ။ Layer Properties 

window တစ်ြေို  ပေါ်လာမည်။  

Properties window ထဲက Symbology tab က ို သွာ်းပါ။ Single Symbol က ို  ရွ်းပါ။  

Symbol layers  အာက်က အတွင််းဖက် simple marker က ို  ရွ်းလ ိုက်ပါ။ Symbol 

layer type  ပေါ်လာမည်။  

 ပေါ်လာ သာ အထဲမှ SVG marker က ို  ရွ်း ပ်းလ ိုက်ပါ။ Scrollbar က ို  အာက်သ ိုို့ 

ဆွဲြေျပပ ်း SVG Image ထဲမှ မ မ နှစ်သက် သာ  လယာဉ်ပျပံိုံက ို  ရွ်းပါ။ ပပ ်းလ င် 

သငေ့် တာ် သာ size က ိုခပင်ပါ။ fill color, stoke color က ို သငေ့် တာ် သာ 

အ ရာင်က ို ရွ်းပါ။ 



MIMU Capacity Building Training 

 

 Copyright © MIMU 2020 34 

OK button က ို နှ ပ် ပ်းလ ိုက်ပါ။  ခပာင််းပပ ်း သာ ပိုံမှာ  အာက်ပါအတ ိုင််း ခဖစ် န လ မ်ေ့မည်။ 

ပပ ်းလ င် OK နှ ပ်ပါ။ ပိုံပါအတ ိုင််း တွဲ့န ိုင်သည်။ 

 လေ့ကျငေ့်ြေန််း အခဖစ် World Cities, Town or village point, road, railway စသညေ့် layer မျာ်းက ို 

၎င််းတ ိုို့နှငေ့် သငေ့် လျာ်ရာ symbol မျာ်းသ ိုို့  ခပာင််းကကညေ့်ပါ။  

3.4 Categorized Symbol 

Layer တစ်ြေိုရဲဲ့ Attribute column တစ်ြေိုထဲမှာ ပါရှ  နတဲေ့ Information  တွက ို အတန််းအစာ်း အလ ိုက် ြေွဲခြော်းပပ ်း ခပြေျင်ရင် 

သိုံ်းပါတယ်။ အမျ  ြု်းအစာ်း အလ ိုက် မတူည ဘ ဲကွဲခပာ်း နတာက ို  ဖေါ်ခပြေျင်ပါက သိုံ်းတယ။် 

ေ နည််းနဲဲ့ ခပြေျင်ရင် Layer pane ထဲက ဖ ိုင်နာမည် ပေါ်မှာ Double-click လိုပ်ပါ။  ပေါ်လာတဲေ့ Properties window ထဲက Style tab 

က ိုသွာ်းပါ။ Symbol အတွက် ေ တစ်ြေါ Categorized က ို  ရွ်း ပ်းပါ။  

ခပြေျင် သာ Column က ို ဆက် ရွ်း ပ်းပါ။ နမူနာတွင် continent က ို ရွ်းထာ်းပါသည်။ 

ခပြေျင် သာ သ ကေတ အတွက် Symbol  ဘ်းတွင်ရှ  သာ change  အာက်မှ အမျ  ြု်းအစာ်းက ို ဆက် ရွ်း ပ်းပါ။ 

ခပြေျင် သာ အ ရာင် အတွက် Color ramp (သ ိုို့မဟိုတ)် random colors က ို  ရွ်း ပ်းပါ။ နမူနာတွင် random colors က ို 

 ရွ်းထာ်းပါသည်။ 

Classify button က ို နှ ပ်ပပ ်း Apply က ို ဆက်နှ ပ်လ ိုက်ပါ။ 

 
 ဖေါ်ခပပါပိုံအတ ိုင််း တွဲ့ရပါမည်။ 
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ထ ိုနည််း အတူ Attribute ထဲမှာပါတဲေ့ Field/Column တ ိုင််းက ို Categorized နည််းနဲဲ့ လ ိုက်ပပ ်း ြေွဲခြော်းခပကကည်ေ့လ ိုို့ 

ရန ိုင်ပါတယ်။ ေ တစ်ြေါ type ဟူ သာ column က ို  ခပာင််း ရွ်းကကည်ေ့ပါ။ 

 

 

 

World countries မျာ်းက ို type ဟူ သာ field က ိုအသိုံ်းခပြု၍ခပထာ်း သာပိုံ 
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World countries မျာ်းက ို income အနည််းအမျာ်း အလ ိုက်ခပထာ်း သာပိုံ 

Exercises 

mmr_ppp1_adm3.shp ဖ ိုင်တွင် Town levelColumn က ို Symbology က ိုယ်တ ိုင် စမ််း ခပာင််းကကည်ေ့လ ိုက်ပါ။ 

ခမန်မာန ိုင်ငံ၏ ပမ ြုဲ့ တာ်မျာ်းခပ သာ Layer က ို State/Region column က ို သိုံ်းပပ ်း Categorized နည််းခဖင်ေ့ ခပ ပ်းပါ။ 

3.5 Graduated Symbol 

အဆင်ေ့အတန််းအလ ိုက်၊ တန်ဖ ို်းကက ်းသွာ်းခြေင််း၊ နည််းသွာ်းခြေင််း စသည်တ ိုို့က ို နှိုင််းယှဉ်  ဖေါ်ခပြေျင် သာ အြေါမှာ သိုံ်းတယ်။ 

ဥပမာ အပူြေျ  န် နည််းရာက နမျာ်းရာသ ိုို့ တခဖည််းခဖည််းခြေင််း  ခပာင််းသွာ်း သာ  နရာမျာ်းက ို နှိုင််းယှဉ် ခပတာမျ  ြု်း၊ လူဦ်း ရ 

သ ပ်သည််းဆက ို နှိုင််းယှဉ်ခပတာမျ  ြု်း စသည်ခဖင်ေ့ အသိုံ်းခပြုတယ်။ 

ေ နည််းနဲဲ့ ခပြေျင်ရင် Layer pane ထဲက ဖ ိုင်နာမည်  ပေါ်မှာ Double-click လိုပ်ပါ။  ပေါ်လာတဲေ့ Properties window ထဲက 

Style tab က ိုသွာ်းပါ။ Symbol အတွက် ေ တစ်ြေါ Graduated က ို  ရွ်း ပ်းပါ။  

ခပြေျင် သာ Column pop_est က ို ဆက် ရွ်း ပ်းပါ။ 

အတန််းစာ်း မည်မ ခပြေျင်သလဲ Number of Classes က ို ဆက် ရွ်း ပ်းပါ။ 

ခပသြေျင် သာ သ ကေတ အတွက် Symbol အမျ  ြု်းအစာ်းက ို ဆက် ရွ်း ပ်းပါ။ 

ခပြေျင် သာ အ ရာင် အတွက် Color ramp (သ ိုို့မဟိုတ်) random colors က ို  ရွ်း ပ်းပါ။  

ေ မှာ break point အတွက် Mode မှာ ကက ြုက်တဲေ့နည််းက ို  ရွ်းပါ။ 
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Classify button က ို ဆက်နှ ပ်လ ိုက်ပါ။  

Add class က ိုနှ ပ်ပပ ်း class ထပ်ထည်ေ့လ ိုို့လည််း ရန ိုင်တယ်။ 

Class တစ်ြေိုက ို select လိုပ်ထာ်းပပ ်း Delete က ိုနှ ပ်ကာ class က ို  လ ာေ့လ ိုို့လည််း ရန ိုင်တယ။် 

Value ဆ ိုတဲေ့ Header  ပေါ်မှာ Click တစ်ြေျက်နှ ပ်ပပ ်း Legend က ို အထက်၊ အ အာက် Order  ခပာင််းစ လ ိုို့ ရတယ။် 

 
World countries မျာ်းက ို population အနည််းအမျာ်း အလ ိုက်ခပထာ်း သာပိုံ 

Raster မ  ျားအ ွက် Classified Symbol 

 နာက်မှ ထပ် ခပာမယ် Continuous field တန်ဖ ို်း တွရှ တဲေ့ Raster ဖ ိုင်အမျ  ြု်းအစာ်းမှာ သိုံ်းန ိုင်မယ်။ ဥပမာ DEM, 

temperature, NDVI စသည်ေ့  ေတာမျ  ြု်းမှာ သိုံ်းန ိုင်တယ်။ 

E.g. Township Population Density or World GDP map 

3.6 Layer Transparency က ို ခပာင််းကကည်ေ့ခြေင််း 

Layer name > Properties > Style tab မှာ ရှ တဲေ့ Layer rendering  အာက်က Layer transparency ဆ ိုတဲေ့ slider bar 

က ို  ရ ဲ့ကကည်ေ့လ ိုက်ပါ။ Percentage အလ ိုက်  ဖာက်ခမင် နပါမည်။ Layer မျာ်း၏ အ ရာင်မျာ်းက ို  ပါင််းစပ်ြေျင် သာအြေါ 

အ ပေါ်လွှာက အ ရာင်က ို ပါ်းပါ်း လ်းသာ ခပြေျင် သာ အြေါမှာ သိုံ်းတယ။် 

QGIS map project က ို Save လိုပ်ပပ ်း သ မ််းထာ်းလ ိုက်ပါ။ 

3.7 Assignment 

Compose a map by Myanmar State/Region, Township, Town, Road datasets. 

Point, Different Point Symbolizer, Different Point Size 

Area map, Density map, Area by Graduate Color, Area by Classified Color with Township example by Population 

Density, Assignment by 3W datasets. 

Line by Class, e.g. Road type 
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4. Map Projection 

ကမဘာကက ်းက စက်ဝ ိုင််း တစ်လိုံ်းလ ို အထက် အာက်  ရှဲ့ နာက် ည မ ပပ ်း တာေ့ လိုံ်းဝ ိုင််း  နတယ်လ ိုို့ ထင်ရတယ်။ 

တစ်ကယ်တမ််း တာေ့ ဝ ိုင််းစက် နတာ မဟိုတ်ပါဘူ်း။ နည််းနည််း လ်း တာေ့ ပိုတ ိုတ ို လ ိုမျ  ြု်း လ်း ခဖစ် နပါ သ်းတယ်။ ကမဘာကက ်းရဲဲ့ 

အတ ိုင််းအတာ နဲဲ့ ပိုံသဏဌာန်က ို နည််းမျ  ြု်းစိုံနဲဲ့ ပညာရှင် တွက အမှန် ရရှ  အာင် တွက်ြေျက်ပပ ်း တ ိုင််းထွာြေဲေ့ကကတယ်။ 

မှန််းဆကကည်ေ့ကကတယ်။ အဲေ ပညာရပ်က ို Geodesy လ ိုို့လည််း ြေေါ်တယ။် 

 

4.1 Geoid 

ကမဘာ၏ Geoid မျက်နှာခပင် ဆ ိုတာက ကမဘာေ့ဆွဲငင်အာ်း ည မ  န သာ မျက်နှာခပင် တစ် လ ာက်က ို ဆ ိုလ ိုပါသည်။  အာက်ပါပိုံကဲေ့သ ိုို့ 

ကမဘာေ့ ဆွဲငင်အာ်းသည် စက်ဝန််း မျက်နှာခပငက်ဲေ့သ ိုို့ မျက်နှာခပင် ည ညာစွာ ရှ  နခြေင််း မဟိုတ်ပါ။  နရာ ေသ အလ ိုက်  ခပာင််းလဲ 

တည်ရှ  နပါသည်။ ပင်လယ် ရ မျက်နှာခပင်သည် ဤ ခမမျက်နှာခပင် ဆွဲအာ်းနှင်ေ့ ဆက်စပ်မှုရှ ပပ ်း ဤမျဉ််းနှင်ေ့ ပပ ြုင် နပါသည်။ 

ည မ ပါသည်။ ထ ိုို့ ကကာင်ေ့ အခမင်ေ့ ပက ို တ ိုင််းထွာ သာအြေါ ပျမ််းမ  ပငလ်ယ် ရ မျက်နှာခပင် အထက်  ပ ဘယ် လာက်ရှ သည်ဟို 

 ခပာဆ ိုကကခြေင််း ခဖစ်ပါသည်။  လလည််း  ပ်းမတ ိုက်နဲဲ့၊ လှိုင််းလဲ ပ်းမပိုတန်ဲဲ့၊  ရလည််း ပ်းမစ ်းနဲဲ့၊ အာ်းလို်ံး ပင မ်ပင မ် လ်း 

ပင မ်သက် နတဲေ့အြေါ ရရှ လာမည်ေ့  ရမျက်နှာခပင် အ နအထာ်းပိုံက ို ဆ ိုလ ိုခြေင််း ခဖစ်ပါတယ။် 

နှစ်ရာနဲဲ့ြေျ  ပပ ်း မှန််းဆြေဲေ့ကကတယ်။ အြေို ဆယ်စိုနှစ် လာက်ကမှ Gravity Field က ိုတ ိုင််းတဲေ့ နည််းပညာနဲဲ့မှ အန ်းစပ်ဆိုံ်း 

မှန််းဆန ိုင်ကကတယ်။ အ သ်းစ တ်က ို သ ြေျင်ရင် International Gravimetric Bureau ရဲဲ့ တရာ်းဝင် website http://bgi.obs-mip.fr/ 

မှာ ဆက်လက် ဖတ်ရှုကကည်ေ့လ ိုက်ပါ။ 

    
 ခမမျက်နှာခပင်ရှ  ကမဘာေ့ဆွဲအာ်းပိုံ 

 

အမှန်တကယ် ရှ  န သာ ကမဘာ၏ Geoid မျက်နှာခပငက် ို Anomali ခဖင်ေ့ခပထာ်းပိုံ (ကမဘာအ ရှဲ့ခြေမ််း) 

(Source : http://bgi.obs-mip.fr/) 

WGS 1984 နည််း အဆ ိုအရ၊ ကမဘာကက ်း၏ အြေျင််းဝက်  တွက ို တ ိုင််းတာ ကကည်ေ့တဲေ့ အြေါမှာ Equator မျဉ််း အတ ိုင််း၊ တ ိုင််းကကည်ေ့ရတဲေ့  

Semi-major axis သည် a = 6,378,137 (meter) ရှ ပပ ်း၊ 

 တာင်ဝငရ် ို်းစွန််း နှင်ေ့  ခမာက်ဝင်ရ ို်းစွန််း တ ိုို့နှစ်ဖက်က ို တ ိုင််းတာရသည်ေ့  

Semi-minor axis သည် b = 6,356,752.3 (meter) အသ ်းသ ်း ရှ ကကသည်။ 

အဲေ  ရှည်တဲေ့ ဝင်ရ ို်းနဲဲ့ တ ိုတဲေ့ဝင်ရ ို်းတ ိုို့ရဲဲ့ ခြော်းနာ်းခြေင််း အြေျ  ြု်းက ို Flattening ratio(f) လ ိုို့ 

 ြေေါ်ဆ ိုပါတယ်။ GRS80 ရဲဲ့ အဆ ိုအရ a ဝင်ရ ို်းက ၂၉၈.၅၇ ဆ ရှ ြေဲေ့ရင် b ဝင်ရ ို်းက ၁ ဆ 

ပ ိုနည််းတယ်လ ိုို့ အဓ ပပါယ် ရပါတယ်။ (a-b)/a နဲဲ့ ခပန်တွက်ြေျက်လ ိုို့ ရန ိုင်ပါတယ်။ 

 

Ellipsoid Major axis, a (m) Minor axis, b (m) Flattening ratio, f 

Clarke (1866) 6,378,206 6,356,584 1/294.98 

GRS80 6,378,137 6,356,752 1/298.57 
 

ထ ိုအထဲမှ Ellipsoid အြေျ  ြုဲ့က ို C:\Program Files\QGIS 3.10\share\epsg_csv ထဲ ရှ  ellipsoid.csv ဖ ိုင် ထဲမှ နမူနာ အခဖစ် 

ကကညေ့်ရှုန ိုင်ပါတယ။် 

 
a 

b 

http://bgi.obs-mip.fr/
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အဲေ  တာေ့ ကမဘာကက ်းရဲဲ့ Equator ပတ်ပတ်လည် တစ် လ ာက်က အကျယ်အဝန််းက ို သြေေျာည မ ခြေင််းနဲဲ့ ခပန်ပပ ်း တာေ့ 

တွက်ြေျက်လ ိုို့ ရန ိုင်ပါတယ။် 

 

4.2 Datum 

Geodetic Datum ဆ ိုတာက  ခမပိုံတစ်ြေိုက ို  ရ်းဆွဲရာတွင် အသိုံ်းခပြုထာ်းသည်ေ့ ကမဘာ၏ အရွယ်အစာ်းနှင်ေ့ 

ပိုံပန််းသဏဌာန်က ို မှန််းဆတွက်ြေျက် ပ်းထာ်းသည်ေ့နည််း နှင်ေ့ ၎င််း Datum  ပေါ်မူတည်ပပ ်း  ရ်းဆွဲထာ်းသည်ေ့ Coordinate System 

တစ်ြေို၏ အတ ိုင််းအတာ အမှတ်စတင်သည်ေ့  နရာတ ိုို့က ို  ဖေါ်ခပခြေင််း ခဖစ်ပါသည်။ ယ နဲ့ အထ  Global Scale အတွက် အန ်းစပ်ဆိုံ်း 

မှန််းဆတွက်ြေျက်ထာ်း သာနည််းတစ်ြေိုမှာ WGS 1984 Datum ဟို ခပာဆ ိုကကပါသည်။ ထ ိုို့ ကကာင်ေ့ သာမန်အာ်းခဖင်ေ့ အသိုံ်းခပြုရာတွင် 

WGS 1984 Datum က ို အမျာ်းဆိုံ်း အသိုံ်းခပြုကကပါသည်။ 

ေ မှာ တစ်ြေိုမှတ်သာ်းရမှာက Global အတွက် မှန်ြေျင်မှန်မယ်။ သ ိုို့ ပမယ်ေ့ မ မ တ ိုို့ သိုံ်း န သာ Local Area အတွက် Local sea-level 

ကွာခြော်းြေျက် ကကာင်ေ့ တစ်နည််းအာ်းခဖင်ေ့ Local Geoid Surface ကွာခြော်းြေျက် ကကာင်ေ့ (မ မ  အတွက်) မှန်ြေျင်မှ မှန် ပမည်။ 

အမျာ်းအာ်းခဖင်ေ့ Elevation  ြေေါ် သာ အခမင်ေ့ ပတ ိုင််းရာတွင် လွဲမှာ်း န ပမည်။ ထ ိုို့ ကကာင်ေ့ Local Datum မျာ်းက ို ရှာ ဖွ 

တွက်ြေျက်ပပ ်း သိုံ်းစွဲ နကကခြေင််း ခဖစ်ပါသည်။ GPS က ို က ိုင်ပပ ်း WGS 1984 Datum ခဖင်ေ့ ဧရာဝတ ခမစ်ဝကျွန််း ပေါ် ေသက ို တ ိုင််းတာ 

ကကည်ေ့ပါက အခမင်ေ့ ပသည် GPS တွင် အနိုတ်ခပ နပပ ်း ပင်လယ်ခပင ် မျက်နှာခပင် အာက်  ရာက် နတတ် ကကာင််း  တွဲ့ရသည်။ 

အဲေါက Local Geoid မျကန်ှာခပင်က Global ရဲဲ့ Average ထက် န မ်ေ့ နလ ိုို့ ခဖစ်ပါတယ။် 

အဲေါ ကကာင်ေ့ က ိုယ်ေ့အရပ် ေသနဲဲ့ အန ်းစပ်ဆိုံ်း က ိုက်ည မှုရှ  သာ အတ ိုင််းအတာရ အာင် န ိုင်ငံမျာ်းစွာ၌ Local Datum 

မျာ်းက ို အသ ်းသ ်း တ ထွင် အသိုံ်းခပြုထာ်းကကပါသည်။ EPSG ၏ Code မျာ်းတွင် အသိုံ်းခပြုထာ်း သာ Datum မျာ်း၏ စာရင််း 

အခပည်ေ့အစိုံက ို QGIS software ထည်ေ့သွင််းစဉ်က ပါလာ သာ C:\Program Files\QGIS 3.10\share\epsg_csv ထဲရှ  pcs.csv 

ဖ ိုင်တွင် ကကည်ေ့ရှုန ိုင်ပါသည်။ 

 

ထ ိုအထဲမှ ခမန်မာ နှင်ေ့သက်ဆ ိုင် သာ Datum အြေျ  ြုဲ့က ို နမူနာ အခဖစ်  ကာက်နိုတ် တင်ခပထာ်းပါသည်။ 

datum_name Kalianpur 1880 

datum_type geodetic 

origin_description Fundamental point: Kalianpur. Latitude: 24Â°07'11.260"N, longitude: 

77Â°39'17.570"E (of Greenwich). 

realization_epoch 1880 

datum_scope Topographic mapping. 

remarks Includes 1916 extension into Burma (Myanmar).  Replaced by 1937 adjustment. 

information_source G. Bomford; "The Re-adjustment of the Indian Triangulation"; Survey of India 

Professional Paper 28; 1939. 

datum_name Indian 1954 

datum_type geodetic 

origin_description Extension of Kalianpur 1937 over Myanmar and Thailand. 

realization_epoch 1954 

datum_scope Topographic mapping. 

 

အဲေ မှာ မှတ်သာ်းစရာ တစ်ြေိုက အထက်ပါ သြေေျာ ဖေါ်ခမ လာက န ယူဆထာ်းတဲေ့ WGS 1984 Elipsoid နဲဲ့ Geoid ရဲဲ့ 

အမှန်တကယ ်တည်ရှ  နတဲေ့ မျက်နှာခပငတ် ိုို့ ထပ်ပပ ်းကွာခြော်းမှု ရှ  နပါ သ်းတယ်။ Earth Gravitational Model 1996 (EMG96) က 

ကမဘာေ့ရဲဲ့ အမှန်တကယ် ရှ  န သာ Geoid မျက်နှာခပငက် ို အန ်းစပ်ဆိုံ်း  ဖေါ်ခပထာ်းပါတယ။် WGS84 Elipsoid မျက်နှာခပငန်ဲဲ့ EMG96 

Geoid တ ိုို့  နရာ ေသ ပေါ် မူတည်ပပ ်း ကွာခြော်းပိုံက ို  အာက်ပိုံမှာ  လေ့လာ တွဲ့ရှ န ိုင်ပါတယ။် 

 

r2 nceCircumfere =
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အထက်ပါပိုံ အတ ိုင််းဆ ိုရင် GPS  တွနဲဲ့ အခမင်ေ့ ပ တ ိုင််းတဲေ့ အြေါမှာ အခပာ နရာမှာ  နရာအမှန် အာက် Under ခပ နမယ်။ 

အန  ရာင် Region  နရာမှာ တ ိုင််းရင်  နရာအမှန်ထက် Over ခပ နမယ်။ အခမင်ေ့ ပ အမှန်ရ အာင် တ ိုင််းြေျင်ရင် တာေ့ Local Geoid 

နဲဲ့ အ ပါင််း၊ အနိုတ်လိုပ်ကာ ခပန်ပပ ်း ညှ ယူရတယ။် 

 
 

GPS မှာ WGS84 ဆ ိုပပ ်း တာေ့ တ ိုင််းလ ိုို့ရှ ရင် Elipsoid surface က နပဲ reference ယူပပ ်း elevation က ို ခပ နပါမည်။ 

အခပာ ရာင် ဧရ ယာထ ဲကျ နတဲေ့  နရာအတွက် GPS နဲဲ့ တ ိုင််းလ ိုို့ရလာတဲေ့ height က ို Local Geoid Difference တန်ဖ ို်းနဲဲ့ ထပ် ပါင််း 

 ပ်းမှ အခမင်ေ့ ပ (Elevation) အမှန်က ို ရလာမယ်။  

အန  ရာင် ဧရ ယာထ ဲကျ နတဲေ့  နရာအတွက် GPS နဲဲ့ တ ိုင််းလ ိုို့ရလာတဲေ့ height က ို Local Geoid Difference တန်ဖ ို်းနဲဲ့ 

ခပန်နိုတ် ပ်းမှ အခမင်ေ့ ပ (Elevation) အမှန်က ို ရလာမယ်။ 

 

4.3 Map Projection 

ကျွန်ိုပ်တ ိုို့ နထ ိုင် န သာ တကယ်ေ့ ကမဘာကက ်းက3D မျက်နှာခပင် အ နအထာ်းခဖင်ေ့ လိုံ်းဝန််းပပ ်း တည်ရှ   နပါသည်။ 

Projection ဆ ိုသည်မှာ ထ ိုလိုံ်း န သာ ကမဘာကက ်း၏ မျက်နှာခပငက် ို အခပာ်းပိုံရှ  န သာ 2D မျက်နှာခပင် ပေါ်သ ိုို့  ခပာင််းလဲ 

 ရ်းဆွခဲြေင််း Process ခဖစ်ပါသည်။ နမူနာနဲဲ့  ခပာခပရလ င် လ  မ္ာ်သ ်း တစ်လိုံ်းက ို အြေွံက ို ြေွာပပ ်း စာ်းပွဲ ပေါ်တွင် ထ ိုအြေွံက ို 

ခပာ်းကပ် န အာင် ဖ ကပ်ထာ်းသကဲေ့သ ိုို့ အခဖစ်မျ  ြု်း ခဖစ်ပါမည်။ 

C:\OSGeo4W64\apps\qgis-dev\globe\world.tif 
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ထ ိုကဲေ့သ ိုို့ 2D မျက်နှာခပင် ပေါ် ခပန်ပပ ်း တာေ့  ခပာင််းလ ဲ  ရ်းဆွဲ သာ အြေါတွင် အဓ ကအာ်းခဖင်ေ့ နည််း (၃) နည််းနှင်ေ့ 

 ရ်းဆွနဲ ိုင်သည်။ ထ ိုနည််း ၃ နည််းက ို  အာက်ပါအတ ိုင််း  ဖေါ်ခပထာ်းသည်။ 

 

4.4 Projection အမျ  ြု်းအစာ်းမျာ်း 

အဓ ကအိုပ်စိုကက ်း ၃ ြေို ရှ ကကပါတယ။်  အာက်မှာ ခပထာ်းတာက Tangent နဲဲ့ Secant အမျ  ြု်းအစာ်း တွ ပါဝင်တယ်။ 

ကမဘာရဲဲ့မျက်နှာခပင် က ို အခပာ်းမျက်နှာခပငပ်ိုံရှ တဲေ့ (2 D surface) ဆလင်ေါ ၃ မျ  ြု်း ပေါ်မှာ ခပန်ပပ ်း တာေ့  ရ်းဆွဲတဲေ့နည််း ခဖစ်ပါတယ်။ 

 အာက်က ပိုံ တွမှာလ ိုမျ  ြု်း ကမဘာေ့မျက်နှာခပင်  နရာမျာ်းက ို အ နအထာ်း ပိုံစံအမျ  ြု်းမျ  ြု်းနဲဲ့ ထ ထာ်းကကတယ။် 

 

 

          Cylindrical Projection 

 

 

     Conic Projection 

 

 

Planner Projection 

 

 

Cylindrical Projection 

ဆလင်ေါပိုံ မျက်နှာခပင် ပေါ် ကဲေ့သ ိုို့  ခပာင််းခြေင််း။ 

ဆလင်ေါပိုံ အ ထာင်လ ိုက် ထာ်းပပ ်း တာေ့ သိုံ်းမယ်ဆ ိုရင် ထ တဲေ့ အမှတ်က equator ပတ်ပတ်လည် တစ ်လ ာက်လိုံ်း 

ခဖစ်မယ်။ Equator တစ ်လ ာက်လိုံ်းအတွက် မှန်မယ်။ အထက်နဲဲ့  အာက်ပ ိုင််း (North Pole, South Pole) က ိုသွာ်း လ လ 

Distortion မျာ်းလာ လ လ ခဖစ်တယ်။ 

    
 

Transverse Mercator မှာကျ တာေ့ ဆလင်ေါက ို 

အလှဲလ ိုက်ထာ်းတာ။ ေါဆ ိုရင် ထ တဲေ့ အမှတ်က Longitude 

မျဉ််းတစ်ြေိုြေိုရဲဲ့ တစ် လ ာက်လိုံ်း ခဖစ်မယ်။ ေ နည််းက 

 တာင် ခမာက်ရှည်တဲေ့ န ိုင်ငံ တွ အတွက် ပ ိုသင်ေ့ လျာ်မယ်။  

ဆလင်ေါက ို အ စာင််းလ ိုက်ထာ်းပပ ်း သိုံ်းရင် Oblique 

Mercator ခဖစ်လာမယ်။ 

 

 

Conic Projection 
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 ရစစ်ပိုံ ကဲေ့သ ိုို့ ကမဘာေ့မျက်နှာခပင် ပေါ်  ခပာင််းခြေင််း။ ထ တဲေ့အမှတ်က  ဘ်း စာင််း နရာ၊ 

ဥပမာ - Albers Equal Area, Lambert Conformal Conic.  

Good for East-West land areas 

 
 

Planner Projection 

ဇ ကာပိုံ မျက်နှာခပင် ပေါ်ကဲေ့သ ိုို့  ခပာင််းခြေင််း။ ကမဘာေ့မျက်နှာခပငန်ှင်ေ့ ထ တဲေ့အမှတ် နရာ တစမ်ှတ်တည််း ခဖစ်ပပ ်း 

ထ  သာပိုံစံက အမျ  ြု်းမျ  ြု်း ခဖစ်န ိုင်တယ။် ထ ရိုံသာထ  တယ။် 

             
အဲေ  တာေ့ Tangent ထ  နတဲေ့  နရာ လ်းက ပ ိုမှန်တယ်။ အဲေ  နရာနဲဲ့  ဝ်း လ Distortion မျာ်းလာ လ ခဖစ်ပါတယ်။ 

ဥပမာ Lambert Azimuthal Equal Area. Good for global views. 

 

Planner Project မှာမှ  နာက်တစမ်ျ  ြု်းက ကမဘာေ့မျက်နှာခပင် 

အထဲက ို ခဖတ်သွာ်းတဲေ့ Secant ပိုံမျ  ြု်းနဲဲ့လည််း  ဖေါ်ခပလ ိုို့ ရန ိုင်ပါတယ်။ 

 

 

 

 

 

 

Secant Projection နှင်ော့ Tangent Projection အမ   ျားအစ ျား 

အထက်က အဓ က Projection ၃ မျ  ြု်းက ိုပဲ ထပ်ပပ ်း 

ကွန်ဲ့လ ိုက်တာက ကမဘာက ို (Tangent) ထ ရို ံ မဟိုတ်ဘဲ 

အြေျ  ြုဲ့ နရာ တွမှာ Distortion က ို ပ ိုနည််းသွာ်း အာင် ဆ ိုပပ ်း တာေ့ 

Projection plane က ို (Secant) ကမဘာေ့အတွင််းထဲက ို နည််းနည််း ခဖတ်သွာ်း 

တယ။် ေ  တာေ့ကာ ခဖတ်သွာ်းတဲေ့ မျက်နှာခပငန်ဲဲ့ ကမဘာ မျက်နှာခပင်တ ိုို့ 

ထ  နတဲေ့ နရာ ၂ ြေိုရှ လာမယ်။ အဲေါက ို Standard parallel မျဉ််းလ ိုို့လည််း 

 ြေေါ်ပါတယ်။ 
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4.5 Standard Parallel 

Standard Parallel လ ိုင််း ဆ ိုတာ ကမဘာက ို Secant နည််းနဲဲ့ 

ခဖတ်သွာ်းတဲေ့ Projection Plane  နရာရဲဲ့ အ ပေါ်မျဉ််း နဲဲ့  အာက်မျဉ််း တ ိုို့ရဲဲ့ 

Latitude တည် နရာ တန်ဖ ို်းက ို ဆ ိုလ ိုတာပါ။ အမျာ်းအာ်းခဖင်ေ့ Secant 

အတွက် Latitude မျဉ််း ၂ ြေို ရှ ကကတည်။ Conic Projection 

အမျ  ြု်းအစာ်းမှာ သိုံ်းကကတာ မျာ်းပါတယ။် Costomized projection 

မျာ်းတွင် အမျာ်းအာ်းခဖင်ေ့ က ိုယ် ရ်းဆွမဲည်ေ့  ခမပိုံ၏ အထက်နဲဲ့  အာက် 

အနာ်းတ ိုို့က ို ခြေြုံငိုံမ  စရန် Standard Parallel မျဉ််း ကကာင််းက ို  နရာ 

 ရွဲ့ ခပာင််းကာ အသိုံ်းခပြု  လေ့ရှ ကကတယ။် 

 

4.6 Central Meridian သ ိုို့မဟိုတ ်Prime Meridian 

Projection တစ်ြေိုရဲဲ့ Prime Meridian လ ိုင််း ဆ ိုတာ ၎င််း Projection ရဲဲ့ Center အ နနဲဲ့ သိုံ်းထာ်းတဲေ့  ေါင်လ ိုက် ရှ  သာ 

Longitude မျဉ််း တည် နရာ တန်ဖ ို်းက ို  ခပာတာပါ။ ေ  Longitude မျဉ််းရဲဲ့ ဘယ်ဘက်နဲဲ့ ညာဘက်ခြေမ််းမှာ အြေျ  ြု်းည ည   ခမပိုံ တွ 

ခဖစ် နပါမယ်။ အမျာ်းအာ်းခဖင်ေ့ Central Meridian မျဉ််း ကကာင််း တစ်ြေိုပဲ ရှ ပါတယ။် 

 

4.7 Cartographic Projection Library 

QGIS တွင် projection တစ်ြေိုမှ အခြော်းတစ်ြေိုသ ိုို့  ခပာင််းန ိုင်ရန် အတွက် free and open source software တစ်ြေိုခဖစ် သာ 

PROJ.4 - Cartographic Projections Library က ို အသိုံ်းခပြု ထာ်းပါသည်။ QGIS တွင် လူအမျာ်း သ ထာ်းပပ ်း သာ projection  ပါင််း 

၂၇၀ဝ ြေန်ဲ့က ို အခပန်အလှန်  ခပာင််းလဲ ပ်းန ိုင်ပါသည်။ PROJ.4 အ ကကာင််းက ို အ သ်းစ တ် ထပ်မံ  လေ့လာြေျင်ပါက 

http://trac.osgeo.org/proj/ တွင် ဆက်လက် လေ့လာန ိုင်ပါသည်။ 

 

4.8 Coordinate System 

Geographic Coordinate 

Coordinate System ဆ ိုတာက  ခမပိုံတစ်ြေိုထဲမှာ ပါဝင် နတဲေ့ အမှတ်မျာ်း၊ အရာဝတထြုမျာ်းရဲဲ့ အလျာ်း၊ အနံ၊ အခမင်ေ့၊ X, Y, 

Z တည် နရာမျာ်းက ို တ ကျစွာ  ဖေါ်ခပဖ ိုို့ရန် အတွက် ဂဏန််း ယူနစ်တစ်ြေိုခဖင်ေ့ အသိုံ်းခပြု  ရ်းဆွဲထာ်းတဲေ့ အတ ိုင််းအတာ စနစ်က ို 

ဆ ိုလ ိုပါသည်။ ဥပမာအာ်းခဖင်ေ့ X (အလျာ်းလ ိုက်)  ရွဲ့လျာ်း သာ အတ ိုင််းအတာအတွက်  လာင်ဂျ  တွေ် (Longitude) မျဉ််းတန်ဖ ို်း နှင်ေ့ 

Y ( ေါင်လ ိုက်)  ရွဲ့လျာ်း သာ အတ ိုင််းအတွက် လတတ တွေ် (Latitude) မျဉ််းတန်ဖ ို်း တ ိုို့က ို ေ ဂရ  စနစ်မျာ်းခဖင်ေ့  ဖေါ်ခပထာ်း သာ 

Geographic Coordinate System စနစ်ကဲေ့သ ိုို့မျ  ြု်း ခဖစ်ပါသည်။ ထ ို GCS စနစ်တွင် အမှတ်တစ်ြေို၏ တည် နရာက ို  ဖေါ်ခပသည်ေ့အြေါ 

ထ ိုအမှတ် ပေါ်တွင် ကျ ရာက် န သာ Latitude နှင်ေ့ Longitude မျဉ််းတ ိုို့၏ Coordinate တန်ဖ ို်းမျာ်းခဖင်ေ့  ဖေါ်ခပကကပါသည်။ 

            
တ ိုင််းတာ သာယူနစ် နှင်ေ့ အသိုံ်းခပြုထာ်း သာ Datum  ပေါ်မူတည်ပပ ်း၊ Coordinate System အမျ  ြု်းအစာ်းက ို အဓ က အိုပ်စိုကက ်း ၂ ြေို 

ြေွဲခြော်းထာ်း ပါသည်။ ၎င််းတ ိုို့မှာ  

• Geographic Coordinate System အိုပ်စို နှင်ေ့ 

• Projected Coordinate System အိုပ်စိုတ ိုို့ ခဖစ်ကကပါသည်။ 
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4.9 Geographic Coordinate System (GCS) အိုပ်စို  

ေ  GCS Group ထဲမှာ အဓ က  ခမပိုံက ို Latitude/Longitude ခဖင်ေ့ တစ်ကမဘာလိုံ်းက ို  ဖေါ်ခပဖ ိုို့ရန် အတွက် အသိုံ်းခပြုကကသည်။ 

၎င််းတွင် Distortion မျာ်းပါရှ  သာ ကကာင်ေ့  ခမပိုံ၏ အတ ိုင််းအတာ (အလျာ်း၊ ဧရ ယာ စသည်ခဖင်ေ့) က ို တ ိုက်ရ ိုက် တွက်ြေျက်ခြေင််း 

အတွက် သိုံ်း လေ့ မရှ  ပ။ အြေျ  ြုဲ့ သာ GIS software မျာ်းတွင် 

GCS စနစ်က ို အသိုံ်းခပြုထာ်း သာ  ခမပိုံ ပေါ်တွင် ဧရ ယာက ို 

တ ိုက်ရ ိုက် တကွြ်ေျက်န ိုင်ရန် အတွက် feature မျာ်း အပ ို 

ထည်ေ့သွင််းထာ်းပါသည်။ 

Geographic Projection 

(Linear projection) တွင် 

ခမင် တွဲ့ရ သာ ကမဘာ၏  ခမပိုံ 

Geographic Coordinate System ထဲမှာရှ တဲေ့ 

Projection စာရင််းမျာ်းအခပည်ေ့အစိုံက ို QGIS software ထည်ေ့သွင််းစဉ်က ပါလာ သာ C:\Program Files\QGIS 

3.10\share\epsg_csvထဲရှ  pcs.csv ဖ ိုင်တွင်  လေ့လာ ကကည်ေ့ရှုန ိုင်ပါသည်။ 

 
 

4.10 Projected Coordinate System (PCS) အိုပ်စို 

ဤ PCS စနစ်တွင်  ခမပိုံ၏ အတ ိုင််းအတာက ို  ဖေါ်ခပဖ ိုို့ရန်နှင်ေ့ Local map က ို  ရ်းဆွဲ ဖေါ်ခပဖ ိုို့ရန် အတွက် 

အသိုံ်းခပြုကကသည်။ ၎င််းတွင် မ မ တ ိုို့ အသိုံ်းခပြုထာ်း သာ Projection  ပေါ်မူတည်ပပ ်း  ခမပိုံ၏ အတ ိုင််းအတာ ခဖစ် သာ အကွာအ ဝ်း၊ 

ဧရ ယာ စသည်တ ိုို့က ို တ ိုက်ရ ိုက် တွက်ြေျက်ခြေင််းအတွက် အသိုံ်းခပြုန ိုင်ပါသည်။ 

Projected Coordinate System အတွက် Projection စာရင််း အခပည်ေ့အစိုံက ို QGIS software ထည်ေ့သွင််းစဉ်က 

ပါလာ သာ C:\Program Files\QGIS Valmiera\share\epsg_csvထဲရှ  pcs.csv ဖ ိုင်တွင် ကကည်ေ့ရှုန ိုင်ပါသည်။ 

    
Albers Equal Area Projection   Mollweide Equal Area Projection 

 

Equator 

N 50
0

 

N. Pole 
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Sinusoidal Equal Area Projection   Lambert Azimuthal Equal Area 

 

Universal Transverse Mercator (UTM) System 

UTM မှာ Transverse Mercator စနစ်က ို သိုံ်းထာ်းခြေင််း ခဖစ်ပပ ်း ဆလင်ေါက ို အလှဲလ ိုက်ထာ်းပပ ်း project လိုပ်ထာ်းခြေင််း 

ခဖစ်ပါသည်။ UTM စနစ်တွင် ဇိုန် ပါင််း ၆၀ ြေွဲခြော်းထာ်းပပ ်း၊ ဇိုန်တစ်ြေိုလ င် ဆလင်ေါ တစ်ြေိုနှုန််းခဖင်ေ့ အသိုံ်းခပြုထာ်းခြေင််း ခဖစ်ပါတယ်။ 

UTM Zone တွင် ကမဘာ၏  ခမာက်ဘက်ခြေမ််း နှင်ေ့  တာင်ဘက်ခြေမ််းတ ိုို့က ို Equator ခဖင်ေ့ ထပ်မံြေွဲခြော်းထာ်းပါသည်။ ထ ိုို့ ကကာင်ေ့ 

ကမဘာ၏  တာင်ဘက်ခြေမ််း နှင်ေ့  ခမာက်ဘက်ခြေမ််း တွင်ရှ  သာ ဇိုန်မျာ်း အတွက် Parameter တစ်စိုံစ  သ ်းခြော်းစွာ ရှ ကကပါသည်။ 

အ ရှဲ့ နှင်ေ့ အ နာက် လာ်းရာအတွက် West Longitude 180° မှ စပပ ်း 6° စ ခြော်းပပ ်း  ေါင်လ ိုက် ရှည်လျာ်း သာ 

ဇိုန်တစ်ြေိုစ ခဖင်ေ့ အ နာက်ဖက ်ဇိုန်နံပါတ် ၁ မှာ စတင် ရတွက်ကာ အ ရှဲ့ဖက် East Longitude 180° အထ  ကမဘာတစ်ပတ် (၃၆၀°) 

က ို ဇိုန်အ ရအတွက် ပါင််း 60 ခဖင်ေ့ ြေွဲခြော်း ထာ်းပါသည်။ Norway န ိုင်ငံနာ်းရှ  ဇိုန်နံပါတ် 31 ၊ 32 နှင်ေ့  ခမာက်ဘက်ဆိုံ်း၏ ဇိုန်နံပါတ် 

31 မ ှ37 မှာ သာမန်ကဲေ့သ ိုို့ မဟိုတ်ဘ ဲထူ်းခြော်းစွာ စ တ်ပ ိုင််းထာ်း ကကာင််း မှတ်သာ်းရပါမည်။  

 တာင် နှင်ေ့  ခမာက် လာ်းရာအတွက် South Latitude 80° မှ စတင်ပပ ်း ဇိုန်တစ်ြေိုလ င် 8° ကျယ် သာ အလျာ်းလ ိုက် 

ရှည်လျာ်း သာ အကခရာဇိုန်မျာ်းခဖင်ေ့ သတ်မှတ ် ပ ိုင််းခြော်းထာ်းပပ ်း၊ ဇိုန်က ို အဂေလ ပ်အကခရာ “C” ခဖင်ေ့ စတင်  ရတွက်ကာ၊ 

 ခမာက်ဘက်အရပ်သ ိုို့ တ ို်းလာရာ North Latitude 84° အထ  အဂေလ ပ်အကခရာ “X” တွင် အဆိုံ်းသတ်ပပ ်း၊ အကခရာဇိုန် ပါင််း 20 ခဖင်ေ့ 

ထပ်မံြေွဲခြော်း ထာ်းပါသည်။ အထူ်းမှတ်သာ်းရန်မှာ  ခမာက်ဘက်ဆိုံ်းခဖစ် သာ အကခရာဇိုန် “X” သည် 12° ကျယ်ဝန််းပပ ်း၊ North 

Latitude 80° မ ှ 84° အထ ရှ ပါသည်။ ထ ိုို့ ကကာင်ေ့  ေါင်လ ိုက ် ရှည်လျာ်းသည်ေ့ အ ရှဲ့အ နာက် ဇိုန်နံပါတ်တစ်ြေိုြေျင််းစ အတွက် 

အစ တ် ပါင််း ၂၀ ခဖင်ေ့  တာင် ခမာက်အတ ိုင််း ခပန်ပ ိုင််းထာ်း သာ အကခရာဇိုန် ပါင််း ၂၀ ရှ သည်ဟို မှတ်ယူရပါမည်။ 

 

 
UTM ဇုန မ  ်ားက်ဳို ျပော ပု ံ

အဂေလ ပ်အကခရာ “I” and “O” တ ိုို့သည် digit one နှင်ေ့ zero တ ိုို့နှင်ေ့ ဆင်တူ  န သာ ကကာင်ေ့ ထည်ေ့သွင််းထာ်းခြေင််း မရှ ပါ။ 

ကမဘာ  ခမာက်ဘက်ခြေမ််းအတွက် အကခရာဇိုန်အစမှာ အဂေလ ပ်အကခရာ “N” ပင်ခဖစ်ပါသည်။ “N” မတ ိုင်မ  လာ သာ 

အကခရာတ ိုင််းသည် ကမဘာ၏  တာင်ဘက်ခြေမ််းတွင် ရှ  နပါသည်။  

UTM စနစတ်ွင် North Latitude 84° နှင်ေ့ South Latitude 80° အတွင််းတွင် တ ိုင််းထွာန ိုင်ရန် သတ်မှတ်ထာ်းသည်။ Scale 

Factor က ိုလည််း Central Meridian တစ် လ ာက်တွင် 0.9996 တွင် တစ်သမတ်တည််း ခဖစ် န အာင် ထ န််းသ မ််း ထာ်းပါသည်။ 

ထ ိုို့ ကကာင်ေ့ UTM စနစ်က ို အသိုံ်းခပြုပါက အတ ိုင််းအတာမျာ်း ပ ိုမ ိုတ ကျသည်ဟို ဆ ိုကကခြေင််း ခဖစ်ပါသည်။ 



MIMU Capacity Building Training 

 

 Copyright © MIMU 2020 46 

ဤ UTM စနစ်အရ ခမန်မာန ိုင်ငံသည် ကမဘာ၏  ခမာက်ဘက်ခြေမ််း ထဲတွင်ပါဝင်ပပ ်း အ ရှဲ့အ နာက် ဇိုန်နံပါတ် 46 နှင်ေ့ 47 

နှစ်ြေို အတွင််းတွင် ကျ ရာက် နပပ ်း  တာင် ခမာက် အကခရာဇိုံ P ၊ Q နှင်ေ့ R ထဲတွင် ကျ ရာက်  နပါသည်။  နရာ ေသ 

တစ်ြေိုအတွက် ကျ ရာက် န သာ ဇိုန်မျာ်းက ို  ြေေါ်ဆ ိုရာတွင်  ေါင်လ ိုက် ဇိုန်နံပါတ်မျာ်း နှင်ေ့ အလျာ်းလ ိုက် အကခရာဇိုန် အမည်မျာ်းက ို 

 ပါင််းပပ ်း ထည်ေ့သွင််း  ြေေါ်ဆ ို လေ့ရှ ကကပါသည်။ ဥပမာအာ်းခဖင်ေ့ ခမန်မာန ိုင်ငံ၏ တနသောရ တ ိုင််း ကျ ရာက် န သာ ဇိုန်သည် UTM 47P 

ခဖစ်ပါသည်။ 

 

 
UTM Zone မျာ်းနှင်ေ့ ခမန်မာန ိုင်ငံ ကျ ရာက် န သာ ပိုံ 

 

UTM တွင် အ ရှဲ့အ နာက် Coordinate မျာ်းက ို Easting နှင်ေ့ Northing တန်ဖ ို်းမျာ်းခဖင်ေ့  ဖေါ်ခပထာ်းပါသည်။ Easting 

ဆ ိုတာက အ ရှဲ့အ နာက် (X Coordinate) အတွက် တ ိုင််းတာ ဖေါ်ခပဖ ိုို့ ခဖစ်ပပ ်း ဇိုန်တစ်ြေိုြေျင််းစ အတွက် Easting Coordinate စမှမှာ 

၎င််းဇိုန်၏ Central Meridian မျဉ််း၏ အ နာက်ဘက် မ တာ 500,000 ကွာ ဝ်း သာ (၎င််းဇိုန်၏ အ နာက်ဘက်အရပ် အခပင်ဘက်) 

အမှတ်တစ် နရာမှ စတင်ပပ ်း အ ရှဲ့ဘက်သ ိုို့တ ို်းလာ လ ဂဏန််းတ ို်းပပ ်း ကက ်းလာ လ ခဖစ်ပါသည်။ GPS တွင် Easting တန်ဖ ို်းက ို 

အမျာ်းအာ်းခဖင်ေ့ ဂဏန််း ၆ လိုံ်းခဖင်ေ့ ခပ လေ့ရှ သည်။  

UTM တွင်  တာင် ခမာက် (Y Coordinate) မျာ်းက ို Northing တန်ဖ ို်းခဖင်ေ့  ဖေါ်ခပထာ်းပါသည်။ Northing ဆ ိုတာက 

 တာင် ခမာက် Coordinate အတွက် တ ိုင််းတာ ဖေါ်ခပဖ ိုို့ ခဖစ်ပပ ်း ကမဘာ၏  တာင်ဘက်ခြေမ််း ကျ သာ ဇိုန်မျာ်းအတွက် Equator ၏ 

 တာင်ဘက် meter ဆယ်သန််း 10,000,000  ဝ်း သာ  နရာ (80° South Latitude နာ်း) မ ှစတင်ပပ ်း၊ ကမဘာေ့ ခမာက်ဘက်ခြေမ််း 

ကျ သာ ဇိုန်မျာ်း အတွက် Equator တွင် စတင်ပပ ်း၊  ခမာက်ဘက်သ ိုို့ တ ို်းသွာ်း လ ဂဏန််းကက ်းလာ လ ခဖစ်ပါသည်။ GPS တွင် 

Northing တန်ဖ ို်းက ို အမျာ်းအာ်းခဖင်ေ့ ဂဏန််း ၇ လိုံ်းခဖင်ေ့ ခပ လေ့ရှ သည်။ 
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ဥပမာ ဇိုန် 46 အတွက် Central Meridian သည် 93° ခဖစ်ပပ ်း ဇိုန် 46 အတွက် Easting Coordinate စမှတ်သည် 93° မျဉ််း၏ 

အ နာက်ဘက် မ တာ ၅၀ဝ,ဝ၀ဝ ကွာ ဝ်း သာ  နရာတွင် စတင်ပါသည်။ ကမဘာ၏  ခမာက်ဘက်ခြေမ််းအတွက် Equator နာ်းရှ  

အမှတ်တွင် Northing တန်ဖ ို်းက ို စတင်ပါသည်။ ကမဘာ၏  တာင်ဘက်ခြေမ််း အတွက် Equator နာ်းရှ  အမှတ်တွင် Northing 

တန်ဖ ို်းက ို စတင်ပါသည်။ 

အဲေ  Easting နဲဲ့ Northing တ ိုို့ စတင်တဲေ့ အမှတ် 

က ို False Easting, False Northing ဟိုလည််း 

 ြေေါ်ဆ ိုပါ သ်းသည်။ ထ ိုကဲေ့သ ိုို့ သာ စမှတ် မျာ်းသည် 

ကမဘာ၏  ခမာက်ဘက်ခြေမ််းနှင်ေ့  တာင်ဘက်ခြေမ််း နှင်ေ့ ဇိုန် ၆၀ 

စလိုံ်းအတွက် အသ ်းသ ်းစ  ရှ ကကပါသည်။ ထ ိုို့ ကကာင်ေ့ UTM 

က ိုသိုံ်းပပ ်း Coordinate က ို  ရ်းမှတ်၊  ပ်း ဝ၊  ခပာဆ ိုရာတွင် 

မည်ေ့သည်ေ့ဇိုန် ထဲမှာ ကျ ရာက် နသလဲ ဆ ိုတာက ိုပါ 

 ရ်းသာ်း၊  ပ်း ဝ၊  ခပာဆ ို ရပါမည်။ အတ ိုင််းအတာ 

ခပြုလိုပ်ရာတွင် Error မျာ်းနည််း စရန် အတွက် 

ဇိုန်ငယ်မျာ်းအခဖစ် စ ပ်ပ ိုင််းပပ ်း တွက်ြေျက် ခပြုလိုပ်ထာ်းခြေင််း 

ခဖစ်ပါသည်။ ထ ိုို့ ကကာင်ေ့ ၎င််းတ ိုို့နှင်ေ့ သက်ဆ ိုင် သာ ဇိုန်က ို 

အသိုံ်းခပြုပပ ်း အတ ိုင််းအတာက ို တွက်ြေျက် အသိုံ်းခပြုသင်ေ့ 

ပါသည်။ ဇိုန်ငယ်တစ်ြေိုတည််းက ို သိုံ်းပပ ်း ဇိုန်ခပငပ်တွင် 

ကျ ရာင် န သာ ဧရ ယာမျာ်းက ို တွက်ြေျက်ခပြုလိုပ်ခြေင််းက ို 

ခဖစ်န ိုင်သမ   ရှာင်ရှာ်းသင်ေ့ပါ သည်။ 

UTM အ ကကာင််းက ို ထပ်မံသ ြေျင်ပါ က  အာက်ပါ 

လင်ေ့မျာ်းတွင် ဆက်လက် ဖတ်ရှုန ိုင်ပါသည်။ 

http://www.dmap.co.uk/ll2tm.htm 

http://www.dmap.co.uk/utmworld.htm 

   http://geokov.com/education/utm.aspx 

 

4.11 Trade-off between projection 

transformation 

 ကွ်း နတဲေ့ မျက်နှာခပင်က ို ခပာ်း နတဲေ့ မျက်နှာခပင် ပေါ်ခပန် ဆွဲတဲေ့အြေါမှာ ဘယ်လ ိုမှ အမှန်မရှ န ိုင်ပါဘူ်း။ အရ ဲဲ့အ စာင််း 

 တွခဖစ်ပပ ်း Distortion  တွ ဝင်လာတယ်။ အကွာအ ဝ်း၊ လာ်းရာ၊ ပိုံပန််းသဏဌာန်၊ အကျယ်အဝန််း စတဲေ့ အတ ိုင််းအတာ 

အကိုန်လိုံ်းက ို တြေါတည််း မှန် န အာင် ခပန်လ ိုြေျင်လ ိုို့ မရ တာေ့ပါဘူ်း။ က ိုယ်လ ိုြေျင်တဲေ့ အတ ိုင််း အတာမျာ်း ခဖစ်တဲေ့ distance, 

direction, shape, area ထဲက အတ ိုင််းအတာ မှန်ကန်မှု ခပန်ရ အာင်၊ တစ်ကက မ်လ င် တစ်ြေို က ိုသာ  ရွ်းြေျယ်န ိုင်မှာ ခဖစ်ပါတယ်။ 

တစ်ြေိုက ို  ရွ်းပပ ်း အမှန်ရရှ ရန် တွက်ြေျက်လ ိုက်လ င်  ကျန်တဲေ့ အတ ိုင််းအတာ တွက တာေ့ မမှန် တာေ့ဘဲ Trade-off  တွ တာေ့ 

ရှ ပါတယ။် 

Maintain Distance results in distortion of shape, area and direction 

Maintain Area results in distortion of distance, direction and shape 

Maintain Shape results in distortion of distance, direction and area 

Maintain Direction results in distortion of distance, shape and area 

 

http://www.dmap.co.uk/ll2tm.htm
http://www.dmap.co.uk/utmworld.htm
http://geokov.com/education/utm.aspx
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4.12 Map Scale 

စ က်းဆ ိုတာ က တာေ့ " ခမပိုံ ပေါ်မှာ  ရ်းဆွဲထာ်းသည်ေ့ ၁ ယူနစ် အကွာအ ဝ်း အတ ိုင််းအတာ တစ်ြေိုသည်  ခမခပင် ပေါ်တွင် 

အကွာအ ဝ်း ဘယ် လာက်က ို က ိုယ်စာ်းခပြုထာ်းပါသည်" ဆ ိုတဲေ့ အကွာအ ဝ်း အတ ိုင််းအတာတ ိုို့ ဆက်စပ်ပိုံက ို စနစ်တကျ 

 ဖေါ်ခပခြေင််းပင် ခဖစ်ပါသည်။ ထ ိုကဲေ့သ ိုို့ စနစ်ကျတဲေ့ နည််းနဲဲ့  ခမပိုံ ပေါ်မှာ စ က်းက ိုက်  ရ်းဆွထဲာ်းမှာ ခဖစ်ပါတယ။် 

 

Bar Scale 

Bar Scale ဆ ိုတာက  ခမပိုံနှင်ေ့  ခမခပင်တ ိုို့အကကာ်း အတ ိုင််းအတာ ဆက်စပ်ပိုံက ို  ခမပိုံ ပေါ်တွင် ဘာ်း အစ တ် တွနဲဲ့ 

က ိုယ်စာ်းခပြုပပ ်း  ဖေါ်ခပထာ်းခြေင််း ခဖစ်ပါသည်။ 

 
 

Verbal Scale 

Verbal Scale ဆ ိုတာက  ခမပိုံ ပေါ်ရှ  ၁ ယူနစ်နှင်ေ့ ၎င််းက ိုယ်စာ်းခပြုထာ်း သာ  ခမခပင် ပေါ်ရှ  ယူနစ်ပမဏ အတ ိုင််းအတာက ို 

ည မ ခြေင််း ခဖင်ေ့  ဖေါ်ခပထာ်းခြေင််း ခဖစ်ပါသည်။ ဥပမာ 

1 inch = 1 mile ၁ လက္ ၁ မ ိုင်၊  ၁ လက္ ၄ မ ိုင် စသည်တ ိုို့ ခဖစ်သည်။ 

1:1m ဆ ိုသည်မှာ  ခမပိုံ ပေါ်မှာ ရှ  နသည်ေ့ ၁ လက်မသည်  ခမခပင် ပေါ်တွင် လက်မ ပါင််း ၁ သန််းနှင်ေ့ ည မ  ကကာင််းက ို ဆ ိုလ ိုပါသည်။ 

 

Fractional Scale 

Fractional Scale ဆ ိုတာက  ခမပိုံ ပေါ်တွင် ရှ သည်ေ့ ၁ ယူနစ်၏ အြေျ  ြု်း နှင်ေ့  ခမခပင် ပေါ်တွင် ၎င််းက ိုယ်စာ်းခပြုထာ်း သာ 

အတ ိုင််းအတာတ ိုို့၏ အြေျ  ြု်းက ို  ဖေါ်ခပသည်။  1 : 63,360  (unitless) 

 

 

 

 

 

 

Large Scale vs.Small Scale 

အသိုံ်းခပြုမည်ေ့ ရည်ရွယ်ြေျက် ပေါ် မူတည်ပပ ်း  ခမပိုံက ို စ က်း အမျ  ြု်းမျ  ြု်းခဖင်ေ့  ရ်းဆွဲန ိုင်ပါသည်။ 

 

 

 

 

 

 

 

 

 

Large Scale သည် ပ ို၍ (အ သ်းစ တ်) အနိုစ တ်ပပ ်း၊ small scale သည် ပ ို၍  ယဘိုယျဆန်သည်။  

Detail City Map : large scale 

World Map : small scale 

Large Scale Mapping ဆ ိုတာ 

  Scale 
 

Largest Scale 1:10,000   

  1:25,000 (Local scale) 

  1:50,000 (Local scale) 

  1:100,000 (Regional scale) 

  1:250,000 (Regional scale) 

  1:1 million   

  1:2.5 million   

  1:5 million   

Smallest Scale 1:10 million   

Bar scale 

Fractional Scale 
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ေ မှာ ခပာတဲေ့ large scale ဆ ိုတာက  နရာ ေသ တစ်ြေိုက ို ပ ိုမ ို၍ အ သ်းစ တ်  ရ်းဆွဲခြေင််းက ို ဆ ိုလ ိုခြေင််းသာ ခဖစ်ပပ ်း ဧရ ယာ 

အကျယ်ကက ်းက ို  ရ်းဆွဲသည်ဟို မဆ ိုလ ို ပ။ 

 

Myanmar map sizes in different scale 

ခမန်မာန ိုင်ငံ၏ ခမပိုံက ို စာရွက်အခပည်ေ့ခဖင်ေ့  ရ်းဆွဲရာတွင် ဘယန်ှစ်ဆ ြေျြုံဲ့ပပ ်း  ရ်းဆွထဲာ်းသနည််း။ မ မ က ိုယ်တ ိုင်  ရ်းဆွပဲပ ်း 

 အာက်ပါ ကွက်လပ်တွင် လ ိုအပ် န သာ စ က်းက ို ခဖည်ေ့ ပ်းပါ။ 

Paper Size Map Scale (ခဖည်ေ့ပါ) 
A4 1: 10 m ? 
A3  
A2  
A1  
A0  

4.13 QGIS တငွ် Projection မျာ်း အခပနအ်လှန်  ခပာင််းကကည်ေ့ခြေင််း 

Layer pane ထဲက ို Projection  ခပာင််းြေျင် သာ Layer ထည်ေ့ထာ်းလ ိုက်ပါ။ ထ ို Layer ၏ လက်ရှ  Coordinate Reference 

System က ို သ ြေျင်ပါက Properties > Information tab မှာ Information from provider ဆ ိုတဲေ့ အပ ိုင််း လ်း ပါ နလ မ်ေ့မည်။ 

Storage file type, Encoding, Geometry type CRS, Extent, UNIT, Feature count စသညေ့် အြေျက်အလက်မျာ်း  တွဲ့ရမည်။ 

CRS တွင် EPSG code နံပါတ်နှင်ေ့ projection Type က ို  တွဲ့ရပါမည်။  

 
 

အဲေ  EPSG code နံပါတ်က ဘယ်လ ို  ပ်းထာ်းတာလဲ? Geodesy Subcommittee of OGP's (International Association 

of Oil and Gas Producers) Geomatics Committee ဆ ိုတဲေ့ အဖွဲဲ့က လိုပ် ပ်းထာ်းတာ။ တရာ်းဝင ်ဆ ိုေ်က http://www.epsg.org/ 

http://www.epsg-registry.org/ မှာ projection အသစ် တွက ို parameter  တွနှင်ေ့ တကွ စာရင််းသွင််း တင်ခပန ိုင်တယ။် အရင် 

register လိုပ် စာရင််းသွင််းတဲေ့ system အမည်က ို နံပါတ် အစဉ်လ ိုက် တပ်ထာ်းတာ။ code နံပါတ်နဲဲ့ projection နာမည်နဲဲ့ 

တွဲမှတထ်ာ်းသင်ေ့ပါတယ။် 

QGIS က ေ  projection database/parameter တွက ို အြေမဲေ့နဲဲ့ ယူသိုံ်းထာ်း ပါတယ။် free software  တွက ို ခပန်လည် 

အသိုံ်းြေျရန်အတွက် ၎င််းတ ိုို့ရဲဲ့ Terms of Use က ို နမူနာယူစရာ  လေ့လာဖတ်ရှု ကကည်ေ့န ိုင်ပါတယ်။ 

http://www.epsg.org/TermsOfUse 

 

Layer  စခ် က     က်ထပ် layer အသစ် စခ် အပ စ်သ မ်ျားပခင်ျား 

ထ ို Layer အမည ် ပေါ်က ို Right-click > Export> Save feture as  ရွ်းပပ ်း နှ ပ် ပ်းလ ိုက်ပါ။ 

ေ  နရာမှာ ေ လ ိုမျ  ြု်း file တစ်ြေိုက ို Save as လိုပ်ခြေင််းသည် GIS  ေတာက ို ဖ ိုင်အသစ်တစ်ြေို အ နခဖင်ေ့  ခပာင််းပပ ်း Save 

လိုပ်ခြေင််း ခဖစ်ပါသည်။ 

 ပေါ်လာ သာ Save vector layer as ဆ ိုတဲေ့ window ထဲမှာ  ခပာင််းြေျင် သာ File format က ို ESRI Shape file 

ဟို ရွ်းထာ်း ပ်းလ ိုက်ပါ။ 

Save as မှာ သ မ််းမည်ေ့  နရာက ို Browse လိုပ် ပ်းပပ ်း Layer အသစ်နာမည်က ို ရ ိုက်ထည်ေ့ ပ်းလ ိုက်ပါ။ 

ေါဟာ QGIS မှ GIS file မျာ်းက ို Export ခပြုလိုပ်ခြေင််း ခဖစ်ပါသည်။ 

ေ အြေန််းပပ ်းရင် စာဖတ်သူသည် QGIS ထဲက ို GIS  ေတာ တွ Import ၊ Export လိုပ်နည််း သ သွာ်းပါပပ ။  

http://www.epsg.org/TermsOfUse
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CRS  ခ မှ အပခ ျား CRS  စခ် သ  ို့ ပပ င်ျား၍ layer အသစ်  ်  ျားပခင်ျားပခင်ျား 

 မ မ  CRS  ခပာင််းြေျင် သာ layer  ပေါ်သ ိုို့ Right click လိုပ်၍ Export > save feature as က ို  ရွ်းပါ။ save as vector layer 

window  ပေါ်လာပါမည်။ file name  နရာတွင် မ မ  ပ်းလ ို သာ file name က ို ပ်းပါ။ CRS  နရာတွင် မ မ  ခပာင််းလ ို သာ CRS  

က ို ရွ်းရန် Select CRS က ို click လိုပ်ပါ။ EPSG:23647 က ို ရွ်းပါ။ EPSG:23647 သည် WGS 84 / UTM zone 47N က ိုဆ ိုလ ိုသည်။ 

အကယ်၍ UTM zone 46N က ို ရွ်းလ ိုလ င် EPSG:23646 က ို ရွ်း ပ်းရမည။် ပပ ်းလ င် OK က ို click လိုပ် ပ်းပါ။ Coordinate system 

အသစ်ခဖင်ေ့ file အသစ်တစြ်ေို ရာက်ရှ လာသည်က ို  တွဲ့ရမည်။  

 
ေ  နရာမှာ က ိုယ် ခပာင််းြေျင်တဲေ့ projection system ရဲဲ့ EPSG နံပါတ်က ို သ ထာ်းလ င် လိုပ်ရက ိုင်ရတာ ပ ို၍ အဆင် ခပ 

လွယက်ူပါမည်။ က ိုယ်သိုံ်းမယ်ေ့ ဧရ ယာ အတွက် သ ပမ်ျာ်းမျာ်း စာ်းစာ်း မရှ ပါဘူ်း။ 

 World GCS WGS 84က ို ခပန် ခပာင််းြေျင်ရင် EPSG:4326 က ို ရွ်း ပ်းလ ိုက်ပါ။ Filter မှာ စမ််းရ ိုက်ကကည်ေ့ပပ ်း  ခပာင််းကကည်ေ့ 

လ ိုက်ပါ။ 

Datum, Projection, Coordinate System ဘာလိုပ်ဖ ိုို့လ။ဲ  

Datum ဆ ိုတာက ကမဘာရဲဲ့ အရွယ်အစာ်းနှင်ေ့ ပိုံပန််းသဏ္ဍာန ်သ ဖ ိုို့ရန် အတွက်။ 

Projection က န ိုင်ငံတစြ်ေို၏ တည် နရာ နှင်ေ့ က ိုက်ည သည်ေ့ Projection အမျ  ြု်းအစာ်း  ရွ်းတတ် စရန် နှင်ေ့ 

အတ ိုင််းအတာမျာ်း အမှန်  ရွ်းတတ် စရန် အတွက်။ 

Coordinate System က အတ ိုင််းအတာ ယူနစ် အမျ  ြု်းအစာ်း အတွက် (ေ ဂရ  ၊  ပ ၊ က ိုက် ၊ မ တာ စသည်ခဖင်ေ့)။ 

Projection မှာ အမျာ်းအာ်းခဖင်ေ့ သူို့ Dautm နှင်ေ့သူ တွဲလျက် ပါရှ ပပ ်းသာ်း၊ Coordinate System လည််း 

သတ်မှတ်ထာ်းပပ ်းသာ်း မျာ်းတယ်။ (ဥပမာ GCS လတ်တ တွတ၊်  လာင်တ တွတ် ယူနစ်၊ UTM မ တာ ယူနစ် စသည်ခဖင်ေ့)။  
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5. GIS  ေတာမျာ်းခဖင်ေ့ ကစာ်းကကည်ေ့ခြေင််း 

5.1 Query က ိုအသိုံ်းခပြုပပ ်း Attribute မျာ်းက ို Filter လိုပ်ခြေင််း 

Query ဆ ိုတာက GIS  ေတာထဲမှာ ပါရှ တဲေ့ information  တွ အကိုန်လိုံ်းထဲက က ိုယ်လ ိုြေျင်တဲေ့ အြေျက် လ်းက ိုပဲ 

(selective information) လှမ််းပပ ်း တာေ့ ထိုတ်နိုတ် အသိုံ်းခပြုတာက ို ဆ ိုလ ိုပါတယ။် ဘယ်လ ိုထိုတ်သလဲဆ ို တာေ့ database rule 

တစ်ြေိုနဲဲ့ သတ်မှတ်ပပ ်း တာေ့ ထိုတ်ပါတယ။် အ ခြေြေံထာ်းတဲေ့နည််းက တာေ့ SQL database က ို SQL query command  ြေေါ် 

expression  တွနဲဲ့ အ ခြေြေံ ထာ်းပါတယ။် 

SQL command  တွ အကိုန်လိုံ်းက ို အ ခြေြေံက န အ သ်းစ တ် စတင်  လေ့လာြေျင်သူ အတွက် online resource ခဖစ် သာ 

http://www.w3schools.com/sql/ တွင် ဆက်လက်  လေ့လာ န ိုင်ပါသည်။ 

GIS Database ထဲတွင်  ေတာ ပါင််း  ခမာက်မျာ်းစွာ တည်ရှ  နန ိုင်ပါသည်။ ဥပမာ- ခမန်မာန ိုင်ငံ၏  ကျ်းရွာမျာ်းက ို 

ထညေ့်ထာ်း သာ Village GIS database ကဲေ့သ ိုို့ခဖစ်ပါမည်။ ဤ database ထဲက (database က ို မ ခပာင််းလဲ၊ မထ ြေ ိုက် စပဲ) 

က ိုယ်အသိုံ်းခပြုမည်ေ့ ပမ ြုဲ့နယ်တစ်ြေိုထဲတင်ွ ရှ  န သာ  ကျ်းရွာမျာ်းက ိုသာ Retrieve လိုပ်ကာ ဆွဲထိုတ်ပပ ်း၊ Analysis ခပြုလိုပ်ခြေင််း၊ 

 ခမပိုံထိုတ်လိုပ်ခြေင််း စသည်တ ိုို့ ခပြုလိုပ်န ိုင်ပါသည်။ ဤကဲေ့သ ိုို့ ခပြုလိုပ်န ိုင်ရန် အတွက် SQL command  တွထဲက SELECT ဆ ိုတဲေ့ 

command တစ်ြေိုက ို မသ မခဖစ် သ ထာ်းရပါမည်။ ဘာလ ိုို့လဲဆ ို တာေ့ ကျွန် တာ်တ ိုို့က GIS Attribute ဖ ိုင်ထကဲ န က ိုယ်လ ိုြေျင်တဲေ့ 

အပ ိုင််း လ်းက ိုသာ SELECT လိုပ်ပပ ်း တာေ့ သိုံ်းရမှာ ခဖစ်ပါတယ။် SELECT ဆ ိုတဲေ့ command အတွက် WHERE ဆ ိုတဲေ့ condition နဲဲ့ 

တွဲပပ ်း သိုံ်းရပါတယ။် ဥပမာ- ပင််းတယ ပမ ြုဲ့နယ် အတွက် 

 
SELECT * FROM VillageFile  WHERE Township = ‘Pindaya’ 

 

GIS software မှာက Shapefile အမျ  ြု်းအစာ်းက ို သိုံ်းထာ်းရင် Layer ဖ ိုင်အမည် ပေါ်မှာ Select လိုပ်ထာ်းပပ ်း ၎င််းရဲဲ့ 

Attribute table က ို Query လိုပ်ရမှာ ခဖစ်ပါတယ။် Database ဖ ိုင်အမျ  ြု်းအစာ်း ဆ ိုရင် တာေ့ import လိုပ်ကတည််းက တစြ်ေါတည််း 

Select ပပ ်း  Query ခပြုလိုပ် ပ်းန ိုင်ပါတယ။် Select ဆ ိုတာက လွယ်ပါတယ။် Layer  ပေါ်က ို mouse တစ်ြေျက် Click  ပ်းရိုံပါပဲ။ ေ မှာ 

where ဆ ိုတဲေ့ အ ခြေအ နက ို မှန်မှန်ကန်ကန် ခဖစ် အာင် ထညေ့် ပ်းတတ်ဖ ိုို့ အ ရ်းကက ်းတယ်။ GIS ဖ ိုင်မျာ်း၏ Attribute table က ို 

Query လိုပ်ဖ ိုို့ရန်အတွက် SELECT နဲဲ့ WHERE command အသိုံ်းခပြုပိုံက ို  အာက်ပါ နမူနာမှာ  လေ့လာန ိုင်ပါတယ်။ 

 
SELECT column_name 

FROM Attribute_table_name 

WHERE column_name operator value; 
 
SELECT column_name(s) 

FROM Attribute_table_name 

WHERE column_name LIKE pattern; 

 

WHERE clause မှာ အသိုံ်းခပြုန ိုင်တဲေ့ Operator  တွက တာေ့ 

Operator Description 

= Equal 

<>  Not equal. Note: In some versions of SQL this operator may be written as    != 

> Greater than 

< Less than 

>= Greater than or equal 

<= Less than or equal 

Query Builder မှ  ဘ  ရျားရမှ လဲ 

 ကယ် မ်ျား   ော့ QGIS ရဲျို့ Query Builder ထဲမှ  

SELECT  စ်ခ လ ုံျားအ ွက် အပပည်ော့အစ ုံ  ရျားရ   

မဟ  ်ဘဲ WHERE     ဲော့ clause အပ  င်ျား လျား 

အ ွက်က  ပဲ Expression ထည်ော့ ရျား ပျားရ  ပါ။ 
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BETWEEN Between an inclusive range 

LIKE Search for a pattern 

IN To specify multiple possible values for a column 

 

= Operator က ို အသိုံ်းခပြုပိုံမှာ 

SELECT * FROM Customers 

WHERE  Country='Germany' 

= က ကွက်တ  တူတေဲ့ အရာက ို ရှာဖ ိုို့ ခဖစ်ပါတယ။် ကွက်တ  တူြေျင်တဲေ့အြေါမှာ သိုံ်းပါတယ်။ Number  ရာ Text ပါ 

အသိုံ်းခပြုလ ိုို့ရပါတယ်။ 

 

!=   သ ိုို့မဟိုတ ် <>  Operator က ို အသိုံ်းခပြုပိုံမှာ 

SELECT * FROM Customers 

WHERE  Country='Germany' 

!=  , <> က ကွက်တ  မတူတဲေ့ အရာက ို ရှာဖ ိုို့ ခဖစ်ပါတယ။် ၎င််းမှလွဲ၍ အခြော်း သာ အရာက ို ရှာြေျင်တဲေ့အြေါမှာ သိုံ်းပါတယ။် Number 

 ရာ Text ပါ အသိုံ်းခပြုလ ိုို့ရပါတယ်။ 

 

AND Operator က ို အသိုံ်းခပြုပိုံမှာ 

SELECT * FROM Customers 

WHERE "SOV0NAME" = 'Germany' AND "NAME" = 'Berlin'  

AND က ၂ ြေိုစလိုံ်းနဲဲ့ က ိုက်ည တဲေ့ အရာက ို ရှာဖ ိုို့ ခဖစ်ပါတယ်။  

 

OR Operator က ို အသိုံ်းခပြုပိုံမှာ 

SELECT * FROM Customers 

WHERE "NAME" = 'Berlin' OR "NAME" = 'Munchon' 

OR က ၂ ြေိုထဲက တြေိုြေိုနဲဲ့တူတဲေ့၊ က ိုက်ည တဲေ့ အရာက ို ရှာဖ ိုို့ ခဖစ်ပါတယ။် ၂ ြေိုစလိုံ်းနဲဲ့လည််း တူန ိုင်ပါတယ။် 

  

AND နှင်ေ့ OR က ို တွဲပပ ်း အသိုံ်းခပြုပိုံမှာ 

SELECT * FROM Customers 

WHERE "SOV0NAME" = 'Germany' AND "NAME" = 'Berlin' OR "NAME" = 'Munchon' 

 

LIKE က ို အသိုံ်းခပြုပိုံ မှာ  

SELECT column_name(s) 

FROM table_name 

WHERE column_name LIKE pattern 

LIKE က ဆင်တူတဲေ့ အရာက ို ရှာဖ ိုို့ခဖစ်ပါတယ။် အတ အကျ မသ တဲေ့အြေါမှာ သိုံ်းပါတယ။် LIKE အတွက် % နဲဲ့ တွဲသိုံ်းရပါတယ်။ 

ေ  နရာမှာ % က ဘာမဆ ို ခဖစ်န ိုင်တဲေ့ Text အတွက် variable အခဖစ် အသိုံ်းခပြုထာ်းပါတယ်။ 

Number နငှ်ော့ Text 
ဒ မှ   စ်ခ  သ ထ ျားရမှ က Query လ ပ်မယ်ော့ Attribute Column သည် အကခရ စ လ ုံျား အမ   ျားအစ ျား ပ စ်လျှင် single quote 

‘ ’ ထဲ ွင် ထည်ော့ ပျားရပပ ျား၊ ဂဏ ်ျား အမ   ျားအစ ျား ပ စ်လျှင် SQL expression ၌    က်ရ  က် ထည်ော့ ရျားလ  ို့ ရသည်။ 
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LIKE နှင်ေ့% Wildcard က ို Text field တွင် အသိုံ်းခပြုပိုံမှာ 

SELECT * FROM Customers 

WHERE "NAME" LIKE 'ber%' 

ber နှင်ေ့ စထာ်း သာ စကာ်းလိုံ်း၊ အမည်မျာ်း အာ်းလို်ံးက ို စစ်ထိုတဖ် ိုို့အတွက် ခဖစ်ပါတယ်။ ဆင်တူ တွက ို ရှာြေျင်တဲေ့အြေါမှာ 

သိုံ်းပါတယ်။ 

 

SELECT * FROM Customers 

WHERE "NAME" LIKE '%es%' 

 

စကာ်းလို်ံးမျာ်း၏ ကကာ်းတွင် es ပါ သာ အမည်မျာ်း အာ်းလိုံ်းက ို ရှာဖ ိုို့ခဖစ်ပါတယ်။ ဆင်တူ တွက ို ရှာြေျင်တဲေ့အြေါမှာ သိုံ်းပါတယ်။ 

  

 

SELECT * FROM Customers 

WHERE "NAME" LIKE '_erlin' 

 ရှဲ့စာလိုံ်း ၁ လိုံ်း ပါရှ ပပ ်း (၁ လိုံ်းမသ ) _erlin နှင်ေ့ အဆိုံ်းသတ်ထာ်း သာ စကာ်းလို်ံး၊ အမည်မျာ်း အာ်းလို်ံးက ို ရှာဖ ိုို့ခဖစ်ပါတယ်။ 

စကာ်းလို်ံး အ ရအတွက်တူပပ ်း ဆင်တူတဲေ့ အမည် တွက ို ရှာြေျင်တဲေ့အြေါမှာ သိုံ်းပါတယ။် 

 

SELECT * FROM Customers 

WHERE NAME" LIKE 'L_n_on’ 

L_n_on ပါရှ ပပ ်း၊ ေိုတ ယစာလိုံ်းမသ  (၁ လိုံ်းမသ ) ၊ စတိုတထ စာလိုံ်းမသ   သာ စကာ်းလိုံ်း၊ အမည်မျာ်း အာ်းလို်ံးက ို ရှာဖ ိုို့ခဖစ်ပါတယ်။ 

စကာ်းလို်ံး အ ရအတွက်တူပပ ်း ဆင်တူတဲေ့ အမည် တွက ို ရှာြေျင်တဲေ့အြေါမှာ သိုံ်းပါတယ။် 

 

IS နှင်ေ့တွဲပပ ်း NULL တန်ဖ ို်းက ို အသိုံ်းခပြုပိုံ မှာ  

SELECT LastName,FirstName,Address FROM Persons 

WHERE Address IS NULL 

IS NULL က Blank ခဖစ် နတဲေ့ တန်ဖ ို်း  တွက ို ရှာဖ ိုို့ ခဖစ်ပါတယ်။  

 

IS NOT နှင်ေ့တွဲပပ ်း NULL   က ို အသိုံ်းခပြုပိုံမှာ 

SELECT LastName,FirstName,Address FROM Persons 

WHERE Address IS NOT NULL 

IS NOT NULL က Blank မဟိုတ်တဲေ့ တန်ဖ ို်း  တွက ို ရှာဖ ိုို့ ခဖစ်ပါတယ။် 

 

ေ လ ိုနည််းနဲဲ့ Filter လိုပ်ပပ ်း ရလာတဲေ့  ေတာက ို  ခမပိုံ ပေါ်မှာ  ဖေါ်ခပတာပဲခဖစ်ခဖစ်၊ analysis ဆက်လိုပ် တာပဲခဖစ်ခဖစ် 

အသိုံ်းခပြုလ ိုို့ ရပါတယ်။ အြေို Visualization အြေန််းမှာ တာေ့  ခမပိုံ ပေါ်မှာ ခပဖ ိုို့ သက်သက်ပဲ နမူနာ လိုပ်မယ်။ GIS ဖ ိုင်ရဲဲ့ Attribute 

Database ထဲက န က ိုယ်လ ိုြေျင်တဲေ့ အြေျက်အလက်က ို ကျွမ််းကျင်စွာနဲဲ့ Query ဆွဲတတ် အာင် ဆက် လေ့ကျင်ေ့သွာ်းပါ။ 

လက် တွဲ့ လေ့ကျင်ေ့ရန်အတွက် Training data/ World folder ထဲမ ှ ne_10m_populated_places.shp ဟူ သာ 

ကမဘာေ့န ိုင်ငံမျာ်း၏ ပမ ြုဲ့မျာ်း ပါရှ  သာ ဖ ိုင်က ို ဖွင်ေ့လ ိုက်ပါ။ 

‘ % ’  ခေါ် Character Wildcard 

Wildcard      က မည်သည်ော့ Character စ လ ုံျားမ   ၊ စ လ ုံျားအ ရအ ွက် ဘယ်နစှလ် ုံျားပဲရှ ရှ  က  ယ်စ ျားပပ    ို့ရ ် 

အ ွက ်Expression ထဲမှ  သ ကေ  အ   ဲဲ့ သ ုံျားပပ ျား  ‘ % ’    ပပ ျား ထည်ော့ ရျား ပျား ရ ယ်။ 
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 ရှဲ့ဆက် မသွာ်းြေင် လ်းမှာ ေ  Layer ရဲဲ့ Attribute table က ို တစ်ြေျက် ဖွင်ေ့ပပ ်း၊ ဘာ Field / Column  တွပါ သလဲဟို 

စူ်းစမ််း  လေ့လာကကည်ေ့လ ိုက်ပါ။ အဲေ  table က ကျွန် တာ်တ ိုို့ Query လိုပ်မည်ေ့ database ဖ ိုင်ပါပဲ။ ADM0CAP ဆ ိုတဲေ့ field ပါသလာ်း။ 

ကကည်ေ့လ ိုက်ပါ။ 

 
 

QGIS ရဲဲ့ Layers pane ထဲ၌ne_10m_populated_places နာမည် ပေါ်သ ိုို့ Right-click တင်ပပ ်း  ပေါ်လာ သာ Command 

မျာ်းထဲမှ Properties ဟူ သာ စာသာ်းက ို နှ ပ်ပါ။ ထ ို Layer အတွက် properties window တစ်ြေို  ပေါ်လာပါမည်။ 

properties window ရဲဲ့ ဘယ်ဘက် pane ထဲမှာ၊ အ ပေါ်နာ်းက Source ဟူ သာ tab က ို နှ ပ်လ ိုက်ပါ။ သူနဲဲ့ သက်ဆ ိုင်တဲေ့ 

page  ပေါ်လာမည်။ 

 
 ပေါ်လာတဲေ့ page ရဲဲ့ ညာဘက်  အာက်နာ်းမှာ Query Builder ဆ ိုတဲေ့ button  လ်းက ို ဆက်နှ ပ်လ ိုက်ပါ။ Query Builder 

window တစ်ြေို  ပေါ်လာ လ မ်ေ့မည်။ 
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Fields ဆ ိုတဲေ့ List ထဲက ADM0CAP က ို 

Double-click နှ ပ်ပပ ်း expression သ ိုို့မဟိုတ် 

formula အကွက် ထဲမှာ “ADM0CAP”  ပေါ်လာ 

လ မ်ေ့မည်။ 

ထ ိုို့ နာက် Operators ဆ ိုတဲေ့ စာရင််းထဲက 

ည မ ခြေင််း ခဖစ်တဲေ့ = က ို တစ်ြေျက် နှ ပ်လ ိုက်ပါ။ 

အြေို လာက်ဆ ို Expression အကွက်ထဲမှာ 

"ADM0CAP" =  ဆ ိုပပ ်း  ပေါ် နသင်ေ့ပါသည်။ 

ေ  Field ထဲက Value  တ ွ က ို အကိုန် 

(အကိုန်လိုံ်း) populate လိုပ်ဖ ိုို့ရန် အတွက် 

ညာဘက် အ ပေါ်နာ်းက All ဆ ိုတဲေ့ button က ို 

နှ ပ်လ ိုက်ပါ။ ေ  Field ထဲမှာ ပါဝင်တဲေ့ 0 နဲဲ့ 1  တွ 

 ပေါ်လာလ မ်ေ့မယ်။  

အဲေ  အထဲက 1 ဆ ိုတာက ို Double-click 

နှ ပ်ပပ ်း  ရွ်း ပ်းလ ိုက်ပါ။ အြေို လာက်ဆ ို 

Expression အကွက်ထဲမှာ "ADM0CAP" = 1 ဆ ိုပပ ်း 

 ပေါ် နသင်ေ့ပါသည်။ 

အဲေ  နာက်  အာက်နာ်းက Test ဆ ိုတဲေ့ 

button က ို နှ ပ်ပပ ်း မ မ ၏ Expression မှန်၊ မမှန် စမ််းကကည်ေ့ န ိုင်ပါသည်။ မှန်ပါက   အာက်ပါ 

ကဲေ့သ ိုို့ Query Resultmessage မျ  ြု်း ခပ နပါလ မ်ေ့မည်။ 

OK မျာ်း ဆက်နှ ပ်ပပ ်း  ခမပိုံက ို ခပန်ကကည်ေ့လ ိုက်ပါ။ န ိုင်ငံမျာ်း အသ ်းသ ်း၏ ပမ ြုဲ့ တာ်မျာ်းက ိုသာ  ဖေါ်ခပ နပါလ မ်ေ့မည်။ 

Layer pane ထဲက ဖ ိုင်နာမည် ပေါ် Right-click > Filter နှ ပ် သာ် ဘာ ပေါ်လာသနည််း။ 

 
အထက်ပါ ကျွန် တာ်တ ိုို့ လိုပ်ြေဲေ့ သာ Query သည် populate places GIS ဖ ိုင်ထဲရှ  ပမ ြုဲ့ တာ်မျာ်းထဲမှ န ိုင်ငံ၏ 

ပမ ြုဲ့ တာ်က ိုသာ စစ်ထိုတ်ယူပပ ်း  ခမပိုံ ပေါ်တွင် လာ ရာက် ခပသခြေင််း ခဖစ်ပါသည်။ Query ခပြုလိုပ်ခြေင််း သည် original database က ို 

ခပြုခပင် ခပာင််းလဲခြေင််း မဟိုတ် ပ၊ မထ ြေ ိုက် ပ။ 

ဤကဲေ့သ ိုို့ Query ခပြုလိုပ်န ိုင်ရန် အတွက် Attribute database ထဲတွင် ပမ ြုဲ့ တာ် ဟိုတ်သည် မဟိုတ်သည် စသည်ေ့ 

အြေျက်အလက် က ို ADM0CAP ထဲ၌ 1 နှင်ေ့ 0 ဟို code မျာ်းခဖင်ေ့ စနစ်တကျ ထည်ေ့သွင််းထာ်းပါသည်။ 
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5.2 Attribute Query Exercise 

Number မျာ်းပါ သာ Field မျာ်းက ို Query လိုပ်ပပ ်း 

 ခမပိုံ ပေါ်တွင် ခပ ပ်းပါ။ 

အသိုံ်းခပြုရမည်ေ့ Operator မျာ်းမှာ =   <=   >=   != 

String  ြေေါ် Text မျာ်းပါ သာ Field မျာ်းက ို Query လိုပ်ပပ ်း 

 ခမပိုံ ပေါ်တွင် ခပ ပ်းပါ။ 

အသိုံ်းခပြုရမည်ေ့ Operator မျာ်းမှာ =   !=   LIKE   ILIKE  

'%'  NULL 

 

5.3 Attribute edition 

Layer တစြ်ေို၏ Attribute က ို Edit ခပြုလိုပ်န ိုင်ရန် အတွက် ၎င််း၏ Attribute table က ို ဖွင်ေ့ထာ်းပါ။ Toggle editing mode 

က ို Click နှ ပ် ပ်းခြေင််းခဖင်ေ့ Activate လိုပ်လ ိုက်ပါ။ သ ိုို့မဟိုတ ်Ctrl + E က ို နှ ပ်ပါ။ 

 
ကဲေါဆ ိုရင် Attribute က ို manually တည််းခဖတ်ခြေင််း ခပြုလိုပ်န ိုင်ပါပပ ။ Cell တစ်ြေိုထဲက ို Double-click လိုပ်ပပ ်း တာေ့ 

စာသာ်း က ို အသစ် ခပာင််းရ ိုက် ကကည်ေ့လ ိုက်ပါ။ 

 

Row  ခေါ် Entry က     က်ပခင်ျား 

ဖျက်ြေျင် သာ row က ို select လိုပ်ထာ်းပပ ်း Delete 

နှ ပ်လ ိုက်ပါ။ သ ိုို့မဟိုတ ် Delete Selected Features က ို 

နှ ပ်လ ိုက်ပါ။ 

 

Column  ခေါ် Field က     က်ပခင်ျား 

Delete field သ ိုို့မဟိုတ် ‘Ctrl + L’ က ို နှ ပ်ပါ။ 

 ပေါ်လာ သာ Delete Attribute Window တွင် 

ဖျက်ြေျင် သာ column က ို select လိုပ်ထာ်းပပ ်း OK က ို 

ဆက်နှ ပ်လ ိုက်ပါ။ 

 

 

 

 

 

 

Column အသစ်ထညော့ပ်ခင်ျား 

၂ ြေျက် လ ိုအပ် ပါသည်။  

၁။ Operator က ို မှန်ကနစ်ွာနှင်ေ့ ကျွမ််းကျင်စွာ 

အသိုံ်းခပြု တတ်ရန် လ ိုအပ်ပါသည်။ 

၂။ GIS database တစ်ြေိုက ို တည် ဆာက် ပါက 

Attriburte မျာ်းက ို စိုံလင်စွာခဖင်ေ့ စနစ်တကျ 

ထည်ေ့သွင််းထာ်း ရပါမည်။ 
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New Column သ ိုို့မဟိုတ ်‘Ctrl + W ’ က ို 

နှ ပ်ပါ။ 

 ပေါ်လာ သာ Add Column window 

တွင် Name, Type, Width က ို ခဖည်ေ့ ပ်းပါ။ 

Name : column အမည် 

Type : က န််းခပည်ေ့ အတွက် Integer, ေဿမက န််း အတွက် Decimal, 

စကာ်းလို်ံးအတွက် Text အမျ  ြု်းအစာ်းက ို  ရွ်း ပ်းပါ။ 

Width : ဤ column အတွက် အမျာ်းဆိုံ်း အသိုံ်းခပြုန ိုင်မည်ေ့ စကာ်းလို်ံး 

အ ရအတွက်က ို ခဖည်ေ့ ပ်းပါ။ (shapefile အတွက် 1-256 အတွင််း) 

 

5.4 Field Calculator အသိုံ်းခပြုခြေင််း 

 Field calculator သည် Attribute တန်ဘ ို်းမျာ်းက ို တွက်ြေျက်ရန်လိုပ် ဆာင်န ိုင်ပါသည်။ ဥပမာ feature တြေို၏ 

အလျာ်းက ိုတကွ်ခြေင််း၊ ဧရ ယာက ိုတကွ်ခြေင််း၊ feature ၏ latitude and longitude က ိုတကွ်ခြေင််း၊ 

တွက်ထာ်းပပ ်း သာအြေျက်အလက်မျာ်းက ို New attribute field အခဖစ် သ ိုို့မဟိုတ် virtual field အခဖစ် သ ိုို့မဟိုတ် ရှ ပပ ်းသာ်း field 

တွင် update အခဖစ်လိုပ် ပ်းန ိုင်ပါသည်။ 

 

Polygon အမ   ျားအစ ျား အ ွက် Area Calculation  

ဥပမာ- Area က ို တွက်ဖ ိုို့ရန်အတွက် Function 

စာရင််း အာက်က Geometry သွာ်းပါ။ 

$area က ို Double-Click နှ ပ်လ ိုက်ပါ။ 

Expression ထဲတွင် $area  ပေါ်လာလ မ်ေ့မည်။ Expresion 

မှန်ကန်ပါက  အာက်နာ်းတွင် Preivew မျာ်း  ပေါ်လာ ပါမည်။ 

(မှာ်း နပါက မှာ်း န ကကာင််း message  ပေါ် နပါမည်။) 

ပပ ်းလ င် OK က ို ဆက်နှ ပ်လ ိုက်ပါ။ 

ေါဆ ိုရင် Area ဆ ို သာ Column အသစ်တစ်ြေို Create လိုပ်ပပ ်းသာ်း 

ခဖစ် နပပ ်း ထ ို Column အသစ်ထဲတင်ွလည််း feature တစြ်ေိုြေျင််းစ  

အတွက် ဧရ ယာ တန်ဖ ို်းမျာ်း ပါရှ  နပါလ မ်ေ့မည်။  

Point အမျ  ြု်းအစာ်း GIS layer အတွက် Point မျာ်း၏ Longitude တည် နရာက ို ' $x ' ခဖင်ေ့ ခပန်လည် တွက်ြေျက်  ပ်းန ိုင်ပါသည်။ 

Point အမျ  ြု်းအစာ်း GIS layer အတွက် Point မျာ်း၏ Latitude တည် နရာက ို ' $y ' ခဖင်ေ့ ခပန်လည်တွက်ြေျက်  ပ်းန ိုင်ပါသည်။ 

Line အမျ  ြု်းအစာ်း GIS layer အတွက် Line မျာ်း၏ အလျာ်းတကွ်ခြေင််း၊ လမ််းအရှည်တွက်ခြေင််း မျာ်းက ို ' $length ' ခဖင်ေ့ 

ခပန်လည်တွက်ြေျက်  ပ်းန ိုင်ပါသည်။  

 

Field နှင်ော့ Values မ  ျားက    ွက်ခ က်ပခင်ျား အ ွက် 

ဤ Field calculator တွင် Column တစြ်ေိုက ို ဂဏန််းမျာ်း ခဖင်ေ့  ပါင််း၊ နိုတ်၊  ခမာက်၊ စာ်း ခြေင််းမျာ်းက ို လည််း ခပြုလိုပ် န ိုင်ပါသည်။ 

ဂဏန််း Column မျာ်း တစြ်ေိုနှင်ေ့တစြ်ေို  ပါင််း၊ နိုတ်၊  ခမာက်၊ စာ်း ခြေင််းမျာ်းက ိုလည််း ခပြုလိုပ် ပ်း န ိုင်ပါသည်။ 
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6. GIS data Create လိုပ်ရန်ခပင်ဆငခ်ြေင််း 

ဤ Data Cteation အြေန််းက ို  လေ့လာန ိုင်ရန် အတွက် စာဖတ်သူသည ်Projection အြေန််း၊ Data type အြေန််း၊ Attribute 

အြေန််းတ ိုို့က ို အရင်ဦ်းစွာ နာ်းလည် အာင် သင်ယူပပ ်းသူ ခဖစ်ရပါမည်။ 

 ေတာ တွက ို ဖန်တ ်းယူန ိုင်တဲေ့ ပထမဆိုံ်း နည််းလမ််းတစ်ြေိုက တာေ့ Digitizing  ြေေါ် က ိုယ်တ ိုင်  ရ်းဆွခဲြေင််းပဲ ခဖစ်ပါတယ်။ 

Digitizing ဆ ိုတာက ပိုံတစ်ြေိုြေို ပေါ် အ ခြေြေံပပ ်း၊ Layer အသစ်တစ်ြေိုက ို ဖန်တ ်း ရ်းဆွဲခြေင််း ခဖစ်ပါတယ။် အဲေ  တာေ့ကာ Digitizing 

လိုပ်ဖ ိုို့ရန်အတွက်  အာက်ြေံ ခမပိုံ  ြေေါ် base map တစ်ြေို လ ိုအပ်လာပါတယ။် ေ က ိုယ်သိုံ်းမယ်ေ့ base map သည် GeoRegistration 

လိုပ်ပပ ်းသာ်း၊ Geoinformation ပါရှ နှင်ေ့ပပ ်းသာ်း ခဖစ်ရပါမည်။ တြေါတရံတွင် ပိုံနှစ်ြေိုထက်မက ထပ်ပပ ်း၊ ဆက်ပပ ်း တာေ့မှ Digitizing 

ခပြုလိုပ် ရ်းဆွဲရ သာအြေါမျ  ြု်းလည််း ရှ ပါမည်။ ထ ိုအြေါမျ  ြု်းတွင်  အာက်ြေံ  ခမပိုံနှစ်ြေို  နရာ တစထ်ပ်တည််း မကျပဲ၊ 

GeoRegistration မျာ်း လွဲ နတတ်ကကပါသည်။ ထ ိုသ ိုို့ GeoRegistration မျာ်းလွြဲေဲေ့ပါက  နရာမှန် သ ိုို့ ခပန်ခဖစ် အာင် Rectification 

ခပြုလိုပ်ခြေင််းက ို ကက ြုတင်ပပ ်း အရင်ဆိုံ်း ခပြုလိုပ်ထာ်းရပါမည်။  သ ိုို့မှသာ မ မ တ ိုို့  ရ်းဆွဲပပ ်းရရှ လာမည်ေ့ Layer အသစ်သည်  နရာအမှန် 

နှင်ေ့ ရလာပါမည်။ 

အြေိုအြေန််းမှာ တာေ့ On-screen digitizing နည််းက ိုသိုံ်းပပ ်း ဆွဲမှာ ခဖစ်ပါတယ။် Digitizing လိုပ်မယ်ဆ ို တာေ့ ဘယ် ခမပိုံ ပေါ်မှာ 

အ ခြေြေံပပ ်း လိုပ်မည်လဲ ဆ ိုတဲေ့ Base Map တစ်ြေိုလ ိုအပ်လာပါတယ်။ 

 

6.1 Base Map 

Analogue map 

က ိုယ် အ ခြေြေံထာ်းတဲေ့ map က Analogue format နဲဲ့ ခဖစ်တဲေ့ ပိုံလည််း ခဖစ်ြေျင်ခဖစ်ပါမယ်။ Digitizer table ရှ ြေဲေ့ပါက အဲေ  

 ခမပိုံက ို Control point  တွနဲဲ့ register လိုပ်ပပ ်း၊ Digitizer နဲဲ့ digitizing လိုပ်လ ိုို့ရပါတယ်။ တကယ်လ ိုို့ က ိုယ်သိုံ်းမယ်ေ့ base map 

က ေ လ ို Analogue map ခဖစ် နပပ ်း၊ on-screen digitizing လိုပ်ြေျင်လ ိုို့ရှ ရင်  အာက်ပါ အဆင်ေ့အတ ိုင််း ခပြုလိုပ်ဖ ိုို့ လ ိုအပ်ပါမည်။ 

၁ - Analogue format က န Digital format က ို အရင်  ခပာင််း ပ်း ရမှာ ခဖစ်ပါတယ။် Scan to digital format, JPEG or 

PNG. Etc. 

၂ - ရလာတဲေ့ digital ပိုံက ို Georeference လိုပ် ပ်းရပါမယ်။ 

၃ - GeoReference ခပြုလိုပ်ထာ်းတဲေ့ map  ပေါ်မှာ အ ခြေြေံပပ ်း တာေ့ on screen digitizing နည််းနဲဲ့ GIS data မျာ်းက ို  ရ်းဆွဲ 

(create) သွာ်းမှာ ခဖစ်ပါတယ်။ 

 

6.2 Georeferencing Base Map 

GIS data မျာ်းက ို အသိုံ်းခပြုပပ ်း topographic map အမျ  ြု်းမျ  ြု်းက ို  ရ်းဆွနဲ ိုင်ပါသည်။ အြေျ  ြုဲ့က original soft copy GIS data 

မျာ်း မရှ  သာ ကကာင်ေ့ နဂ ိုက GIS က ို အသိုံ်းခပြုပပ ်း  ရ်းဆွထဲာ်းတဲေ့ hard copy topographic map မျာ်း ပေါ်တွင် digitizing 

တဖန်ခပန်ပပ ်း ခပြုလိုပ် နကကပါသည်။ ဤသ ိုို့ ခပြုလိုပ်ခြေင််းအာ်းခဖင်ေ့ GIS data က ို ဖန်တ ်းန ိုင် သာ်လည််းပဲ procedure အရ 

 ခပာင််းခပန်ခဖစ်ရိုံသာမက ရရှ လာ သာ data မျာ်း၏ Accuracy သည်လည််း  လျာေ့ကျ ကကာင််း သ ထာ်းသင်ေ့ပါသည်။ 

 

Georeferencing ခပြုလိုပ်ဖ ိုို့ရန်အတွက် Georeferenced GDAL plugin က ို ဖွင်ေ့ထာ်း ပ်းရပါမည်။                           

Georeferencing နငှ်ော့ GCP point 

Scan လိုပ်ထာ်း သာ  ခမပိုံတြေိုက ို GIS ထဲတငွ် အခြော်း သာ  ခမပိုံမျာ်းနငှ်ေ့ တထပ်တည််းကျ အာင် 

တင်န ိုင်ဖ ိုို့ရန် အတွက ်၎င််း  ခမပိုံ၏ တည ်နရာအမှန်က ို register လိုပ်ထာ်းမှသာ ခဖစမ်ည်။ ထ ို Process က ို 

Georeferencing ဟို  ြေေါ်ပါသည်။ ထ ိုကဲေ့သ ိုို့ ခပြုလိုပ်ရာတွင် တည ်နရာက ို အတ အကျ ခဖစ ်န အာင် 

 ခမခပင ်ပေါ်နငှ်ေ့  ခမပိုံ ပေါ် နှစ် နရာစလိုံ်းတငွ် ပါရှ သည်ေ့၊  တွဲ့ခမင်န ိုင်သည်ေ့ သ သာထင်ရှာ်းတဲေ့ 

အမတှ်အသာ်းမျာ်းက ို Ground Control Point (GCP) အ ထာက်အက ူအခဖစ် အသိုံ်းခပြုကကပါသည်။ GCP 

 ကာက်ဖ ိုို့ရန ်အတကွ် ကွင််းဆင််းပပ ်း၊ GPS ခဖင်ေ့ အမတှ်မျာ်းစွာတ ိုို့၏ Coordinate မျာ်းက ို တ ိုင််းတာ ရပါမည။် 
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Main menu bar>Plugins > Manage and Install plugins..  မ ှဖွင်ေ့ထာ်း န ိုင်ပါသည်။ 

 
Base map အ နနဲဲ့ topographic map, scan map  တွက ို နမူနာ အ နနဲဲ့ Georeferencing ခပြုလိုပ်ခပသွာ်းပါမည်။ နမူနာ scan 

map မျာ်းက ို Online က န Download ရယူန ိုင် သာ  နရာမျာ်းမှာ 

နမူနာ အ နခဖင်ေ့ ရန်ကိုန် ပါရှ  သာ  ခမပိုံက ို Georeferencing ခပြုလိုပ်ခပပါမည်။ 

1:45,000 စ က်း ခဖင်ေ့  ရ်းဆွဲထာ်း သာ ၁၉၂၉ ြေိုနှစ် ရန်ကိုန်  ခမပိုံ အ ဟာင််း -  

http://www.lib.utexas.edu/maps/historical/baedeker_indien_1914/txu-pclmaps-mandalay_1914.jpg 

အခြော်း သာ အသိုံ်းခပြုန ိုင်သည်ေ့ - ၁၈၂၇ ြေိုနှစ်  ခမပိုံ  နှငေ့် အခြော်း သာခမန်မာန ိုင်ငံအတွက် ခမပိုံမျာ်းမှာ…. 

http://www.lib.utexas.edu/maps/historical/birman_empire_1827.jpg 

http://legacy.lib.utexas.edu/maps/ams/burma/ 

http://www.lib.utexas.edu/maps/middle_east_and_asia/burma_trans-2007.pdf 

Georeferencing ခပြုလိုပ်ရန် အတွက် Georeferencer က ို ဖွင်ေ့လ ိုက်ပါ။ Georeferencer window တစြ်ေို  ပေါ်လာပါမည်။ 

 
Features 

Icon Purpose Icon Purpose 

 

Open raster 
 

Start georeferencing 

 

Generate GDAL Script 
 

Load GCP Points 

 

Save GCP Points As 
 

Transformation settings 

 

Add Point 
 

Delete Point 

 

Move GCP Point 
 

Pan 

 

Zoom In 
 

Zoom Out 

 

Zoom To Layer 
 

Zoom Last 

http://www.lib.utexas.edu/maps/historical/birman_empire_1827.jpg
http://docs.qgis.org/2.0/en/_images/mActionOpenRaster.png
http://docs.qgis.org/2.0/en/_images/mActionStartGeoref.png
http://docs.qgis.org/2.0/en/_images/mActionGDALScript.png
http://docs.qgis.org/2.0/en/_images/mActionLoadGCPpoints.png
http://docs.qgis.org/2.0/en/_images/mActionSaveGCPpointsAs.png
http://docs.qgis.org/2.0/en/_images/mActionTransformSettings.png
http://docs.qgis.org/2.0/en/_images/mActionAddGCPPoint.png
http://docs.qgis.org/2.0/en/_images/mActionDeleteGCPPoint.png
http://docs.qgis.org/2.0/en/_images/mActionMoveGCPPoint.png
http://docs.qgis.org/2.0/en/_images/mActionPan.png
http://docs.qgis.org/2.0/en/_images/mActionZoomIn.png
http://docs.qgis.org/2.0/en/_images/mActionZoomOut.png
http://docs.qgis.org/2.0/en/_images/mActionZoomToLayer.png
http://docs.qgis.org/2.0/en/_images/mActionZoomLast.png
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Icon Purpose Icon Purpose 

 

Zoom Next 
 

Link Georeferencer to QGIS 

 

Link QGIS to Georeferencer 
 

  

Georeferencer window ၏ menu bar မ ှFile > Open Raster က ို နှ ပ်ပပ ်း Georegistration ခပြုလိုပ်မည်ေ့ Yangonmap_1924.jpg 

ပိုံက ို Browse လိုပ်ပပ ်း Import လိုပ်ကာ ဖွင်ေ့လ ိုက်ပါ။ 

ေ ပိုံအတွက် ဘယ ် CRS က ိုသိုံ်းမှာလဲ လ ိုို့  မ်းတဲေ့ အြေါမှာ WGS84 ခဖစ်တဲေ့ EPSG:4326 က ို သိုံ်းမည်ဟို Assign လိုပ် ပ်းလ ိုက်ပါ။ 

အကယ်၍ WGS 84 / UTM Zone 47N က ို သိုံ်းြေျင်ပါက EPSG:32647 က ို  ရွ်း ပ်းလ ိုက်ရိုံပါပဲ (မ မ အသိုံ်းခပြုလ ို သာ coordinate 

System က ို ရွ်း ပ်းရမည်)။ 

 

 

ဤ Georegistration မပါရှ  သာ ၁၉၂၄ ြေိုနှစ် 

ရန်ကိုန်ပမ ြုဲ့ ပိုံက ို Georegistration ထညေ့် ပ်းရန် 

အတွက်  ခမခပင်မှ တ ိုင််းတာထာ်း သာ GPS 

coordinate မျာ်း လ ိုအပ်ပါသည်။ GPS ခဖင်ေ့ 

ကွင််းဆင််းတ ိုင််းတာ ထာ်းခြေင််း မရှ ြေဲေ့ပါက ရှ နှင်ေ့ 

ပပ ်းသာ်း  ခမပိုံမျာ်းနှင်ေ့လည််း Map to Map 

Registration ခပြုလိုပ်န ိုင်ပါသည်။ 

ထ ိုကဲေ့သ ိုို့ Map to Map Registration 

ခပြုလိုပ်န ိုင်ဖ ိုို့ရန် အတွက် QGIS map project 

ထဲသ ိုို့ Georegistration ရှ ထာ်းပပ ်း သာ  ခမပိုံ 

တစ်ြေိုက ို ဖွင်ေ့ထာ်း ပ်းလ ိုက်ပါ။ 

အြေိုနမူနာ reference  ခမပိုံအတွက် သိုံ်းထာ်းတာ 

က တာေ့ Open street Map မှ ရယူထာ်း သာ 

Road data နှငေ့် Sentinel2 Image အမျ  ြု်းအစာ်း 

ခဖစ်ပါတယ်။ 

 

Reference Image က CRS မတူဘ်ူး ခဖစ်ြေဲေ့ရင် က စစမရှ ပါဘူ်း။ Project > Project Properties… က ိုသွာ်းပပ ်း၊ လ ိုြေျင်တဲေ့ CRS က ို 

 ခပာင််းပပ ်း Apply လိုပ် ပ်းလ ိုက်ရိုံပါပဲ။ 

http://docs.qgis.org/2.0/en/_images/mActionZoomNext.png
http://docs.qgis.org/2.0/en/_images/mActionLinkGeorefToQGis.png
http://docs.qgis.org/2.0/en/_images/mActionLinkQGisToGeoref.png
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Image to Image Registration နည််းမှာ အဓ က လိုပ်ရမှာက တာေ့ က ိုယ် Register လိုပ်မည်ေ့  ခမပိုံ ပေါ်က အမှတ် နရာက ို 

Reference အ နနဲဲ့ယူထာ်းတဲေ့ Image  ပေါ်က တူည တဲေ့ အမှတ် နရာနဲဲ့ တ ိုက်ပပ ်း တာေ့  ခမပိုံက ို တည် နရာ အမှန်ခဖစ် အာင် 

ခပန်တည်ေ့မှတ် ပ်း လ ိုက်တာပါပဲ။  

Image to GPS GeoReferencing နည််းမှာ အဓ က လိုပ်ရမှာက တာေ့ Register လိုပ်မည်ေ့ အမှတ် နရာက ို တ ိုင််းထာ်းသည်ေ့ GCP 

အမှတ်မျာ်းရဲဲ့ X, Y Coordinate တန်ဖ ို်းနဲဲ့  ခမပိုံရဲဲ့ တည် နရာအမှန်က ို ခပန်တည်ေ့မှတ် ပ်း လ ိုက်တာပါပဲ။ 

GCP အမှတ်က ို စထညေ့်ဖ ိုို့ရန် အတွက် Georeferencer window တွင်    

Add Point က ို နှ ပ်လ ိုက်ပါ။ Pointer ၏ Cursor သည် Cross hair အခဖစ် 

 ခပာင််းသွာ်းပါမည်။ 

Georeferencer  ခမပိုံတွင် မ မ  reference  ပ်းလ ို သာ  နရာက ိုသွာ်းပပ ်း၊ 

ပိုံမှာခပထာ်းသည်ေ့ အတ ိုင််း လမ််းဆိုံ နရာက ို Mouse ခဖင်ေ့ Left-Click 

တစ်ြေျက် နှ ပ် ပ်းလ ိုက်ပါ။ 

နှ ပ်လ ိုက်တာနဲဲ့ အဲေ  နရာ အတွက် X, Y map Coordinate တန်ဖ ို်း တွက ို 

ထညေ့်ဖ ိုို့ window တစ်ြေို  ပေါ်လာပါမည်။ ေ မှာ GPS နဲဲ့ တ ိုင််းထာ်းတာ 

ရှ ြေဲေ့လ ိုို့ရှ ရင် Option 1 နဲဲ့ 2 ခဖစ်တဲေ့ Latitude နှင်ေ့ Longitude တန်ဖ ို်း တွက ို 

ထညေ့် ပ်းရမည် ခဖစ်ပါတယ။် 
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အြေို တာေ့ reference လိုပ်ထာ်းတဲေ့  ခမပိုံဆ က နယူမှာ ခဖစ်တဲေ့အတွက် Option 2 ခဖစ်တဲေ့၊ From map Canvas က ို နှ ပ်လ ိုက်ပါ။ 

ေါဆ ိုရင် QGIS ရဲဲ့ map project ဆ က ို  ရာက်သွာ်းပါမယ်။ 

QGIS map project ထဲမှာ Satellite image နဲဲ့ လမ််းပိုံ ထဲက မ မ  reference လိုပ်လ ို သာ နရာက ို Zoom in လိုပ်လ ိုက်ပါ။ 

လမ််းဆိုံ နရာနာ်းက ို Left-Click တစ်ြေျက်နှ ပ် ပ်းလ ိုက်ပါ။ အဲေ  နရာရဲဲ့ X, Y Coordinate က ို map coordinate window က 

အလ ိုအ လျာက်ပဲ ဖမ််းယူပပ ်းနံပါတ်မျာ်းက ို ခပထာ်းပပ ်းသာ်း ခဖစ် နလ မ်ေ့မယ်။ 

 
ေ တစြ်ေါ OK က ို နှ ပ်ပပ ်း အမှတ်တစ်မှတ်အတွက် အဆိုံ်းသတ် ပ်းလ ိုက်ပါ။ 

Reference map နဲဲ့ မနတ လ်း  ခမပိုံ ပေါ်မှာ အြေိုမှထညေ့်ပပ ်းသွာ်းတဲေ့ အမှတ်အတွက် X, Y coordinate တန်ဖ ို်း တွ အသ ်းသ ်း စာသာ်းနဲဲ့ 

 ပေါ်လာလ မ်ေ့မယ်။ 

    
 အာက်နာ်းမှာ GCP  တွရဲဲ့ စာရင််းမျာ်းက ိုလည််း  ဖေါ်ခပထာ်းတာ  တွဲ့ရမည်။  နာက်တစမ်ှတ်အတွက် တူ သာ  နရာမျာ်းက ို 

အထက်က အဆင်ေ့လ ိုို့ပဲ တစြ်ေိုပပ ်းတစြ်ေို ဆက်မှတ်သွာ်းရ အာင်။ ေ လ ို sampling လိုပ်ရာမှာ random စနစ်က ို သိုံ်းဖ ိုို့ 

recommendation  ပ်းကကပါတယ်။ GCP မျာ်း ထညေ့်သွင််းပပ ်းသွာ်း သာ ပိုံမှာ  အာက်ပါ အတ ိုင််း ခဖစ်သည်။ 
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အမှတ် တ ွမှတ်ပပ ်းပပ ဆ ိုရင် အမှတ် တွက ို  နာက်တစ်ကက မ်မှာ ခပန်ပပ ်း ထိုတ်ယူ ဆန််းစစ်လ ိုို့ရ အာင် Georeferencer menu bar > 

File > Save GCP points as… နဲဲ့ အရင်ဆိုံ်း သ မ််းထာ်း ပ်းလ ိုက်ပါ။ 

 ခမပိုံက ို Referencing မလိုပ်ြေင် ဘယန်ည််းနဲဲ့ လိုပ်ရမှလဲဆ ိုတဲေ့ Transformation 

method က ို  ရွ်း ပ်းဖ ိုို့ လ ိုအပ်ပါတယ။် Georeferencer menu bar > Settings > 

Transformation Settings က ို သွာ်းလ ိုက်ပါ။ အဲေ မှာ 

Transformation type : Linear က ို ရွ်းလ ိုက်ပါ။ 

Resampling method : Nearest Neighbour က ို  ရွ်း ပ်းလ ိုက်ပါ။ 

GeoTiff file က ို လ ိုြေျင်ပါက Output raster က ို Browse လိုပ်လ ိုက်ပါ။ Default အရ 

၎င််း Input file ရှ  သာ  နရာတွင်ပင် မူလဖ ိုင် အမည် နာက်တွက် _modified.tif 

ဟူ သာ အမည်က ို ထညေ့် ပ်းထာ်းတတ်သည်။ ဤ နရာတွင် World file က ိုသာ 

အလ ိုရှ ပါက Create World file က ို Tic လိုပ် ပ်းထာ်း ပ်းလ ိုက်ပါ။ 

OK က ို နှ ပ်ပပ ်း ထွက်လ ိုက်ပါ။ 

က ဲ ခမပိုံက ို တကယ ်တည် နရာြေျဖ ိုို့ အတွက် Process က ို Run ရပါမည်။  

Georeferencer menu bar > File > Start georeferencer က ို နှ ပ်လ ိုက်ပါ။ 

က ိုယ် ရွ်းထာ်းတဲေ့ ouputfile အတ ိုင််း ဖ ိုင် အသစ်တစ်ြေို ရလာမည်။ GeoTiff file က ို 

 ရွ်းထာ်းပါက (mandalay_1914_modified.tif) ဟူ သာ ဖ ိုင်အသစ်တစ်ြေို 

ရလာပါမည်။ World file က ိုသာ  ရွ်းထာ်း သာ သူမျာ်းအတွက်၊ မနတ လ်း  ခမပိုံရှ တဲေ့ 

folder အထဲမှာ ၎င််း ခမပိုံအတွက် (mandalay_1914.wld) ဆ ိုတဲေ့ world file တြေို 

ရလာပါပပ ။ အဲေ   ခမပိုံက ို Mandalay Satellite image နဲဲ့ ထပ်လ ိုို့ ရသွာ်းပါပပ ။  နရာလွဲ နတာမျ  ြု်းရှ ြေဲေ့လ ိုို့ရှ ရင် GCP က ို 

ခပန် နရာ ရွဲ့ပပ ်း တာေ့ Georeference က ို ထပ်ပပ ်းခပြုလိုပ်န ိုင်ပါတယ်။ 

 
ေ လ ိုနည််းနဲဲ့ မ မ တ ိုို့ Georeferencing ခပြုလိုပ်ဖ ိုို့လ ို သာ scan  ခမပိုံမျာ်းက ို အလာ်းတူ ခပြုလိုပ် ပ်းန ိုင်ပါသည်။ ကဲ scan  ခမပိုံတစ်ြေိုက ို 

Georegistration ရှ သွာ်း အာင် လိုပ်တတ်ပပ ဆ ိုရင် ြေရ ်းဆက်ရ အာင်။ 

 

Satellite Image 

တကယ်တမ််းက တာေ့ Satellite Image က ို အဓ ကအာ်းခဖင်ေ့ Digital Analysis ခပြုလိုပ်ဖ ိုို့နှင်ေ့၊ Visual Interpreatation ခပြုလိုပ်ဖ ိုို့ပဲ 

ခဖစ်ပါတယ။် ရံဖန်ရံြေါမှာ တာေ့ အဲေ နည််းနဲဲ့ မလိုံ လာက်ဘူ်းဆ ိုရင် တာေ့ Satellite Image  ပေါ်မှာ Digitizing ခပြုခြေင််းခဖင်ေ့ Data က ို 
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Capture ခပြုလိုပ်န ိုင်ပါတယ။်  အာက်ပါ နမူနာမှာ Georegistration ခပြုလိုပ်ထာ်းတဲေ့ Satellite image အသိုံ်းခပြုပပ ်း Digitizing က ို 

နမူနာ အခဖစ် စမ််းသပ်ပပ ်း  ရ်းဆွဲ သွာ်းန ိုင်ပါသည်။  

 

6.3 Satellite Image က ို Base Map အ နခဖင်ေ့ အသိုံ်းခပြုခြေင််း 

QGIS ထဲမှာ Google map Layer က ို Base Map အ နနဲဲ့ အသိုံ်းခပြုပပ ်း Digitizing ခပြုလိုပ်န ိုင်ပါတယ်။ အဲသလ ို သိုံ်းြေျင်ရင် တာေ့ QGIS 

ထဲမှာ OpenLayer Plugin သ ိုို့မဟိုတ် quick map services က ို အရင်ဆိုံ်း Install ထည်ေ့ထာ်းဖ ိုို့ တာေ့ လ ိုပါမယ်။ ထည်ေ့ဖ ိုို့ရန် အတွက် 

 အာက်ပါ အဆင်ေ့မျာ်းအတ ိုင််း စတင်န ိုင်ပါတယ။် 

 

 
Plugins ထဲမှာ Quick map services ဆ ိုတာက ို Search text box ထဲမှာ ရ ိုက်ထညေ့်ပပ ်း ရှာကကည်ေ့လ ိုက်ပါ။ စာရင််းမျာ်း ကျလာပါမည်။ 

အဲေ  စာရင််း တွ အထဲက Quick map services ဆ ိုတာက ို Select လိုပ်ပပ ်း Install Plugin က ို နှ ပ်လ ိုက်ပါ။ 

 
Install လိုပ်ပပ ်းရင် ဖွင်ေ့ကကည်ေ့လ ိုို့ရပပ ။ Plugin  တွက ို အရင် ဖွင်ေ့ထာ်းလ ိုက်ပါ။ Plugin tab  အာက်ထဲက စာရင််းထဲမှာ 

 ပေါ်လာလ မ်ေ့မယ်။  

Main menu bar > Web > Quick map services က ို သွာ်းလ ိုက်ပါ။ 

quick map services က ို သိုံ်းပပ ်း တာေ့ ဖွင်ေ့န ိုင်တဲေ့ GeoSpatial Web Platform  တွက တာေ့ Google Map, Bing Map, Yahoo Map, 

Open Street Map နှင်ေ့ အခြော်း သာ Map Protocol မျာ်း ခဖစ်ကကပါတယ။် (Online data source က ို အသိုံ်းခပြုသူတ ိုို့အတွက် 

က ိုယ်ကကည်ေ့မည်ေ့ Computer Screen View ကက ်းရင် ကက ်းသလ ို Internet Connection ကလည််း ခမန်ဖ ိုို့ တာေ့ လ ိုပါမည်။ 

 ယြေို လေ့ကျငေ့်ြေန််းမှာ တာေ့ ရှ ထာ်းပပ ်း သာ Sentinel2 Image က ိုအသိုံ်းခပြုပပ ်း  လေ့ကျငေ့်သွာ်းပါမည်။  

Management Layer Tool Bar မ ှadd Raster က ို click လိုပ်ပါ။  
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Raster Dataset တွင်ရှ  သာ အစက်သိုံ်းစက် က ိုနှ ပ်ပပ ်း 

Training Data > Raster  အာက်တွင်ရှ  သာ 

မ မ အသိုံ်းခပြုလ ို သာ Data 

L1C_T46QHD_20200212T035859.tif က ို  ရွ်းပါ။ ပပ ်းလ င် 

add က ို click လိုပ်ပါ။  

 

ေါဆ ိုရင် Base map တစြ်ေို ရလာပါပပ ။ ေ  base map  ပေါ် 

အ ခြေြေံပပ ်း တာေ့ မ မ တ ိုို့ လ ိုြေျင် သာ information မျာ်းက ို 

digitizing နည််းနဲဲ့ Data  တွက ို capture လိုပ်လ ိုို့ ရန ိုင်ပါပပ ။ 

 

Digitizing ခပြုလိုပ်ရန်အတွက် အသိုံ်းခပြုမည်ေ့ Basic Tool 

မျာ်းမှာ 

 

Current Edits 

Toggle editing 

Adding Features: Capture Point 

Adding Features: Capture Line 

Adding Features: Capture Polygon 

Move Feature 

Node Tool 

Delete Selected 

Cut Features 

Copy Features 

Paste Features 

Save layer edits 

 

6.4 Snapping Distance 

Digitizing မခပြုလိုပ်ြေင် Digitizing ခပြုလိုပ်မည်ေ့ Layer တစ်ြေိုြေျင််းစ  အတွက် Snapping Tolerance မျာ်းက ို ကက ြုတင်ပပ ်း သတ်မှတ် 

ထာ်းရန် လ ိုအပ်ပါသည်။ ဥပမာ digitizing_polygon.shp ဟူ သာ GIS shapefile အသစ်တစ်ြေို အတွက် snapping option က ို 

ခပြုလိုပ်ပိုံက ို  ဖေါ်ခပထာ်းပါသည်။ digitizing_polygon.shp ဖ ိုင်က ို QGIS map project ထ ဲimport လိုပ်လ ိုက်ပါ။  

Main menu bar > Setting > က ို click လိုပ်ပါ။ option window  ပေါ်လာမည်။ Digitizing tab က ို click လိုပ်ပါ။ snapping 

နှငေ့်သက်ဆ ိုင် သာ အြေျက်မျာ်း မ မ သငေ့် တာ်သလ ို ခပငဆ်င်န ိုင်ပါသည်။  

ထ ို Option window အထဲတွင် editable ခဖစ် သာ layer မျာ်းက ို  ဖေါ်ခပထာ်းပါသည်။ ထ ို layer မျာ်း တစ်ြေိုြေျင််းစ  အတွက် Mode ၊ 

Tolerance နှင်ေ့ Units မျာ်းက ို  ရွ်း ပ်းရပါမည်။  

Tolerance – snapping distance  

Digitizing ခပြုလိုပ်ရာတွင ် Tolerance အကွာအ ဝ်းက ို 

ကက ြုတင်ပပ ်း၊ သတ်မှတ ်ပ်းရန ်လ ိုအပ်ပါသည်။ မ မ  Digitizing 

ခပြုလိုပ် သာ အြေါတွင် အမတှ်တစ်ြေိုက ို ြေျ သာ အြေါမျ  ြု်းတွင ်

Vertex ဟို ြေေါ် သာ feature မျာ်း  ကွဲ့ ကာက ်သာ အြေျ  ြု်း 

 နရာမျာ်း သ ိုို့မဟိုတ် အစနွ််းမျာ်းတငွ် ရှ နငှ်ေ့  နပပ ်းသာ်း 

ခဖစ ်သာ အန ်းစပ်ဆို်ံး Vertex တစြ်ေိုနငှ်ေ့ အလ ိုအ လျာက် 

လှမ််းပပ ်း ြေျ  တ်ဆက်န ိုင်  စရန် အတွက် ခဖစသ်ည်။ သတ်မှတ် 

ထာ်း သာ အကွာအ ဝ်းအတွင််းတငွ် ရှ ပါက ြေျ  တ်ဆက် 

 ပ်းမည်ခဖစပ်ပ ်း Tolerance အကွာအ ဝ်း၏ ခပင်ပတွင ်

 ရာကရ်ှ   နပါက မ မ  cursor အမတှ် ြေျထာ်း သာ 

 နရာတွင်သာ ၎င််းအမတှ်က ရှ  နပါမည်။ 

file:///D:/QGIS%20Tutorials/Editing_files/mActionAllEdits.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionToggleEditing.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionCapturePoint.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionCaptureLine.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionCapturePolygon.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionMoveFeature.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionNodeTool.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionDeleteSelected.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionEditCut.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionEditCopy.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionEditPaste.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionSaveEdits.png
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Mode စာရင််းမျာ်း အထဲက to vertex and segment က ို အမျာ်းအာ်းခဖင်ေ့  ရွ်း ပ်းန ိုင်ပါသည်။ 

ေ တစ်ြေိုက ို  ရွ်း ပ်းခြေင််းအာ်းခဖင်ေ့ vertex  တွအတွက် ရာ segment  တ ွအတွက်ပါ snapping 

က လှမ််းြေျ  တ် ပ်းပပ ်း အသိုံ်းခပြုလ ိုို့ ရသွာ်းတာ ပါို့။  

Units ဆ ို သာ snapping distance အတွက် map units နှင်ေ့ pixels စသည်ခဖင်ေ့ ရှ တဲေ့ အထဲက 

pixels က ို  ရွ်း ပ်းန ိုင်ပါသည်။  

 ရွ်းထာ်းတဲေ့ Units  ပေါ်မူတည်ပပ ်း တာေ့ Tolerance အကွာအ ဝ်း တန်ဖ ို်းက ို ဆက် ရွ်း ပ်းန ိုင်ပါသည်။ ဤ 

digitizing polygon အတွက် Units က ို pixels နှင်ေ့ ခပထာ်း သာ ကကာင်ေ့ pixel unit အ နခဖင်ေ့ 5 pixel ဟို 

Tolerance တန်ဖ ို်း  ပ်းထာ်းပါသည်။   

ေ မှာ ထည်ေ့ထာ်းတဲေ့ 5 pixel tolerance ရဲဲ့ အဓ ပပာယ်က digitizing လိုပ် နစဉ် က ိုယ်ြေျမည်ေ့ အမှတ်နှင်ေ့ ၅ pixel အကွာအ ဝ်း 

အတွင််းတွင် vertex မျာ်း ရှ ြေဲေ့ပါက ထ ို vertex က ို 

အလ ိုအ လျာက် လှမ််းပပ ်း ြေျ  တ်ဆက်ကာ 

ယူသွာ်းပါမည်။ မ မ  ဖွင်ေ့ထာ်း သာ map view ၏ scale 

အ နအထာ်း  ပေါ်တွင်လဲ မူတည်ပါသည်။ ေ ထက် 

ြေပ်ကျဲကျဲ လ ိုြေျင်လ ိုို့ရှ ရင် 10-20 pixel စသည်ေ့ခဖင်ေ့ 

တ ို်းသွာ်းပပ ်း တာေ့ စမ််းကကည်ေ့လ ိုို့ ရပါတယ။် ေ ထက်ပ ို 

အ သ်းစ တ်ြေျင်ရင် 3 pixel  လာက် စမ််းကကည်ေ့လ ိုို့ 

ရပါတယ။်   

 

 
အကယ်၍သာ Digitizing ခပြုလိုပ်မည်ေ့ Layer သည် WGS84/UTM Zone က ို အသိုံ်းခပြုထာ်းပပ ်း tolerance တွင် map unit က ို 

သိုံ်းထာ်းပါက 10 (meters) ၊ 20 (meters) စသည်ခဖင်ေ့ လ ိုအပ်သလ ို ညှ နှိုင််းပပ ်း ထညေ့်သွင််းန ိုင်ပါသည်။ 

အကယ်၍သာ Digitizing ခပြုလိုပ်မည်ေ့ layer သည် WGS84 Geographic Coordinate System က ို အသိုံ်းခပြုထာ်းပါက Tolerance 

တန်ဖ ို်း 0.00008983192 degree သည် အ  ကွတာ အန ်းတစ်ဝ ိုက်တွင် 10 မ တာနှင်ေ့ ည မ ပပ ်း 0.00089831924 degree သည် 

အကကမ််းအာ်းခဖင်ေ့ 100 မ တာ နှင်ေ့ ည မ ပါသည်။  

Digitize လိုပ်မည်ေ့ Layer မျာ်း အတွက် tolerance မျာ်းက ို သတ်မှတ် ပပ ်းပပ ဆ ိုရင် OK နှ ပ် ပ်းလ ိုက်ပါ။  

က ိုယ်ဆွဲြေျင်တဲေ့ Point, Line, Polygon ကက ြုက်နှစ်သက်ရာက ို Digitizing စဆွဲလ ိုို့ ရပါပပ ။ digitizing ခပြုလိုပ်ပိုံက ို  နာက်ပ ိုင််းမှာ 

ဆက်လက်  ဖေါ်ခပသွာ်းပါမယ်။ 

 

6.5 Digitizing Point 

Point အမျ  ြု်းအစာ်းအတွက်  ကျ်းရွာမျာ်းက ို နမူနာ အခဖစ် digitize လိုပ်ခပပါမည်။  ရှဲ့ဆက်မသွာ်းြေင် ထ ို Point အတွက် Attribute 

က ို ကက ြုတင်၍ စဉ််းစာ်း ထာ်းရန် လ ိုအပ်ပါသည်။ Digitizing လိုပ် နစဉ်မှာပင် လ ိုအပ် သာ Attribute မျာ်းက ို တစြ်ေါတည််း 

ထည်ေ့သွင််းသွာ်းန ိုင်ပါသည်။ ယြေို ရ ို်းရှင််းစွာ ခပသရန် အတွက် Attribute 3 ြေိုက ိုသာ ထည်ေ့သွင််းထာ်းပါသည်။ 

 

VillageName Household Population 

Pyawbwe 150 500 

Aung Su Pan 120 420 

Snapping tolerance က ိုသိုံ်းတာ ဘာအကျ  ြု်းရှ လဲ 

Tolerance က ို ခပြုလိုပ် ပ်းခြေင််းအာ်းခဖင်ေ့ Feature မျာ်း 

Digitizing ခပြုလိုပ်ရာတွင် ပ ိုမ ိုလွယ်ကူပါမည်။ အန ်းစပဆ်ို်ံး 

Vertex မျာ်းက ို လှမ််းယ ူသာ ကကာင်ေ့၊ Feature မျာ်းအကကာ်း 

 နရာဟပပ ်း ကျန် နခြေင််း၊  နရာမျာ်း တစြ်ေိုနငှ်ေ့တစြ်ေို 

ထပ် နခြေင််းတ ိုို့က ို  ရှာင်ရှာ်းန ိုင် သာ ကကာင်ေ့ topology 

ပ ိုမ ို၍ မှန်ကန်စွာခဖငေ့် ရရှ လာမည်။ 
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မ မ  ေတာတွင် Attribute မျာ်းစွာ ထာ်းမည်ေ့အကကံရှ ြေဲေ့ပါက Attribute database က ို သ ်းသန်ဲ့ထာ်းပပ ်း၊ Digitizing ခပြုလိုပ်ရာတွင် 

အ ရ်းပါသည်ေ့ Key တစ်ြေိုက ိုသာ ထည်ေ့သွင််းပပ ်း  ရ်းဆွဲပါက ပ ို၍ ခမန်ဆန်ပါမည်။ ခပန်ြေျ  တ်နည််းက ို  နာက်အြေန််းမျာ်းတွင် 

 လေ့လာသွာ်းပါမည်။ 

 

 အာက်ပါ Layer မျာ်းက ို QGIS ထဲသ ိုို့ Import လိုပ်လ ိုက်ပါ။ 

Township boundary 

Bago Village 

L1C_T46QHD_20200212T035859.tif 

Exe-04- Digitizing point ဟို QGIS project က ို Save လိုပ်လ ိုက်ပါ။ 

Symbology မျာ်းက ို  အာက်ပါ ပိုံအတ ိုင််း  ခပာင််း ပ်းလ ိုက်ပါ။ 

 
ပထမဆိုံ်း Digitizing Toolbar က ို ဖွင်ေ့ရန်လ ိုအပ်ပါသည်။ Menu bar  ပေါ်တွင် Right-click လိုပ်ပါ။ Tool 

bar တွင်ရှ  သာ Digitizing toolbar check box က ို အမှန်ခြေစ်လိုပ် ပ်းလ ိုက်ပါ။ 

Digitize ခပြုလိုပ်န ိုင်ရန် အတွက် Layer အသစ်တစ်ြေို ဖန်တ ်းပါမည်။  အာက်ပါအတ ိုင််း Layer အသစ်တစ်ြေို ဖန်တ ်း ပ်း န ိုင်ပါသည်။ 

 
Shape file အသစ်တွင် File name  နရာတွင် မ မ  ပ်းလ ို သာ Name က ို ရ်းပါ။ File Encoding  နရာ တွင် UTF8 က ို ရွ်းပါ။ 

shapefile type အတွက် 'Point' နှင်ေ့ CRS (Coordinate Reference System) အတွက်'EPSG4326 – WGS 84' က ို  ရွ်း ပ်းလ ိုက်ပါ။ 

File name  နရာတွင် မ မ ထာ်းလ ို သာ folder က ို ရွ်းပပ ်း file Name  ရ်း ပ်းပါ။ 

 
New attribute အတွက် အထက်တွင် ကက ြုတင် လျာထာ်း သာ Attribute table က ို Field name မျာ်း ထည်ေ့ ပ်းရပါမည်။ ေ မှာ 

အ ရ်းကက ်းတာက Field တစ်ြေိုခြေင််းစ ရဲဲ့ Data type နဲဲ့ ၎င််းတ ိုို့ရဲဲ့ width တ ိုို့ပဲ ခဖစ်ပါတယ။် 

VillageName Field အတွက် ထည်ေ့ပိုံမှာ  အာက်ပါပိုံ အတ ိုင််း ခဖစ်ပါတယ။် 

Name: VillageName 

Type: text 

Width: 80 
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Field တစ်ြေိုအတွက် သတ်မှတ်ပပ ်းတ ိုင််းမှာ Add to attributes list က ို ဆက်၍ နှ ပ် ပ်းလ ိုက်ပါ။ 

 နာက်ထပ်ရှ  သ်းတဲေ့ Field  တွက ို ဆက်ထည်ေ့ ပ်းလ ိုက်ပါ။ 

Name: Population 

Type: =Whole number 

Width: 10 

 

Attribute အတွက် လ ိုအပ် သာ Field မျာ်းထည်ေ့ပပ ်း ပိုံပါအတ ိုင််း 

 တွဲ့ရပါမည်။ 

OK နှ ပ်ပပ ်း  သာအြေါ QGIS project ထဲသ ိုို့ 'myVillage' နာမည်နဲဲ့ 

shapefile တစ်ြေို ပေါ်လာပါမည်။ သူို့အထဲမှာ တာေ့ Frame 

ပဲရှ မယ်။ ဘာ entry မ ှမထည်ေ့ ပ်းရ သ်းဘူ်း။ ေါ ပမယ်ေ့ Symbol 

က ို ကက ြု ခပာင််း ပ်းလ ိုို့ ရပါတယ။် 

 
Digitizing စလိုပ်ဖ ိုို့ရန် အတွက် 'myVillage'ဆ ိုတေဲ့ layer  ပေါ်က ို select လိုပ် ပ်းထာ်းပပ ်း   Toggle editing ဆ ိုတဲေ့ tool က ို 

ဖွင်ေ့ ပ်းလ ိုက်ပါ။ 

 

ဖွင်ေ့ပပ ်းပါက Toggle editing tool က active ခဖစ်လာပါမည်။ 

 

 ကဲစဆွဲရ အာင်    Adding Features: Capture 

Point က ို နှ ပ်လ ိုက်ပါ။ 

 

file:///D:/QGIS%20Tutorials/Editing_files/mActionCapturePoint.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionToggleEditing.png
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 ခမပိုံ ပေါ်မှာ Pan Map ၊ Zoom In စသည်တ ိုို့က ို သိုံ်းပပ ်း က ိုယ် digitize လိုပ်မည်ေ့  နရာနာ်းက ို သွာ်းပါ။ Pan Map နဲဲ့ Add Point 

Feature တ ိုို့က ို အခပန်ခပန် အလှန်လှန် အသိုံ်းခပြုပပ ်း  ခမပိုံ ပေါ်တွင် လ ိုြေျင် သာ  နရာက ို သွာ်းန ိုင်ပါသည်။  

 ခမပိုံ ပေါ်တွင် mouse ခဖင်ေ့ အစက်ြေျြေျင် သာ  ကျ်းရွာ နရာ ပေါ်တွင် 

click လိုပ်လ ိုက်ပါ။ ၎င််း Point အတွက် Attribute ထည်ေ့ရန် window 

တစ်ြေို  ပေါ်လာပါမည်။ 

၎င််း Point အတွက် လ ိုအပ် သာ Attribute က ို ခဖည်ေ့ ပ်းလ ိုက်ပါ။ 

ပပ ်းလ င် OK က ို ဆက်နှ ပ်လ ိုက်ပါ။ 

ဤ layer က ိုဖွင်ေ့ထာ်းပါက  ခမပိုံ ပေါ်တွင် Point  ပေါ်လာပါလ မ်ေ့မည်။ 

၎င််းရဲဲ့ Attribute က ို ဖွင်ေ့ကကည်ေ့ပပ ်း စူ်းစမ််းန ိုင်ပါသည်။ 

 
 

Digitizing လိုပ် နစဉ် မကကာြေဏ Save layer edits က ို နှ ပ် ပ်းပပ ်း သ မ််း ပ်းရန်အထူ်းလ ိုအပ်ပါသည်။ 

ဤကဲေ့သ ိုို့ သာ နည််းမျာ်းခဖင်ေ့ Point မျာ်းက ို ဆက်ပပ ်း ထည်ေ့သွာ်း ပ်းလ ိုက်ပါ။ 

 
 

Digitizing က ို ရပ်ဖ ိုို့ရန်အတွက်    Toggle editing ဆ ိုတဲေ့ tool က ို တစ်ြေျက် ထပ်နှ ပ်  ပ်းလ ိုက်ပါ။  

Point  တွက ို  နရာ ရ ဲ့ြေျင်သလာ်း။ Vertex tool က ို သိုံ်းန ိုင်ပါသည်။ Point တစ်ြေျ  ြု လာက် စမ််း ရ ဲ့ကကည်ေ့ပါလာ်း။ 

Entry  တွက ို ဖျက်ြေျင်သလာ်း။ ဖျက်ြေျင် သာ entry က ို select လိုပ်ပပ ်း delete က ို နှ ပ် ပ်းလ ိုက်ပါ။ 

 

file:///D:/QGIS%20Tutorials/Editing_files/mActionToggleEditing.png
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6.6 Digitizing Line 

Line အမျ  ြု်းအစာ်းအတွက် ခမစ် ြေျာင််းမျာ်းက ို နမူနာ အခဖစ် digitize လိုပ်ခပပါမည်။  ရှဲ့ဆက်မသွာ်းြေင် Layer အတွက် Attribute 

က ို ကက ြုတင်၍ စဉ််းစာ်းထာ်းရန် လ ိုအပ်ပါသည်။ Digitizing လိုပ် နစဉ်မှာပင် လ ိုအပ် သာ Attribute မျာ်းက ို တစြ်ေါတည််း 

ထည်ေ့သွင််းသွာ်းန ိုင်ပါသည်။ ယြေိုရ ို်းရှင််းစွာ ခပသရန် အတွက် Attribute ၂ ြေိုက ိုသာ ထည်ေ့သွင််း ထာ်းပါသည်။ 

River Type 

Bago River Major Road 

Ngamoeyeik Chaung Major Road 

 

 အာက်ပါ Layer မျာ်းက ို QGIS ထဲသ ိုို့ Import လိုပ်လ ိုက်ပါ။ 

Township boundary 

Bago Village 

Yangon Village 

L1C_T46QHD_20200212T035859.tif 

Exe-04- Digitizing Line ဟို QGIS project က ို Save လိုပ်လ ိုက်ပါ။ 

Symbology မျာ်းက ို  အာက်ပါ ပိုံအတ ိုင််း  ခပာင််း ပ်းလ ိုက်ပါ။ 

ပထမဆိုံ်း Digitizing Toolbar က ို ဖွင်ေ့ရန်လ ိုအပ်ပါသည်။ Menu bar  ပေါ်တွင် Right-click လိုပ်ပါ။ 

tool bar တွင်ရှ  သာ Digitizing toolbar check box က ို အမှန်ခြေစ်လိုပ် ပ်းလ ိုက်ပါ။ 

Digitize ခပြုလိုပ်န ိုင်ရန် အတွက် Layer အသစ်တစ်ြေို ဖန်တ ်းပါမည်။  အာက်ပါအတ ိုင််း Layer အသစ်တစ်ြေို ဖန်တ ်း ပ်း န ိုင်ပါသည်။ 

 
Shape file အသစ်တွင် File name  နရာတွင် မ မ  ပ်းလ ို သာ Name က ို ရ်းပါ။ File Encoding  နရာ တွင် UTF8 က ို ရွ်းပါ။ 

shapefile type အတွက် 'Line' နှင်ေ့ CRS (Coordinate Reference System) အတွက်'EPSG4326 – WGS 84' က ို  ရွ်း ပ်းလ ိုက်ပါ။ 

File name  နရာတွင် မ မ ထာ်းလ ို သာ folder က ို ရွ်းပပ ်း file Name  ရ်း ပ်းပါ။ 

 
New attribute အတွက် အထက်တွင် ကက ြုတင်လျာထာ်း သာ Attribute table က ို Field name မျာ်း ထည်ေ့ ပ်းရပါမည်။ ေ မှာ 

အ ရ်းကက ်းတာက Field တစ်ြေိုခြေင််းစ ရဲဲ့ Data type နဲဲ့ ၎င််းတ ိုို့ရဲဲ့ width တ ိုို့ပဲ ခဖစ်ပါတယ။် 

RiverName အတွက် ထည်ေ့ပိုံမှာ  အာက်ပါပိုံ အတ ိုင််း ခဖစ်ပါတယ်။  

Name: River 

Type: text 
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Width: 80 

OK နှ ပ်ပပ ်း ဆက်သွာ်းပါ။ 

တစ်ြေိုအတွက် သတ်မှတ်ပပ ်းတ ိုင််းမှာ Add to Fields 

list က ို ဆက်၍ နှ ပ် ပ်းလ ိုက်ပါ။ 

 နာက်ထပ်ရှ  သ်းတဲေ့ Field  တွက ို ဆက်ထည်ေ့ 

 ပ်းလ ိုက်ပါ။ 

Name: Type 

Type: =Text 

Width: 80 

OK နှ ပ်ပပ ်း ဆက်သွာ်းပါ။ 

OK နှ ပ်ပပ ်း  သာအြေါ QGIS project ထဲသ ိုို့ 'River' နာမည်နဲဲ့ shapefile တစ်ြေို ပေါ်လာပါမည်။ သူို့အထဲမှာ တာေ့ Frame ပဲရှ မယ်။ 

ဘာ entry မ ှမထည်ေ့ ပ်းရ သ်းဘူ်း။ ေါ ပမယ်ေ့ Symbol က ို ကက ြု ခပာင််း ပ်းလ ိုို့ ရပါတယ။် 

Digitizing စလိုပ်ဖ ိုို့ရန် အတွက် 'river' ဆ ိုတဲေ့ layer က ို select လိုပ်ထာ်းပပ ်း   Toggle editing ဆ ိုတဲေ့ tool က ို ဖွင်ေ့ ပ်းလ ိုက်ပါ။ 

 
ဖွင်ေ့ပပ ်းပါက Toggle editing tool က active ခဖစ်လာပါမည်။ 

 

Adding Features: Capture Line က ို နှ ပ်ပပ ်း 

စဆွဲလ ိုို့ရပါပပ ။ 

 ခမပိုံ ပေါ်မှာ Pan Map ၊ Zoom In စသည်တ ိုို့က ို သိုံ်းပပ ်း 

က ိုယ် digitize လိုပ်မည်ေ့  နရာနာ်းက ို သွာ်းပါ။ Pan Map နဲဲ့ Add Feature တ ိုို့က ို အခပန်ခပန် အလှန်လှန် အသိုံ်းခပြုပပ ်း  ခမပိုံ ပေါ်တွင် 

လ ိုြေျင် သာ  နရာက ို သွာ်းန ိုင်ပါသည်။  

 ခမပိုံ ပေါ်တွင် mouse ခဖင်ေ့ ြေျ  န်ထာ်းပပ ်း အစက်ြေျြေျင် သာ  နရာ ပေါ်တွင် click 

လိုပ်လ ိုက်ပါ။  နာက် ဆက်ပပ ်း တာေ့ အ ကွဲ့အ ကာက်ရှ တ ိုင််း အစက် တစ်စက်စ  

ြေျသွာ်း ပ်းပါ။  

Line တစ်ြေို၏ အဆိုံ်းက ို  ရာက်ပပ ်းဆ ိုပါက Right-click က ို နှ ပ် ပ်းလ ိုက်ပါ။ 

၎င််း Line feature အတွက် Attribute ထည်ေ့ရန် window တစ်ြေို  ပေါ်လာပါမည်။ 

file:///D:/QGIS%20Tutorials/Editing_files/mActionCaptureLine.png
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၎င််း feature အတွက် လ ိုအပ် သာ  ြေျာင််းအမည်၊ 

ခမစ်အမည် က ို Attribute မှာ  ရ်းခဖည်ေ့ ပ်းလ ိုက်ပါ။ 

ပပ ်းလ င် OK က ို ဆက်နှ ပ်လ ိုက်ပါ။ 

ဤ layer က ိုဖွင်ေ့ထာ်းပါက  ခမပိုံ ပေါ်တွင် မ မ  

ဆွဲထာ်း သာ Line  ပေါ်လာပါလ မ်ေ့မည်။ ၎င််းရဲဲ့ 

Attribute က ို ဖွင်ေ့ကကည်ေ့ပပ ်း စူ်းစမ််းန ိုင်ပါသည်။ 

Digitizing လိုပ် နစဉ် မကကာြေဏ Save layer edits 

က ို နှ ပ် ပ်းပပ ်း သ မ််း ပ်းရန် အထူ်းလ ိုအပ်ပါသည်။ 

ဤကဲေ့သ ိုို့ သာ နည််းမျာ်းခဖင်ေ့ အခြော်း Line မျာ်းက ို 

ဆက်ပပ ်း ထည်ေ့သွာ်း ပ်းလ ိုက်ပါ။ 

 

Digitizing က ို ရပ်ဖ ိုို့ရန်အတွက်    Toggle editing ဆ ိုတဲေ့ tool က ို တစ်ြေျက် ထပ်နှ ပ်  ပ်းလ ိုက်ပါ။  

Line ထဲက အြေျ  ြု်းအ ကွဲ့ တစြ်ေျ  ြုဲ့က ို ခပင်ြေျင်ပါက    Node Tool က ို သိုံ်းပပ ်း  ရ ဲ့ ပ်းန ိုင်ပါသည်။ တစ်ြေို လာက် ထပ်ပပ ်း 

 ရ ဲ့ကကည်ေ့လ ိုက်ပါလာ်း။ 

Line တစ်ြေိုလိုံ်းက ို  နရာ ရ ဲ့ြေျင်သလာ်း။    Move feature tool က ို သိုံ်းပပ ်း  ရ ဲ့န ိုင်ပါသည်။ တစ်ြေို လာက် 

စမ််း ရ ဲ့ကကည်ေ့ပါလာ်း။ 

Entry  တွက ို ဖျက်ြေျင်သလာ်း။ ဖျက်ြေျင် သာ entry က ို select လိုပ်ပပ ်း delete က ို နှ ပ် ပ်းလ ိုက်ပါ။ 

 

6.7 Digitizing Polygon 

For township boundary and village tract boundary 

For water feature (body) 

For forest area feature 

For agriculture land, etc. 

Polygon အမျ  ြု်းအစာ်းအတွက် ခမစ် ြေျာင််းမျာ်း၏ area က ို နမူနာ အခဖစ် digitize လိုပ်ခပပါမည်။  ရှဲ့ဆက်မသွာ်းြေင် Layer အတွက် 

Attribute က ို ကက ြုတင်၍ စဉ််းစာ်းထာ်းရန် လ ိုအပ်ပါသည်။ Digitizing လိုပ် နစဉ်မှာပင ်လ ိုအပ် သာ Attribute မျာ်းက ို တစြ်ေါတည််း 

ထည်ေ့သွင််းသွာ်းန ိုင်ပါသည်။ ယြေို ရ ို်းရှင််းစွာ ခပသရန် အတွက် Attribute ၂ ြေိုက ိုသာ ထည်ေ့သွင််းထာ်းပါသည်။ 

 

 အာက်ပါ Layer မျာ်းက ို QGIS ထဲသ ိုို့ Import လိုပ်လ ိုက်ပါ။ 

Township boundary 

Bago Village 

Yangon Village 

L1C_T46QHD_20200212T035859.tif 

exe - Digitizing Polygon ဟို QGIS project က ို Save လိုပ်လ ိုက်ပါ။ Symbology မျာ်းက ို  အာက်ပါ ပိုံအတ ိုင််း 

 ခပာင််း ပ်းလ ိုက်ပါ။ 

Digitize ခပြုလိုပ်န ိုင်ရန် အတွက် Layer အသစ်တစ်ြေို ဖန်တ ်းပါမည်။  အာက်ပါ အတ ိုင််း Layer အသစ်တစ်ြေို ဖန်တ ်း ပ်းပါ။ 

 

file:///D:/QGIS%20Tutorials/Editing_files/mActionToggleEditing.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionNodeTool.png
file:///D:/QGIS%20Tutorials/Editing_files/mActionMoveFeature.png
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Shape file အသစ်တွင် File name  နရာတွင် မ မ  ပ်းလ ို သာ Name က ို ရ်းပါ။ File Encoding  နရာ တွင် UTF8 က ို ရွ်းပါ။ 

shapefile type အတွက် 'Polygon' နှင်ေ့ CRS (Coordinate Reference System) အတွက် 'EPSG4326 – WGS 84' က ို  ရွ်း ပ်း 

လ ိုက်ပါ။ 

 

New attribute အတွက် အထက်တွင် ကက ြုတင်လျာထာ်း သာ 

Attribute table က ို Field name မျာ်း ထညေ့် ပ်းရပါမည်။ ေ မှာ 

အ ရ်းကက ်းတာက Field တစ်ြေိုခြေင််းစ ရဲဲ့ Data type နဲဲ့ ၎င််းတ ိုို့ရဲဲ့ 

width တ ိုို့ပဲ ခဖစ်ပါတယ်။ 

RiverName အတွက် ထည်ေ့ပိုံမှာ  အာက်ပါ ပိုံအတ ိုင််း 

ခဖစ်ပါတယ။်  

Name: River 

Type: text 

Width: 80 

Field တစ်ြေိုအတွက် သတ်မှတ်ပပ ်းတ ိုင််းမှာ Add to attributes 

list က ို ဆက်၍ နှ ပ် ပ်းလ ိုက်ပါ။ 

 နာက်ထပ်ရှ  သ်းတဲေ့ Field  တွက ို ဆက်ထည်ေ့ ပ်းလ ိုက်ပါ။ 

Name: Type 

Type: =Text 

Width: 80 

OK နှ ပ်ပပ ်း ဆက်သွာ်းပါ။ 

QGIS project ထဲသ ိုို့ 'Waterbody' နာမည်နဲဲ့ shapefile တစ်ြေို ပေါ်လာပါမည်။ သူို့အထဲမှာ တာေ့ Frame ပဲရှ မယ်။ ဘာ entry မှ 

မေ့ထည်ေ့ ပ်းရ သ်းဘူ်း။ ေါ ပမယ်ေ့ Symbol က ို ကက ြု ခပာင််း ပ်းလ ိုို့ ရပါတယ။် 

Digitizing စလိုပ်ဖ ိုို့ရန် အတွက် 'Waterbody' ဆ ိုတဲေ့ layer က ို select 

လိုပ်ထာ်းပပ ်း   Toggle editing ဆ ိုတဲေ့ tool က ို ဖွင်ေ့ ပ်းလ ိုက်ပါ။ 

ဖွင်ေ့ပပ ်းပါက Toggle editing tool က active ခဖစ်လာပါမည်။ 

 

 

 

 

 

file:///D:/QGIS%20Tutorials/Editing_files/mActionToggleEditing.png
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စဆွဲရန်အတွက် Adding Features:  Capture 

Polygon က ို နှ ပ်လ ိုက်ပါ။ 

 ခမပိုံ ပေါ်တွင် mouse ခဖင်ေ့ ြေျ  န်ထာ်းပပ ်း၊ အစက်ြေျ 

ြေျင် သာ  နရာ ပေါ်တွင် click လိုပ်လ ိုက်ပါ။ 

 နာက်ဆက်ပပ ်း တာေ့ အ ကွဲ့အ ကာက်ရှ တ ိုင််း အစက် 

တစ်စက်စ  ြေျသွာ်း ပ်းပါ။  

Polygon တစ်ြေို၏ အပ တ် နရာ အဆိုံ်းက ို  ရာက်ပပ ်း 

ဆ ိုပါက Right-click က ို နှ ပ် ပ်းလ ိုက်ပါ။ 

 

၎င််း feature အတွက် Attribute ထည်ေ့ရန် window 

တစ်ြေို  ပေါ်လာပါမည်။ 

၎င််း feature အတွက် လ ိုအပ် သာ Attribute က ို ခဖည်ေ့ ပ်းလ ိုက်ပါ။ ဥပမာ  

Ayeyarwady River 

ပပ ်းလ င် OK က ို ဆက်နှ ပ်လ ိုက်ပါ။ 

ဤ layer က ိုဖွင်ေ့ထာ်းပါက  ခမပိုံ ပေါ်တွင် မ မ ဆွဲထာ်း သာ Polygon 

 ပေါ်လာပါလ မ်ေ့မည်။ ၎င််းရဲဲ့ Attribute က ို ဖွင်ေ့ကကည်ေ့ပပ ်း စူ်းစမ််းန ိုင်ပါသည်။ 

 ခမပိုံ ပေါ်မှာ Pan Map ၊ Zoom In စသည်တ ိုို့က ို သိုံ်းပပ ်း က ိုယ် digitize လိုပ်မည်ေ့  နရာနာ်းက ို သွာ်းပါ။ Pan Map နဲဲ့ Add Feature 

တ ိုို့က ို အခပန်ခပန် အလှန်လှန် အသိုံ်းခပြုပပ ်း  ခမပိုံ ပေါ်တွင် လ ိုြေျင် သာ  နရာက ို သွာ်းန ိုင်ပါသည်။ 

 

6.8 Advanced Digitizing 

Digitizing ခပြုလိုပ်ရန် အတွက် Menu bar > Right-Click > Advanced Digitizing tool 

က ိုဖွင်ေ့ထာ်းပါ။. 

 

 

Advanced Digitizing Toolbar အသစ်တစ်ြေို  ပေါ်လာသလ ို Edit menu 

 အာက်တွင်ရှ  သာ Commandမျာ်း active ခဖစ်လာပါမည်။ ဤ tool မျာ်းတွင် GIS feature မျာ်းက ို  ပါင််းခြေင််း၊ ခဖတ်ခြေင််း၊ 

အသစ်ထည်ေ့ခြေင််း၊ ပိုံစံအမျ  ြု်းမျ  ြု်းခဖင်ေ့ အသစ်ထည်ေ့ခြေင််း၊ ပိုံစံအမျ  ြု်းမျ  ြု်းနှင်ေ့ edit ခပြုလိုပ်ခြေင််း စသည်တ ိုို့ ခပြုလိုပ်န ိုင်ရန် ပါရှ ပါသည်။ 

 

6.8.1 Simply feature 

Feature မျာ်းက ို အကကမ််းဖျင််းပို ံ လာက်သာ ခပြေျင်ပါက အသိုံ်းခပြုပါသည်။  

Select feature part Edit > Simplifying feature by selecting the tolerance. 

Feature မျာ်း ြေွဲစ တ်ရန် အတွက် Split Features က ို အသိုံ်းခပြုပိုံ 
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ခဖတ်ြေျင် သာ Feature (line, polygon) က ို select လိုပ်ထာ်း ပ်းပါ။  

Menu bar > Edit > Split Features က ို  ရွ်း ပ်းလ ိုက်ပါ။  

ခဖတ်မည်ေ့ line က ို Polygon  ပေါ်  ကျာ်သွာ်း အာင် ခဖတ်ဆွဲ ပ်းလ ိုက်ပါ။ 

Feature မျာ်း  ပါင််းရန် အတွက် Merge Features က ို အသိုံ်းခပြုပိုံ 

Merge လိုပ်ြေျင် သာ feature မျာ်းက ို select လိုပ်ထာ်းပါ။ 

Menu bar > Edit > Merge Selected Features က ိုနှ ပ်ပါ။ 

 

ေ  နရာမှာ ဘယ ် တစ်ြေိုဆ က Attribute က ို ယူမလဲဆ ိုတာက ို သတ ထာ်းပပ ်း တာေ့ 

 ရွ်း ပ်းဖ ိုို့ လ ိုပါတယ။်  

ဥပမာ  ပိုံ-၁ အရ  အ အမည်ရှ  Feature က ို နှ ပ်ပပ ်း Take attribute from selected 

feature က ို နှ ပ်လ ိုက်ပါက၊ ရလာမည်ေ့ ပိုံသည် Feature  အ ဆ က Attribute နှင်ေ့ 

ခဖစ် နမည်။  

   

ထ ိုကဲေ့သ ိုို့ မဟိုတ်ပဲ အခြော်း သာ feature ဆ က Attribute က ို  ခပာင််းပပ ်း ရယူြေျင်ပါက။ 

ဥပမာ ၊ ပိုံ-၂ အရ ဘ  အမည်ရှ  Feature က ို နှ ပ်ပပ ်း၊ Take attribute from selected 

feature က ို နှ ပ်လ ိုက်ပါက၊ ရလာမည်ေ့ ပိုံသည် အမည်ရှ  Feature ဘ  ဆ က Attribute 

နှင်ေ့ ခဖစ် နမည်။ 

 

OK က ို ဆက်နှ ပ် ပ်းပပ ်း၊ feature က ို  ပါင််း ပ်းလ ိုက်ပါ။ 

 
ေ  နရာမှာ Feature တစ်ြေိုတည််း ခဖစ်သွာ်းရင် တာေ့ Polygon  တွ ကကာ်းက မျဉ် ကကာင််း လ်း  ပျာက်သွာ်းမယ်။ 

Feature ၂ ြေို အ နနဲဲ့ Multi-part feature (နှစ်က ိုယ်ေ့ တစ်စ တ်) ခဖစ် နရင် တာေ့ ကကာ်းက လ ိုင််းက ရှ  နမယ်။  

 

6.8.2 Node Tool က ို အသိုံ်းခပြုပိုံ 

Polygon, Line မျာ်း၏ အနာ်းမျဉ််း ကကာင််း မျာ်းက ို ခပငဆ်င်ညှ န ိုင််းရန်အတွက် အမျာ်းဆိုံ်း 

သိုံ်းပါသည်။  

Editing Tool မျာ်းထဲမှ Node Tool က ို  ရွ်းလ ိုက်ပါ။ 

ခပငြ်ေျင် သာ Polygon ၏ အနာ်းမျဉ််း  ပေါ်သ ိုို့ Mouse ခဖင်ေ့ တစ်ြေျက် 

Click လိုပ် ပ်းလ ိုက်ပါ။ အနာ်းမျဉ််းတစ ်လျာက ်ရှ  န သာ Vertex  ြေေါ် Node 

မျာ်း  ပေါ်လာပါမည်။  

ခပငြ်ေျင် သာ Node  ပေါ်က ို Left Click တစြ်ေျက် လိုပ်လ ိုက်ပါ။ ေါဆ ို 

ရင် အဲေ  Node က Active ခဖစ်လာပပ ်း၊ အခပာ ရာင် ခပ နပပ ်း တာေ့ ခပင်ဆင်ရန် အဆင်သင်ေ့ ခဖစ်ပါပပ ။  

Node တစြ်ေိုက ို  နရာ ရွဲ့ြေျင်ပါက ဘယည်ာ အထက်  အာက် ကက ြုက်ရာ  နရာက ို တွန််း ရွဲ့လ ိုို့ 

ရပါပပ ။ Node  ပေါ်မှာ မဟိုတ်ပဲ၊ မျဉ််း ပေါ်က ို တွန််းပါက  ဘ်းက Node ၂ ြေိုလိုံ်း နဲဲ့ ဆက် နတဲေ့ အခြေမ််း 

လ ိုက် ရွဲ့သွာ်းလ မ်ေ့မည်။  

Node တစြ်ေိုက ို ဖျက်ြေျင်ပါက Node  ပေါ်က ို တင်ပပ ်း တာေ့ Delete က ို နှ ပ်လ ိုက်ပါ။ အဲေ  Active 

ခဖစ် နတဲေ့ အခပာ ရာင် Node တစ်ြေို ပျက်သွာ်းလ မ်ေ့မည်။ ေ နည််းနဲဲ့ လည််း မလ ိုြေျင်တာက ို တစြ်ေိုပပ ်းတစ်ြေို 

ဆက်ပပ ်း ဖျက်သွာ်းလ ိုို့ ရတယ်။  

Node အသစ် တစြ်ေို ထပ်ထညေ့်ြေျင်ပါက ထညေ့်ြေျင် သာ  နရာ လ ိုင််း ပေါ်တည်ေ့တည်ေ့မှာ Mouse 

နဲဲ့ Double-Click လိုပ် ပ်းလ ိုက်ပါ။ Node အသစ်ရလာပါမည်။ ေ နည််းနဲဲ့  ရ်းဆွပဲပ ်းသာ်း ပိုံ တွက ို 

ခပန်ညှ လ ိုို့ ရပါတယ်။ လ ိုအပ်တ ိုင််း၊ ဉာဏ်ရှ သလ ို အသိုံ်းခပြုကက လ တာေ့။ 
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6.8.3 Add Ring 

 ဘ်းပတ်ဝန််းကျင် နှင်ေ့ မတူ သာ အရာ အတွက် ဆွဲသည်။ အ ပါက်  ဖါက်ပစ်လ ိုက်တာ။ 

ဥပမာ- ပတ်ဝန််းကျင်က ကိုန််း ခမ ပေါ် ခဖစ်ပပ ်း အလယ်က အခြော်း သာ ကိုန််း ခမမဟိုတ်သည်ေ့ အရာက ို  ရ်းဆွဲရန် အတွက် သိုံ်းသည်။  

Select feature part 

Edit >Add Ring 

Draw a new small polygon inside an existing big polygon 

Island in lake 

Lake in land 

 

6.8.4 Delete Ring (Add Ring ၏ ဆန်ဲ့ကျင်ဖက်) 

 ဘ်းပတ်ဝန််းကျင် နှင်ေ့ တူသွာ်း အာင် အ ပါက်က ို ခဖည်ေ့ ပ်းလ ိုက်တာ။ 

ဥပမာ- ပတ်ဝန််းကျင်က ကိုန််း ခမ ပေါ် ခဖစ်ပပ ်း အလယ်က အခြော်း သာ ကိုန််း ခမမဟိုတ်သည်ေ့ အရာ ခဖစ် နသည်က ို  ခမဖ ိုို့ 

ပစ်လ ိုက်ပပ ်း တာေ့ အကိုန်လိုံ်း ကိုန််း ခမ ခဖစ် အာင် လိုပ်တာ။  

Select feature part 

Edit > Delete Ring 

Fill polygon သ ဘာမျ  ြု်း 

5.15. Rotate Feature  

သူက တာေ့ လှည်ေ့ဖ ိုို့ အတွက် သိုံ်းတယ။် 

 

6.8.5 Add Part  

သူက တာေ့ Attribute တစြ်ေိုတည််း Feature နှစ်ြေိုထက်မက ရှ  သာ multipart မျ  ြု်း သ ဘာခဖစ်မည်။  

မူလ Feature Polygon က ို  ရွ်း ပ်း။ 

Edit > Add Part 

ထပ်တ ို်းြေျင် သာ Polygon တစ်ြေို ထပ်ဆွဲလ ိုက်ပါ။ 

ေ  Add Part နဲဲ့ ဆွရဲင် Attribute က ထပ်မတ ို်းလာဘူ်း နာ်။ နှစ်က ိုယ်ေ့ တစ်စ တ် ပါို့ လ။ 

 

6.8.6 Delete Part (Add Part ၏ ဆန်ဲ့ကျင်ဖက်) 

သူက တာေ့ Attribute တစ်ြေိုတည််း Feature နှစ်ြေိုထက်မက ရှ  သာ multipart က ို၊ feature part တစ်ြေိုြေိုက ို 

ပယ်ဖျက်ပစ်တာမျ  ြု်း ပါို့။ အပ ိုင််း လ်း တစ်ြေို က ို ခဖတ်ပစ်လ ိုက်တာမျ  ြု်း ပါို့။  

Edit > Delete Part 

ဖျက်ြေျင် သာ Feature  ပေါ် Click လိုပ် ပ်းလ ိုက်ပါ။ ပျက်သွာ်းလ မ်ေ့မယ်။  

ေ  Delete Part နဲဲ့ ဖျက် ရင် Attribute က မပျက်သွာ်းဘူ်း။ တစ်စ တ်ပဲ ပျက်သွာ်းမယ။် ဖဲေ့ပပ ်း ဖျက်လ ိုက်တာ။ (Delete က 

အာ်းလိုံ်းပျက်သွာ်းတာ) 

 

6.8.7 Cut Features 

 ခဖတ်ပပ ်း တာေ့ တ နရာမှာ သွာ်းထညေ့်ဖ ိုို့ သ ိုို့မဟိုတ ်လိုံ်းဝခဖတ်ထိုတ်ဖ ိုို့။ မူရင််းက တာေ့ ပျက်သွာ်းမယ်။  

 

6.8.8 Copy Features 

ကူ်းပပ ်း တာေ့ တ နရာမှာ သွာ်းထညေ့်ဖ ိုို့။ မူလ feature က မပျက်သွာ်းဘူ်း။ 
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6.8.9 Paste Features 

 တ နရာက န ကူ်းပပ ်း လာ ြေျဖ ိုို့။  

 

ကဲေ  လာက်ဆ ို QGIS က ို သိုံ်းပပ ်း တာေ့ Polygon, Line, Point စတဲေ့ Feature  တွက ို topology မှန်ကန်စွာနဲဲ့  ကာင််း ကာင််း 

 ရ်းဆွတဲတ်မယ် ထင်ပါတယ်။ 

 

6.9 QGIS ထဲသ ိုို့ GPS point မျာ်း သ ိုို့မဟိုတ် Excel File မှ Data မျာ်းထည်ေ့သွင််းခြေင််း 

မ မ တ ိုို့ တ ိုင််းတာထာ်း သာ GPS Point  ေတာ မျာ်းက ို MS Excel(.xls) ခဖင်ေ့ သ ိုို့မဟိုတ် (.csv) formatCSV ခဖင်ေ့  ရ်းထည်ေ့ခပင်ဆင် 

ထာ်းပါ။ ၎င််းတွင် Latitude Longitude အတွက် Coordinate column မျာ်း ပါဝင်ရပါမည်။ ဥပမာ အ နခဖင်ေ့ Latitude ၊ Longitude 

၊ Magnitude ၊ Occurrence date နှင်ေ့ အခြော်း သာ အြေျက်အလက်မျာ်း ပါရှ သည်ေ့ ငလျင်  ေတာ ဖ ိုင်တစ်ြေိုက ို နမူနာ ခပြုပပ ်း  လေ့လာ 

သွာ်းပါမည်။ 

ေ  နရာမှာ Map project အြေန််းက error  တွအ ကကာင််းက ို သ ရင် 

မ မ ရဲဲ့ GPS တ ိုင််းတာမှုက ို ခပန်ပပ ်း Correction ခပြုလိုပ်န ိုင်တယ်။ 

ေါမှမဟိုတ် known Point နဲဲ့ခပန်ပပ ်း Correction လိုပ် ပ်းလ ိုို့လည််း 

ရန ိုင်တယ်။ Correction ခပြုလိုပ်ပပ ်း Google Earth  ပေါ်ခပန်ထပ်တဲေ့အြေါ 

မလွဲ တာေ့ဘူ်း ပါို့။ 

GPS အမှတ်မျာ်း ပါရှ  သာ Excel file က ို QGIS တွင် ထည်ေ့ရန် အတွက် 

Menu bar > Layer > Add Delimited Text Layer… က ို သွာ်းလ ိုက်ပါ။ 

 
လာ သာ Window တွင် သ မ််းထာ်း သာ CSV ဖ ိုင်က ို လှမ််းပပ ်း Browse လိုပ်လ ိုက်ပါ။ 

CSV file format နှင်ေ့ Point coordinate 

က ို  ရွ်း ပ်းလ ိုက်ပါ။ 

X field အတွက် မ မ ၏ CSV ဖ ိုင် အတွင််းရှ  

Longitude column က ို  ရွ်း ပ်း 

လ ိုက်ပါ။ 

Y field အတွက် မ မ ၏ CSV ဖ ိုင် အတွင််းရှ  

Latitude column က ို  ရွ်း ပ်းလ ိုက်ပါ။ 

Coordinate Reference System 

အတွက် WGS 84 ခဖစ် သာ EPSG:4326 က ို  ရွ်း ပ်းလ ိုက်ပါ။ 

OK နှ ပ်ပပ ်း ဆက်သွာ်းလ ိုက်ပါ။ Map view တွင် ထ ို ေတာခဖင်ေ့ ဆွဲထာ်း သာ  ခမပိုံ ပေါ်လာပါလ မ်ေ့မည်။ 
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GPS data မ  ျားက   GIS Layer အပ စ်သ  ို့ ပပ င်ျားပခင်ျား 

Layer အမည် ပေါ် Right-Click > Export > Save Feature as က ို သွာ်းလ ိုက်ပါ။ 

Vector layer window တစ်ြေို  ပေါ်လာ လ မ်ေ့မည်။ 

 

 ပေါ်လာ သာ Vector layer window တွင် Browse က ို နှ ပ်ပပ ်း Export လိုပ်ကာ မ မ  

Save လိုပ်မည်ေ့ ဖ ိုင်အမည်က ို  ရ်း ပ်းလ ိုက်ပါ။ 

 

 

 

OK က ို ဆက်နှ ပ်လ ိုက်ပါက QGIS တွင်  ရှဲ့က မ မ  ထည်ေ့ထာ်း သာ GPS  ေတာမျာ်းမှ GIS ဖ ိုင်အသစ်တစ်ြေိုသ ိုို့ ရရှ လာပါမည်။ 

ရရှ လာ သာ GIS shapefile က ို QGIS တွင် စမ််းပပ ်း ဖွင်ေ့ကကည်ေ့န ိုင်ပါသည်။ 

 

 
 

 

 

 

 

7. Attribute table မျာ်းနှင်ေ့ ြေျ  တ်ဆက်၍ အသိုံ်းခပြုခြေင််း 
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Relational Database အ ကကာင််း intro လိုပ် ပ်းရန် နည််းနည််းရှင််းခပရန် 

Why linking to external table? 

ဘာ ကကာင်ေ့ြေျ  တ်ဆက်ပပ ်း သိုံ်းရတာလဲ။ 

RDBMS နည််းက ိုအသိုံ်းခပြုပပ ်း တာေ့ GIS ဖ ိုင်နှင်ေ့ ခပငပ် Attribute 

ဖ ိုင်တ ိုို့က ို ြေျ  တ်ဆက် အသိုံ်းခပြုတဲေ့အြေါ 

• GIS dataset မှာ မပါ သ်းတဲေ့ Attribute က ို map ထဲမှာ 

အလွယ်တကူ ခပန ိုင်တယ။်  

• GIS Software  တွနဲဲ့ GIS datasets မှာ တကူ်းတက 

ခပငဆ်င် စရာမလ ိုဘဲ Attribute  ေတာ တွက ို အခပင်မှာ 

သ ်းခြော်း လွတ်လပ်စွာ ထည်ေ့သွင််း ခပငဆ်င်န ိုင်တယ်။ 

• သ ိုို့ ပမယ်ေ့ ၎င််း datasets နှစ်ြေိုက ို ြေျ  တ်ဆက် ပ်းန ိုင်တဲေ့ 

Common Key တစ်ြေို မရှ မခဖစ် လ ိုအပ်တယ်။ 

Layer တစ်ြေို၏ Attribute table က ို အခြော်း သာ Layer မျာ်း၏ 

Attribute table နှင်ေ့ ြေျ  တ်ဆက်ပပ ်း အသိုံ်းခပြုန ိုင်ပါသည်။ ထ ိုကဲေ့သ ိုို့ 

ခပြုလိုပ်န ိုင်ခြေင််း အာ်းခဖင်ေ့ GIS dataset မူလပထမက မပါရှ  

 သ်း သာ Attribute information မျာ်းက ို ခပငပ်မှ လှမ််းယူန ိုင်ပပ ်း 

Analysis လိုပ်ရာတွင်  သာ်လည််း ကာင််း၊  ခမပိုံမျာ်း ခပင်ဆင်ခပြုလိုပ်ရာတွင်  သာ်လည််း ကာင််း အသိုံ်းခပြုန ိုင်ပါသည်။ 

ေ  အ ခြေြေံ အဆင်ေ့ သင်ြေန််းစာ  တွမှာ အလွယ်တကူ အသိုံ်းခပြု လ ိုို့ရတဲေ့ Flat file  တွနဲဲ့ GIS data  တ ွြေျ  တ်ဆက် အသိုံ်းခပြုပိုံက ို 

နမူနာ တင်ခပထာ်းမယ်။ အခြော်း သာ Spatial Database  တွနဲဲ့ ြေျ  တ်ဆက်ပိုံက ို Intermediate-Advanced သင်ြေန််းစာ  တွမှာ 

 နာက် နာင် အြေွင်ေ့ကကြုံလာပါက တင်ခပ ပ်းသွာ်းပါမည်။ 

 

Table Join by Common Key. 

To add Graphic  

GIS Geometry table, State, Township, Village, etc vs. 

External Table, Township, Village, etc. 

Important :  

Township PCode (Unique Primary Key in both data) 

Village PCode (Unique Primary Key in both data) 

Good attribute format vs. bad attribute format 

  

7.1 Place codes (Pcodes) 

Pcodes သည် “ နရာသ ကေတကိုေ်” အတွက် အတ ိုြေျြုပ်အသိုံ်းအနှုန််းခဖစ်သည်။ ၎င််းသည် zip သ ကေတကိုေ် သ ိုို့မဟိုတ် 

စာတ ိုက်သ ကေတကိုေ်နှင်ေ့ဆင်တူပပ ်း၊ ခမန်မာန ိုင်ငံတစ်ဝှမ််းရှ   နရာ ေသ ပါင််း ၆၇ဝဝဝ ဝန််းကျင်ြေန်ဲ့က ို သ ်းခြော်း ရည်ညွှန််း 

သ ကေတကိုေ်မျာ်းအခဖစ် သတ်မှတ် ပ်း သာ သတင််း အြေျက်အလက် စ မံြေန်ဲ့ြေွဲမှုစနစ်၏ အစ တ်အပ ိုင််းတစ်ြေို ခဖစ်သည်။ 

န ိုင်ငံ တာ်ခပန်တမ််းမျာ်းနှင်ေ့ လူသာ်းြေျင််း စာနာ  ထာက်ထာ်းမှုနှင်ေ့ ဖွံဲ့ပဖ ြု်းမှုဆ ိုင်ရာ အဖွဲဲ့အစည််းမျာ်း အပါအဝင် အရင််းအခမစ်မျ  ြု်းစိုံမှ 

စို ဆာင််း  ကာက်ယထူာ်း သာ သတင််း အြေျက်အလက်မျာ်း အ ပေါ်တွင် အ ခြေြေံ သာ ခမန်မာန ိုင်ငံအတွက် Pcodes စနစ်က ို 

MIMUမ ှ ခပြုစိုထ န််းသ မ််းထာ်းရှ ပါသည်။ အရင််းအခမစ် တစ်ြေိုထက် မက သာ  နရာမျာ်းမှ အြေျက်အလက်မျာ်းက ို 

စိုစည််း ဖာ်ခပန ိုင်ရန်အတွက် စနစ်တကျ သတ်မှတ်ထာ်း သာ Pcode System မရှ ဘ ဲ ဆာင်ရွက်န ိုင်မည်မဟိုတ် ပ။ 

MIMU က န maintain လိုပ်တဲေ့ PCodes က ို Download ရယူြေျင်ရင် website ခဖစ်တဲေ့ http://themimu.info/mm/place-codes 

က န ရယူန ိုင်ပါတယ။် 
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Pcodes တွင် စာလိုံ်း ပါင််းမျာ်း၊ ကွဲခပာ်းခြော်းနာ်း သာ ဘာသာစကာ်းမျာ်း နှင်ေ့  ရ်းနည််း  ရ်းဟန်မျာ်း နှင်ေ့ နာမည် တူ နခြေင််းမျာ်း 

စသည်ေ့ အြေက်အြေဲမျာ်း ရှ  နသည်ေ့  ေသမျာ်းက ို ထည်ေ့သွင််း စဉ််းစာ်းပပ ်း ပမ ြုဲ့ရွာ သ ကေတကိုေ် အသ ်းသ ်း သတ်မှတ ် ပ်းထာ်းခြေင််းခဖင်ေ့ 

 ခဖရှင််း  ပ်းထာ်းပါသည်။ Pcodes စနစ်သည် ခမန်မာန ိုင်ငံရှ  Project လိုပ်က ိုင်  ဆာင်ရွက် နကကသူ အာ်းလို်ံးတ ိုို့က 

န ိုင်ငံတစ်ဝှမ််းလိုံ်းရှ   နရာ ေသ မျာ်းအာ်း ရည်ညွှန််း အသိုံ်းခပြုရာတွင် စံနှုန််းတစ်ြေိုခဖစ် စပါသည်။ သက်ဆ ိုင်ရာ ပါဝင် ဆာင်ရွက်သူ 

အာ်းလိုံ်းတ ိုို့က သ ဘာတူ လက် ြေံထာ်း သာ  နရာဆ ိုင်ရာ အြေျက်အလက် စံနှုန််းမျာ်းသည် Pcodes စနစ ်က ို အသိုံ်းခပြုသမူျာ်းကကာ်း 

အြေျက်အလက်မျာ်း လွတ်လပ်စွာ ဖလှယ်မှုက ို ခဖစ် စပပ ်း၊ တည် နရာမျာ်းနှင်ေ့ ပတ်သက်ပပ ်း ရည်ညွှန််း  ခပာဆ ိုရာတွင်လည််း 

တစ်ြေိုတည််း သာ စိုစည််း ည ညွတ်သည်ေ့ စံစနစ်တစ်ြေိုက ို ဖန်တ ်း ပ်းပါသည်။ 

 

 
မျာ်း သာအာ်းခဖင်ေ့ Pcodes မျာ်းက ို အဖွဲဲ့အစည််းတစ်ြေို၏ အြေျက်အလက် စ မံြေန်ဲ့ြေွဲမှုစနစ် အတွင််းသ ိုို့ လွယက်ူစွာ  ပါင််းစပ် 

ထည်ေ့သွင််းန ိုင်ပါသည်။ MIMU ၏ Pcoder  ဆာေ့ဖ်ဝဲသည် အဖွဲဲ့အစည််း/ ဌာနမျာ်းမ ှ ၎င််းတ ိုို့  ြေေါ် ဝေါ်သိုံ်းစွဲ နသည်ေ့  ကျ်းရွာ 

အမည်မျာ်းပါသည်ေ့ ဖ ိုင်က ို Pcodes စနစ်တွင် သတ်မှတ် ထာ်းသည်ေ့  ကျ်းရွာ အမည်မျာ်းခဖင်ေ့ စစ် ဆ်း ပ်းပပ ်း အဆ ိုပါ 

အြေျက်အလက်ဖ ိုင်၏ ဇယာ်းကွက်တွင်  ကာ်လံအကွက်ပ ိုတစ်ြေိုအာ်းခဖင်ေ့ ထပ် ပါင််း ဖာ်ခပ ပ်းပါသည်။ 

ေ  PCodes စနစ ်နဲဲ့ maintain ခပြုလိုပ်ထာ်းတဲေ့ Project  ေတာ တွက ို GIS file  တွနဲဲ့ ြေျ  တ်ဆက် အသိုံ်းခပြုနည််းက ို ေ အြေန််းမှာ 

 လေ့လာသွာ်းမည်။ 

7.2 Metadata 

Metadata သည် data ၏အ ကကာင််းက ို ရ ို်းရှင််းစွာ ဖာ်ခပထာ်း သာအြေျက်အလက်ခဖစ်သည်။ Data ၏အ ကကာင််းက ို 

အတ ိုြေျြုပ် ဖေါ်ခပထာ်းသည်။ data က ိုအသိုံ်းခပြု သာအြေါ data အ ကကာင််းက ို သြေျာ နာ်းလည်န ိုင်ရန်ခဖစ်ပါသည်။ 

Metadata  အာက်ပါ အြေျက်အလက်မျာ်းက ို  ဖေါ်ခပ ပ်းပါသည်။ 

• What (ဘာအ ကကာင််းလဲ) 

• When (ဘယ်အြေျ  န်ကလဲ) 

• Where (ဘယ် နရာလဲ) 

• Who (ဘယ်သူလိုပ်သလဲ၊ ဘယ်သူပ ိုင်လဲ) 

• How (ဘယ်လ ိုလိုပ်သလဲ) 

• Which (ဘယ်ကရသလဲ)  

• Why (ဘာ ကကာင်ေ့လိုပ်သလဲ) 

Metadata မှာဘာ တွမပါဝင်သလဲ 

Metadata သည် data ၏အ ကကာင််းက ို  ဖာ်ခပထာ်း သာ data ခဖစ်သည်။ သ ိုို့ သာ်လည််း သူက ိုယ်တ ိုင်က တာေ့ data 

မဟိုတ်ပါဘူ်း။ ပိုံမှန်အာ်းခဖင် m့etedata က ိုလိုံခြေြုံစ တ်ြေျစွာ မ  ဝလ ိုို့ရပါတယ်။ အဘယ် ကကာင်ေ့ဆ ို သာ် အြေျက်အလက် တွမပါရှ  

 သာ ကကာင်ေ့ခဖစ်ပါတယ်။ Metadata က ို တွ်းကကည်ေ့လ င် က လ်းဘဝက စာကကည်ေ့တ ိုက်မှာ အသိုံ်းခပြုြေဲေ့ သာကေ်ကဲေ့သ ိုို့ 

စာအိုပ်မျာ်း၏ အ ကကာင််းအရာမျာ်းသာပါရှ မှာ ခဖစ်ပါတယ်။ metadataသည် သူက ိုယ်တ ိုင်စာအိုပ် မဟိုတ်ပါဘူ်း 
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ထ ိုကေ်မှစာအိုပ်၏အ ကကာင််းအရာမျာ်းက ို စစ် ဆ်း လေ့လာန ိုင်ပပ ်း စာအိုပ်က ိုလွယ်ကူစွာ ရှာ ဖွန ိုင်ပါတယ်။ သ ိုို့ သာ်လည််း 

စာအိုပ်ဖတ်ရန်အတွက် တာေ့ သင်စာအိုပ်က ိုဖွင်ေ့ရမှာခဖစ်ပါသည်။ 

 

Metadata (နမူနာ) 

Title: mmr_polbnda_adm3_250k_mimu 

Description / abstract: Township Boundary, Myanmar, State/Region Name, District Name, Township Name all are 

attached with Pcode  

 Spatial reference- GCS-Lat, Long, MapDatum- WGS84 

Temporal coverage: 5-Mar-2010 to 15-Jun-2010 

Last Updated date:  10-Oct-2017 

Source: MIMU 

Type: Polygon 

Format and size: ESRI Shape File (.shp), Number of records - 330 

Methodology: Digitization from 1:250,000 Topographic Map produced by Survey department printed in 2004 

Data quality information: can be used in thematic map, Accuracy: 1:250,000 Scale  Created Date – 15-

Jun-2010 

Language: English, Myanmar (Myanmar3, Win Font) 

Publisher: MIMU GIS Team 

Rights/License/ restrictions of usage: MIMU/WFP 

Keyword / tag: administrative area 

Identifier: mmradmin 

Recommended metadata fields 

Label Definition Comment 

Title A name given to the resource. Title maybe similar to the file name 

Description / 
abstract 

Short text description 

Main abstract of the subject matter, location/ coverage, 
main attributes, data source(s), spatial reference 
system or coordinate reference system associated to the 
data (typically WGS84, UTM, …) 

Temporal 
coverage 

Time period of content includes data collection period or creation date 

Spatial Coverage 

The spatial applicability of the 
resource, or the jurisdiction 
under which the resource is 
relevant. 

May be a named place or a location specified by its 
geographic coordinates. Where appropriate, named 
places can be used in preference to numeric identifiers 
such as sets of coordinates. 

Source 
An entity primarily 
responsible for making the 
resource. 

Ideally the organisation should be linked to the MIMU 
organisation table 

Type 
Information about the data 
set entities and attributes 

Type: point, line, polygon, gridded data, imagery derived 
product, table  

Format and size 
Physical medium and 
dimensions of the resource 

Format of the file. Ex: shp, kml, tiff, jpeg, ... 
Size: nb of records (vector file) / row count, column 
count and vertical count (raster file) 
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7.3 Layer တစ်ြေိုနှင်ေ့ တစ်ြေို Attribute table မျာ်း အြေျင််းြေျင််း ြေျ  တ်ဆကပ်ပ ်း အသိုံ်းခပြုခြေင််း 

Layer တစ်ြေို၏ Attribute table က ို အခြော်း သာ Layer ၏ Attribute table နှင်ေ့ ြေျ  တ်ဆက်ပပ ်း အသိုံ်းခပြု န ိုင်ပါသည်။ 

Join tool က ို အသိုံ်းခပြုပပ ်း Attribute table မျာ်းက ို ြေျ  တ်ဆက်ခြေင််း ခပြုလိုပ်န ိုင်ရန် အတွက်  

နမူနာ ပိုံ ထည်ေ့ရန် 

One to One 

One to Many 

 

7.4 ခပင်ပမှ Table မျာ်းနှင်ေ့ ြေျ  တဆ်က် အသိုံ်းခပြုခြေင််း 

ခပငပ်မှ GIS ဖ ိုင်မဟိုတ် သာ table မျာ်းခဖစ်သည်ေ့ CSV, DBF, Excel စသည်ေ့ ဖ ိုင် အမျ  ြု်းအစာ်း မျာ်းက ိုလည််း ြေျ  တ်ဆက် ပ်း 

ခြေင််းက ို ခပြုလိုပ် ပ်းန ိုင်ပါသည်။ စမ််းသပ်ပပ ်း သာ ြေျ  တ်ဆက် ပ်းန ိုင်သည်ေ့ ဖ ိုင်အမျ  ြု်းအစာ်း အြေျ  ြုဲ့မှာ 

 .csv  (Comma Separated Text  file format) 

 .dbf (MicroSoft Access database file format) 

 .xls  (MicroSoft Excel 2003-2007 file format) 

 .ods  (OpenOffice Calc’s Open Spread Sheet Document) 

 လေ့ကျင်ေ့ြေန််း အ နခဖင်ေ့ ခပည်နယ်နှင်ေ့ တ ိုင််း ေသကက ်း၏ လူဦ်း ရ စာရင််းက ို ခပ သာ CSV, Excel ဖ ိုင် ခဖင်ေ့ ြေျ  တ်ဆက်ခြေင််း 

ခပြုလိုပ်သွာ်းပါမည်။ 

QGIS ထဲက ို Microsoft Excel 2010 format ဖ ိုင်က ို ထည်ေ့လ ိုို့ မရြေဲေ့ရင် Open Spread Sheet format နဲဲ့  ခပာင််းသိုံ်းပပ ်း 

ထပ်ထည်ေ့ကကည်ေ့လ ိုက်ပါ။ QGIS ထဲမှာ သိုံ်းထာ်းတဲေ့ GDAL/OGR library  တွဟာ Open Spread Sheet မှာ ရ်းထာ်းတဲေ့ ဖ ိုင် တွက ို 

ဖွင်ေ့လ ိုို့ ရန ိုင် ကကာင််း ေ  နရာ http://www.gdal.org/ogr/drv_ods.htmlမှာ ဆ ိုထာ်းတယ်။ Open Source software အမျ  ြု်းအစာ်း 

 တွ အြေျင််းြေျင််း interoperability အတွက် အ ထာက်အပံေ့ ခပြုပပ ်း ဖွင်ေ့န ိုင်ပိုံက ို  လေ့လာ  တွဲ့ရှ ရပါမည်။ Open Office Suite က ို 

http://www.openoffice.org/download/index.html က န ရယူန ိုင်ပါသည်။ 

 

Methodology 
process and sources used to 
develop the data  

the way data was collected and its lineage (processing 
history)  

Data quality 
information 

Relevance,  
Accuracy, 
Timeliness,  
Accessibility and 
Interpretability 
Comparability 

For example: 
Relevance: can be used in thematic map 
Accuracy: Accurate to 1:xxx scale 
Timeliness: Last updated in xxxx. Next update scheduled 
in 
Accessibility and interpretability:  requires GIS software 
to access and interpret 
Comparability: can be used in conjunction with other 
MIMU P-codes dataset 

Language 
The language of any text 
information in the data set. 

  

Publisher 

An entity responsible for 
making the resource 
available. And its contact 
details 

Typically, the name of a Publisher should be used to 
indicate the entity. 

Rights/License/ 
restrictions of 
usage 

Information about rights held 
in and over the resource. 

Disclaimers, copyrights and restriction of usage, whether 
it is the official version and whether it has legal validity 

Keyword / tag 
keywords, key phrases, or 
classification codes. 

 Recommended best practice is to use a controlled 
vocabulary. 

Identifier Unique ID of the data   
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7.5 Excel ဖ ိုင်ခဖင်ေ့ြေျ  တ်နည််း 

GIS Shapefile ဖွင်ေ့သလ ိုမျ  ြု်းပဲ Excel ဖ ိုင်က ို import လိုပ်ကာ ဖွင်ေ့လ ိုက်ပါ။ Excel 

မှာ  ပ်းထာ်းတဲေ့ sheet နာမည် အတ ိုင််းပဲ Layers pane ထဲမှာ ‘Demography’ 

ဆ ိုတဲေ့ Table Layer တစ်ြေို  ပေါ်လာပါလ မ်ေ့မည်။ ၎င််း၏Attribute table က ို 

လှမ််းပပ ်း ဖွင်ေ့ကကည်ေ့ကာ အရင်  လေ့လာ ကကည်ေ့လ ိုက်ပါ။ 

ေ ထက်လွယ်ြေျင်သလာ်း? Drag လိုပ်ပပ ်း ဆွဲထည်ေ့လ ိုက်လ ိုို့လည််း  ရတယ်။ 

 

အသိုံ်းခပြုမည်ေ့ External table မျာ်း StateRegion_HouseHold_2014.xls, State 

Region GIS data 

StateRegion_HouseHold_2014.xls တွင် ပါဝင် သာအြေျက်မျာ်း 

 

 

 

 

 

 

 

Import State/Region file. 

State Region GIS data တွင် ပါဝင် သာအြေျက်မျာ်း 

 

  

 
2014_popcensus_State_Reg.xlsx က ို QGIS project ထဲသ ိုို့ import 

လိုပ်ကာ ထည်ေ့သွင််း လ ိုက်ပါ။ 
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ထ ိုသ ိုို့ထညေ့်ရန် မ မ ထညေ့်လ ို သာ file က ို drag လိုပ်ပပ ်း QGIS project ထဲက ို drop လိုပ်လ ိုက်ပါ။ 

 

 

 

အြေျ  ြုဲ့ MS Excel.xlsx နဲဲ့ ြေျ  တ်လ ိုို့ မရဘူ်းလာ်း။ 

၁။ MS Excel ဖ ိုင်က ို Excel 97-2003 Workbook ရဲဲ့ extension ခဖစ်တေဲ့ .xls 

က ို  ခပာင််းပပ ်း ခပန်ထည်ေ့ ကကည်ေ့လ ိုက်ပါ။  

 ၂။ MS Excel ဖ ိုင်က ို CSV format က ို  ခပာင််းပပ ်း ထည်ေ့ကကည်ေ့လ ိုက်ပါ။ QGIS 

မှာ CSV ဖ ိုင် အမျ  ြု်းအစာ်းက ို  ကာင််း ကာင််း support လိုပ် ပ်း ထာ်းတယ။် 

      

QGIS Project Window ထဲက ို မ မ ြေျ  တ်ဆက်လ ို သာ file  ရာက်သွာ်းလ င် 

ြေျ  တ်ဆက်ရန်အဆင်သငေ့်ခဖစ် နပါသည်။ 

 

 

7.6 Joins toolက ို အသိုံ်းခပြုပပ ်း table မျာ်း ြေျ  တ်ဆက်နည််း 

Layers pane ထဲက မ မ  Join လ ို သာ Target layer GIS shape 

file ခဖစ်တဲေ့ mmr_polbnda2_adm1_250k_mimu  ပေါ်မှာ Double-click နှ ပ်ပပ ်း Properties က ို ဖွင်ေ့လ ိုက်ပါ။ property window 

တွင်ရှ  သာ Join tab က ို click လိုပ်ပါ။ ထ ိုို့ နာက် property window  အာက်နာ်းတွင်ရှ  သာ  အ ပါင််း က ို click  

လိုပ်လ ိုက်ပါ။ add vector join window  ပေါ်လာမည်။ add vector join window တွင် join layer တွင် မ မ  join လ ို သာ table 

က ို ရွ်း ပ်းပါ။ Join field တွင်  Join layer နှငေ့် Target Layer နှစ်ြေိုစလိုံ်းတွင်ပါဝင် သာ တူည  သာ key field က ို ရွ်း ပ်းရမည်။ 
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Join လိုပ်ပပ ်း အသစ်ရရှ လာတဲေ့ Join table result က ိုဖွင်ေ့ကကည်ေ့လ ိုက်ပါ။ Join 

လိုပ်တဲေ့ Process ထဲမှာ မပါလာ တေဲ့ row / entry မျာ်း ရှ ြေဲေ့သလာ်း၊ ကျန်ြေဲေ့သလာ်း 

စစ်ကကည်ေ့လ ိုက်ပါ။ ရှ ြေဲေ့ရင် ဘာခဖစ်လ ိုို့ အဲေ  entry က ကျန်ြေဲေ့သလဲ 

စစ်ကကည်ေ့လ ိုက်ပါ။ Before နဲဲ့ After က ို တ ိုက်ကကည်ေ့ လ ိုက်ပါ။ 

ကျန်ြေဲေ့တဲေ့ entry အတွက်  ခမပိုံ ပေါ်မှာ visualize လိုပ်တဲေ့အြေါ  ေတာမရှ ဘူ်း 

ခဖစ် နလ မ်ေ့မယ်။ အဲေ ကျန်တဲေ့ အပ ိုင််း တွက ို  ခမပိုံ ပေါ်မှာ data ဘယလ် ိုခပရမလဲ။ 

 
Table Join လိုပ်ပပ ်း ရလာတဲေ့ Column  တွက Table Layer နာမည် တွ ပါ နပပ ်း Column နာမည် အသစ် တွ ခဖစ် နတတ်တယ်။ 

အဲေါက ို  ခဖရှင််း ပ်းဖ ိုို့ ရန်အတွက် Edit Vector join window တွင် custom field name prefix check box က ို check လိုပ်ထာ်းပပ ်း 

 အာက်တွင် တွဲ့ရ သာ file name က ို ဖျက် ပ်းလ ိုက်ပါ (သ ိုို့) မ မ ထညေ့်လ ို သာ name က ို ရ ိုက်ထညေ့် ပ်းပါ။  

QGIS ထဲမှာ GIS shape file table နဲဲ့ ခပင်ပက Excel Table  တွနဲဲ့ ြေျ  တ်ဆက်တတ်ပပ ဆ ိုရင် ကျန်တဲေ့  ခမပိုံခပင်တဲေ့ အပ ိုင််းက ို 

ြေါတ ိုင််းလ ို ဆက်ခပင်သွာ်းလ ိုို့ ရပါပပ ။ 

 ခမပိုံ၏ Style က ို Graduated Symbol က ို သိုံ်းပပ ်း State/Region_Household ဟူ သာ Join လိုပ်ပပ ်း ရရှ လာသည်ေ့ Column က ို 

Classify နည််းခဖင်ေ့  ခပာင််းပပ ်း ခပကကည်ေ့လ ိုက်ပါ။ 

 

 

Note for Excel file 

Excel file က ို ထည်ေ့လ ိုို့ မရဘ်ူးလာ်း? အဲေါဆ ိုရင် 

အဲေ  Excel file အြေျ  ြုဲ့ သာ non-support format 

သ ိုို့မဟိုတ် character  တွပါ နလ ိုို့လ ဲ ခဖစန် ိုင် 

ပါတယ်။ ေ လ ိုဆ ိုရင် အဲေ  Excel file က ို 

ခပန်ပပ ်း တာေ့ format လိုပ်ဖ ိုို့ လ ိုအပလ် မ်ေ့မယ်။ 
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8. Pie chart, Bar chartမျာ်းခဖင်ေ့ Data Visualization လိုပ်နည််း 

State/Region Male and Female Population က ို Bar chart, Pie chart ခဖင်ေ့  ဖေါ်ခပရန်။ 

 

8.1 Pie Chart ခဖင်ေ့ခပနည််း 

မ မ  data ခပြေျင် သာ layer  ပေါ်တွင် right > Property or double click လိုပ်လ ိုက်ပါ။ layer property window  ပေါ်လာမည်။ 

Layer property window တွင် diagram tab က ို click လိုပ်ပါ။ 

No diagram  နရာတွင် Pie chart က ို ရွ်းပါ။ 

Attributes အတွင််း Male နှင်ေ့ Female population က ို Select လိုပ်ပပ ်း အ ပါင််း လကခဏာက ို နှ ပ် ပ်းခြေင််းခဖင်ေ့ Assign လိုပ်လ ိုက်ပါ။ 

လ ိုအပ်လ င် Color  ပေါ် click နှ ပ် ပ်းပပ ်း အ ရာင်ပါ  ခပာင််း ပ်းလ ိုက်ပါ။ 

 
 

OK နှ ပ်ပပ ်းပါက  ခမပိုံတွင် male and female က ိုခပ သာ Pie chart မျာ်း  ပေါ် နလ မ်ေ့မည်။ 

 

8.2 Bar Chart ခဖင်ေ့ခပနည််း 

မ မ  data ခပြေျင် သာ layer  ပေါ်တွင် right > Property or double click လိုပ်လ ိုက်ပါ။ layer property window  ပေါ်လာမည်။ 

Layer property window တွင် diagram tab က ို click လိုပ်ပါ။ 

No diagram  နရာတွင် Pie chart က ို ရွ်းပါ။ 

Attributes အတွင််း Male နှင်ေ့ Female population က ို Select လိုပ်ပပ ်း အ ပါင််း လကခဏာက ို နှ ပ် ပ်းခြေင််းခဖင်ေ့ Assign လိုပ်လ ိုက်ပါ။ 
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လ ိုအပ်လ င် Color  ပေါ် click နှ ပ် ပ်းပပ ်း အ ရာင်ပါ  ခပာင််းန ိုင်ပါသည်။ 

   
 

Size tab က ို click လိုပ်ပါ။ attribute တွင် assign လိုပ်ထာ်း သာ field မ ှတစြ်ေိုြေိုက ို ရွ်း ပ်းပါ။ ပပ ်းလ င် find က ို click လိုပ်ပါ။ 

Bar length က ို သငေ့် တာ်သလ ို  ခပာင််း ပ်းပါ။ 

 
 

OK နှ ပ်ပပ ်းပါက  ခမပိုံတွင် male and female က ိုခပ သာ Bar chart မျာ်း  ပေါ် နလ မ်ေ့မည်။ 
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Pie chart နှငေ့် Bar Chart တ ို property မျာ်းက ို ခပင်လ ိုလ င် Layer property တွင်ရှ  Diagram tab တွင် တွဲ့ရ သာ 

Attributes 

Rendering 

Size 

Placement 

Options 

Legend စသည်တ ိုို့တွင် ရှ  သာ property မျာ်းက ို မ မ တ ိုို့လ ိုအပ်သလ ို ခပြုခပငန် ိုင်သည်။ 
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9. Print Composerက ို သိုံ်းပပ ်း  ခမပို ံLayout ခပင်ဆငန်ည််း 

Print Composer ဆ ိုသည်မှာ Map layout က ိုခပင်ဆင်ဖ ိုို့ရန် အတွက် နှင်ေ့  ခမပိုံက ို Report တွင် ခပရန်နှင်ေ့ publication 

လိုပ်ရန်အတွက် အသိုံ်းခပြုပါသည်။ ဤ Print Composer ခပင်ဆင်နည််းက ို အသိုံ်းခပြုန ိုင်ရန်အတွက် QGIS ၏ map project ထဲတွင် 

မ မ လ ိုြေျင် သာ  ခမပိုံမျာ်းက ိုအရင်ဆိုံ်း ခပင်ဆင်ပပ ်းသာ်းခဖစ်ရပါမည်။ map project အတွင််းတွင်  ခမပိုံ ပေါ်တွင်ခပသမည်ေ့ layer မျာ်း 

ပါရှ ပပ ်း ၊ အသိုံ်းခပြုမည်ေ့ သ ကေတမျာ်း၊ အ ရာင်မျာ်း၊ အရွယ်အစာ်းမျာ်း စသည်တ ိုို့က ို ခပင်ဆင်ပပ ်း ခဖစ်ရပါမည်။ ဤ print composer 

က ိုခပငဆ်င် နစဉ်အတွင််း ၎င််း၏ QGIS map project က ိုပါ ဖွင်ေ့ထာ်း ပ်းလ ိုက်ပါ။  ခပာင််းြေျင်သည်မျာ်း ရှ ြေဲေ့ပါက map project တွင် 

 ခပာင််းန ိုင်ပပ ်း Print composer တွင် Refresh ခဖင်ေ့ update map က ို အလွယတ်ကူ ရန ိုင်ပါသည်။ 

 

QGIS ၏ Menu bar > Project > New Print Layout က ို သွာ်းပါ။  ပေါ်လာ သာ Layout Title တွင် ဤ Print Composer template 

အတွက်  ြေါင််းစဉ် တစ်ြေို ပ်းလ ိုက်ပါ။  နာက် နာင်တွင် ဤ ခမပိုံ Layout က ို ခပန်လည် ခပြုခပင်ြေျင်ပါက Print Composer တွင် 

ခပန်လည်  ြေေါ်ယူဖွင်ေ့လှစ်ပပ ်း အသိုံ်းခပြုန ိုင်ပါသည်။ 

 

9.1 Layout ခပြုလိုပ်ပို ံခပြုလိုပ်နည််း အတ ိုြေျြုပ် အဆင်ေ့ဆင်ေ့ 

Paper size နှငေ့် Paper orientation က ို အရင်ခပင် ပ်းပါ။ 

ထိုတ်မည်ေ့  ခမပိုံ၏ စ က်းက ို သ လျင် -  

-  ခမပိုံ ပေါ်တွင် ခပြေျင်သည်ေ့ စ က်း က ို တွက်ြေျက်ပပ ်း Paper အရွယ်အစာ်း က ို အရင် ရွ်းပါ။ (ေါက စ က်းက ို အ သ 

ထာ်းပပ ်း၊ Paper အရွယ်အစာ်းက ို လ ိုက် ခပာင််း ပ်းတဲေ့ နည််း တစ်ြေို။) 

စကက  အရွယ်အစာ်း အလ ိုက်ထိုတ်ြေျင်ရင် (ဘယ်စ က်းနဲဲ့ ခပမလဲ  သြေျာမသ လ င်) - 

က ိုယ်သိုံ်းြေျင်တဲေ့ Paper အရွယ်အစာ်းက ို အရင် ရွ်း ပ်းပပ ်း၊  နာက်မှစ က်း နဲဲ့  ခမပိုံက ို ခပန်ပပ ်း ညှ ယူပါ။ (ေါက Paper 

အရွယ်အစာ်းက ို အ သထာ်းပပ ်း၊ Paper နဲဲ့ fitting ခဖစ် အာင် စ က်းက ို လ ိုက် ခပာင််း ပ်းတဲေ့နည််းတစ်ြေို။)  

- Layout ထဲက ို Map အရင်ထည်ေ့ပါ။   

- Move item က ိုသိုံ်းပပ ်း Map frame position က ို  နရာ အရင်ြေျပါ။  ဘာင်က ို (select လိုပ်ပပ ်း) လ ိုအပ် သာ 

အကျဉ််းအကျယ်ရ အာင် အနာ်းသာ်းက ို တွန််း ရွဲ့ပပ ်း ညှ ပါ။ 

- Move Item content က ို သိုံ်းပပ ်း၊ Map view က ို Center ကျ အာင် ြေျ  န်က ိုက်ပပ ်း  ရ ဲ့ပါ။ အထဲက map layer က ို ရ ဲ့တာ။ 

Extent က လ ိုက် ရ ဲ့ နမယ်။ 

- ကျန်တဲေ့ map element  တခွဖစ်တဲေ့ Legend, North Arrow, Scale bar, Title, Logo စသည်တ ိုို့က ို ထည်ေ့ပါ။ 

- Add Text က ိုသိုံ်းပပ ်း တာေ့  ခမပိုံမှာ သသိုံ်းခပြုထာ်းတဲေ့ Map Projection နှင်ေ့ Datum, Sources, Production date, 

Producer, Map Description စသည်တ ိုို့က ို  ခမပိုံတစ်ြေို၏ အဂေါရပ်နှင်ေ့ ည မ  အာင် စိုံလင်စွာခဖင်ေ့  နရာတကျရှ  အာင် 

ထည်ေ့ ပ်းလ ိုက်ပါ။ Item တြေိုြေျင််းစ က ို Font မျာ်း  ခပာင််း ပ်းပါ။ 

- Map element သ ိုို့မဟိုတ် Item တစ်ြေိုက န  နာက်တစ်ြေိုက ို  ခပာင််းြေျင်ရင် Select/Move item နဲဲ့  ခပာင််း ပ်းပါ။ 

 ရ ဲ့ ပ်းပါ။ 

- Object တစ်ြေိုြေျင််းစ  က ိုင်တွယ်နည််း အ သ်းစ တ်က ို  အာက်ပါ သက်ဆ ိုင်ရာ Tool  တွရဲဲ့ လိုပ် ဆာင်ပိုံတွင် ရှာကကည်ေ့ပပ ်း 

လ ိုက်လိုပ်ကကည်ေ့ပါ။ 

Map project နှင်ေ့ Print layout 

Print composer က ို map project က န အြေျ  န်မ ရွ်း ခပန် ြေေါ်လ ိုို့ ရတယ်။ ၂ ြေို တွဲလျက် အပမဲ ပါရှ  နတယ်။ Composer က ို 

Refresh /Update map ခဖင်ေ့ QGIS map project နှင်ေ့ synchronize လိုပ်န ိုင်ပါသည်။ 

 

Layout Manager 

QGIS project တစ်ြေိုအတွက် Print Layout တစ်ြေိုထက် မက အသိုံ်းခပြုန ိုင်သည်။ Composer manager က န Print 

Composer project က ို ခပန် ြေေါ်ကကည်ေ့လ ိုို့ ရန ိုင်ပါသည်။ 
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-  အာက်မှာ Print Composer ထဲက Item တစ်ြေိုြေျင််းစ  နှင်ေ့ အ သ်းစ တ် ခပင်ဆင်ပိုံက ို ‘Map’ နှင်ေ့ နမူနာခပြု  ဖေါ်ခပ 

ထာ်းပါသည်။ 

 

   
      

Pan Layout zoom Select/ 
move item 

Move item 
contents 

Edit nodes 
item 

Adds a 
new map 

to the 
layout 

Adds a 3D 
map to the 

layout 

Adds a new 
picture to 
the layout 

Adds a 
new label 

to the 
layout 

     
 

  

 

Adds a new 
legend to 
the layout 

Adds a 
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the layout 
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North arrow 

to the 
layout 

Add shape Adds a 
new arrow 

to the 
layout 

Add node 
item 

Adds a new 
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layout 

Adds a new 
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table to the 
layout 

 

        

 

Lock 
selected 

item 

Unlock all 
item 

Group item Ungroup 
item 

Raise 
selected 

item 

Align 
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item left 

Distribute 
left edges of 

item 
equidistantly 

Raise item 
width to 

match the 
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item 

 

 

Map Layout Project 

 ရှဲ့အြေန််းတွင်  လေ့လာခပင်ဆင်ြေဲေ့ သာ population QGIS project က ို ဖွင်ေ့လ ိုက်ပါ။  

New Print layout တစ်ြေိုက ို  ြေေါ်လ ိုက်ပါ။ Print layout name က ို “Population Map” ဟို အမည် ပ်း လ ိုက်ပါ။ 

Population Map ဟူ သာ title ခဖငေ့ ်print layout window  တွဲ့ရမည်။ 

 

9.2 Paper size နှငေ့် Paper orientation က ို အရင်ခပင်ဆင်ခြေင််း။ 

ထ ိုသ ိုို့ ခပာင််းရန် layout window  ပေါ်တွင် Right click လိုပ်လ ိုက်ပပ ်း page property က ို click လိုပ်လ ိုက်ပါ။ map layout 

frame ညာဘက်မ ှItem property တွင် paper size နှငေ့် orientation က ိုမ မ  လ ိုသလ ို ခပာင််းလဲန ိုင်သည်။ layout tab တွင်လည််း 

export resolution က ို  ခပာင််း ပ်းန ိုင်သည်။ 
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Project window မ ှ ခမပိုံက ို map layout frame ထဲက ိုထညေ့်လ ိုလ င် Menu bar > 

Add item > add map က ို click လိုပ်လ ိုက်ပါ။ ဘာမှ ပေါ်လာအိုံ်းမည် မဟိုတ်ပါ။ 

paper  ပေါ်မှာ  လ်း ထာင်ေ့ကွက် လ်း ခဖစ်သွာ်း အာင်  ထာင်ေ့တစြ်ေိုက နစပပ ်း 

 နာက် ထာင်ေ့တစြ်ေိုဆ က ို mouse က ိုဖ ထာ်းပပ ်း Drag ဆွဲ ပ်းကာ 

လက်လွတလ် ိုက်ြေါမှ ထ ိုဆွဲလ ိုက် သာ  လ်း ထာင်ေ့ကွက် အတွင််းမှာ 

 ခမပိုံ ပေါ်လာပါမည်။  ရ်းဆွပဲပ ်း ပိုံမှာ  အာက်ကဲေ့သ ိုို့ ခဖစ်မည်။ 

အကယ်၍ မ မ ထညေ့်လ ိုက် သာ ခမပိုံသည် map frame အတွင််း 

လ ိုအပ်သလ ို ရွဲ့လ ိုလ င်  select Move item tool 

က ိုအသိုံ်းခပြုပပ ်း ရွဲ့န ိုင်သည်။ Map Frame တစ်ြေိုလိုံ်းက ို က ိုင်ပပ ်း စာရွက်ရဲဲ့ 

အ ပေါ်မှာ  နရာ  ရ ဲ့ပပ ်း ထာ်းြေျင်တဲေ့အြေါမှာ သိုံ်းတယ။် 

move item content tool  

Map Frame က ို အ သထာ်းပပ ်း အထဲက ခမပိုံက ို  နရာ 

 ရ ဲ့ြေျင်တဲေ့အြေါမှာ သိုံ်းတယ်။ 

Map frame နှငေ့် map item က ို frame အခပညေ့်လ ိုလ င် Item property 

တွင်ရှ  သာ Scale က ို ခပာင််း ပ်းရသည်။ စ က်း မှာ ဂဏန််း သ်း သ်း 

ရ ိုက်ထညေ့်ရင်  ခမပိုံက ပ ိုြေျြုံဲ့သွာ်းမယ်။ ဂဏန််းကက ်းကက ်း ရ ိုက်ထညေ့်ရင် 

 ခမပိုံ ပ ိုြေျဲဲ့လာမယ်။ 

 Zoom In/   Zoom Out ကြေျြုံဲ့/ ြေျဲဲ့ကကည်ေ့ဖ ိုို့ပါပဲ။ စာရွက်က ို 

အန ်းကပ် ဆွဲကကည်ေ့ လ ိုက်တာသာ ခဖစ်ပပ ်း တာေ့ တကယ်ေ့ပိုံက ို မပျက်သွာ်း စပါဘူ်း။ Zoom က ို နှ ပ်လ ိုက်တာ ပိုံကက ်း 

ဝါ်းသွာ်းတတ်ပါတယ ်Refresh က ို တစ်ြေျက် ထပ်နှ ပ် လ ိုက်ပါ။ DPI အမှန် နဲဲ့ ပိုံ ခပန်ပပ ်း ကကည်လင် လာပါမည်။ 

 

9.3 Properties 

Item Properties  အာက်မှာက Mouse နဲဲ့ Select လိုပ်ထာ်းတဲေ့ Object တစ်ြေိုရဲဲ့ Properties က ို လာခပတယ။် ခပင်စရာရှ ရင် ေ  

Properties  အာက်မှာ လာပပ ်းခပငဆ်င် ရပါမယ်။  

က ိုယ်က Map က ို select လိုပ်ထာ်းလ င် အဲေ  map ရဲဲ့ properties က ို တွဲ့ရမယ်။ 

က ိုယ်က Label  ြေေါ် Text က ို select လိုပ်ထာ်းလ င် အဲေ  Text ရဲဲ့ properties က ို တွဲ့ရမယ်။ 

က ိုယ်က Legend က ို select လိုပ်ထာ်းလ င် အဲေ  Legend ရဲဲ့ properties က ိုခပမယ်။ 

က ိုယ်က North Arrow image က ို select လိုပ်ထာ်းလ င် အဲေ  North Arrow image ရဲဲ့ properties က ို တွဲ့ရမယ်။ 

က ိုယ်က Attribute table က ို select လိုပ်ထာ်းလ င် အဲေ  Attribute table ရဲဲ့ properties က ိုခပမယ်။ 

 

Map layout frame ထဲက ို  ခမပိုံထညေ့်ပပ ်းလ င်  ခမပိုံနှငေ့်သက်ဆ ိုင် သာ properties မျာ်း ထညေ့် ပ်းရန်လ ိုအပ်ပါတယ်။ 

Map Title ထညေ့်ရန် Menu bar > Add item >  add label က ို click လိုပ်ပါ။ မ မ စာရ ိုက်လ ို သာ နရာတွင် frame box 

တြေိုဆွဲလ ိုက်ပါ။ Text frame တြေို ပေါ်လာပါမည်။ Item property တွင် မ မ  ရ်းလ ို သာစာသာ်း text size, font style, font color 

စသည်ခဖငေ့် မ မ လ ိုအပ်သလ ိုခပြုခပင်န ိုင်သည်။ 
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Map Legend ထညေ့်ရန် Menu bar > Add item >   add legend က ို click 

လိုပ်ပါ။ မ မ ထာ်းလ ို သာ နရာက ို frame box တစြ်ေိုဆွဲလ ိုက်ပါ။ legend frame 

 ပေါ်လာပါမည်။ Item property တွင် မ မ လ ိုအပ်သလ ိုခပြုခပငန် ိုင်သည်။ 

Legend Item တွင် map view တွင်တင်ထာ်း သာ layer 

မျာ်းအာ်းလို်ံး ပေါ် နသည်က ို  တွဲ့ရမည်။ Legend တွင် မ ဖာ်ခပလ ို သာ item 

မျာ်းက ိုဖျက်လ ိုလ င် Legend item တွင်ရှ  သာ Auto update check box က ို 

ခဖြုတ်ထာ်းပါ။ ပပ ်းလ င် legend item အတွင််းရှ  မ မ ခဖြုတ်လ ို သာ layer က ို select 

လိုပ်ပါ။ ပပ ်းလ င်   အာက်နာ်းတွင်ရှ  သာ အနှတ်လကခဏာက ို click လိုပ်ပါ။  

Layer name  ခပာင််းလ ိုလ င် layer name က ို click လိုပ်ပါ။  ပေါ်လာ သာ legend item 

property တွင် မ မ  ရ်းလ ို သာ name က ို ရ်းန ိုင်သည်။ 

Map Scale ထညေ့်ရန် Menu bar > Add item >  add Scale bar က ို click လိုပ်ပါ။ 

Item property တွင် မ မ လ ိုအပ်သလ ို ခပြုခပငန် ိုင်သည်။ 

North sign ထညေ့်ရန် Menu bar > Add item >  add north arrow က ို click လိုပ်ပါ။  

Logo ပ ုံ ထည်ော့ပခင်ျား Menu bar > Layout >  Add Image က ို နှ ပ်လ ိုက်ပါ။ ဘာမှ  ပေါ်လာအိုံ်းမည် မဟိုတ်ပါ။ paper  ပေါ်မှာ 

က ိုယ်ထာ်းြေျင် သာ  နရာတွင် တစ်ြေျက် click နှ ပ် ပ်းလ ိုက်ပါ။ ၎င််း object ၏ item properties တွင် လ ိုြေျင် သာ Logo ပိုံက ို 

browse လိုပ် ပ်းလ ိုက်ပါ။ 

Arrow  ခေါ် ပမ ျားပ ုံ ထည်ော့ပခင်ျား Menu bar > Layout > Add Arrow က ို နှ ပ်လ ိုက်ပါ။ ဘာမှ  ပေါ်လာအိုံ်းမည် မဟိုတ်ပါ။ paper 

 ပေါ်မှာ က ိုယ်ဆွဲြေျင် သာ ခမာ်း၏ အစ နရာက ို mouse ခဖင်ေ့ ဖ ၍နှ ပ်ထာ်းပပ ်း အရှည်လ ိုက်ဆွဲကာ လ ိုြေျင် သာ အဆိုံ်းနာ်းက ို ရာက်မှ 

ဖ ထာ်း သာ mouse က ို လွှတ်လ ိုက်ပါ။ ၎င််း object ၏ item properties တွင် လ ိုင််း အထူအပါ်း နှင်ေ့ အ ရာင်မျာ်းက ို 

 ခပာင််းန ိုင်ပါသည်။ ဥပမာ-  နာက်တစပ်မ ြုဲ့သ ိုို့ ဆက်သွာ်း သာ ကာ်းလမ််းမျာ်းက ို  ဖေါ်ခပြေျင် သာအြေါမှာ သိုံ်းတယ။် 

 

9.4 Show Grid 

 ခမပိုံ ပေါ်မှာ Grid လ ိုင််း တွနဲဲ့ ခပြေျင်ရင် သိုံ်းန ိုင်တယ။် 

 

 Shape မ  ျားထည်ော့ပခင်ျား (Rectangle, Elipse, Triangle) 

Add Rectangleခဖင်ေ့  လ်း ထာင်ေ့ ပိုံမျာ်းက ို အထက်ပါကဲေ့သ ိုို့ ထည်ေ့န ိုင်သည်။ 

Add Triangle ခဖင်ေ့ ကတ ဂံ ပိုံမျာ်းက ို အထက်ပါကဲေ့သ ိုို့ ထည်ေ့န ိုင်သည်။ 

Add Elipse ခဖင်ေ့ အဝ ိုင််းပိုံမျာ်းက ို အထက်ပါကဲေ့သ ိုို့ ထည်ေ့န ိုင်သည်။ 

 

9.5 Attribute ဇယာ်းမျာ်း ထည်ေ့ခြေင််း 

Menu bar > Layout >  Add Attribute table က ို နှ ပ်လ ိုက်ပါ။ ဘာမှ ပေါ်လာမည် မဟိုတ်ပါ။ paper  ပေါ်မှာ က ိုယ်ထာ်းြေျင် သာ 

 နရာတွင် တစ်ြေျက် click နှ ပ် ပ်းလ ိုက်ပါ။ ၎င််း object ၏ item properties တွင် က ိုယ်ထည်ေ့ြေျင် သာ Attribute Column မျာ်းက ို 

Add/remove လိုပ်ပပ ်း ထည်ေ့သွင််းန ိုင်ပါသည်။ 

 

9.6 HTML မျာ်းထည်ေ့ရန ်

 Add HTML က HTML မျာ်းက ို ထည်ေ့ရန် အတွက်ခဖစ်သည်။ 

 Alignment အ ွက် 
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9.7 ယ နဲ့ Date ထည်ေ့သွင််းနည််း 

Adding current date by putting 

$CURRENT_DATE(yyyy-MM-dd) in text box 

Distribute left edges of item equidistantly 

 

 

 

 Group Item Button က Item မ  ျားက   Group လ ပ် ပျား န  င်သည်။ 

 Ungroup Button က Group item က   ပပ ်ခွဲထ  ်ရ ်အသ ုံျားပပ သည်။ 

 

9.8  ခမပိုံက ို Export လိုပ်၍ပိုံထိုတ်ခြေင််း 

PDF    င် အပ စ်သ  ို့ ပ ုံထ  ်ပခင်ျား 

Composer > Export as PDF က ိုနှ ပ်ပပ ်း  ခမပိုံက ို PDF ဖ ိုင်အခဖစ်သ ိုို့  ခပာင််းလဲ သ မ််းဆည််း 

ထာ်းန ိုင်ပါသည်။ Report တွင်အသိုံ်းခပြုရန် နှင်ေ့ ခဖန်ဲ့ ဝရန် အတွက် အသိုံ်းခပြုန ိုင်ပါသည်။ 

JPEG    င် အပ စ်သ  ို့ ပ ုံထ  ်ပခင်ျား 

Composer > Export as Image က ိုနှ ပ်ပပ ်း  ခမပိုံက ို JPEG ဖ ိုင်အခဖစ်သ ိုို့ 

 ခပာင််းလဲ သ မ််းဆည််းထာ်းန ိုင်ပါသည်။ Report တွင်အသိုံ်းခပြုရန် နှင်ေ့ 

ခဖန်ဲ့ ဝရန် အတွက် အသိုံ်းခပြု န ိုင်ပါသည်။ 

SVG    င် အပ စ်သ  ို့ ပ ုံထ  ်ပခင်ျား 

Composer > Save as SVG, SVG ဖ ိုင်မျာ်းက ို Adobe Illustrator, Photoshop 

မျာ်းတွင် ထည်ေ့သွင််းပပ ်း မ မ ၏ report snapshot မျာ်းတွင် ထည်ေ့သွင််း 

အသိုံ်းခပြုန ိုင်ပါသည်။ 

ပိုံမျာ်း အရွယ်ကက ်းလနွ််းပါက export တွင် အြေက်အြေဲမျာ်း ရှ တတ်ပါသည်။ 

 

9.9 Map Layout Template က ို သ မ််းထာ်းခြေင််း 

Composer > Save as template 

QGIS Print Composer project သ မ််းထာ်းခြေင််း 

Composer > Save project 
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10. GeoProcessing tools အသိုံ်းခပြုနည််းမျာ်း 

10.1 Clip tool 

Clip function က ို Layer မျာ်းက ို မ မ တ ိုို့လ ိုြေျင် သာ  နရာ လ်းက ို 

ကွက်ပပ ်း ခဖတ်ထိုတ်ဖ ိုို့အတွက် သိုံ်းပါသည်။ ဥပမာ  နခပည် တာ် 

အတွင််းတွင် ကျ ရာက် န သာ ရထာ်းလမ််းပ ိုင််း လ်းက ို ခဖတ်ထိုတ်ရန် 

အတွက် 

10.1.1 Main Menu > Vector > GeoProcessing Tools > 

Clip က ိုသွာ်းလ ိုက်ပါ။ 

10.1.2 Input layer (အခဖတ်ြေံမည်ေ့ layer) အခဖစ် ရထာ်းလမ််းက ို  ရွ်း ပ်းပါ။ 

10.1.3  နခပည် တာ်ဧရ ယာ က ိုသာ Query ထိုတ်ပပ ်း ထာ်းသည်ေ့ ခဖတ်မည်ေ့ 

Layer အခဖစ် State က ို  ရွ်း ပ်းပါ။ (ဤ နရာတွင် သ ထာ်းသင်ေ့သည်မှာ 

ခဖတ်မည်ေ့ layer နှင်ေ့ အခဖတ်ြေံမည်ေ့ layer တ ိုို့ Projection System 

တူည သင်ေ့ပါသည်။ GCS vs. GCS သ ိုို့မဟိုတ် UTM vs. UTM) 

10.1.4 ခဖတ်၍ ရရှ လာမည်ေ့ Output file သ မ််းထာ်းမည်ေ့  နရာသ ိုို့ Browse 

လိုပ်ပပ ်း အမည်တစြ်ေို ရ ိုက်ထညေ့် ပ်းလ ိုက်ပါ။ ခဖည်ေ့ပပ ်းပါက  အာက်ပါ 

Screen shot ပိုံအတ ိုင််း ခဖစ်ပါမည်။ 

10.1.5 OK က ို နှ ပ်ပပ ်း clip process က ို run လ ိုက်ပါ။  နခပည် တာ်အတွင််းတွင်သာ ကျ ရာက် သာ 

ရထာ်းလမ််းပ ိုင််းက ို ရရှ လာပါမည်။ 

Clip analysis အတွက် Vector, Raster ဖ ိုင်မျာ်းက ို ခဖတ်ထိုတ်ရန်အတွက် အလာ်းတူ အသိုံ်းခပြုန ိုင်ပါသည်။ 

 

10.2 Buffering Tool 

Feature တစ်ြေို၏ အခပင်ဖက် အကွာအ ဝ်းအတ ိုင််းအတာ 

တြေိုအတွင််းမှာရှ တဲေ့ ဇိုန်က ိုဖန်တ ်းြေျင် သာ GIS analysis မျာ်းတွင် 

အသိုံ်းခပြုန ိုင်ပါသည်။ Buffer ခပြုလိုပ်ရန် CRS သည် UTM ခဖစ်ရန်လ ိုအပ်သည်။ 

ရထာ်းလမ််းမှ ၁ က လ ိုမ တာ အတွင််း ကွာ ဝ်း သာ  နရာမျာ်းက ို Buffer 

တွက်ထိုတ်ရန်အတွက် ခပြုလိုပ်နည််းမှာ 

10.2.1 Main Menu > Vector > GeoProcessing Tools > 

Buffer(s) က ိုသွာ်းလ ိုက်ပါ။ 

10.2.2 UTM စနစ ်သ ိုို့ ခပာင််းထာ်း သာ မ တာ ယူနစ် 

အတ ိုင််းအတာ ခဖစ်သည်ေ့ ရထာ်းလမ််း Layer က ို Input 

file အခဖစ်  ရွ်း ပ်းပါ။ 

10.2.3 UTM စနစ်ခဖစ် သာ ကကာင်ေ့ ၁ က လ ိုမ တာ အတွက် Distance တွင် 1000 ဟို 

ရ ိုက်ထညေ့် ပ်းပါ။ Buffer သ မ််းမည်ေ့ နရာသ ိုို့ Browse လိုပ်ပပ ်း Output file 

အမည်က ို ရ ိုက်ထညေ့် ပ်းပါ။ 

10.2.4 OK နှ ပ်ပပ ်း buffer process က ို run လ ိုက်ပါ။ ရထာ်းလမ််း၏ ပတ်ပတ်လည် ၁ 

က လ ိုမ တာ အကွာအ ဝ်း အတွင််းရှ  သာ Buffer ဇိုန် ရလာပါမည်။ 
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ငလျင်လှုပ် သာ ဗဟ ိုမှတ် နရာမှ ၅ က လ ိုမ တာ၊ ၁၀ က လ ိုမ တာ၊ ၂၀ က လ ိုမ တာ၊ ၅၀ 

က လ ိုမ တာ စသည်ေ့ အကွာအ ဝ်း အတွင််းတွင်ရှ  သာ စည််းဝ ိုင််းတြေိုက ို ဝ ိုင််းြေျင် သာ အြေါတွင် 

သိုံ်းန ိုင်သည်။ Input feature က ို Point, line, polygon စသည်ေ့ feature မျာ်း အတွက် 

အသိုံ်းခပြုန ိုင်ပါသည်။ output က တာေ့ polygon အမျ  ြု်းအစာ်းက ိုသာ ရလာပါမည်။ 

 

 

 

10.3 Dissolve tool 

Dissolve လိုပ်ခြေင််းသည် ကပ်လ က်ရှ ပပ ်း attribute values တူည  သာ polygon မျာ်းက ို single polygon တစြ်ေိုတည််းအခဖစ် 

 ပါင််းစည််း ပ်းခြေင််းခဖစ်သည်။ ဥပမာ- တစန် ိုင်ငံလိုံ်းပမ ြုဲ့နယ်နယ်န မ တ်layer မ ှstate region နယ်န မ တ်လ ိုြေျင်လ င် dissolve tool 

က ိုအသိုံ်းခပြုန ိုင်သည်။ 

   

 

Dissolve မလိုပ်မ ပိုံ  Dissolve လိုပ်ပပ ်းပိုံ 

 

 
GIS ဖ ိုင်ထဲမှာပါရှ တဲေ့ Attribute  ပေါ်မှုတည်ပပ ်း တာေ့ ဖ ိုင်က ို အစ တ်အပ ိုင််း အမျာ်းကက ်း ြေွဲထိုတ်ပစ်ဖ ိုို့ အတွက် အသိုံ်းခပြုတယ။် ဥပမာ 

State.shp သ ိုို့မဟိုတ် Township.shp ဖ ိုင်က ို ြေွဲထိုတ်ကကည်ေ့န ိုင်ပါတယ။်   

Map Unit နှင်ော့ အ   င်ျားအ  မ  ျား 

အတ ိုင််းအတာမျာ်း နှင်ေ့ ပတ်သက်ပပ ်း၊ မ မ သိုံ်း နသည်ေ့ Layer သည် Geographic Coordinate လာ်း၊ Projected Coordinate 

လာ်းဆ ိုတာက ို အပမဲ သတ ခပြုရပါမည်။ Analysis ခပြုလိုပ်ရာတွင် လ ိုအပ် သာ Map Unit အမှန်က ို ထညေ့် ပ်းရမည်။ ထ ိုမှသာ 

မ မ လ ိုအပ် သာ အ ခဖမှန် ထွက်လာပါမည်။ 
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10.3.1 Main menu > Vectors > Data Management Tools > Split Vector Layers …. က ို နှ ပ်လ ိုက်ပါ။ 

10.3.2 ြေွဲထိုတြ်ေျင် သာ ဖ ိုင်က ို ထညေ့် ပ်းလ ိုက်ပါ။ 

10.3.3 ြေွဲထိုတရ်ာတွင် အသိုံ်းခပြုမည်ေ့ Column က ို  ရွ်း ပ်းလ ိုက်ပါ။     

10.3.4 ဖ ိုင်အသစ် တွက ို သ မ််းထာ်းမည်ေ့ folder အမည်က ို  ရွ်း ပ်းပါ။ ပ ိုမ ို ရှင််းလင််း စရန် အတွက် folder ဖွဲဲ့ပပ ်း ၊ 

အသစ်မှာ စမ််းကကည်ေ့သင်ေ့ပါသည်။   

10.3.5 OK က ို နှ ပ်ပပ ်း run လ ိုက်ပါ။ က စစပပ ်းပါက folder ထဲမှာ ဖ ိုင် တွက ို ဖွင်ေ့ကကည်ေ့လ ိုက်ပါ။  

ဤနည််းခဖင်ေ့ GIS  ေတာ အကက ်းကက ်း တစြ်ေိုထဲမှ သက်ဆ ိုင်ရာ  ေတာမျာ်းက ို ခပန်လည် ြေွဲထိုတ်ရယူ န ိုင်ပါသည်။  

 

10.4 Merge Shapefiles to one 

သူက Split ရဲဲ့  ခပာင််းခပန်။ GIS ဖ ိုင် တွအမျာ်းကက ်းက ို တစဖ် ိုင်တည််း ခဖစ် အာင်  ပါင််းစည််းြေျင် သာအြေါတွင် အသိုံ်းခပြု ပါသည်။ 

မှတ်သာ်း ရမှာက ဖ ိုင် တွအကိုန်လိုံ်း Attribute Field မျာ်း စာလိုံ်း ပါင််းနှင်ေ့ အ ရအတွက် အတူတ ူ ခဖစ်သင်ေ့ပါသည်။ မတူြေဲေ့ပါက 

Field မျာ်း မ ပါင််းဘဲ ထပ်ပွာ်း နပါသည်။ 

10.4.1 Main menu > Vectors > Datamanagement Tools > Merge Shapefiles to One …. က ို နှ ပ်လ ိုက်ပါ။ 

10.4.2  ပါင််းြေျင် သာ ဖ ိုင်မျာ်းက ို Folder တစြ်ေိုနည််းတွင် ထည်ေ့ထာ်း ပ်းပါ။ 

10.4.3 အဲေ  folder က ို browser လိုပ် ပ်းလ ိုက်ပါ။ 

10.4.4  ပါင််း၍ ရရှ လာမည်ေ့ ဖ ိုင်အသစ်က ို သ မ််းမည်ေ့ နရာဆ  browe လိုပ်ပပ ်း အမည် ပ်းလ ိုက်ပါ။ 

10.4.5 OK နှ ပ်လ ိုက်ပါ။  

10.4.6 ပပ ်းလျင် ရလေ်က ို ဖွင်ေ့ကကည်ေ့လ ိုက်ပါ။  

အခြော်း မ မ ဖာသာ စမ််းသပ် အသိုံ်းခပြုကကည်ေ့ရန် Tool မျာ်း 

 

10.5 Split Vector Layer 

GIS ဖ ိုင်ထဲမှာပါရှ တဲေ့ Attribute  ပေါ်မှုတည်ပပ ်း တာေ့ ဖ ိုင်က ို အစ တ်အပ ိုင််း အမျာ်းကက ်း ြေွဲထိုတ်ပစ်ဖ ိုို့ အတွက် အသိုံ်းခပြုတယ။် ဥပမာ 

State.shp သ ိုို့မဟိုတ် Township.shp ဖ ိုင်က ို ြေွဲထိုတ်ကကည်ေ့န ိုင်ပါတယ်။   

Main menu > Vectors > Data Management Tools > Split Vector Layers 

10.6 Convex hulls 

Point အစိုအ ဝ်းတြေို၏ (ြေျ  ြုင်ေ့ဝင် န သာ အနာ်းမျာ်းမပါဝင်ဘ)ဲ အခပင်ဆိုံ်းကျ သာ အမှတ်မျာ်းက ိုသာ ြေျ  တ်ဆက်ပပ ်း 

 ရ်းဆွဲ၍ရလာ သာ Polygon ပိုံမျ  ြု်းခဖစ်ပါတယ။် ထင််းစည််း တွက ို သာ်း ရပင်နဲဲ့ ပတ်ထာ်းတဲေ့ အနာ်းတ လျက်ဟာ 

အဲေ့ေ ထင််းစည််းရဲဲ့ Convex hull ဧရ ယာပါပဲ။ 

Main Menu > Vector > GeoProcessing Tools > Convex hull(s) 

10.7 Simplify Geometries 

အမှတ်တစြ်ေိုနှင်ေ့ တစြ်ေို အရမ််းစ ပလ်ွန််း သာ (သ ိုို့မဟိုတ ် န ်းကပ်လွန််း သာ) GIS ဖ ိုင် တစ်ြေိုက ို အမှတ်မျာ်း ြေျဲ ပ်းရန် အတွက် 

သိုံ်းန ိုင်ပါတယ်။ ဤနည််းခဖင်ေ့ မလ ိုအပ် သာ အ သ်းစ တ်မျာ်းက ို ဖယ်ရှာ်း န ိုင်ပါသည်။ ဤ နရာတွင် မ မ တ ိုို့ အသိုံ်းခပြုမည်ေ့  ခမပိုံ၏ 

စ က်း (Scale) နှင်ေ့ လည််း သက်ဆ ိုင်ပါသည်။ အပမဲတမ််း လိုပ်ရမည်ဟို မဆ ိုလ ိုပါ။ 

Main menu > Vectors > Geometry Tools > Simplify Geometries 

10.8 Polygon to line 

Main menu > Vector > Geometry Tools > Polygon to Lines 



Basic GIS Training - Using QGIS 

 Copyright © MIMU 2020 99 

10.9 Line to polygon  

Main menu > Vector > Geometry Tools > Lines to Polygon 

10.10 Polygon Centroid 

Main menu > Vectors > Geometry Tools > Polygon Centroids 

 

10.11 Displaying Raster Data 

Digital Elevation Model (DEM) ဆ ိုတဲေ့ Raster ဖ ိုင် တွထဲမှာ topography ဆ ိုတဲေ့  ခမမျက်နှာခပင် အန မ်ေ့အခမှင်ေ့  တွနဲဲ့ ပါတ်သက်တဲေ့ 

Information  တွ ပါရှ ပါတယ်။ အဲေ  အြေျက်အလက် တွက ို Terrain feature  တ ွ အ နခဖင်ေ့ ခပန်လည်ပပ ်း တာေ့ ထိုတ်ယူလ ိုို့ 

ရန ိုင်ပါတယ်။  အာက်ပါ process မျာ်းက ို လိုပ် ဆာင်န ိုင်ရန် အတွက် Gdal Tools plugins က ို ဖွင်ေ့ထာ်းဖ ိုို့ လ ိုအပ်ပါတယ်။ DEM 

image ရဲဲ့ Pixel Size  ြေေါ် Spatial resolution က အဲေ ပိုံရဲဲ့ အ သ်းဆို်ံး တ ိုင််းန ိုင်တဲေ့ အတ ိုင််းအတာ အ သ်းစ တ်ပဲ ခဖစ်ပါတယ။် 

 

DEM ပိုံက ို စ တ်ကက ြုက်အ ရာင်မျာ်း  ခပာင််းလဲခြေင််း 

10.11.1 Main menu > Layer 

> Add Layer > Add 

Raster Layer က ို 

သွာ်းလ ိုက်ပါ။  

10.11.2 ဖွင်ေ့ြေျင်သည်ေ့ Raster 

ဖ ိုင်က ို browse 

လိုပ် ပ်းလ ိုက်ပါ။ 

10.11.3  ပ်းထာ်း သာ DEM ပိုံက ို QGIS ထဲသ ိုို့ drag ခပြုလိုပ်ပပ ်း ဖွင်ေ့ကကည်ေ့ပါ။ Style အ ရာင်က ို Single band Pseudo 

color ramp ခဖစ် သာ wiki-2 အမည်ရှ  Color Ramp က ို အသိုံ်းခပြုပပ ်း Class Value မျာ်းက ို သင်ေ့ရာ တန်ဖ ို်း 

 ခပာင််း ပ်းကကည်ေ့ပါ။ 

 

DEM မ ှhill shade, Aspect, Contour စသညေ့်မျာ်းအခပင် hydrology နှငေ့်ဆ ိုင် သာအြေျက်အလက်မျာ်းလည််း ထိုတ်ယူအသိုံ်း 

ခပြုန ိုင်ပါသည် 
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11. QGIS Plugin မျာ်း နှင်ေ့ မ တ်ဆက် ပ်းခြေင််း 

Plugin ဆ ိုသည်မှာ မူရင််း အဓိက application ထတဲွငမ်ပါရ ိသ ေးသ ောအပိိုငမ် ောေးကိို ထည ် ွငေ်းအ  ိုေးပပြုနိိုငရ်န ်

တိိုေးခ ဲျဲ့ဖနတ် ေးထောေးပခငေ်းပဖစ် ည်။ 

11.1 Plugin Install လိုပ်နည််း 

Plugin တစ်ြေိုက ို Official Plugin Repository ထံမှ Install ခပြုလိုပ်န ိုင်ရန် အတွက် Computer နှင်ေ့ Internet နှင်ေ့ ြေျ  တ်ထာ်းရန် 

လ ိုအပ်ပါသည်။ 

Menu bar > Plugins > Manage and Install plugin.. က ိုနှ ပ်လ ိုက် ပါ။ 

Under All tab, select the plugin name and click Install plugin 

ဥပမာ OSM Downloader ဟူ သာ Plugin က ို Install လိုပ်နည််းမှာ  အာက်ပါပိုံ အတ ိုင််းခဖစ်ပါသည်။ 

 
 

 
 

11.2 Plugin မျာ်း အြေျ  န်မှန် Version Upgrade ခပြုလိုပ်ခြေင််း 

Install လိုပ်ထာ်းပပ ်းသာ်း Plugin မျာ်းက ိုလည််း Upgrade လိုပ်န ိုင်ပါတယ်… 

သ ဘာတရာ်းက တာေ့ အြေျ  ြုဲ့ သာ Plugin  တွက ို Developer မျာ်းက ပ ိုမ ို ကာင််းမွန် အာင် ခပြုခပငမ်ွမ််းမ ံထာ်းတာ တွရှ ပါတယ်။ 

က ိုယ်ေ့စက်ထဲမှာ Install လိုပ်ထာ်းတဲေ့ Plugin ထဲကအြေျ  ြုဲ့ သာ Plugin မျာ်းဟာ အဲသလ ိုမျ  ြု်း ခပြုခပငမ်ွမ််းမံထာ်းတာရှ တယဆ် ိုရင် 

အလွယ်တကူ Upgrade လိုပ်န ိုင်ပါတယ်။ အာ်းလို်ံးက ို တစပ်ပ ြုင်နက်တည််းလိုပ်ြေျင်တယ်ဆ ိုရင် “Upgrade all” ဆ ိုတဲေ့ 

ြေလိုတ်က လ်းက ိုနှ ပ်လ ိုက်ရိုံပါပဲ။ Upgrade လိုပ်ဖ ိုို့လ ိုတဲေ့ Plugin  တွအာ်းလိုံ်းက ို သူို့အလ ိုအ လျာက် လိုပ်သွာ်းပါလ မ်ေ့မယ်။  

အာ်းလိုံ်းက ိုမလိုပ်ြေျင်ပဲ က ိုယ်လိုပ်ြေျင်တာ လ်းက ို ရွ်းပပ ်း Upgrade လိုပ်ြေျင်တယ်ဆ ိုလည််းရပါတယ။် က ိုယ် Upgrade လိုပ်ြေျင်တဲေ့ 

Plugin  လ်း ပေါ် Highlight  လ်းလိုပ်ထာ်းလ ိုက် ပိုံမှန် ပေါ် နကျ “Reinstall plugin” ဆ ိုတဲေ့ြေလိုတ်က လ်းက Upgrade 

လိုပ်လ ိုို့ရတယ်ဆ ိုရင် Upgrade Plugin ဆ ိုပပ ်း ခပာင််းသွာ်းပါလ မ်ေ့မယ်။ 
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11.3 Plugin က ို ဖွင်ေ့ ၊ ပ တ်လိုပ်နည််း 

Plugin တစ်ြေိုက ို Activate ဖွင်ေ့၊ ပ တ် လိုပ်ရန် အတွက် ။ ၎င််း၏ ဘယဘ်က်  ဘ်းက  လ်း ထာင်ေ့ကွက် လ်းက ို တစ်ြေျက်စ  click 

နှ ပ် ပ်းပါ။ အမှန်ခြေစ် လကခဏာ နှင်ေ့ အဖွင်ေ့ အပ တ် လိုပ် ပ်းန ိုင်သည်။ 

 

ဖွင်ေ့ထာ်းပိုံ →  ပ တ်ထာ်းပိုံ→  
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12. Open Street Map မ တ်ဆက် 

OSM  ြေေါ် Open Stree Map ဆ ိုတာက တစ်ကမဘာလိုံ်းရဲဲ့ GIS  ေတာ တွက ို လူတ ိုင််း 

လွတ်လပ်စွာနဲဲ့ ပါဝင် ရ်းဆွဲပပ ်း တာေ့၊ လွတ်လပ်စွာခဖင်ေ့ ခပန်လည် အသိုံ်းခပြုလ ိုို့ရ အာင် 

တည် ထာင်ထာ်းတဲေ့ Web GIS application တစ်ြေိုခဖစ်ပါတယ်။ ကမဘာေ့ အနှံို့ အခပာ်းမှာ ရှ တဲေ့ GIS user 

 တွကပဲ ဝ ိုင််းဝန််းပပ ်း တာေ့ ဖန်တ ်း ထာ်းပပ ်း၊ ဖန်တ ်း နဆဲ ခဖစ်ပပ ်း တာေ့၊ ဖန်တ ်းထာ်းတဲေ့  ေတာ တွက ို 

လူတ ိုင််းက ခပန်ပပ ်း အသိုံ်းခပြု နကကပါတယ။်  

 ရှဲ့ပ ိုင််းမှာ  လေ့လာြေဲေ့ကကတဲေ့ GIS ဆ ိုတာ ဘာလဲ ၊ GIS  ေတာ ဆ ိုတာဘာလဲ၊ GIS 

 ေတာ တွက ို ဘယ်လ ို ဖန်တ ်းရတာလဲ၊ Digitizing tool  တွက ို အသိုံ်းခပြုနည််း၊ GIS က ို ဘယလ် ို နရာ တွမှာ အသိုံ်းခပြုကကတာလဲ 

ဆ ိုတာ သ ပပ ်းပပ  ဆ ိုရင် တာေ့ အြေို  နာက်ထပ် သ စရာ လ်း တွက ို အလျင််းသင်ေ့သလ ို မ တ်ဆက် ပ်းသွာ်းပါမယ်။ အ ခြေြေံအဆင်ေ့နဲဲ့ 

GIS က ို ခပန်ဲ့ပွာ်း အာင် လိုပ်ကကရင််းနဲဲ့  ပျာ် မွဲ့ပပ ်း သ ြေျင်စ တ် တွနဲဲ့ အပမဲဆာ လာင်ကကပါ။ ရပ် နလ ိုို့ မရ သ်းပါဘူ်း၊ 

သ ထာ်းစရာ တွက ထပ်ရှ  နပါ သ်းတယ်။ မျက်စ  လ်းဖွင်ေ့ပပ ်းအခပင်ကမဘာက ို တစ်ြေျက်လှမ််းကကည်ေ့လ ိုက်ပါ။ GIS ကမဘာကက ်းက 

ဆက်သွာ်း နကကပပ ။ OSM မှာ  နရာတစ် နရာ အတွက် တစ်ဦ်း တစ် ယာက်က  ေတာ တွက ို တစ်ြေါပဲ  ရ်းဆွဲပပ ်းသွာ်းပပ ဆ ိုရင် 

ကျန်တဲေ့လူက အဲေါက ို Repeat ထပ် ရ်းဆွစဲရာ 

မလ ို တာေ့ဘူ်း၊ ထပ်ပပ ်းခပည်ေ့စိုံ အာင် ခဖည်ေ့ဆည််းဖ ိုို့နဲဲ့ 

အဆင်သင်ေ့ယူသိုံ်းရိုံပဲရှ  တာေ့တယ်။ Repeat of effort 

မရှ  တာေ့ဘူ်း ပါို့။  

OSM က ို သိုံ်းမယ်ဆ ိုရင် လ ိုင်စင်တင််းကကပ်မှု 

သ ပ်မရှ ပါဘူ်း။ OSM  ေတာ တွက ို အသိုံ်းခပြု 

ထာ်း ကကာင််း အသ အမှတ်ခပြုဖ ိုို့နဲဲ့၊ ပ ိုမ ို ကာင််းမွန် 

 အာင် ခပြုခပင်ထာ်း သာ  ေတာမျာ်းက ို ခပန်လည် 

မ  ဝ ပ်း ဖ ိုို့ပဲခဖစ်ပါတယ်။ OSM အ ကကာင််းက ို 

အ သ်းစ တ ် ထပ်သ ြေျင်ပါက ၎င််း၏ မူရင််း website 

http://www.openstreetmap.org/ တွင် ဖတ်ရှုန ိုင် 

ပါသည်။ 

  

12.1 OSM တငွ် GIS  ေတာ Edit ခပြုလိုပ်၊  ရ်းဆဲွနည််း 

OSM မှာ Digitizing လိုပ်ဖ ိုို့ရန်အတွက် မ မ  Computer မှာ ဘာ GIS software မှ 

မလ ိုပါဘူ်း။ အဲ Online အတွက် Internet  တာေ့ ထပ်လ ိုလာတယ်။ 

• Create a free account so that you can contribute. 

• Collect data using a GPS unit or by other methods. 

• Upload GPS data (skip this section if you are not using GPS). 

• Edit maps to make changes to OpenStreetMap. 

• Edit data, add tags and upload changes. 

• See your changes on the map. 

• Finally, there is a page of additional resources and next steps including 

some other excellent tutorials. 

 

12.2 OSM Account လိုပ်နည််း 

https://www.openstreetmap.org/user/new မှာ user acount တစ်ြေို register လိုပ် လ ိုက်ပါ။ 
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OSM website မှာ မ မ က ိုယ်ပ ိုင် login လိုပ်လ ိုက်ပါ။ 

OSM မှာ Web map  တွက နပပ ်း  အာက်ြေံ Satellite 

image ထည်ေ့ထာ်း ပ်းတယ။် ေါက Reference 

လိုပ်ဖ ိုို့သက်သက်  ပ်းထာ်းတာပါ။ မ မ လ ိုြေျင် သာ 

 နရာ ရာက် အာင်  ခမပိုံ ပေါ်မှာ Navigate လိုပ်သွာ်းပါ။ 

ညာဘက်နှာ်းမှာ Background Satellite က ို ရွ်းရန် 

ဖွင်ေ့လ ိုက်ပါ။  

 

အ သ်းစ တ်ခမငက်ွင််းအထ  Zoom In လိုပ်လ ိုက်ပါ။ 

OSM သ ိုို့  ေတာ ထည်ေ့နည််း၊ Digitizing လိုပ်နည််း 

မ မ  Digitize လိုပ်မည်ေ့  နရာသ ိုို့ ရာက် အာင် 

 ခမပိုံက ို Navigate လိုပ်သာွ်းပါ။ ကာ်းလမ််း၊ 

အ ဆာက်အဦမျာ်း ရှင််းလင််းစွာ  တွဲ့ရသည် အထ  Zoom 

In လိုပ်လ ိုက်ပါ။ 

Feature မျာ်းက ို Digitizing လိုပ်ရန် အတွက် Menu bar 

တွင် Edit Tab က ို နှ ပ်လ ိုက်ပါ။ 

Point, Line, Polygon အမျ  ြု်းအစာ်း အလ ိုက်  ရွ်း ပ်းပပ ်း 

 ခမပိုံ ပေါ်တွင် Digitize လိုပ်လ ိုက်ပါ။ 

Double-Click နှ ပ်ပပ ်း feature တစ်ြေိုက ို Digitizing အဆိုံ်းသတ်  ပ်းလ ိုက်ပါ။ 

ထ ို feature အတွက် သင်ေ့ လျာ် သာ အမည်နှင်ေ့ ကဏ္ဍမျာ်းက ို  ရ်း ပ်း၊  ရွ်း ပ်းလ ိုက်ပါ။ 

Save Edit လိုပ် ပ်းလ ိုက်ပါ။ 

မ မ ကကည်ေ့ န သာ Map Canvas အကျယ်အတ ိုင််းရှ  န သာ OSM  ေတာမျာ်းက ို Export လိုပ်ြေျင်ပါက အထက် Menu bar 

တွင်ရှ  သာ Export Tab က ို နှ ပ်လ ိုက်ပါ။ Data Download ကျလာပါမည်။ 
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12.3 OSM ၏ GIS  ေတာမျာ်းက ို Download ရယူနည််း 

ဧရ ယာ တစ်ြေိုက ို  ခမပိုံဆွဲရန် အတွက် OSM data  တွက ို မ မ  Computer ထဲသ ိုို့ download ရယူန ိုင်ပါသည်။ 

 ရ်းဆွထဲာ်းတဲေ့  ေတာရှ ရင် ရမှာ ပါို့ လ။ QGIS version 

2.2 Varlmiera မှာ OSM  ေတာ တွက ိုအလွယတ်ကူ 

download ရယူန ိုင်ပါသည်။  

QGIS တွင် မ မ   ရ်းဆွဲလ ို သာ ပမ ြုဲ့ ခမပိုံ နရာ က ို အရင် 

ဖွင်ေ့ထာ်းလ ိုက်ပါ။ ပမ ြုဲ့ နရာ က ိုသာ လ ိုအပ်ပါက ပမ ြုဲ့အထ  

1: 10000 စ က်း အထ  Zoom In ခပြုလိုပ်ထာ်းပါ။ 

ပမ ြုဲ့ပတ်ဝန််းကျင် နရာပါ လ ိုြေျင်ပါက Map Canvas 

က ိုြေျဲဲ့ထာ်းပပ ်း၊ Zoom Out ခပြုလိုပ်ပါ။  နရာကျယ်ကျယ် 

လ ိုြေျင်ရင်  ေတာ file size ကက ်းကက ်းနှင်ေ့ Download 

အြေျ  န်မျာ်းမျာ်း ကကာခမင်ေ့ပါမည်။ 

 

OSM Downloader က ို check လိုပ်ထာ်းလ င် Tool Bar 

တွင် OSM Downloader tool  ပေါ် နမည်။ 

ထ ို tool က ို click လိုပ်ပပ ်း မ မ  download 

လိုပ်လ ို သာ နရာက ို  လ်း ထာင်ေ့ frame ဆွဲလ ိုက်လ င် 

OSM downloader window  ပေါ်လာမည်။ output file 

name  နရာတွင် မ မ သ မ််းလ ို သာ file path  နှငေ့် file 

name  ပ်းလ ိုက်ပါ။ load layer after download check box 

က ို အမှန်ခြေစ်လိုပ်ထာ်း ပ်းပါ။ Download ပပ ်းသွာ်းလ င် 

message  ပေါ်လာပါမည်။ OK လိုပ်လ ိုက်ပါ။ 

 

 

Project window တွင် ရာက်လာ ပါမည်။ 

checkbox က ိုအမှန်မခြေစ်ထာ်းလ င် တာေ့ add vector layer သ ိုို့မဟိုတ ် file folder မ ှ drug and drop လိုပ်ထညေ့်လ င်လည််း 

ရပါသည်။ 
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Layer မျာ်း၏ Attribute က ို စူ်းစမ််းကကည်ေ့ပပ ်း  လေ့လာ န ိုင်ပါသည်။  ရ်းထာ်းတဲေ့ Attribute  ပေါ်မူတည်ပပ ်း တာေ့  ေတာက ို 

Query လိုပ်ပပ ်း တာေ့  ခမပိုံ ပေါ်မှာ Class နဲဲ့ ြေွဲပပ ်း ခပလ ိုို့ရပါမည်။ Digitize လိုပ်စဉ်က Attribute  ေတာက ို  ကာင််း ကာင််း 

ခပည်ေ့စိုံ အာင် ထည်ေ့ထာ်းလ ိုို့ရှ ရင်  ခမပိုံ ကာင််း ကာင််း ရလာလ မ်ေ့မယ်။ က ဲ က ိုယ်လ ိုြေျင်တဲေ့ နရာက ို  ခမပိုံထိုတ်လ ိုို့ ရပါပပ  

ြေင်ဗျာ်း။ ရှ ပပ ်းသာ်း  ေတာ တွနဲဲ့ အလွယ်တကူ ဆွဲလ ိုို့ရတာ မ ကာင််းဘူ်းလာ်း။ 

 

OSM layer မျာ်းက ို Save as နည််းခဖင်ေ့ shapefile သ ိုို့ Export ခပြုလိုပ်ြေျင်ပါက လိုပ်န ိုင်ပါသည်။ 

 

OSM  ေတာ တွက ို န ိုင်ငံတကာမှာ Humanitarian နဲဲ့ Development အတွက် အသိုံ်းခပြု နတာ  တွဲ့ရပါတယ်။ 

Humanitarian OSM Teamမှာ နမူနာ အ နခဖင်ေ့ ဆက်လက် ဖတ်ရှုန ိုင်ပါတယ။်  

http://wiki.openstreetmap.org/wiki/Main_Page 

The Humanitarian OpenStreetMap Team [HOT] applies the principles of open source and open data sharing for 

humanitarian response and economic development. 

http://hot.openstreetmap.org/projects/central_african_republic_activation 

OSM GIS  ေတာ တွက ို မ မ တ ိုို့ရဲဲ့ GPS ထဲမှာ ထည်ေ့ပပ ်း အသိုံ်းခပြုလ ိုို့လည််း ရန ိုင်ပါတယ။် ကာ်းထဲမှာ သိုံ်းတဲေ့ Car Navigation 

System အတွက်  ခမပို ံအခဖစ် အသိုံ်းခပြုလည််း ရန ိုင်ပါတယ။် 

 

  

http://wiki.openstreetmap.org/wiki/Main_Page
http://hot.openstreetmap.org/projects/central_african_republic_activation
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13. Google Earth အသိုံ်းခပြုနည််း 

န ေါန််း 

ေ  နဲ့မှာ တာေ့ Google Earth/Maps က ို အသိုံ်းခပြုပပ ်း တာေ့  ခမပိုံအမှတ်အသာ်း ခပြုလိုပ်ခြေင််းနဲဲ့၊ မ မ တ ိုို့တ ိုင််းလာတဲေ့ GPS 

 ေတာမျာ်းက ို Google Earth  ပေါ်တင်ပပ ်း အသိုံ်းခပြုခြေင််း၊ KML ဖ ိုင်မျာ်းက ို  ခမပိုံခပြုလိုပ်ခြေင််း၊ Google Earth တွင်ခပြုလိုပ်ထာ်း သာ 

 ခမပို ံ အမှတ်အသာ်းမျာ်းက ို KML ဖ ိုင်ခဖင်ေ့ share ခပြုလိုပ်ခြေင််း စသည်တ ိုို့က ို  လေ့လာရန် ခဖစ်ပါသည်။ အခြော်းသင်ေ့ လျာ် သာ 

အပ ိုင််းမျာ်းက ို လည််း အလျင််းသင်ေ့သလ ို  ဖေါ်ခပသွာ်းမည်ခဖစ်ပပ ်း၊ မ မ ဖာသာ  လေ့လာသွာ်းရန် ရည်ရွယပ်ါသည်။ 

 

  

Google Earth သင်ြေန််းစာ အတွက် လ ိုအပ်ြေျက် 

ေ သင်ြေန််းစာ တွ အတွက် Desktop Computer ၊ Keyboard နဲဲ့ Middle scroll wheel ပါရှ  သာ Mouse နှင်ေ့ 

အ ရ်းကက ်းဆိုံ်းက ပထမဆိုံ်းအကက မ် တွင် Internet speed  ကာင််း ကာင််း ရှ ဖ ိုို့ လ ိုအပ်ပါတယ။် Google Earth 

တွင် Image မျာ်းက ို Cache ခပြုလိုပ်ပပ ်းပါက Internet မလ ိုပဲ offline မှာတင် အသိုံ်းခပြုန ိုင်ပါတယ်။ 3D vitural 

က ို ကကည်ေ့န ိုင်ဖ ိုို့ရန် အတွက်၊ အြေျ  ြုဲ့က 3D Game ကစာ်း သာ Computer specification မျ  ြု်း လ ိုအပ်ပါမည်။ ဆ ိုလ ိုတာက Graphic 

Card  ကာင််းရမည်၊ 3D က ို support လိုပ် ပ်းန ိုင်ရမည်၊ RAM ဆ ိုတဲေ့ Computer Memory မျာ်းရမည်။ မ မ သိုံ်း သာ software 

မျာ်း ပေါ်တွင်လည််း မူတည်ပါမည်။ 

13.1 Google Map ဆ ိုတာ ဘာလဲ 

Google က နထိုတ်လိုပ်တဲေ့ Web based 2D Mapping Service ပ ဲ

ခဖစ်ပါတယ။် ထူ်းထ်ူး ထွ ထွ GIS software မျာ်းမလ ိုအပ်ပဲ Modern Web 

browser  တွခဖစ်တဲေ့ Internet Explorer, FireFox, Chrome, Safari, 

စသည်တ ိုို့နှင်ေ့ပင် အလွယ်တကူ ကကည်ေ့ရှုန ိုင်ပါတယ။်  

https://www.google.com/maps တွင် Google map က ို ကကည်ေ့ရှုန ိုင်ပါတယ။် 

ညာဖက် အ ပေါ် ေါင်ေ့နာ်းက Text box ထဲမှာ မ မ  ကကည်ေ့ြေျင်တဲေ့  နရာနာမည်က ို 

ရ ိုက်ထညေ့ ်ပ်းလ ိုက်တာနဲဲ့ GIS ရဲဲ့နည််းပညာ တြေိုခဖစ်တဲေ့ Google GeoCoder 

နည််းပညာက မ မ ထညေ့်လ ိုက်တဲေ့  နရာက ို ရှာ ပ်းပပ ်း အဲေ  နရာက ို  ခမပိုံက 

အလ ိုအ လျာက် လာခပ ပ်းမှာ ခဖစ်ပါတယ။် ( နာက် နာင် အြေွင်ေ့သင်ေ့ပါက 

GeoCoder အ ကကာင််းက ို ဆက်လက် တင်ခပ ပ်း သွာ်းပါမည်။) ဥပမာ " 

Yangon " ဆ ိုပပ ်း တာေ့ စကာ်းလို်ံး ရ ိုက်ထညေ့်လ ိုက်ရင် ခမန်မာန ိုင်ငံရဲဲ့ 

ရန်ကိုန်ပမ ြုဲ့က ို လာခပပါလ မ်ေ့မည်။ ကမဘာေ့ ခမပိုံ ပေါ်မှာ ' Paris ' ဆ ိုတာ 

ဘယန်ာ်းမှာ ရှ မှန််း သ စရာမလ ိုပဲနှင်ေ့ ရ ိုက်ထညေ့်ပပ ်း ကကည်ေ့လ ိုို့ ရပါတယ်။ 

 ခမပိုံ တွ ြေပ်ခမန်ခမန် ကျလာဖ ိုို့အတွက် Internet  ကာင််းဖ ိုို့ တာေ့ လ ိုပါမယ်။ 

 

Google Map ဟာ အခြော်း သာ Google ထိုတ်ကိုန်မျာ်း (Google Play, 

Google Drive, Gmail, Google +, Google Calendar, Google Photo ) 

နည််းတူ Google Account (Google Mail Account) နှင်ေ့ ြေျ  တ်ဆက်ထာ်းပါတယ။် ေါ ကကာင်ေ့ မ မ က account ထဲက ို log in 

လိုပ်ထာ်းရင် မ မ  အသိုံ်းခပြုထာ်းတဲေ့  ခမပိုံက ို အမှတ်အသာ်းခပြုပပ ်း ၊ share လိုပ်ဖ ိုို့၊ မှတ်သာ်းထာ်းဖ ိုို့ အတွက် အသိုံ်းခပြုလ ိုို့ ရန ိုင်ပါတယ်။ 

မ မ ခပြုလိုပ် သာ အမှတ်အသာ်းက ို ၊ ဓါတ်ပိုံ တွ၊ Link  တွ၊ ဗွ ေ ယ ို တွ၊ အစည််းအ ဝ်း နရာ တွ၊ စသည်ခဖင်ေ့ မ မ သူငယ်ြေျင််းမျာ်းက ို 

၊ အခြော်းသူမျာ်းက ို direct share လိုပ်လ ိုို့ရန ိုင်ပါတယ။် Google + ထဲမှာလည််း တ ိုက်ရ ိုက် ခပန်သိုံ်းလ ိုို့ ရပါတယ။် 
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Google Map မှာ  ခမပိုံက ို အန ်းကပ် ြေျဲဲ့ကကညေ့်ဖ ိုို့အတွက်၊ 

ြေျြုံဲ့ကကညေ့်ဖ ိုို့အတွက် ညာဖက်  အာက်နာ်း လ်းက 

အ ပါင််း၊ အနိုတ် လကခဏာ လ်းက ို နှ ပ်ပပ ်း ကကညေ့်သွာ်း 

န ိုင်ပါတယ။် 

 

13.2 Google Map မှာ ဘာ ခမပိုံ တွရှ လဲ 

1. Satellite Image မျာ်း ပိုံ (ပဂ ြုလ်တို ဓါတ်ပိုံမျာ်း 

အမျ  ြု်းမျ  ြု်း) 

2. Google Street/Road Map ပိုံ (normal, default 2D map, လမ််းနှင်ေ့  နရာ အမည်မျာ်း) 

3. Google Terrain ပိုံ ( တာင်၊ ခမစ် ြေျာင််း မျာ်းပိုံ) 

4. Google Satellite နှင်ေ့ Street map တ ိုို့ ပါင််းထာ်း သာ Google Hybrid ပိုံ စသည်တ ိုို့ ရှ ပါတယ်။ 

 

က ဲGoogle Earth က ို ဆက်သွာ်းရ အာင်။ 

 

 

 

13.3 Google Earth ဆ ိုတာ ဘာလဲ 

3D model ကမဘာလိုံ်းပိုံ ပေါ်မှာ  ခမပိုံ တွ၊ ပဂ ြုလ်တိုဓါတ်ပိုံ တွ၊ က ို  ဖေါ်ခပထာ်းပပ ်း၊ ပထဝ သတင််း အြေျက်အလက်မျာ်းက ိုပါ 

ထပ်ဆင်ေ့တင်ထာ်း ပ်းတဲေ့ အလကာ်းလည််းကကည်ေ့လ ိုို့ရတဲေ့ Map GIS software တစြ်ေိုပဲ ခဖစ်ပါတယ။် အဲေ မှာ ဘာ တွကကည်ေ့လ ိုို့ 

ရသလဲဆ ို တာေ့ တစ်ကမဘာလိုံ်းရဲဲ့ ပဂ ြုလ်တိုဓါတ်ပိုံ တွ၊ ကမဘာေ့ ခမပိုံ အမျ  ြု်းမျ  ြု်း တွ၊  ခမမျက်နှာခပင် အနှ မ်ေ့အခမင်ေ့ပိုံ တွ၊ 

အ ဆာက်အဦ်း တွရဲဲ့ 3D model  တ ွ ၊ အာကသထဲက ပဂ ြုလ် တွ (Mars) ၊ လ တွ၊ နဂါ်း ငွဲ့တန််း တွ၊ 

ပငလ်ယ်ထဲ ြေျာက်နက်ကက ်း တွ၊ စသည်ခဖင်ေ့ စ တ်ဝင်စာ်းဖွယ်ရာ အမျ  ြု်းအစာ်းမျာ်းစွာ ကကည်ေ့ရှုန ိုင်ကကပါတယ။် အကက မ် ပါင််း ၁ 

ဘ လံ ကျာ် လာက် download လိုပ်ထာ်းတယ ်(တကယ်သိုံ်းမသိုံ်း တာေ့ မသ ဘူ်း ပါို့။)  

 

13.4 Google Earth ဘယ်နှစမ်ျ  ြု်း ရှ သလဲ 

Desktop ကွန်ပျြုတာ အတွက်၊ Mobile ဖိုန််း အတွက် Web site plugin 

စသည်တ ိုို့အတွက် အမျ  ြု်းမျ  ြု်း ရှ ပါတယ။်  

Google Earth က   ဘယ်လ   ရယူန  င်သလဲ 

Desktop အမျ  ြု်းအစာ်းအတွက် ယြေင်က offline installation  ပ်း ပမယ်ေ့ 

ယြေို တာေ့ Installer script က န Online installation (Internet နှင်ေ့ 

တ ိုက်ရ ိုက်ြေျ  တ်ဆက်ပပ ်း ထညေ့်သွင််းခြေင််း) သာရရှ န ိုင်ပါတယ်။ ယ နဲ့အထ  update 

version က တာေ့ 7.3 ခဖစ်ပါတယ။် Download ရယူန ိုင်တဲေ့  နရာက တာေ့ http://www.google.com/earth/ ခဖစ်ပါတယ်။ 

ယြေို နာက်ပ ိုင််းမှာ အရင်တိုန််းက ပ ိုက်ဆံနဲဲ့ ပ်းဝယ်ပပ ်းမှ သိုံ်းလ ိုို့ရတဲေ့ Google Earth Professional version က ို အြေမဲေ့ အသိုံ်းခပြုြေွင်ေ့ 

ရပါပပ ။ ပိုံ တွက တာေ့ အတူတူပါပဲ။ ပ ိုလာတာက Professional feature  တွပါ။  နာက်အြေန််း တွမှာ  ဖေါ်ခပသွာ်းပါမယ်။ 

အသိုံ်းခပြုန ိုင်ပိုံ လ ိုင်စင်က ို  အာက်ပါ လင်ေ့တင်ွ ကကည်ေ့န ိုင်ပါတယ်။ 

http://www.google.com/earth/explore/products/desktop.html 

 3D Virtual Globe မျာ်းက ို ကကည်ေ့ရှုန ိုင်ရန် အတွက် လ ိုအပ် သာ System requirement နှင်ေ့ Graphic Card Specs မျာ်းမှာ 

 အာက်ပါ အတ ိုင််း ခဖစ်ပါသည်။ 

PC - Windows XP, Windows Vista, or Windows 7 

Mac - Mac OS X 10.6.0 or later 

http://www.google.com/earth/
http://www.google.com/earth/explore/products/desktop.html
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Linux - LSB 4.0 (Linux Standard Base) libraries 

Requirements: a 3D video card with updated drivers is necessary. World Wind has been tested on Nvidia, ATI/AMD, 

and Intel platforms using Windows, MacOS 10.9, and Fedora Core 6. 

Note: Update your video card drivers. 

မ မ  Download တေဲ့ version  ပေါ်မှုတည်ပပ ်း    သ ိုို့မဟိုတ်   ဆ ိုတဲေ့ installer ဖ ိုင်က ို Click 

လိုပ်လ ိုက်ပါ။ ဆက်ပပ ်း တာေ့ OK, Agree, Continue, Install စသည်ခဖင်ေ့ လ ိုအပ်သလ ို 

ဆက်သွာ်းပါ။ Google Earth Pro က ို intall ခပြုလိုပ်ပါက၊ user name  နရာတွင် မ မ ၏ E-

mail က ို ထညေ့်ပပ ်း၊ License key  နရာတွင် GEPFREE ဟို ရ ိုက်ထညေ့်ကာ ဆက်ဝငလ် ိုက်ပါ။ 

Install ခပြုလိုပ်စဉ် ပထမဆိုံ်းအကက မ်တွင် Google Map Server နှင်ေ့ ြေျ  တ်ဆက် ရန် အတွက် 

နှင်ေ့ Image မျာ်း download ခပြုလိုပ်န ိုင်ရန် အတွက် Internet လ ိုအပ်ပါသည်။ Install ခပြုလိုပ်ပပ ်းပါက အသိုံ်းခပြုန ိုင်ပါပပ ။ 

13.5 Google Earth က ို မ တ်ဆက ် ပ်းခြေင််း 

 

 

 

 

 

Window Start > All Programs > Google Earth > Google Earth သ ိုို့မဟိုတ ်Google Earth Pro က ို စဖွင်ေ့ လ ိုက်ပါ။ Sever က ို 

ပထမဆိုံ်း အကက မ် Connect လိုပ်ပပ ်းတာနဲဲ့ 

စသိုံ်းလ ိုို့ရပါပပ ။ အရင်ဆိုံ်း မျက်စ  

ယဉ်သွာ်း အာင် Google Earth မှာပါတဲေ့ 

Graphic User Interface က ို အရင်ဆိုံ်း 

မ တ်ဆက် ပ်းရ အာင်။  အာက်ကပိုံ လ်း 

အတ ိုင််း  တွဲ့ရမယ်။ 

 

 

 

1 က Main Menu  တ ွ ရှ တယ။် File 

 တွက ို သ မ််းဖ ိုို့ ၊ View က ို ခပင်ဖ ိုို့ ၊ Option 

 တွက ို setting ခပင်ဖ ိုို့၊ Tool 

 တွက ို ြေေါ်သိုံ်းဖ ိုို့ ၊ Place mark  တွက ို 

ထညေ့်ဖ ိုို့ အတွက် သိုံ်းပါတယ်။ 

2 က အသိုံ်းခပြုန ိုင်တဲေ့ Tool  တွနဲဲ့ Theme က ို အလွယတ်ကူ  ခပာင််းဖ ိုို့အတွက် Main menu က န ထိုတ် ပ်းထာ်းခြေင််း ခဖစ်ပါတယ်။ 

3 က 3D ကမဘာလိုံ်းပိုံ သ ိုို့မဟိုတ်  ခမပိုံမျာ်းခပ သာ ဧရ ယာ ခဖစ်ပါတယ။် 

4 က  ခမပိုံက ို လာ်းရာ လှည်ေ့ဖ ိုို့၊ အထက် အာက ်၊  ဘ်း ၊ ဘယ်ညာ လှည်ေ့ ဖ ိုို့နှင်ေ့ ြေျဲဲ့ကကည်ေ့ဖ ိုို့၊ ြေျြုံဲ့ကကည်ေ့ဖ ိုို့အတွက် သိုံ်းပါတယ။်  

5 Places မှာ က က ိုယ်ထညေ့်ထာ်းတဲေ့ ဖ ိုင် Layer  တွရဲဲ့စာရင််း တွ ခပဖ ိုို့ ခဖစ်ပါတယ။် မ မ က ဖ ိုင်တစြ်ေို ထညေ့်လ ိုက်တ ိုင််း ေ  နရာမှာ 

လာ ပေါ် နလ မ်ေ့မယ်။ 

6 Layers ဆ ိုတဲေ့ နရာမှာ တာေ့ Google က  န ပ်းထာ်းပပ ်း အသိုံ်းခပြုန ိုင်တဲေ့ Layer  တွရဲဲ့စာရင််း တွ ရှ ပါတယ်။  

တစြ်ေါတစ ်လ က ိုယ်ကကည်ေ့ြေျင် သာ အရာက ို ထင် ပေါ်ြေျင် သာ အရာက ို ပ ိုမ ို  ပေါ်လွင် အာင်ပဲခဖစ်ခဖစ်၊ ကက ြုတင်ပပ ်း တာေ့ Google 

Earth က ို အခမင် ခပာင််းသွာ်း အာင် လိုပ်ြေျင်လ ိုို့ပဲခဖစ်ခဖစ်၊ setting က ို လ ိုအပ်သလ ို ခပင်ဆင် ပ်းရတာ တွ ရှ ပါတယ်။ အဲသလ ို 

Setting ခပင်ရန် အတွက် Menu bar > Tools > Options က ို သွာ်းလ ိုက်ပါ။ အဲေ မှာ 3D View ၊ Cache ၊ Touring ၊ Navigation ၊ 

General စတဲေ့ tab မျာ်းက ို  တွဲ့ရပါလ မ်ေ့မယ်။  
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3D View tab ထဲမှာ Color က ို ခပငလ် ိုို့ရတယ၊် Pointer Location က ို ယူနစ် အမျ  ြု်းမျ  ြု်းနဲဲ့ခပဖ ိုို့ ခပင်လ ိုို့ရတယ်၊ တ ိုင််းတာတဲေ့ ယူနစ်က ို 

ခပငလ် ိုို့ရတယ်၊ 3D ပိုံကကည်ေ့မယ်ဆ ိုရင် ပ ိုထင်ရှာ်း အာင် ဘယန်ှစ်ဆ ြေျဲဲ့ြေျင်လဲ ခပင်လ ိုို့ရတယ။် 

Cache tab ထဲမှာ Google Earth image  တွက ို သ မ််းထာ်းန ိုင်မည်ေ့ Disk Cache (2 Giga Byte အထ ) နှင်ေ့ Memory Cache 

အရွယ်အစာ်းတ ိုို့က ို ခပင်ဆင်န ိုင်ပါသည်။ Offline အသိုံ်းခပြုြေျင်ပါက မျာ်းမျာ်း ထာ်း ပ်းရပါမည်။ အကယ်၍ Image မျာ်းက Cache 

ထက် ကျာ်လွန်လာပါက  ရှဲ့ပ ိုင််းမှ Cache မျာ်းက ို အလ ိုအ လျာက် ဖျက်ပစ်ပပ ်း၊ 

 နာက်ဆိုံ်းကကည်ေ့ထာ်း သာ image မျာ်းက အစာ်းထ ို်း နရယူပါလ မ်ေ့မည်။ 

Touring ဆ ိုတဲေ့ tab  အာက်မှာ Google Earth က ို tour ဖန်တ ်းရာတွင် မ မ စ တ်ကက ြုက် 

ကက ြုတင် ခပင်ဆင်န ိုင်ပါသည်။  

Navigation tab မှာ လည််း ပျသံန််းခြေင််းနှင်ေ့ tool မျာ်း၏ setting က ို ခပငဆ်င် 

န ိုင်ပါသည်။ 

 ခပာ နတာက ပ ိုကကာပါတယ်၊ လက် တွဲ့လိုပ်ခပလ ိုက်ရင် ပ ိုခမန်ပပ ်း၊ ပ ိုနာ်းလည် 

လွယပ်ါတယ။် က ဲအထက်က  ခပာြေဲေ့တဲေ့အရာ တွက ို လက် တွဲ့ သရိုပ်ခပမယ် နာ်။ 

ကိုလာ်းထ ိုင် နာက်ပစ်ထ ိုင် နပပ ်း သက် တာင်ေ့သက်သာနဲဲ့ လ ိုက်ကကည်ေ့ နပါ။  

 

13.6 Google Earth က ို ဘယ်လ ိုကကည်ေ့ရမလဲ 

Navigation Tool က ို အသိုံ်းခပြုခြေင််း 

ညာဖက် အ ပေါ်နာ်းမှာ ရှ တဲေ့ tool  တွက ို ပိုံပါ အတ ိုင််း စမ််းကကည်ေ့လ ိုက်ပါ။ 

 နရာက ို လည်ေ့ကကည်ေ့ပပ ်း၊ ြေျဲဲ့ကကည်ေ့ပပ ်း၊  ခပာင််းလ ိုက်တာနဲဲ့ ပိုံအသစ် တွ  ပေါ်လာပါလ မ်ေ့မယ်။ မ မ ရဲဲ့ Internet band width / speed 

 ပေါ်မှုတည်ပပ ်း အ နှ်းနဲဲ့အခမန် ပိုံမျာ်း ကျလာပါမည်။ က ဲ  နရာ တစ ်နရာက ို View က ို လမ််း တွ၊ အ ဆာက်အဦ တွ ခမင် န 

ရ အာင် Zoom Level က ို တ ို်းြေျဲဲ့ပပ ်း တာေ့ ကကည်ေ့ထာ်းလ ိုက်ပါ။  

Keyboard နှင်ေ့ Mouse တ ိုို့က ိုတွဲသိုံ်းပပ ်း တာေ့လည််း ကကည်ေ့န ိုင်ပါ သ်းတယ်။ 

 

Mouse ခဖင်ေ့ သိုံ်းနည််း။ 

Drag လိုပ်ပပ ်း  နရာ  ရွဲ့ကကည်ေ့ပါ။ 

Scroll wheel က ို  ရှဲ့တ ို်း၊  နာက်ဆိုတ် လိုပ်ကကည်ေ့ပါ။  

ပိုံ၏  နရာတစ ်နရာ ပေါ်တွင် Mouse ၏ Middle-button က ို ဖ ထာ်းပပ ်း mouse က ို အ ပေါ် အာက်၊ 

 ဘ်းဘယည်ာ  ရွဲ့ကကည်ေ့ပါ။ 

 

Keyboard ခဖင်ေ့ သိုံ်းပပ ်း ကကည်ေ့နည််း။ 

Up/Down arrow နှင်ေ့ Left/Right arrow  

Page Up / Page Down 

Ctrl + Up/Down Arrow နှင်ေ့ Ctrl + Left/Right Arrow 

Shift + Up/Down Arrow နှင်ေ့ Shift + Left/Right Arrow 

Ctrl + Shift + Up/Down Arrow   

Keyboard နှင်ေ့ Mouse က ို တွဲပပ ်း သိုံ်းနည််း 

Ctrl + Scroll forward/backward (mouse အလယ်ဘ ်းက ို  ရှဲ့၊  နာက်သ ိုို့ လ မ်ေ့ပါ။) 

Shift + Scroll forward/backward (mouse အလယ်ဘ ်းက ို  ရှဲ့၊  နာက်သ ိုို့ လ မ်ေ့ပါ။ 
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13.7 Layer မျာ်းက ို ဖွင်ေ့ပပ ်း ကကည်ေ့ခြေင််း 

ဘယဖ်က်  အာက်မှာရှ တဲေ့ Layer  တွက ို တစြ်ေိုပပ ်းတစြ်ေို Tic လိုပ်ပပ ်း ဖွင်ေ့ကကည်ေ့လ ိုက်ပါ။ Borders and Labels က ို 

ဖွင်ေ့ကကည်ေ့ပါက၊ မ မ သိုံ်းတဲေ့ Zoom Level  ပေါ်မှုတည်ပပ ်း န ိုင်ငံ၊ ပမ ြုဲ့၊ ရွာ၊ လမ််း၊  နရာ စသည်ေ့  နရာ တွရဲဲ့ အမည်မျာ်း နှင်ေ့ 

သ ကေတမျာ်း  ပေါ်လာပါမည်။ တစြ်ေိုပပ ်းတစြ်ေို မ မ က ိုယ်တ ိုင် ဆက်သိုံ်းကကည်ေ့လ ိုက်ပါ။ 

 

 

 

 

 

 

 

 

 

 

 

 

13.8  လေ့ကျင်ေ့ြေန််း 

1. Save image tool က ို သိုံ်းပပ ်း မ မ ကကည်ေ့ န သာ Google Satellite Image ပိုံက ို Save လိုပ်ကကည်ေ့ပါ။ 

2. ထင်ရှာ်း သာ ပမ ြုဲ့ တာ်မျာ်းက ို သွာ်းပပ ်း Google Street View က ို စမ််းပပ ်း သိုံ်းကကည်ေ့ပါ။ 

3. ထင်ရှာ်းတဲေ့ကမဘာေ့ပမ ြုဲ့ကက ်း တွက ို သွာ်းလည်ကကည်ေ့ပပ ်း 3D building  တွက ို ရှာပပ ်း တာေ့လည််း ကကည်ေ့ကကည်ေ့ပါ။ 

4.  ခမပိုံက ို Geographic Grid line မျာ်းခဖင်ေ့  ဖေါ်ခပ ပ်းပါ။ 

Google Earth မှာ  ရ်းထာ်းတဲေ့ နာမည်က အကိုန် မှန်သလာ်း။ 

အပမဲတမ််း  တာေ့ မမှန်ပါဘူ်း။ (ခပင်ဆင်ဖ ိုို့ လ့ ိုအပ်  နပါ သ်းတယ်) 

ခပထာ်းတေဲ့ လမ််း တွက အပမဲတမ််း မှန်သလာ်း။ 

အပမဲတမ််း မမှန်ပါဘူ်း။ (Ground survey လ ိုက်ဖ ိုို့ လ ိုအပ် 

 နပါ သ်းတယ်။ မယိုံရင်  ရ  တာင်ကကာ်းထဲက လမ််း တွက ို 

ဝင်သွာ်းကကည်ေ့လ ိုက်ပါ။) 
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5. စ က်းဘာ်း ထညေ့်ခပပါ။ 

6. Overview  ခမပိုံ ထညေ့်ခပပါ။ 

13.9 Google Earth က ို အသိုံ်းခပြုခြေင််း အပ ိုင််း 

ဖ ိုင်မျာ်းက ို Folder ဖွဲဲ့ပပ ်း စနစ်တကျ သ မ််းထာ်းခြေင််း  

 ကာင််း သာ Data Management အ လေ့အကျင်ေ့ လ်း အတွက် အရင်ဆိုံ်း Google Earth ထဲမှာ အလိုပ်လိုပ် သမ  သာ 

မ မ ဖ ိုင်မျာ်းက ို Folder မျာ်းခဖင်ေ့ စနစ်တကျ ြေွဲထာ်းပပ ်း သ မ််းထာ်းသင်ေ့ပါသည်။ project တစြ်ေိုက ို folder တစြ်ေိုစ  ဖွဲဲ့ထာ်း ပ်းရပါမည်။ 

ယြေို digitize ခပြုလိုပ်မည်ေ့ ဖ ိုင်မျာ်းအာ်းလိုံ်း ဤ folder  အာက်တွင် ထာ်းမည် ခဖစ်ပါသည်။  

13.9.1 Folder တစြ်ေိုက ို ဖန်တ ်းဖ ိုို့ရန်အတွက် Main menu bar > Add > Add Folder က ို နှ ပ်လ ိုက်ပါ။ folder 

Property window  လ်းတစြ်ေို  ပေါ်လာပါမည်။  

13.9.2 Name တွင် အမည် တစြ်ေို ပ်းလ ိုက်ပါ။ (myProject) 

13.9.3 အဲေ မှာ ‘Allow this folder to be expended’ က ို Check လိုပ်ထာ်း ပ်းပါ။  

13.9.4 Description မှာ ေ  Project အ ကကာင််းနဲဲ့ folder ထဲမှာ ဘာ တွထညေ့်ထာ်းလဲ  ဖေါ်ခပ ပ်းလ ိုက်ပါ။ 

13.9.5 Link နဲဲ့ Image က ို  နာက်မှ လ ိုအပ်ရင် ခပန်ထညေ့်မယ်။ 

13.9.6 OK က ို ဆက်နှ ပ်လ ိုက်ပါ။ ေါဆ ိုရင် ညာဖက် အ ပေါ်နာ်းက Places  အာက်နာ်းမှာ ြေိုနက ဖန်တ ်းလ ိုက်တဲေ့ 

‘myProject’ ဆ ိုတဲေ့ folder  လ်း ပေါ်လာ လ မ်ေ့မယ်။ 

13.9.7 ကဲ  နာက်မှာ Digitizing  ရ်းဆွဲမည်ေ့ layer  တွအကိုန်လိုံ်းက ို ေ  ‘myProject’ folder  အာက်ထဲမှာ 

ထာ်းသွာ်းပါမည်။ 

13.10 Add Placemark ခဖင်ေ့  နရာအမှတ်အသာ်း  ရ်းဆဲွခြေင််း 

Add Placemark က  နရာ တစ်ြေိုက ို အမှတ်အသာ်း ခပြုဖ ိုို့ရန်အတွက် သိုံ်းတယ်။ လ ိုြေျင် သာ Zoom Level  ရာက် အာင် 

 ခမပိုံက ို (Ctrl+Shift+Up arrow) ြေျဲဲ့ထာ်းပပ ်း၊ View က ို အ စာင််းလ ိုက် မထာ်းဘ ဲအတည်ေ့အတ ိုင််း ခပန်ထာ်းလ ိုက်ပါ။ (Shift + Up 

arrow အဆိုံ်းထ  နှ ပ်ပါ) 

13.10.1 Placemark က ို ထညေ့်ရန်အတွက် Main menu bar > Add > 

Placemark က ို နှ ပ်လ ိုက်ပါ။ 

13.10.2  ခမပိုံ ပေါ်တွင် အဝါ ရာင် ပင််းအပ်နှင်ေ့ New placemark ဆ ိုတဲေ့ 

Widow တစြ်ေို ပေါ်လာပါမည်။  

13.10.3 မ မ  မှတ်သာ်းြေျင် သာ  နရာ ပေါ်က ို အတ အကျ  ရာက် အာင် 

ပင််းအပ်က ို  နရာ ရွဲ့ ပ်းပါ။ 

13.10.4 New placemark window ထဲက Name ဆ ိုတဲေ့ နရာ လ်းမှာ 

မှတ်သာ်းြေျင် သာ အမည်က ို ရ ိုက်ထညေ့်ပါ။ 

13.10.5 အမည် ဘ်းက Icon  လ်းက ို ဆက်နှ ပ်လ ိုက်ပါ။  
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13.10.6 အသိုံ်းခပြုန ိုင်တဲေ့ Icon အမျ  ြု်းအစာ်း မျာ်းစွာ  ပေါ်လာပါမည်။ 

မ မ မှတ်သာ်းထာ်း သာ  နရာနှင်ေ့ သင်ေ့ လျာ် သာ သ ကေတ 

တစ်ြေိုက ို  ရွ်း ပ်းပပ ်း၊ OK က ိုနှ ပ် ပ်းလ ိုက်ပါ။ မ မ က ိုယ်ပ ိုင် Icon 

ခဖစ်တဲေ့ ရိုံ်းသ ကေတ၊ အဖွဲဲ့အစည််းသ ကေတ၊ project 

အမျ  ြု်းအစာ်းသ ကေတ စသည်ခဖင်ေ့ ဖန်တ ်းပပ ်း ထညေ့်သွင််းန ိုင်ပါတယ်။  

13.10.7 ေ အမှတ် အ ကကာင််းက ို  ဖေါ်ခပ ပ်း သာ Description နဲနဲ 

 ရ်း ပ်းလ ိုက်ပါ။  

13.10.8 OK က ို ဆက်နှ ပ်လ ိုက်ပါ။ ေါဆ ိုရင်  နရာတစြ်ေိုက ို အမှတ ်

မှတ်သာ်းပပ ်းပါပပ ။  

13.10.9 မ မ မှတ်လ ိုက် သာ placemark သည် ဘယဖ်က် Places 

 အာက်တွင်  ရာက် နပါလ မ်ေ့မည်။ (မ ရာက်ြေဲေ့လျင်လည််း ‘myProject’ folder  အာက်ထဲမှာ 

တစ်စိုတစစ်ည််းထ ဲခဖစ် အာင် အထက် အာက် Drag လိုပ်ပပ ်း ဆွထဲညေ့် ပ်းလ ိုက်ပါ။) 

13.10.10 က ဲအဲေ မှာ  ပေါ် နတဲေ့ ဖ ိုင်အမည် ပေါ်က ို Double-click လိုပ်လ ိုက်ပါ။  ခမပိုံက အဲေ့ေ  နရာနာ်းဆ က ို 

 ြေေါ်သာွ်းလ မ်ေ့မယ်။  ခမပိုံ ပေါ်မှာ က ိုယ်မှတ်ထာ်းတဲေ့ အမှတ် ပေါ်က ို mouse ခဖင်ေ့ တစြ်ေျက် click 

လိုပ်ကကည်ေ့လ ိုက်ပါ။ ဘာခဖစ်သွာ်းလဲ။ အမှတ်ရဲဲ့ Description က ိုခပ ပ်းတဲေ့ Pop up window  လ်း 

 ပေါ်လာတယ။် ေ လ ိုနည််းမျ  ြု်းနဲဲ့  နရာမျာ်းက ို မှတ်သာ်းန ိုင်ပါတယ်။  

13.10.11 ေ တြေါ  နာက်ထပ်တစမ်ှတ် ထပ်ပပ ်း မှတ်ပါ။ ေ တစြ်ေါ မှာ Placemark အတွက် ၊ Style Color ၊ View ၊ Altitude 

စသည်ခဖင်ေ့ ထပ်ထညေ့်ကကည်ေ့ပါ။ အာ်းလိုံ်းပပ ်းရင် OK နှ ပ်လ ိုက်ပါ။ အဲေ  မှတ်ထာ်းတဲေ့ Placemark က ို ခပငြ်ေျင်ပါက ၊ 

အဲေ ဖ ိုင် ပေါ်က ို Click  ြေေါ်ပပ ်း Properties က ို ခပန်ကကည်ေ့ပပ ်း တာေ့ ခပငဆ်င်န ိုင်ပါတယ်။ 

 

 

 

 

 

Placemark  လော့က င်ော့ခ ်ျား  

1. Google Earth  ပေါ်တွင် မ မ  စ တ်ဝင်စာ်းသည်ေ့  နရာက ို သွာ်းပါ။ Placemark အမျ  ြု်းမျ  ြု်း တစ်ြေိုပပ ်းတစြ်ေို မှတ်သာ်းပပ ်း 

ထညေ့်သွာ်း ပ်းပါ။ (အနည််းဆိုံ်း ၁၀ ြေို လိုပ်ကကည်ေ့ပါ။) 

2.  ရ်းဆွထဲာ်း သာ  နရာ ေသမျာ်း၏ တည် နရာ Latitude/Longitude တန်ဖ ို်းမျာ်းက ို ထိုတ်နိုတ်ခပပါ။ 

13.11 Add Path ခဖင်ေ့ လမ််း ကကာင််း  ရ်းဆဲွခြေင််း 

ေ တစြ်ေါ လမ််း ကကာင််းက ို မှတ်သာ်းဖ ိုို့ ဆွဲကကည်ေ့ရ အာင်။ 

 နရာ ၊ လမ််း ကကာင််း စသည်တ ိုို့က ို ထညေ့်သွင််းရန် အတွက်  ခမပိုံက ို (အ ပေါ်စ ်းမှ  အာက်က ို တည်ေ့တည်ေ့ 

ကကည်ေ့သကဲေ့သ ိုို့) အပမဲတမ််း အ နအထာ်းနှင်ေ့ လာ်းရာ (View angle နှင်ေ့ Orientation) အမှန် ခဖစ် အာင် 

အတည်ေ့ထာ်းပပ ်းမှ  ရ်းဆွဲရပါမည်။ သ ိုို့မဟိုတ်ပါက အကကည်ေ့ ြေပ် စာင််း စာင််း အ နအထာ်းနဲဲ့  ရ်းဆွဲ တာေ့ 

 ခမခပင် ပေါ်က တကယ်ေ့ နရာနှင်ေ့ လွဲသွာ်းမှာ ပါို့။ 
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13.11.1 လမ််း ကကာင််းက ို ဆွဲြေျင်ပါက Main menu bar > Add > Add Path က ို နှ ပ်လ ိုက်ပါ။ 

13.11.2 Property window တစြ်ေို ပေါ်လာပပ ်း၊  ခမပိုံ ပေါ်ရှ  Cursor သည်  လ်း ထာင်ေ့ပိုံ ြေျ  န်ကွင််း  လ်းခဖစ်လာပါမည်။ 

13.11.3 လမ််း ကကာင််း စ ရ်းဆွဲြေျင် သာ  နရာမှ စပပ ်း၊ လမ််း ကကာင််းမျာ်းက ို အမှတ်တစြ်ေိုပပ ်းတစြ်ေို ဆက်ပပ ်း ြေျသွာ်းပါ။ 

ြေျပပ ်း သာ အမှတ်သည် အန  ရာင် ခဖစ် နပပ ်း၊  နာက်ဆိုံ်း အမှတ်သည် အခပာ ရာင် ခပ နပါမည်။ 

 ရ်းဆွဲ နရင််းနဲဲ့ ၊  ခမပိုံက ို လ ိုအပ်သလ ို ြေျြုံဲ့ြေျဲဲ့ ၊ ဘယည်ာ  ရွဲ့ ရွဲ့သွာ်း န ိုင်ပါသည်။ လ ိုင််းအ ရာင် ၊ 

အထူအပါ်းနှင်ေ့ Transparency က ို Property ၏ Style, Color tab ထဲတွင် ခပင်ဆင်သွာ်းန ိုင်ပါသည်။ 

 ရ်းဆွပဲပ ်း သာပိုံမှာ  အာက်ပါ နမူနာ အတ ိုင််း  တွဲ့ရမည်။ 

 

 
 

 လေ့ကျင်ေ့ြေန််း 

1. Ruler ခဖင်ေ့ အကွာအ ဝ်း မျာ်းက ို ယူနစ် အမျ  ြု်းမျ  ြု်းခဖင်ေ့ တ ိုင််းကကည်ေ့ပါ။ 

2. မ မ   ရ်းဆွဲထာ်း သာ Path Layer အမည် ပေါ် Right-click တင်ပပ ်း၊ Show elevation profile က ို နှ ပ်လ ိုက်ပါ။ 

မ မ ဆွဲထာ်း သာ လမ််းတစ် လျာက် အတွက် အခမင်ေ့ ပမျာ်းက ို ခပ သာ topo cross section profile တစ်ြေို 

 အာက်နာ်းတွင်  ပေါ်လာလ မ်ေ့မည်။ 

3. လမ််းတစ ်လျာက်ရှ  အခမင်ေ့ ပ မျာ်းက ို သ ြေျင်ပါက Profile  ပေါ်တွင် coursor က ို တင်လ ိုက်ရိုံနှင်ေ့  ခမပိုံ ပေါ်တွင် 

လာ ရာက် ခပသပါမည် သ ရှ န ိုင်ပါသည်။ 

4. Measurement tool က ို သိုံ်းပပ ်း လမ််း ကကာင််းဆွဲကာ အကွာအ ဝ်းက ို တ ိုင််းကကည်ေ့ပါ။ 

5.  ရ်းဆွထဲာ်း သာ လမ််း ကကာင််းမျာ်းအတွက် Elevation profile က ို  ဖေါ်ကကည်ေ့ပါ။ 

6.  တာင်အတက်အဆင််း  တွပါရှ ပပ ်း စ တ်ဝင်စာ်းဖွယ် သဘာဝ ရှုြေင််းမျာ်းနှင်ေ့  ကျ်းလက်ဓ လေ့မျာ်းက ိုပါ  လေ့လာန ိုင်သည်ေ့ 

Tourist Tracking လမ််း ကကာင််း တစြ်ေို ဆွဲ ပ်းပါ။ 

7. စက်ဘ ်းစ ်းသွာ်းလ ိုို့ ရန ိုင်မည်ေ့ လမ််း ကကာင််း နရာနှင်ေ့  တာင်အတက်အဆင််း သ ပ်မမတ်သည်ေ့ Elevation Profile 

မျ  ြု်းရ အာင် Bike Tracking လမ််း ကကာင််း တစြ်ေို ဆွဲ ပ်းပါ။ 
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13.12 Add Polygon ခဖင်ေ့ ဧရ ယာ  နရာ  ရ်းဆဲွခြေင််း 

13.12.1 ဧရ ယာ တစြ်ေိုက ို digitizing ခပြုလိုပ်မည်ဆ ိုပါက Main menu bar > Add > Add Polygon က ို နှ ပ်လ ိုက်ပါ။  

13.12.2 Property window တစြ်ေို ပေါ်လာပပ ်း  ခမပိုံ ပေါ်ရှ  

Cursor သည်  လ်း ထာင်ေ့ပိုံ ြေျ  န်ကွင််း လ်း 

ခဖစ်လာပါမည်။ ဧရ ယာ စ ရ်းဆွဲြေျင် သာ  နရာမှ စပပ ်း 

အနာ်းစွန််းမျာ်းက ို အမှတ်တစြ်ေိုပပ ်းတစြ်ေို ဆက်ပပ ်း 

ြေျသွာ်းပါ။ Opacity 100 % ထာ်းပါက  အာက်ကပိုံက ို 

လိုံ်းဝ အပ တ်ခဖင်ေ့ ဖိုံ်းအိုပ် နပါမည်။  အာက်ပိုံက ို 

 ဖျာက်ပပ ်း ခမငြ်ေျင်ပါက Polygon ရဲဲ့ Opacity က ို 

ဂဏန််း နည််းနည််းခဖင်ေ့  လျာေ့၍ ခဖည်ေ့ကကည်ေ့ပပ ်း ကကည်ေ့လ ိုို့အဆင် ခပတဲေ့  နရာမှာ ထာ်း ပ်းလ ိုက်ပါ။ 

ဆွဲပပ ်းနမူနာပိုံမှာ  အာက်ပါအတ ိုင််း ခဖစ်သည်။ 
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 လေ့ကျင်ေ့ြေန််း 

1. Measurement tool က ိုသိုံ်းပပ ်း Polygon ၏ ဧရ ယာမျာ်းက ို တ ိုင််းတာကကည်ေ့ပါ။ 

2. အထက်က နည််းမျာ်းက ို သိုံ်းပပ ်း Topographic profile ၊ Elevation feature မျာ်းနှင်ေ့ 3D model က ို အသိုံ်းခပြုပပ ်း  ပ ၁၀ဝ 

အခမင်ေ့ ဆည် ဆာက်ြေဲေ့သည်ရှ  သာ်  ရလွမ််းမ ို်းန ိုင်မည်ေ့  နရာမျာ်းက ို Polygon area ခဖင်ေ့ ခပသဖ ိုို့ရန် အတွက်  ရ်းဆွခဲပပါ။ 

 

13.13 လမ််း ကကာင််းနှင်ေ့ Polygon မျာ်းက ို Edit ခပြုလိုပ် ခပင်ဆငခ်ြေင််း 

ခပငြ်ေျင် သာ လမ််း ကကာင််း သ ိုို့မဟိုတ ်polygon က ို Select လိုပ်ထာ်းပပ ်း ၎င််းရဲဲ့ Property က ိုဖွင်ေ့လ ိုက်ပါ။ ခပငြ်ေျင် သာ 

အမှတ် နရာ ပေါ်က ို Click လိုပ်ပါ။ မျဉ််းမျာ်း၏အမှတ် အခပာ ရာင် ခဖစ်လာပါက ၎င််းအမှတ်က ို တွန််းပပ ်း  ခပာင််းြေျင် သာ  နရာသ ိုို့ 

 ရွဲ့ ပ်းလ ိုို့ရတယ။် Delete နှ ပ်ပပ ်း ဖျက်လ ိုို့လည််းရတယ်။ အမှတ်ထပ်ပပ ်း တ ို်းြေျင်ပါက လ ိုင််း ပေါ်မှာ Click နှ ပ်လ ိုက်ရင်လည််း 

ရပါတယ။် Edit လိုပ် နရင််း Right-Click လိုပ်ပပ ်း ခပန်ခပင်ြေျင်ရင်လဲ ရတယ်။ Edit ပပ ်းလျင် Property က ို ခပန်ပ တ်ထာ်းလ ိုက်ပါ။ 

 

13.14 Ruler ခဖင်ေ့ တ ိုင််းတာနည််း အမျ  ြု်းမျ  ြု်း 

Google Earth Pro တွင် Ruler (Menu bar > Tools > Ruler) 

က ိုသိုံ်းပပ ်း တာေ့ မျဉ််း ခဖာင်ေ့တစြ်ေို၏ အကွာအ ဝ်း၊ 

( ကွဲ့ ကာက် န သာ) လမ််း ကကာင််းတစြ်ေို၏ အကွာအ ဝ်း၊ 

ဧရ ယာတစြ်ေို၏ အနာ်းမျဉ််းအရှည်နှင်ေ့ အကျယ်အဝန််း၊ စက်ဝ ိုင််းပိုံ 

ဧရ ယာ တစြ်ေို၏ အြေျင််းဝက်၊ အနာ်းမျဉ််းအရှည်နှင်ေ့ အကျယ်အဝန််း၊ 

သိုံ်းဖက်ခမင် 3D ပိုံတစြ်ေို၏ အခမင်ေ့၊ အကျဉ််းအကျယ်၊ ဧရ ယာ 

စသည်တ ိုို့က ို တ ိုင််းတာ ပ်းန ိုင်ပါသည်။ 

 

13.15 Google Earth ထဲသ ိုို့ GIS  ေတာမျာ်း Import လိုပ်နည််း 

( ကာင််းသတင််း) Google Earth Pro version မှာ GIS data  တွက ို တ ိုက်ရ ိုက် ထညေ့်ဖွင်ေ့လ ိုို့ ရပါပပ ။ Main menu > File 

> Import က ို  ရွ်းလ ိုက်ပါ။ ထညေ့်မည်ေ့ဖ ိုင် အမျ  ြု်းအစာ်းက ို  ရွ်း ပ်းပါ။ အသိုံ်းမျာ်းတဲေ့ဖ ိုင်အမျ  ြု်းအစာ်း  တာ် တာ်မျာ်းမျာ်း ထညေ့်ဖွင်ေ့လ ိုို့ 

ရန ိုင်ပါတယ်။ (သတင််း ကာင််း)။ Import လိုပ်ပပ ်း ရင် Layer Style ပါ တစြ်ေါတည််း ခပငလ် ိုို့ ရန ိုင်ပါတယ။် 
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ခမန်မာန ိုင်ငံ ခပည်နယ်နှင်ေ့ တ ိုင််း ေသ မျာ်းပါရှ  သာ ပိုံက ို တ ိုက်ရ ိုက် Import လိုပ်ကကည်ေ့ပိုံ 

 လေ့ကျင်ေ့ြေန််း အ နခဖင်ေ့ မ မ က ိုယ်တ ိုင် GIS  ေတာမျာ်းက ို Google Earth တွင် Import လိုပ်ကကည်ေ့ပါ။ 

 

13.16 Google Earth မှ  အာက်ြေ ံ ကာင််းကင်ဓါတ်ပိုံမျာ်းက ို Save လိုပ်ပပ ်း သ မ််းထာ်းခြေင််း 

Google Earth Pro version မှာ Google Earth မှာ ခမင ်နရတဲေ့ ပဂ ြုလ်တိုဓါတ်ပိုံ  တွက ို Save လိုပ်ပပ ်း သ မ််းထာ်းြေျင်ပါက Main 

menu bar > File > Save > Save Image…  က ို နှ ပ်လ ိုက်ပါ။ 
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အဲေ မှာ က ိုယ်ကကည်ေ့ နတဲေ့ Computer Screen  ပေါ်ကခမင် နရတဲေ့ ပိုံ တွက ို သ မ််းတဲေ့အြေါမှာ၊ ဘယ ်Resolution နဲဲ့ သ မ််းြေျင်သလဲ 

 ရွ်း ပ်းလ ိုက်ပါ။ Resolution (width & height) မျာ်း လ ပိုံက ပ ိုပပ ်း အ သ်းစ တ် လ 

ခဖစ်ပါသည်။ အဲေ လ ို သ မ််းတဲေ့အြေါမျ  ြု်းမှာ Map Title ၊ Legend ၊ North Arrow 

စသည်တ ိုို့က ိုလည််း ထညေ့်ပါဝင်န ိုင်ပါသည်။ က ိုယ်တ ိုင် လက် တွဲ့ Save လိုပ်ကကည်ေ့ရန်။ 

 

 

 

 

 

 

 

 

 

 

PDF ပိုံ အ နခဖင်ေ့လည််း Print ထိုတ်န ိုင်ပါသည်။ က ိုယ်တ ိုင် လက် တွဲ့ လိုပ်ကကည်ေ့ရန်။ 

   
PDF ခဖင်ေ့ Print မလိုပ်မှ ပိုံ     PDF ခဖင်ေ့ Print လိုပ်ပပ ်းရလာ သာပိုံ 

 

13.17 Template ထဲရှ  Place Layer မျာ်းက ို သ မ််းထာ်းခြေင််း နှင်ေ့ ပယ်ဖျကခ်ြေင််း 

Places  အာက်တွင်ရှ  သာ မ မ  ရ်းဆွထဲာ်း သာ၊ ကကည်ေ့ထာ်း သာ ဖ ိုင်မျာ်းက ို Folder ထဲသ ိုို့ Save လိုပ်ပပ ်း၊ သ မ််းထာ်းလ ိုို့ 

ရသည်၊ Google Earth ထဲတွင် သ မ််းထာ်းလ ိုို့ရသည်။ Google Earth ထဲမှ ဖယ်ပစ်လ ိုို့ ရသည်။ လိုပ်ြေျင် သာ Folder  ပေါ်တွင်၊ 

ဖ ိုင် ပေါ်တွင် Mouse က ို တင်ထာ်းပပ ်း တာေ့ကာ 

Right-click > Save Place As.. ခဖင်ေ့ သ မ််းထာ်းန ိုင်ပပ ်း၊  

Right-click > Delete ခဖင်ေ့ ဖယ်ထိုတ်ပစ် န ိုင်ပါသည်။  

မ မ မှတ်သာ်းထာ်း သာ အမှတ်က ို ဖ ိုင်တစြ်ေိုအ နခဖင်ေ့ သ မ််းထာ်းြေျင်ပါက ၊ Menu bar > File > Save > Save Place As.. က ို 

နှ ပ်လ ိုက်ပါ။ ဖ ိုင်တစြ်ေိုြေျင််းစ က ိုလည််း သ မ််းထာ်းန ိုင်ပါသည်။ placemark, path, polygon စသည်ေ့ layer အစိုံပါရှ  သာ folder 

တစ်ြေိုလိုံ်းက ိုလည််း သ မ််းထာ်းန ိုင်ပါသည်။ 

 

အဲေ  သ မ််းထာ်းတဲေ့ KMZ သ ိုို့မဟိုတ် KML ဖ ိုင်မျာ်း က ို 

 နာက် နာင် ခပန်သိုံ်းပပ ်းကကည်ေ့လ ိုို့ရပါတယ်၊ 

အခြော်းသူမျာ်းက ို ပ ိုို့ ပ်းဖ ိုို့အတွက်လည််း သိုံ်းန ိုင်ပါတယ်။ 

KMZ ဆ ိုတာ KML က ို Zip လိုပ်ပပ ်း ြေျြုံဲ့ထာ်းတဲေ့ ဖ ိုင်ခဖစပ်ါတယ်။  ခဖြေျင်လျင် Zip က ို  ခဖပပ ်း ကကည်ေ့လ ိုကမ်ယ် 

ဆ ိုရင် doc.kml ဖ ိုင် နငှ်ေ့ လ ိုအပ် သာ ပိုံမျာ်းက ို  တွဲ့ရမှာ ခဖစပ်ါတယ။် 
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KML ဖ ိုင်မျာ်းက ို QGIS ထညေ့်သ ိုို့ Import လိုပ်၍လည််း ရန ိုင်ပါသည်။ 

 

13.18 KMZ နှင်ေ့ KML ဖ ိုင်မျာ်းက ို Google Earth တွင် ဖွင်ေ့ကကည်ေ့ခြေင််း 

KML (Keyhole Markup Language) ဆ ိုတာ Google Earth ကနာ်းလည်တဲေ့ ဖ ိုင်အမျ  ြု်းအစာ်းတစြ်ေို ခဖစ်ပါတယ။် Google Earth မှာ 

 ရ်းဆွထဲာ်းတဲေ့ placemark, path, polygon စသည်တ ိုို့က ို  ရ်းမှတ်ထာ်း သာ ဖ ိုင်ခဖစ်ပါတယ။် အဲေ လ ို format မျ  ြု်းနဲဲ့ 

 ရ်းမှတ်ထာ်းတဲေ့ ဖ ိုင်က ို Google Earth က န ခပန်ပပ ်း ဖွင်ေ့ကကည်ေ့န ိုင်ပါတယ။် Google Earth က ို သိုံ်း နသမ  ကာလပတ်လိုံ်း KML 

ဖ ိုင်မျာ်းခဖင်ေ့၊  ေတာမျာ်းက ို အသွင််း၊ အထိုတ ်ခပြုလိုပ်ကာ အသိုံ်းခပြု နရမည် ခဖစ်ပါသည်။ Location နှင်ေ့ Information အြေျ  ြုဲ့က ိုသာ 

share ပပ ်း ကျန် သာ  အာက်ြေံ ခမပိုံက Google မှသာ ခပန်ပပ ်း သိုံ်းရခြေင််းခဖစ် သာ ကကာင်ေ့  ပါို့ပါ်းပါသည်။ ေါဟာ Google Earth 

ရဲဲ့ ကာင််းကွက် တွထဲက တစ်ြေို ပါို့။ ဥပမာ USGS က ငလျင်လှုပ်ြေဲေ့တဲေ့  နရာ အမှတ်အသာ်း တွက ို  ပါို့ ပါို့ပါ်းပါ်းနဲဲ့ 

ကကည်ေ့န ိုင် အာင် KML ဖ ိုင် အ နနဲဲ့လည််း ခဖန်ဲ့ ဝ  ပ်းပါတယ။် http://earthquake.usgs.gov/earthquakes/map/ မှာ 

သွာ်းကကည်ေ့ပပ ်း Download ရယူန ိုင်ပါတယ။် 

 
19 December 2014  နဲ့မှာ ၂၄ နာရ  အတွင််းမှာ လှုပ်ြေဲေ့တဲေ့ Earthquake  တွအတွက် Download ခပြုလိုပ်ပပ ်း Google Earth တွင် 

ဖွင်ေ့ကကည်ေ့လ ိုက် တာေ့  အာက်ပါ အတ ိုင််း တွဲ့ရပါမယ်။ 

 
အခြော်း သာ KML ဖ ိုင်မျာ်းက ိုလည််း စမ််းဖွင်ေ့ကကည်ေ့လ ိုက်ပါ။ 
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13.19 GPS  ေတာ တွက ို Google Earth  ပေါ်ဘယ်လ ိုတင်မှာလဲ 

Garmin ၊ Magellan စသည်ေ့ GPS မျာ်းက ို Computer ထဲသ ိုို့ Serial port သ ိုို့မဟိုတ် USB port ကက ြု်းခဖင်ေ့ အရင်ဆိုံ်း 

ြေျ  တ်ဆက်ထာ်းပပ ်း GPS  ေတာမျာ်းက ို ထညေ့်သွင််း အသိုံ်းခပြုန ိုင်ပါသည်။ 

13.19.1 GPS မ ှ ေတာမျာ်းက ို ထညေ့်သွင််းရန်အတွက် Main 

menu > Tool > GPS က ို နှ ပ်ပါ။  

13.19.2 GPS အမျ  ြု်းအစာ်းက ို  ရွ်း ပ်းပပ ်း > Import က ို 

ဆက်နှ ပ်လ ိုက်ပါ။  ေတာမျာ်း Google  ခမပိုံ ပေါ်တွင် 

 ပေါ်လာပါလ မ်ေ့မည်။  

13.19.3 အကယ်၍ (လမ််း လျာက် နရင််း၊ 

ကာ်း မာင််း နရင််းနှင်ေ့) GPS ဖွင်ေ့လျက် မ မ လက်ရှ  

သွာ်း န သာ လမ််း ကကာင််းမျာ်းက ို Google Earth 

 ခမပိုံ ပေါ်တွင် ြေျက်ြေျင််းလက်ငင််း real-time ကကည်ေ့ြေျင်၊ 

တင်ြေျင်ပါက Realtime က ိုနှ ပ်ပါ။ မ မ ယြေို 

 ရာက် န သာ  နရာက ို  ခမပိုံ ပေါ်တွင် 

လာခပ နပါလ မ်ေ့မည်။ 

 

တ ိုင််းတာထာ်းသည်ေ့ GPS  ေတာမျာ်းက ို Spreadsheet တ ိုို့တွင် ရ ိုက်ထညေ့်ပပ ်း 

KML ဖ ိုင် အခဖစ်သ ိုို့ ခပာင််းပပ ်း Google Earth တွင် ခပန်သိုံ်းလ ိုို့ ရန ိုင်ပါတယ်။ 

အဲေ အတွက် ခပြုလိုပ်နည််း၊ ခပြုလိုပ် ပ်းတဲေ့ software မျာ်းစွာ ရှ ပါတယ။်  အာက်တွင် အသိုံ်းလွယ်ကူမည်ေ့ အြေျ  ြုဲ့က ို  ဖေါ်ခပ  ပ်းထာ်း 

ပါတယ။် 

 

 

 

13.20 Microsoft Excel က ိုသိုံ်းပပ ်း GPS  ေတာ တွက ို 

KML ဖ ိုင ်ခပာင််းနည််း 

မ မ တ ိုို့ကွင််းဆင််းပပ ်း တ ိုင််းထာ်းတဲေ့ GPS  ေတာ တွက ို MS Excel 

ထဲမှာ ခပန်ရ ိုက်ထညေ့ပ်ပ ်း တာေ့၊ KML ဖ ိုင် အခဖစ်သ ိုို့ ခပာင််းပပ ်း Google 

Earth တွင်ခပန်ကကည်ေ့န ိုင်ပါတယ်။ ေ လ ိုလိုပ်ဖ ိုို့ရန် အတွက် Macro 

Script  တထွညေ့်ထာ်းတဲေ့ အထူ်း MS Excel လ ိုအပ်ပါတယ်။ ယြေို  လေ့ကျင်ေ့ြေန််းမှာ တာေ့  ပ်းထာ်းတဲေ့ ready made template 

 လ်းက ို သိုံ်းကကည်ေ့ရ အာင်။ 



Basic GIS Training - Using QGIS 

 Copyright © MIMU 2020 121 

13.20.1  ပ်းထာ်း သာ programs folder ထဲမှ 

excel2kml.xls က ို ဖွင်ေ့လ ိုက်ပါ။ sheet ၃ ြေို 

 တွဲ့ရပါမည်။ 

13.20.2 ‘Data’ ဟူ သာ sheet ထဲတွင် 

တ ိုင််းတာထာ်း သာ GPS Latitude ၊ 

Longitude နှင်ေ့ အခြော်း အြေျက်အလက်မျာ်းက ို ရ ိုက်ထညေ့် ပ်းလ ိုက်ပါ။ 

13.20.3 File_details sheet ထကဲ ို သွာ်းပပ ်း output 

file က ို သ မ််းထာ်းမည်ေ့  နရာ 

(d:\myfile.kml  နရာတွင်) နှင်ေ့ file 

အမည်က ို ရ ိုက်ထညေ့် ပ်းပါ။ မ ခပာင််းမှ ပိုံ 

13.20.4  ခပာင််းပပ ်းပိုံမှာ  အာက်ပါ အတ ိုင််း 

ခဖစ်သည်။ 

13.20.5 Kml ဖ ိုင်က ို ထိုတ်ရန်အတွက် Alt + F8 က ို 

နှ ပ်လ ိုက်ပါ။  

13.20.6  ပေါ်လာ သာ Macro window တွင် 

generateKML က ို  ရွ်း ပ်း လ ိုက်ပါ။ 

13.20.7 Run က ို နှ ပ် ပ်းလ ိုက်ပါ။ 

13.20.8  ပ်းထာ်း သာ folder  နရာတွင် 

ဖ ိုင်နာမည်နှင်ေ့ KML  ရာက် နလ မ်ေ့မည်။ 

 

 

13.20.9 ရလာ သာ KML ဖ ိုင် 

အသစ်က ို Google Earth တွင် 

ဖွင်ေ့ကကည်ေ့လ ိုက်ပါ။ 

 

အဲေ လ ို KML conversion Macro ပါတဲေ့ Excel 

ဖ ိုင်မျ  ြု်း ရ အာင် မ မ က ိုယ်တ ိုင် Google 

က ပ်းထာ်းတဲေ့  လေ့ကျင်ေ့ြေန််း လ်း အတ ိုင််း 

 လေ့လာပပ ်း စ တ်ကက ြုက် 

ဖန်တ ်းယူလ ိုို့လည််း ရန ိုင်ပါတယ်။ 

 

 

13.21 CSV2KML software က ိုသိုံ်းပပ ်း GPS  ေတာ တွက ို KML ဖ ိုင် ခပာင််းနည််း 

csv2kml.exe free software က ို download ရယူန ိုင်ပါသည်။ csv2kml version အမျ  ြု်းမျ  ြု်းရှ ပါသည်။ အဆင် ခပရာတစြ်ေိုက ို ယူပပ ်း 

သိုံ်းကကည်ေ့လ ိုက်ပါ။ 

http://sourceforge.net/projects/csv2kml/ 

http://www.tchartdev.com/csv2kml.htm  

http://www.coveragetools.com/csv2kml  
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Install လိုပ်လ ိုက်ပါ။ တစြ်ေါတစ်ရံ Window extension မျာ်း လ ို နတတ်ပါသည်။ ရှာ ဖွပပ ်း ထပ်ထညေ့် ပ်းလျင် Run လ ိုို့ ရပါသည်။  

13.21.1 MS Excel ဖ ိုင်တွင် တ ိုင််းထာထာ်း သာ 

GPS အမှတ်မျာ်း၏ Latitude ၊ 

Longitude အပါအဝင် အခြော်း သာ 

Column မျာ်းက ို ရ ိုက်ထညေ့်ပါ။ 

13.21.2 ဥပမာ ၁ 

 

 

 

 

 

 

 

13.21.3 ဥပမာ ၂ 

 

13.21.4 Excel file က ို CSV (Comma Seperated) အ နခဖင်ေ့ Save 

လိုပ်လ ိုက်ပါ။ ဥပမာ ‘myGPS_point.csv’ 

13.21.5 Csv2kml software က ို run 

လ ိုက်ပါ။ 

13.21.6 သ မ််းထာ်း သာ csv ဖ ိုင်က ို 

browse လိုပ်ပါ။ 

13.21.7 Latitude နှင်ေ့ Longitude 

 ကာ်လံမျာ်းက ို 

 ရွ်း ပ်းလ ိုက်ပါ။ 

13.21.8 Run က ိုနှ ပ်လ ိုက်ပါ။ 

အဆင် ခပပါက successful 

ခဖစ် ကကာင််း  တွဲ့ရလ မ်ေ့မည်။ 

13.21.9 csv ဖ ိုင်သ မ််းထာ်း သာ  နရာတွင် kml ဖ ိုင် တစြ်ေို ဖန်တ ်း ပ်းပါလ မ်ေ့မည်။ 

13.21.10 အသစ်ရလာ သာ KML ဖ ိုင်က ို Double-click ပပ ်း ဖွင်ေ့လ ိုက်ပါ။ Google Earth 

တက်လာပပ ်း၊ KML တွင် ပါရှ သည်ေ့ layer မျာ်းက ို  တွဲ့ရပါလ မ်ေ့မည်။ 
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13.22 အခြော်း သာ KML ဖ ိုင်သ ိုို့  ခပာင််းန ိုင်သည်ေ့ နည််းလမ််းမျာ်း 

အခြော်း သာ GPS to KML, CVS to KML, DXF to KML, KML to DXF, စသည်တ ိုို့က ို အခပန်အလှန်  ခပာင််းလဲ ပ်းန ိုင်သည်ေ့ online 

program မျာ်းက ိုလည််း ဆက်လက်  လေ့လာသွာ်းန ိုင်ပါသည်။  

http://kmltools.appspot.com/csv2kml 

13.23 Google Earth အသို်ံးခပြုရခြေင််းရဲဲ့  ကာင််းတဲေ့အြေျက်က ဘာလဲ 

High resolution image  တွကကည်ေ့လ ိုို့ရန ိုင်တယ်။ အြေျ  ြုဲ့ထင်ရှာ်း ကျာ်ကကာ်းတဲေ့  နရာ တွမှာ ၆ လက္ြေန်ဲ့အထ  အ သ်းစ တ် 

ခမငန် ိုင်ပါတယ်။ ပ ိုက်ဆံမ ပ်းလဲ ကကည်ေ့လ ိုို့ရတယ။်  နရာတစြ်ေို ဘယန်ှာ်းမှာရှ မှန််း သ စရာမလ ိုဘနဲဲဲ့ အဲေ  နရာ နာမည်က ို 

ရ ိုက်ထညေ့လ် ိုက်ရိုံနဲဲ့ ကကည်ေ့လ ိုို့ရတယ။် Latitude/Longitude က ိုသ လ ိုို့ ရ ိုက်ထညေ့်ရင်လဲ ရတယ။် Offline storage လိုပ်လ ိုို့ရန ိုင်တယ်။ 

Internet မ ကာင််းတဲေ့လနူဲဲ့ ၊ ကွင််းဆင််းသွာ်းမဲေ့လူ တွ အတွက်က အလွန် ကာင််းတယ်။ 

 နရာမျာ်းက ို အမှတ်အသာ်း ခပြုလိုပ်ဖ ိုို့အတွက် ရ ို်းရှင််းပပ ်း၊ လွယ်ကူတယ်။ GIS သ စရာမလ ိုတဲေ့ သာမန် user အတွက် ပ ို ကာင််းတယ်။ 

ေါ ကကာင်ေ့ အဖွဲဲ့အစည််း တွမှာ ဝန်ထမ််းအမျာ်းစို အတွက် အသိုံ်းခပြုန ိုင်တယ်။ လွယက်ူတဲေ့အတွက် ကကာင်ေ့ မ မ တ ိုို့ရဲဲ့လိုပ်ငန််းမျာ်းက ို 

အပမဲတမ််း Monitor လိုပ်ဖ ိုို့ရန် အတွက် အသိုံ်းခပြုန ိုင်တယ။်  ခမခပင် ပေါ်မှာ ရှ  နတဲေ့အ နအထာ်းနဲဲ့၊  အာက်ြေံဓါတ်ပိုံတ ိုို့က ို  ခမပိုံကကမ််း 

အလွယ်တကူ ထိုတ်န ိုင်တယ်။ ကွင််းဆင််းသွာ်းတဲေ့ ဝန်ထမ််းနှင်ေ့ ရိုံ်းမှာရှ တဲေ့ ဝန်ထမ််းတ ိုို့ အလွယ်တကူ အခပန်အလှန ်Information မျာ်း 

ဖလှယ်န ိုင်တယ။် 

 

13.24 Exercises 

1. Project တြေိုစ က ို folder တစ်ြေိုစ ထာ်းပါ။ 

2. မ မ  project အလ ိုက် အလျင််းသင်ေ့ သာ placemark, path, polygon စသည်တ ိုို့ခဖင်ေ့ digitizing ခပြုလိုပ်ပပ ်း  ခမပိုံ ရ်းဆွပဲါ။ 

3. အြေျင််းြေျင််း share ခပြုလိုပ်ရန် အတွက် KMZ file မျာ်းက ို အသိုံ်းခပြုပါ။ 

4. Folder မျာ်းက ို Computer ထဲသ ိုို့ Save လိုပ်ပပ ်း သ မ််းထာ်းပါ။ 

5.  ခမပိုံက ို Grid ခဖင်ေ့ခပကကည်ေ့ပါ။ 

6. Save image ခဖင်ေ့ လ ိုအပ်လျင် ပိုံမျာ်းက ို အခြော်းသူအာ်းခပသရန်၊ Internal report တွင် အသိုံ်းခပြုရန် သ မ််းထာ်း ပ်းပါ။ 

7. Legend မျာ်း ထညေ့်န ိုင်လျင် ထညေ့် ပ်းပါ။ 

8. Printer ရှ ပါက Print tool က ို သိုံ်းကကည်ေ့ပါ။ 
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13.25 Add Photo 

13.25.1 JPEG, PNG, BMP, tif အမျ  ြု်းအစာ်း ဓါတ်ပိုံ သ ိုို့မဟိုတ ် ခမပိုံ တြေိုက ို Google Earth  ပေါ်တွင် ထပ်ပပ ်း 

ကကည်ေ့မည်ဆ ိုပါက Main menu bar > Add > Add Photo က ို နှ ပ်လ ိုက်ပါ။  

13.25.2 အမည်က ို  ရ်းထညေ့် ပ်းပါ။ 

13.25.3 မ မ  Computer ထဲရှ  ဓါတ်ပိုံက ို Browser လိုပ် ပ်းလ ိုက်ပါ။ 

13.25.4 ပိုံအတွက် View Parameter နှင်ေ့ Camera Parameter မျာ်းက ို ြေျ  န် ပ်းပါ။ 

13.25.5 Transparency ြေျ  န်ကကည်ေ့ပါ။ OK ဆက်နှ ပ်ပပ ်း ကကည်ေ့ပါ။ 

 

13.26 Add Image Overlay 

13.26.1 JPEG, PNG, BMP, tif အမျ  ြု်းအစာ်း ဓါတ်ပိုံ သ ိုို့မဟိုတ ် ခမပိုံ တြေိုက ို Google Earth  ပေါ်တွင် overlay 

ခပြုလိုပ်မည်ဆ ိုပါက Main menu bar > Add > Add Image Overlay က ို နှ ပ်လ ိုက်ပါ။  

13.26.2 အမည်က ို  ရ်းထညေ့် ပ်းပါ။ 

13.26.3 Image Link အတွက် မ မ  Computer ထဲရှ ပိုံက ို Browser လိုပ် ပ်းလ ိုက်ပါ။ 

13.26.4  ခမပိုံအတွက်  အာက်ြေံပိုံနှင်ေ့  နရာမှန်ကျ န အာင် Location (Image Extent) ညှ  ပ်းပါ။ လက်နဲဲ့ ဆွဲပပ ်း 

ညှ လည််း ရတယ်။ 

13.26.5 Altitude, View Parameter နှင်ေ့ Description မျာ်းက ို ြေျ  န် ပ်းပါ။ 

13.26.6 Transparency ြေျ  န်ကကည်ေ့ပါ။ OK ဆက်နှ ပ်ပပ ်း ကကည်ေ့ပါ။ 

 

13.27 Add Tour 

13.27.1 Google Earth  ပေါ်တွင် ြေရ ်းစဉ်တြေိုက ို Record ခပြုလိုပ်မည်ဆ ိုပါက Main menu bar > Add > Add Tour က ို 

နှ ပ်လ ိုက်ပါ။  

13.27.2 ဘယဖ်က်  အာက်နာ်းတွင် Tour က ို record ခပြုလိုပ် ပ်းမည်ေ့ tool  ပေါ်လာလ မ်ေ့မည်။  

13.27.3 အန  ရာင် အစက်နှင်ေ့ Recorder က ို စဖွင်ေ့လ ိုက်ပါ။ Record ခပြုလိုပ်ပါမည်။  

13.27.4 ကကည်ေ့ြေျင် သာ လမ််း ကကာင််းနှင်ေ့ လာ်းရာ view အတ ိုင််း စပပ ်းကကည်ေ့ပါ။ speed နှင်ေ့ 

movement မျာ်း အာ်းလိုံ်း Record လိုပ် နပါမည်။ 

13.27.5 အဆိုံ်းသတ်ရန် အတွက် Recorder က ို တြေျက် ထပ်နှ ပ်လ ိုက်ပါ။ 

13.27.6 အသင် Record လိုပ်ထာ်း သာ ြေရ ်းစဉ်အတွက် 

Play ြေလိုပ်က ို နှ ပ်ပပ ်း၊ ခပန်ကကည်ေ့ န ိုင်ပါပပ ။ 

Repeating play လည််း ခပြုလိုပ်န ိုင်ပါသည်။ 

13.27.7 Tour က ို ဖန်တ ်းရာတွင် Smooth moving ခဖစ်ရန်အတွက် လက်ယဉ်ပါ်း န အာင်  လေ့ကျင်ေ့ ရပါမည်။ 

13.27.8 Recorder tool ရဲဲ့ညာဖက်နာ်းက Save button က ို နှ ပ်လ ိုက်ပါ။ 

13.27.9 Tour က ို အမည် ပ်းပပ ်း OK နှ ပ်လ ိုက်ပါ။  

13.27.10 Tour recorder tool က ို ထွက်လ ိုက်ပါ။ 

သင်ေ့၏ စ တ်ဝင်စာ်းဖွယ် virtual ြေရ ်းစဉ်က ို အခြော်းသူမျာ်းက ို ခပန်ပပ ်း share ခပြုလိုပ် ပ်းန ိုင်ပါပပ ။ 
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13.28 Geotag Photo မျာ်း ထည်ေ့သွင််းခြေင််း 

Google Earth  ပေါ်တွင် ဓါတ်ပိုံမျာ်းက ို Geotag ခပြုလိုပ်ပပ ်း တင်ြေျင်ပါက Google ၏ ဓါတ်ပိုံ Album software ခဖစ် သာ Picasa 

လ ိုအပ်ပါမည်။ 

13.28.1 Picasa (Online) တွင် ဓါတ်ပိုံမျာ်းက ို Upload လိုပ်လ ိုက်ပါ။ 

13.28.2 ဓါတ်ပိုံတစြ်ေိုြေျင််းစ က ို သွာ်းပပ ်း Geotab this photo က ို လိုပ် ပ်းလ ိုက်ပါ။  

13.28.3 View this photo in Google Map က ို သွာ်းကကည်ေ့န ိုင်ပါပပ ။ 

13.28.4 Google Earth  ပေါ်တွင် ကကည်ေ့လ ိုို့ ရန ိုင်သည်ေ့ ဓါတ်ပိုံ အခဖစ်လည််း ခပြုလိုပ် ပ်းန ိုင်ပါသည်။ 

13.28.5 Panoramio က ိုတင်ပပ ်း တာေ့လည််း မ မ  Geotag ဓါတ်ပိုံမျာ်းက ို share ခပြုလိုပ်န ိုင်ပါသည်။ 

13.28.6 Google Earth ၏ Layers စာရင််း အာက်က Photos ထဲတွင် ရှ သည်ေ့ Panoramio ဟူသည် အမျာ်းက share 

လိုပ်ထာ်း သာ ဓါတ်ပိုံမျာ်း ခဖစ်ကကပါသည်။ 

 

13.29 Google Earth Profession version နဲဲ့ ရ ို်းရ ို်း Free version နဲဲ့ ဘာကွာသလဲ 

ခမင် နရတဲေ့၊ ကကည်ေ့ နရတဲေ့ Satellite ဓါတ်ပိုံက ပိုံက တာေ့ အတူတပူါပဲ။ ဘာပိုံမှ 

ပ ိုမလာပါဘူ်း။ အရင်တိုန််းက Professional version က ပ ိုက်ဆံ ပ်းရတယ။် Pro version မှာ 

Pro Feature  တ ွအပ ို ပါလာတယ။် Ruler မှာ ပ ိုစိုံတယ်။ High resolution ပိုံ တွ Save 

လိုပ်ပပ ်း၊ သ မ််းထာ်းလ ိုို့ ရတယ။် GIS data  တွက ို Import လိုပ်ဖ ိုို့ ပါလာတယ။် Offline Movie 

 တ ွ ဖန်တ ်းပပ ်း ၊ ခပန် share လ ိုို့ရတယ်။ လ ိုင်စင်အရ အရင်တိုန််းက တာေ့၊ ပ ိုက်ဆံ ပ်းရတာ 

ကွာတယ်။ ေါဆ ို ဘာထူ်းလဲ။ ထူ်းတာက တာေ့  

 အရင်တိုန််းက Profession version ဝယ်ထာ်းရင် အဲေ ခမင် နရတဲေ့၊ ကကည်ေ့ နရတဲေ့ 

Google Earth ထဲက Satellite ဓါတ်ပိုံ တွက ို  ခမပိုံအခဖစ် ခပန်ခပငပ်ပ ်း တာေ့ က ိုယ်ေ့ရဲဲ့ report 

 တွမှာ၊ စာတမ််း တွမှာ၊ ဂျာနယ် တွမှာ၊ သတင််းစာ တွမှာ ခပန်ပပ ်း တာေ့ ခဖန်ဲ့ြေွင်ေ့၊ 

အသိုံ်းခပြုြေွင်ေ့ရှ တယ။် မ ပ်းရင် ကကည်ေ့ရိုံပဲကကည်ေ့လ ိုို့ရတယ်။ ထပ်ဆင်ေ့ကူ်းယူ၊ ခဖန်ဲ့ြေျ  ြေွင်ေ့ မရှ ဘူ်း။ 

အ သ်းစ တ်က ို Google Maps/Earth Terms of Service မှာ ဆက်ဖတ်ပါ။ အြေို တာေ့ Pro 

Feature  တွက ို သိုံ်းြေွင်ေ့ခပြုလ ိုက်ပပ ၊ ပိုံ တွက ို ခပန်လည် ပိုံနှ ပ် အသိုံ်းခပြုြေွင်ေ့ ရ၊မရ က တာေ့ သူို့ရဲဲ့ 

လ ိုင်စင်မှာ ဖတ်ကကည်ေ့ပါ။ 

 

13.30 Google Earth Professional Feature မျာ်းက ို အသိုံ်းခပြုနည််း  

Google Flight Simulator 

Google Earth ရဲဲ့ 3D  ခမပိုံ ပေါ်မှာ 

လမ််း ကကာင််း လ်းဆွပဲပ ်း  လယာဉ် မာင််းသကဲေ့သ ိုို့ 

သွာ်းြေျင်ရင် တာေ့ Flight Simulator ဆ ိုတဲေ့ (Pilot က ိုင် 

စတ ယာရင် လ ိုမျ  ြု်း) အပ ိုပစစည််း လ်း လ ိုပါလ မ်ေ့မယ်။ 

အဲေ မှာ က ိုယ်သွာ်းြေျင်တဲေ့ နရာ၊  မာင််းမဲေ့ လမ််း ကကာင််း၊ 

 လယာဉ်အခမင်ေ့ ပ၊ ဘယ ်စာင််းညာ စာင််း၊ ဦ်းပ ိုင််းက ို 

အထက် အာက် နှ မ်ေ့ခမင်ေ့၊ အရှ န်အ နှ်းအခမန်၊ 

 လယာဉ်အတက်ဆင််း စသည်တ ိုို့က ို  ကာင််း ကာင််းကက ်း 

(ကက ်း ကာင်ကက ်းမာ်းနဲဲ့)  ဆာေ့ကစာ်းန ိုင်မှာ ခဖစ်ပါတယ်။ 

Google Earth Flight Simulator မရှ လည််း Keyboard ခဖင်ေ့  ဆာေ့ကစာ်း န ိုင်ပါ သ်းသည်။ Keyboard ခဖင်ေ့ အသိုံ်းခပြုပိုံက ို  အာက်ပါ 
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လင်ေ့တွင်  တွဲ့ရှ န ိုင်ပါသည်။  စာ လ်းပပ ်း ပင ်း ငွဲ့ နရင် အပျင််း ခပ စမ််းကကည်ေ့လ ိုို့ ရတာ ပါို့။ 

https://support.google.com/earth/answer/148092?hl=en 

 

3D Virtual Globe  ဲဲ့ပါ ်သက်ပပ ျား  ပခ ျားဘ   ွ ရှ  သျားလဲ 

3D Virtual Globe နဲဲ့ပတ်သက်ပပ ်း တာေ့ ထပ်မံ လေ့လာြေျင်ပါက  နာက်ထပ် Free software 

တစြ်ေိုခဖစ်တဲေ့ Marble ဆ ိုတဲေ့ software က ို ထပ်စမ််းကကည်ေ့န ိုင်ပါတယ။် သူို့မှာက Real-time 

satellite image မျာ်း၊ Historical  ခမပိုံမျာ်း၊ Climate နှင်ေ့ဆ ိုင်တဲေ့  ေတာမျာ်း၊ စသည်ေ့ 

အခြော်း သာ Layer မျာ်းနှင်ေ့ တကွ ၊ လကမဘာ နှင်ေ့ Venus ၊ Mars စသည်ေ့ အခြော်းပဂ ြုလ်မျာ်းက ိုပါ  လေ့လာန ိုင်တဲေ့ ခဖစ်ပါတယ်။ 

သူို့မှာလည််း Window, Linux, Mac အခပင ်Mobile ဖိုန််းမျာ်း အတွက်ပါ ရှ ပါတယ်။ စက်တင်ဘာလ ၂၀၁၄ မှာ ထွက်ထာ်းတဲေ့ Latest 

version က 1.91 ခဖစ်ပပ ်း၊ ၎င််းရဲဲ့ တရာ်းဝင် website မှာ ရယူန ိုင်ပါတယ။် 

https://marble.kde.org/ 

NASA World Wind 

 NASA World Wind က NASA က နထိုတ်တဲေ့ 3D Virtual Globle Free GIS 

Mapping software တစြ်ေိုပဲ ခဖစ်ပါတယ။် 

http://worldwind.arc.nasa.gov/java/  မှာ Download ရယူန ိုင်ပါတယ။်  

 

Google Earth အ ကကာင််းက ို ဆက် လေ့လာြေျင်ပါက 

http://www.google.com/earth/learn/ မှာ ဆက်ပပ ်း  လေ့လာ သွာ်းပါ။ 

KML  ရ်းနည််း အမျ  ြု်းမျ  ြု်းက ို ဆက်ပပ ်း တာေ့  လေ့လာသွာ်းပါ။ 

Virtual Globe မျာ်း အ ကကာင််း 

http://en.wikipedia.org/wiki/Virtual_globe  

  ဆ ိုတာလည််း ရှပါ သ်းတယ်။ အြေျ  န်ရပပ ်း စ တ်ဝင်စာ်းရင် စူ်းစမ််းကကည်ေ့ န ိုင်ပါတယ။်  

 

Google Earth Pro အသိုံ်းခပြုခြေင််း ေ မှာ ပပ ်းပါပပ ။ 

 

  

https://support.google.com/earth/answer/148092?hl=en
https://marble.kde.org/
http://worldwind.arc.nasa.gov/java/
http://www.google.com/earth/learn/
http://en.wikipedia.org/wiki/Virtual_globe
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မှ ခငမ််းက ို်းကာ်း 

www.qgis.org 

QGIS Training manual - http://www.qgis.org/en/docs/index.html 

QGIS User Guide - http://www.qgis.org/en/docs/index.html  

QGIS online tutorial 

A gentle introduction to QGIS 

http://docs.qgis.org/2.0/en/docs/index.html 

www.naturalearth.com 

Shape file Technical Description 

http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf 

www.wikipedia.org 

 

 

Abbreviation 

SQL  Structured Query Language 

SDI  Spatial Data Infrastructure 

GPS  Global Positioning Systems 

GIS  Geographic Information Systems 

RS  Remote Sensing 

 

http://www.qgis.org/
http://www.qgis.org/en/docs/index.html
http://www.qgis.org/en/docs/index.html
http://docs.qgis.org/2.0/en/docs/index.html
http://www.naturalearth.com/
http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf

